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EspressDashboard User's guide
Welcome to the EspressDashboard Online User's Guide.

Here you will find information about all the functions and features in EspressDashboard. For additional API re-
sources, please refer to the API JavaDoc for both the Report API and EDAB API.

EspressDashboard Users guide consists of several elements:

QuickStart This is a good starting point for EspressDashboard first time users. It ex-
plains some of the most commonly used features, and provides examples of
administration, report and chart design, and publishing.

Administration This section provides an overview of EDAB along with installation instruc-
tions, and information for administering the reporting environment.

Organizer This section explains how to use the Organizer interface, security fea-
tures, and provides information about using and connecting to different data
sources.

Designing Reports & Charts This section explains how to use all the design tools including the Chart
Designer, thin-client QuickDesigner Reports and QuickDesigner Charts.

Designing Maps This section explains how to use Map Builder interface for creating Google
and Bit maps.

Designing Dashboards This section explains how to use Dashboard Builder interface to create and
deploy dashboards as well as migrating Dashboards from one EDAB Server
to another.

Publishing (Menus & URLs) This section covers the built-in publishing features available with EDAB.

Programming This section explains how to use the EDAB API to manage users and groups,
customize the menu page, call the Organizer, and create a menu page listener.

Configuration This section explains how to configure EspressDashboard to run with differ-
ent application servers and databases.

Internationalization Explains how to set EDAB to create dashboards in virtually any language
and locale-specific formating.

Alerts Explains how to monitor your KPI (Key Performance Indicator) alerts.

If you upgraded from an older EDAB version, you might be interested in seeing the list of V7.0 new features.

Tip
If you're reading the PDF version, enable Bookmarks toolbar in your PDF viewer.

Please select an option from the menu on the left to begin.
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QuickStart
Q.1. Overview

Welcome to the EspressDashboard Quick Start Guide. This guide is the recommended starting point for users who
are new to EDAB and would like to get up to speed fairly quickly. This guide can also help users to quickly evaluate
the product capabilities.

This guide provides step-by-step tutorials for basic administration features, report and chart creation, and publishing
features. Only a small portion of the features are described in this guide, so for more information and detail, please
refer to the other sections in the User's Guide.

Q.1.1. Setup
The QuickStart assumes that you are working with EDAB in default configuration. This means a clean installation
using the Tomcat server that comes with EDAB and running connected to the default HSQL database. For more
information about installation options, please see Section 1.3.1 - Installing EDAB. The information and exercises
in this guide can be used in other configurations, however, references to certain options and file paths may not
be applicable.

For more information about EDAB components and architecture, see Section 1.1.1 - EDAB Components.

Q.2. Getting Started
The first step to run EDAB is to start the application server, if it didn't auto-start (installation default). In this
case, it means starting the Tomcat server that comes with the EDAB installation. To start the Tomcat, execute
startup.bat/.sh in the /bin/ directory of your Tomcat installation. If you installed EDAB on Windows,
you can also start Tomcat from a shortcut in the Start Menu.

After the Tomcat is successfully started, you can load the Start page for EDAB from the following location:

http://<machinename>:<port>/EDAB/index.jsp

Replace <machinename> with your server hostname or IP address, and replace port with the port you specified
for Tomcat during installation. The default port is 8080. If you installed EDAB on Windows, you can launch the
Start page from the Start Menu.

EDAB Start Page - EDAB Server is OFF
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Before we start working with EDAB, the EDAB Server needs to be running. If the Autostart feature has been
enabled during installation process (see Section 1.3.1 - Installing EDAB for more details), the EDAB Server should
be now running. If the server is off, turn it on by clicking on the Start Server button.

EDAB Server Started

Now you need to first login before continuing.

Q.2.1. Create a User
With the server running, login as the system administrator. The default login for the administrator is username:
admin, and password: admin. Once you have logged in, the Start page will be displayed.

Admin Logged into Start Page

To launch the Admin Console, click the Admin Console button in the lower left corner of the Start page.
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Admin Console

The Admin Console opens the User List tab. By default, the administrator is the only defined user. To add a new user
to the system, click the Add New User button. This will open a window allowing you to add details about a new user.

Add User Dialog

Enter details for a new user and make sure to select Designer as the primary role. Please note that if you select
Viewer as the primary role, you will not have access to the core design/development tools like Chart Designer,
QuickDesigner Reports, QuickDesigner Charts and Organizer. For more information about creating users, please
visit Section 1.4.1.1 - User List.

When you're done, click the Ok button to create a new user. The dialog will close and the new user will be added
to the user list in the Admin Console.

Now that you have entered a new user, return to the Start page by clicking on the  Home icon in the
upper left corner of the Admin Console.

Q.2.2. Start the Organizer
While we are still logged in as admin, let's do one more thing that will facilitate some of the exercises later. Click
on the Organizer in the left menu of the Start page. This will open a pop-up window. Confirm EDAB_Organiz-
er.jnlp file open by Java Web Start Launcher and the Organizer will open.
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Opening Organizer

If you're using a different browser like Chrome, you have to save the EDAB_Organizer.jnlp file first and
then open it from your download directory. You will see a window with a question: "Do you want to run this
application?" Click the Run button and the Organizer will open.

Opening Organizer in Chrome

Once the Organizer is opened, you will see this window:
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Organizer Interface

The Organizer is a virtual file management system that allows you to create, manage, publish, and schedule reports
and charts. The Organizer is used in conjunction with most of the other interfaces in EDAB and will be referenced
extensively throughout this guide.

Once the Organizer is opened, click the Manage Data Sources button  and the Data Registry Manager window
will pop-up. Highlight Sample.xml and click the Privilege button in the lower right corner of the window.

Data Registry List

A new dialog Set Data Registry Permission will be displayed. Click the Add button and switch to the User tab.
Highlight the user you previously created via Admin Console and click the Add button. Close the window by
clicking the Close button.
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Add Data Registry Privilege

Now check the Write and Read checkboxes in the Set Data Registry Permission window and click the Done button
to close it.

Data Registry Read Write Privilege

Close the Data Registry Manager window by clicking on the Close button and then close the Organizer. You should
now be on the Start Page.

Q.2.2.1. Login as User
We are done with all the administration activities, so you can now login as the designer user you created previously.
On the Start page, click the Logout button. This will logout the administrator out of the system.

Now log in again using the user that you created in Section Q.2.1 - Create a User. After you login, notice that the
administration functions are not available. Click on the Organizer on the left to open the Organizer.
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User Logged into Start Page

Q.2.2.2. Add a Project
Reports and charts in the Organizer are grouped into projects and folders. Now we are going to create a new project
in which to add reports and charts that we will use later in this guide. To add a new project, click the New Project

button on the toolbar . A new node will be added with the name New project or New project(1), if a node
of that name already exists.

To edit the new project, right click on the new node and select Edit from the pop-up menu. This will bring up a
dialog allowing you to re-name the project and to specify a description.

Edit Project Dialog

Specify a new name and description for the project and click Ok. The changes will be applied. When you select a
project in the Organizer, you will see its description at the bottom of the page.

Q.2.2.3. Inserting a File
If you do not have the Organizer open, open it. Then select your project in the left side window. Next, click the

Insert File button on the toolbar.  a new dialog allowing you to select a file to insert into the Organizer.
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Insert File Dialog

In the dialog, click the Browse button, navigate to help/quickstart/templates and select Quick-
Start42.tpl. The display name and corresponding URL should be automatically filled. Click the Ok button to
add the chart. The dialog will close and you will see an entry in the Organizer for the newly added chart.

Q.3. Setup Data Sources
Data sources in EDAB are maintained in XML data registry files. These files are created and managed from within
the Organizer. Detailed documentation about the data sources can be found in Section 3.1 - Data in Organizer.

Q.3.1. Create a Data Registry

To create a new data registry, open the Organizer and click the Manage Data Sources button . This will pop
up a dialog containing all the registries defined in EDAB.

Registry List Dialog

Click the Add button in this dialog to add a new data registry. A dialog will open prompting you to specify a name
for the registry. Enter any name you like (e.g. Quickstart_sample) and click the Ok button. The registry will
be created and the Data Source Manager window for the new registry will open.
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Data Source Manager Window

Q.3.1.1. Setup Database Connections
EDAB allows you to connect to JDBC compliant data sources. Few examples are included in your installation.

Q.3.1.1.1. Setup a JDBC Connection
In this tutorial, we will set up a JDBC connection to the Woodview HSQL database that comes with the EDAB
Installation. If you are running EDAB using the configuration described in Section Q.1.1 - Setup then the HSQL
JDBC driver will already be in the classpath of your Tomcat server, as HSQL is also used as the default EDAB
database. If this is not the case, or if you are using a different database for EDAB, you will need to make sure that
your database driver (hsqldb.jar for HSQL) is in the <EDABInstallDir>/WEB-INF/lib directory, or
in Tomcat's classpath.

The classpath and Woodview sample database were already created during installation, so you can select the Wood-
view database in your registry. From the Data Source Manager window, click on the Databases node in the left
panel, select Woodview and hit the Edit button to reach the following Setup Database panel, where HSQL is on the
Driver List, jdbc:hsqldb:help/examples/DataSources/database/woodview for the URL, and
org.hsqldb.jdbcDriver as the Driver. Click on both the Require Login and Save Password boxes. Next,
enter sa for the User Name and leave the Password blank will connect to the built-in HSQL database.
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Add Database Dialog

The procedure for connecting to other databases is very similar. First, select the type from the database list and
then fill in the values. The JDBC Driver will be automatically provided so it is usually not necessary to modify this
field. Here is an example connecting to a MySQL database.

URL: jdbc:mysql://192.168.0.55:3306/woodview 
Driver: com.mysql.jdbc.Driver 
User Name: root 
Password: ******

Leave the Auto Join and Table Name properties alone, and click the Test Connection button to make sure you've
entered the information correctly. Click OK to bring up the Data Source Manager window, where there will be an
existing node under Databases for Woodview.

Q.3.1.2. Create a Query
EDAB provides a number of different interfaces to query a database to retrieve the report data. You can type a SQL
statement, use the Query Builder, or use data views to create a query interface that insulates the end user from the
database structure. In this example, we will use the Query Builder to create a query.

To create a new query, click to expand the Woodview node in the left-hand frame of the Data Source Manager. Two
sub-nodes will appear, one called Queries and one called Data Views. Select the Queries node and click Add. A
dialog will appear prompting you to specify a name for the query and to select whether to launch the Query Builder
or to enter an SQL statement.

Query Name Dialog

Enter any name you would like, select Open query builder, and click on OK. The Query Builder will launch. You
will see a separate window containing all of the tables for Woodview sitting over top of the main Query Builder
window.
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Query Builder Dialog

To add a table to the query, select a table in the Tables window and click the Add button. You can also double click
on the table name. Using one of the two methods, add the following tables to the query:

CATEGORIES
CUSTOMERS
ORDER_DETAILS
ORDERS
PRODUCTS

The tables will appear in the top half of the Query Builder window. You will see the join lines connecting various
fields in the tables.

Query Builder with Tables

To add a field to the query, you can either double click on the field in the table window or double click on the Table
and Field fields in the lower (QBE) portion of the Query Builder window and select the table and field from the
drop-down menu. Using either method, add the following fields to the query.
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ORDERID from ORDERS
COMPANY from CUSTOMERS
REGION from CUSTOMERS
CATEGORYNAME from CATEGORIES
PRODUCTNAME from PRODUCTS
UNITPRICE from PRODUCTS
QUANTITY from ORDER DETAILS

In the eighth column, which should be blank, right click in theField field and select Build from the pop-up menu.
This will open the Formula Builder interface allowing you to create a computed column.

Formula Builder Window

To build a column, first click the left parenthesis button. Then double click on the Tables folder. It will expand
into five nodes, one for each table you selected for the query. Opening a table folder will list all of the column
fields in that table. Open up the PRODUCTS folder, select UNITPRICE and click Insert. Then click the add (+)
button. Next, insert STAINCOST from the ORDER_DETAILS table. Then click the right parenthesis button. Click
the multiply (*) button and finally insert QUANTITY from the ORDER_DETAILS column. The finished formula
should look like this:

(PRODUCTS.UNITPRICE + ORDER_DETAILS.STAINCOST) * ORDER_DETAILS.QUANTITY



QuickStart

13

Formula Builder Window with Formula

Click the OK button and the built column will be added to the query. Next, we will give the column you built an
alias. Right click on the column and select Alias from the pop-up menu. A window will appear asking you to enter
a column alias. Enter "SALES" (without quotation marks) and click the OK button.

Column Alias Dialog

Click the OK button and you will see the column name change in the Query Builder. Now click on the Datasheet
View tab in the Query Builder. Your query will run and you should see the first thirty records of the query results.
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Query Builder Datasheet View

Now that you have finished designing the query, select Done from the File menu to save the changes. This will
close the Query Builder window and return you to the Data Registry Manager window. There will now be a node
under Queries for the query you have just designed.

Data Source Manager With Query

Q.3.1.2.1. Add Query Parameters
EDAB allows you to easily parameterize queries, allowing report and chart data to be dynamically filtered at run-
time. In this tutorial we will add parameters to the query created in Section Q.3.1.2 - Create a Query.

To open the query that you created, select it, click the Edit button in the Data Source Manager, and click the OK
button. Your query will re-open in the Query Builder. The Tables window will open on top of the Query Builder.
Click Close to close the Tables window and scroll down in the lower (QBE) portion of the Query Builder window
until you see the Condition field. Right click in the Condition field under the ORDERID column and select Build
from the pop-up menu. This will bring up the Formula Builder allowing you to construct a condition for the query.
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Double click on the Tables folder within the Formula Builder to expand it. Then expand the ORDERS node and
double click on the ORDERDATE field. Next click the Between button and then click the Parameter button. This
will bring up a dialog prompting you specify a name for the query parameter.

Parameter Name Dialog

Enter StartDate as the parameter name and click the OK button. The parameter will be added to the query.
Then click the And button. Click the Parameter button again. Enter EndDate as the second parameter name. The
finished condition should look like this

Orders.OrderDate BETWEEN :StartDate AND :EndDate.

Formula Builder with Conditions

Click OK to close the Formula Builder and return to the Query Builder window. Now click on the Datasheet View
tab. Because you have just added two parameters to the query, an initialization dialog will appear, asking you to
specify a few properties for the query parameters.
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Parameter Initialization Dialog

From this window, click on Map to a database column and select ORDERS.ORDERDATE from the drop-down
menu. This will automatically fill the Default Value and Data Type options. Next, enter Start Date into the
Prompt Name, then click the Next Parameter button and map the EndDate parameter to the same column. Click
on the Define Value drop-down menu to select an end date. Select a date far enough from the start date that by
default you will have more than a couple records to work with (this makes report design easier). Change its Prompt
Name to End Date.

Click OK to close the initialization window once you have specified all the options. A new dialog will appear
prompting you to select a date range by which to filter the result set.

Parameter Selection Dialog

Select the Start and End date that you would like and click OK. You will now see the filtered result in the datasheet
window. Now, click Done from the File menu to save the changes you have made to the query.

Q.3.1.3. Create a Data View
A unique feature in EDAB is the ability to create data views. Data views are local schemas/views that allow an
administrator to pre-configure a group of tables and fields, so that the end users only need to select fields and define
simple conditions to create a query. Data views are also used with the ad hoc QuickDesigner. To create a data view,
select the Data Views node under Woodview and click Add.

This will open a new dialog asking you to select database tables you would like to use. Select the following tables
and add them to the Selected Tables panel by clicking on the ADD >> button:

CUSTOMERS
ORDERS
ORDER_DETAILS
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PRODUCTS

Data View Tables Dialog

Next, click on the Joins tab. You will see a representation of the tables like in the Query Builder. You can see the
auto-join lines between the tables. This window can be used to join the tables or modify the auto-joins if necessary
(for more about joins please see Section 3.1.3.2.1.2 - Joins). Click Ok to finalize the table selection. The next
window allows you to select and group fields for the view. At the top of the window you can specify a name for
the view. Name it Invoicing.

Next, double click on the CUSTOMERS folder to reveal the fields for that table. Add the following fields by double
clicking them or selecting them and clicking on the Add >> button:

COMPANY
CONTACTNAME
ADDRESS
CITY
STATE
ZIP

Now add fields from the other tables as follows:

ORDERS:

ORDERDATE
SHIPDATE
SHIPTO
SHIPADDRESS
SHIPCITY
SHIPSTATE
SHIPZIP

ORDER_DETAILS:

ORDERID
STAIN
STAINCOLOR
QUANTITY

PRODUCTS:
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PRODUCTNAME
UNITPRICE
STAINPRICE

Now click the Add Heading button. At the prompt, specify the name Customer Info. Add two more headings
in the same way, one called Shipping Info and one called Order Info. Once they are created, select the
following fields (Using CTRL+Click or SHIFT+Click for multiple selection):

COMPANY
CONTACTNAME
ADDRESS
CITY
STATE
ZIP 

Once the fields are selected, click the Group Fields button and select Customer Info from the drop-down list. The
fields will be moved under that heading. Next, select the following fields in the same way:

SHIPTO
SHIPADDRESS
SHIPCITY
SHIPSTATE
SHIPZIP
SHIPDATE

Add these fields to the Shipping Info group the same way as before. Next, select the following fields:

ORDERDATE
ORDERID
STAIN
STAINCOLOR
QUANTITY
PRODUCTNAME
UNITPRICE
STAINPRICE

Add these fields to the Order Info group. Next, select the CONTACTNAME field on the right side and click the
Rename button. In the dialog, specify the name Contact Name. Repeat this for every field in order to give it
proper names.

Next, select the Order ID field on the right side and click on the up arrow button to move the field to the top of the
Order Info heading. Use the arrows to arrange the items in the Order Info heading in the following order:

Order ID
Order Date
Product Name
Unit Price
Stain
Stain Color
Stain Price
Quantity
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Data View Fields Window

Now that the data view has been created, click the OK button in the fields window to save the view. It will be saved
as a new node under Data Views in the Data Source Manager.

Q.3.1.3.1. Query a Data View
Now that the data view has been created, you can write queries against the view. This allows users to develop queries
without knowing the underlying structure of the database. It also allows administrators to limit which database
elements the user has access to. In this tutorial we will create a query for the data view you created in. Section Q.3.1.3
- Create a Data View.

In the Data Source Manager, select the Invoicing data view. Then click the View button. This will open a dialog,
prompting you to select fields from the view. To select fields, first double click on a heading to expand it. Add the
following fields to the query by double clicking or selecting them and clicking on the ADD button:

Order ID
Order Date
Product Name
Unit Price
Quantity

Data View Query Field Selection Dialog
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Once you have finished adding the fields, click OK. This will bring up a new window allowing you to set conditions,
grouping, and ordering for the query. Like the Query Builder this window also allows you to preview the query
result with the Datasheet View tab.

Data View Conditions Dialog

First specify a name for the query in the space provided at the top. Then double click on the Condition field for the
Order Date column. This will bring up a dialog allowing you to specify a condition for the field.

Specify Condition Dialog

Click the Between button. A new dialog will appear prompting you to specify a start and end date with which to
filter the results. Select 2003-10-12 as the first date and 2003-12-09 as the second.

Specify Condition Fields Dialog

Click OK to close the dialog and add the condition. You will be taken back to the conditions window. Now you can
click on the Datasheet View tab to preview the query. Click OK in the main window and the query will be saved
using the name you provided. You will then be taken to a screen showing the result of the data view query. Options
in this screen allow you to use the results to create a report or chart. Click Cancel in this dialog to close the interface
and return to the Data Source Manager. There will now be a new node for your query under the Invoicing data view.
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Q.3.1.4. Setup a Text Data Source
In addition to database data, EDAB can also draw data from flat files(XML and text). In this tutorial we will setup
a text file data source in the registry. To add a new text file, select the node labeled TXTFiles and click the ADD
button. This will bring up a dialog allowing you to specify a display name and the location for the text data source.

Enter any display name you would like (e.g. Sample). Then click the Browse button and browse to the help/
examples/DataSources/text directory. Select the sample.dat file.

Setup Text File Dialog

After you have finished entering the information, click OK. You will see a new node in the Data Source Manager
for the text file.

Q.4. Chart Designer
After setting up data sources and creating queries, the next step to creating charts is to take the results of the data
source and map them to the chart. This section only covers basic charting from mapping the data to modifying the
look and feel. For more information, please refer to Section 4.1 - Chart Designer.

Q.4.1. Chart Mapping
This section will look at several ways that data can be mapped to charts. This section will use the text file data
source that was setup in Section Q.3.1.4 - Setup a Text Data Source.

Q.4.1.1. Column Chart
Column charts are a good starting point as the mapping for column charts is very similar to that of bar, area, and line

charts. To begin creating a chart, click the Chart Designer button in the Organizer toolbar . This will launch
the Chart Designer interface and open the Data Source Manager. Click CHANGE DATA option in the lower right
corner, select Quickstart_sample.xml data registry and click OK.

Change Data Registry
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Select Data Registry

Now, select the Sample text data source and click the NEXT button. A dialog will open a table with the contents
of the text file (first 20 records).

Contents of Text File

At the bottom of the dialog, click the Next button. A dialog will open asking you if you would like to select an
additional data source for the chart.

Add Data Source Dialog

Select the Process Data option and click Next. You will then be taken to a dialog prompting you to select which
type of chart you would like to create.
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Chart Types Dialog

In this dialog, leave selected a Column Chart (the first image) and a 2D option (two-dimensional chart) as the data
type and click Next. You will then be taken to the data mapping dialog which allows you to map columns from
the data source to chart elements.

Chart Data Mapping Dialog

Set the Data Series to None, the Category to Drink and the Value to value. Then click Done to finish the Wizard
and go to the Chart Designer interface.

If the generated chart does not fit in the viewport of the Chart Designer, select Canvas from the Format menu. This
will bring up a dialog allowing you to set the size of the chart.
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Chart Canvas Dialog

Enter a smaller size for the chart canvas and click OK to close the dialog. You should now see the whole chart
in the viewport.

Chart Designer Showing Column Chart

Notice that the column chart contains a column for each distinct value in the Drink column and shows the corre-
sponding value.

Q.4.1.1.1. Add a Data Series
At this point, the column chart only contains data points for the categories Drink column. However, EDAB sup-
ports adding another dimension to this data by way of a series. To add a series to the column chart, click the Data

Mapping button in the toolbar . This will return you to the data mapping window.

In the mapping window, change the Data Series option from None to Day and click Done to return to the Chart
Designer.
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Chart Designer Showing Column Chart with Series

Notice now that instead of a single data point for each drink, the column for each drink is now comprised of seven
small columns, one showing the data point for each day.

Q.4.1.1.2. 3D Column Chart
In a two-dimensional chart, the data series is represented in-line along the X axis. However, a three-dimensional
representation provides another axis to work with.

In the Chart Designer select 3D Chart from the Type menu to convert the column chart to a 3D representation.

Chart Designer Showing 3D Column Chart

The 3D toolbar will automatically appear at the bottom of the Chart Designer when the chart is converted to 3D.
The chart may appear squished when you convert it. You can use the sliders next to the zoom function to change
the X, Y, and Z scaling for the 3D chart. You can also use the navigation buttons to position the chart in space. For
more information about 3D features, see Section 4.1.4.4 - The Navigation Panel.

Notice that with the chart in 3D, the data series is now moved to the Z axis of the chart by default.
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Q.4.1.2. Pie Chart
Pie charts are another commonly used chart type that shows values as a percentage of a whole. To convert your chart
to a pie chart, first go to the Type menu and select 2D Chart to convert your column chart back to two-dimensional
form. Then select Pie from the Type menu. The chart will then be converted to a pie representation.

Chart Designer Showing Pie Chart with Series

Multiple pies are drawn when you have a data series; one for each category. Each category is broken down showing
percentage contribution for the series elements.

In order to turn the chart into a single pie, we will remove the series. Click the Change Data Mapping button 
on the toolbar to bring up the mapping options.

Data Mapping Options for Pie Charts

Change the Data Series option to None and click Done. Now in the Chart Designer you will see a single pie made
up of your drink categories.
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Chart Designer Showing Pie Chart

Q.4.1.3. Stack Column Chart
Another way to display multi-dimensional data is to use a stack type representation to show contributions to a total.
To convert your pie chart into a stack column chart, select Stack Column from the Type menu. Chart Designer will
ask whether you want to redo data mapping for the new chart type. Click Yes and confirm the change by clicking
Done in the “Select Data Mapping for 2D Stack Column Chart” dialog. The chart will then be converted to a stack
column layout.

Chart Designer Showing Stack Column Chart

Notice that the chart now shows the columns as stacks made up of the values for each drink. Now click the Data

Mapping button  on the toolbar. In the data mapping window there is a new option called Sum by. This is set
to the Day column. The Sum by column provides the individual stacks in these types of charts. Set Sum by to Drink
and Category to Day. Click Done to return to the Chart Desinger. You should see the following chart.
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Stack Column Chart

Now that you have finished designing a chart, click the Save button on the Toolbar . A dialog will open prompt-
ing you to specify a location and file name for the chart.

Save As Dialog

Enter a file name, and select to use either a PAC, CHT, or TPL format. For more about chart formats, see Sec-
tion 4.1.6.1 - Saving Charts. The chart will be saved in the /ChartFiles/ directory under the EDAB installation
by default. You will then be prompted to add the file to the Organizer. Select the QuickStart Examples Organizer
folder and click OK. Close the Chart Designer.

Q.4.2. Basic Chart Formatting
In this section, we will use some of the basic formatting features in the Chart Designer to change the look and feel
of an unformatted chart.

Right click on the QuickStart42.tpl file (which you added earlier in the Section Q.2.2.3 - Inserting a File
chapter) and select Open File from the pop-up menu. This will open the chart in the Chart Designer. As you can
see, it is relatively un-formatted.
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Unformatted Chart in Designer

Q.4.2.1. Axis Options
Many chart appearance options are controlled using the Axis Elements dialog. To bring up this dialog, click the

Format Value Elements button on the toolbar . This will bring up a tabbed dialog allowing you to set different
options for each chart axis. Click on the Y Axis tab to bring up options for the value axis.

Axis Elements Dialog

Check the box marked Show grid to add grid lines to the Y Axis. Select Fixed point for the data format and click
the Format button. This will bring up an additional dialog allowing you to set format options for the numeric data.
Select the number of decimals as 2 and click OK.
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Numberic Format Dialog

Click OK again to dismiss the axis elements dialog and you will see the specified changes reflected in the chart.

Chart with new Axis Formatting

Q.4.2.2. Modify Color and Font
Chart colors can be selected individually or you can select predefined color set. In Chart Designer, click on the
Color set tab on the right and select a color combination you like.

Now click on one of the X axis (category) labels. The lower left corner of the design window will reflect your
selection. In the font dialog in the lower right corner, change the angle of the labels from 90 to 45 degrees and
press Enter.

Font Panel

The chart labels will then rotate. You may need to adjust the position of the labels slightly. To do this, click and
drag on a label. All the X axis labels will follow your cursor around the chart canvas.
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Q.4.2.3. Add Titles
Next, we will add titles to the chart. To do this, select Titles from the Insert menu. This will bring up a dialog
prompting you to enter a main title for the chart as well as titles for each of the axes.

Chart Titles Dialog

Enter any titles that you would like for the various elements and click OK. The titles will then be added to the
chart. Titles are placed automatically but you can manually adjust their positions by clicking and dragging the text
on the chart canvas.

If you do not see chart titles, click and drag on the chart plot to move the chart. You should then be able to see
the titles. You can adjust the font and font size of the chart titles by clicking them and changing the settings in
the font panel.
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Chart With Titles

Q.4.2.4. Customize Plot Area
You can also customize the plot of two-dimensional charts, creating a separate background for the data points. To
do this, select Plot Area from the Format menu. This will bring up a dialog allowing you to set display options
for the chart plot.

Plot Area Dialog

Select to draw both the Area and the Border with a Thickness of 1. Specify None for the Appearance. Once you
have specified the options, click OK and the plot area for the chart will be modified. You can change the background
color of the plot area by clicking to select it and then modifying the color in the color panel.
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Chart With Colored Plot Area

Now save the changes you have made to the chart and exit the Chart Designer.

Q.4.3. Advanced Charting Features
In this section we will use some of the charting features in EDAB to provide a chart that quickly conveys salient
information to the viewer. For detailed information about the features discussed in this section and other charting
features, please see Section 4.1.4 - The Chart Designer Interface.

Following the same procedure shown earlier, add the QuickStart43.tpl file under help/quick-
start/templates into your project in the Organizer. Then right-click on the entry for this file in Organizer
and select Open File from the pop-up menu. This will open the chart in Chart Designer.

QuickStart43.tpl in Chart Designer

The chart shows hourly defect counts for a manufacturing process. Since the chart shows three days worth of data
it is difficult to make out the individual points and the X axis labels are not legible because they are drawn on top
of each other.
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Q.4.3.1. Time-Series Zooming
One way to improve the chart, is to use the time series zooming feature to aggregate the data into fewer data points.
In this instance, lets look at the total number of defects for each eight hour shift, instead of plotting the data for
each hour.

To turn on zooming, select Time Zooming Options from the Format menu. This will bring up the following dialog.

Zoom Options Dialog

In this dialog, set the Scale to 8 hours and Linear option to true. Leave the Disable Upper Bound and Disable
Lower Bound options checked. Check the Enable Zooming option. This will bring up a new dialog prompting you
to select the aggregation for the zooming.

Aggregation Options Dialog

In this dialog, set the Primary Aggregate to be sum, the Minimum Scale to be 1 hour, and the Maximus Scale to
be 1 day. Then click OK to return to the zoom options dialog, and OK again to return to apply the zoom setting.
The chart now shows the total number of defects for each eight hour period.



QuickStart

35

Chart With Zooming Applied

Q.4.3.2. Control Areas
Next, we will use the control area feature to highlight any shift where there were more than 20 defects.

To add a control area, select Control Area from the Insert menu and then click Insert in the control range list. This
will bring up a dialog allowing you to select options for the new control area.

Control Area Dialog

In this dialog, enter a name for your control area. Then check the option marked Use Value Axis Scale, and enter
20 for the Starting Scale, and 30 for the Ending Scale. Then at the bottom of the dialog check the options marked
Show Label In Legend and Highlight Overlap Area. Then click OK to apply the control area. Notice how only the
areas where the number of defects is colored. You can set the color, by selecting the overlapped area, and selecting
a new color from the palette on the right-hand side.
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Chart With Control Areas Applied

Once you have finished modifying the chart, click the Save button on the toolbar to save the changes you have
made and close the Chart Designer.

Q.5. QuickDesigner Reports
QuickDesigner Reports interface provides a thin-client interface for creating ad hoc queries and reports. In this
chapter, we will create a query and a report using QuickDesigner Reports.

To start QuickDesigner Reports, go to the EDAB Start page and login using the user created in Section Q.2.1 -
Create a User. When you login click the link labeled QuickDesigner Reports to launch QuickDesigner Reports.

Q.5.1. Create a Query
QuickDesigner Reports allows you to build a report using any data source from the Organizer. However, if you want
to modify a data source, you can only query DataViews or modify existing DataView queries using QuickDesigner
Reports.

When QuickDesigner Reports opens, there are only two options accessible, to create a new report or open an existing
one.
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QuickDesigner Reports

Click the  New button on the toolbar and the Data Source Dialog will open. Select the Quickstart_sample data
registry from the left top drop-down list (the data registry you created in Section Q.3.1 - Create a Data Registry).
The tab bellow shows all of the defined data sources in the registry. Expand the nodes and select the DataView
Invoicing that you created in Section Q.3.1.3 - Create a Data View. You will see all headings and fields of
the view in DataView Builder in the right pane of Data Source Dialog. Add the following fields from the Order
Info heading by clicking on them in the left side panel.

Order ID
Order Date
Product Name
Unit Price
Quantity

Data Source Dialog
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After adding the columns, click the Build Formula button to build a computed column. This will launch the Formula
Builder in a new window.

Formula Builder

In the Formula Builder, expand the View node in the right-hand side. Then expand the Order Info  node. Under this
node click the Unit Price entry. The text will be added to the main formula window. Click the multiply button (*).
Finally, select the Quantity field. The finished formula should look like this: {Order Info.Unit Price}
* {Order Info.Quantity}. Once you have finished, click OK to add the formula. A new column will be
added in the column selection dialog.

To provide an alias for the expression column, select it and click the Rename button. This will bring up a dialog
allowing you to specify the alias.

Rename Dialog

Enter SubTotal as an alias for the computed column and click OK. The computed column is renamed.
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Renamed Column

Click the Next button to submit the column selection. The next dialog that opens allows you to set sorting, grouping,
and conditions for the DataView query.

Conditions Dialog

Click the  Condition Wizard button for the Order Date field. Select the Select From Column option and
then click the Between operator.
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Condition Operators

This will open a dialog allowing you to select a date range by which to filter the query.

Select Condition Value Dialog

Select the date range that you would like and click OK. The condition will be added for the Order Date field.
Now you can preview the finished query by clicking the View DataSheet tab.

Data Preview
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Next, go back to the Conditions tab and click the Save Query button to save this DataView query back to the registry.
This will bring up a dialog prompting you to select a name for the query.

Save Query Dialog

Enter the name you would like to use for the query and click OK. The new query appears under DataView node
in the left pane of the Data Source Dialog.

New DataView Query

Q.5.2. Create a Report
Now that you have completed the query, click OK to close the Data Source Dialog and to open the main page of
QuickDesigner Reports.
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QuickDesigner Reports Main Page

You can insert any column to the report by using a double-click on the column or by dragging it to the report. So,
insert columns Order ID, Product Name, Unit Price, Quantity, SubTotal.

Columns Selecting

Collapse the left Column pane by clicking the  Collapse button and adjust the width of columns. To do this, move
your mouse over the right side of the column header. You will see a double arrow. Then left click and drag it.
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Column Width Setting

Right click on the Order ID header, select Aggregation and then Group(Row Break) option.

Aggregation Dialog

Right click on the SubTotal header, select Aggregation and then SUM option. Your report should look like this now:

Report with Aggregation
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Q.5.2.1. Format Report Elements
QuickDesigner Reports allows you to change the style of the report by using several predefined styles. Click the

 Styles button on the toolbar. The Styles dialog will open above the report.

Styles Dialog

Select the style you like, e.g. the Blue style, and close the Styles dialog by clicking Hide button.

Style Applied

Next, place a pagination under the report. Click  Pagination/Scrolling button on the toolbar and Pagina-
tion/Scrolling dialog opens. Select Bottom option for Paginator Position and click OK.
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Pagination/Scrolling Dialog

Now, add a report title. Click the  Report Title button on the toolbar and the Report Title dialog appears. Type

Order Information as the title and click  Apply button.

Report Title Dialog

The report title appears on the left side of the report by default. Move it to the center of the report. Click on the
title, hold the mouse button and move the mouse slightly. Dashed rectangles appear. Move the title to the middle
rectangle and release the mouse button.

Title Placement

Your report should look like the report below. For more detail about all the formatting option available in Quick-
Designer Reports, see Section 4.2.4 - Format Report Elements.
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Report With Changes Applied

Q.5.2.2. Save the Report
Now that you have finished formatting, you can save the report you have created back to Organizer so that other

users can view it. To save the report, click the Save button on the toolbar . This will bring up a dialog allowing
you to specify a name for the template.

Save Report Dialog

Enter a name for the report, and select the QuickStart Examples project that you created in Section Q.2.2.2 - Add
a Project. Click Save button to save the report.

Q.6. QuickDesigner Charts
QuickDesigner Charts is a thin-client ad-hoc charting interface. It provides users a scaled-down design tool to create
charts. With QuickDesigner Charts, end users can easily select, filter, and present data without mastering database
structures, all with zero client download.

For more detailed information about all the chart options available in QuickDesigner Charts, see Section 4.3 -
QuickDesigner Charts.
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Q.6.1. Create a Chart
To start QuickDesigner Charts, go to the EDAB Start page and click the link labeled QuickDesigner Charts. Quick-
Designer Charts should open, and you can create a new chart or open an existing one.

QuickDesigner Charts

Click the Create New Chart button on the toolbar . You will be taken to the Data Source Dialog, where you
can select a data registry and a data source for a new chart. Select the Quickstart_sample data registry from the
top left drop-down list, and then select the Sample.dat text file data source that you created in Section Q.3.1.4
- Setup a Text Data Source. You can see records of the text file in the View Data Sheet window on the right side
of the Data Source Dialog. Click the OK button to continue.

Data Source Dialog

You can see the Chart Mapping dialog that allows you to select the chart type and mapping options. Select to create
a 2D High Low chart using the first options in the dialog.
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Chart Mapping Dialog

For the mapping options select year as the Data Series, Day as the Category, high as the High, low as the Low,
and close as the Close. Click OK and the chart will open on the right side of QuickDesigner Charts.

QuickDesigner Charts Interface

Q.6.1.1. Format Chart Elements

Click the Canvas Size button on the toolbar . This will bring up a dialog allowing you to set the size of the
chart canvas. Set the size to be 500 by 400 pixels and click OK.
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Chart Canvas Size Dialog

Next, click the Font Settings button on the toolbar . This will bring up a dialog allowing you to set the font
options for the different text elements in the chart. From the drop-down list in the top of the dialog select X Axis
Labels. Then set the font to be Arial, 8 pt, and Plain.

Chart Font Dialog

Now repeat this process for the Y axis labels and the legend text, setting them all to be Arial, 8pt and Plain.
Click OK.

Next, click the Format Legend button on the toolbar . This will bring up a dialog allowing you to set display
options for the chart legend. Change the Layout option to Horizontal, uncheck the Border option, and change
the 3D Effect option to None. Click OK to apply the changes.
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Format Legend Dialog

Now left click on the chart, hold the mouse button down and move the chart to keep the best position. Do the same
with the legend. You can also set the plot area size by dragging the sides or dragging the corners of the chart. To
do this, mouse over the side or the corner of the chart until you see the arrow. Then left click and drag.

Finished Chart

For more detailed information about all the chart formatting options available in QuickDesigner Charts, see Sec-
tion 4.3.5 - Data Formatting.

Q.6.1.2. Save the Chart
Now that you have finished formatting the chart, you can save it back to the Organizer. To save the chart, click the

Save button on the toolbar . This will bring up a dialog allowing you to specify a name for the chart.
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Save Chart Dialog

Select the QuickStart Examples project that you created in Section Q.2.2.2 - Add a Project and enter a name for the
chart. Click OK to save the chart. The window will then give you a message to indicate that the chart was saved
successfully. Click OK to close the dialog.

Q.7. Online Maps
An alternative way of presenting your data is by using the EDAB maps feature. EDAB maps are designed to report
geographical data from data sources. They fetch geographical data from a data source and mark them on a map.
There are two types of maps: Online Maps and SVG Maps. We will work with Online Maps at first and then with
SVG Maps. (SVG Maps are described in Section Q.8 - SVG Maps.)

Q.7.1. Create Coordinates
Before creating an Online Map, you will need to create a coordinates file. Coordinates files contain coordinates of
places that you want to mark on the map. For more details about coordinates, see section Section 5.2.4.2 - Create
Coordinates.

After launching Online Maps, you can create a new map, open some existing map, or create/edit coordinates.
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EDAB Online Maps

Click the  Coordinates Editor/Edit Coordinates icon on the toolbar. The Coordinates Editor will open.

Coordinates Editor Start Options

Click the  New Coordinates icon. The Data Source Dialog will appear, allowing you to select a data source for
the coordinates file. Select the Sample data registry and click on the TXTFiles node to show all TXT data sources.
Select the Customers data source. You can see a table displaying records of the selected data source in the right
pane. It allows you to check whether you chose the right data source. Click OK to close the Data Source Dialog.
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Selecting Data Source

You will be prompted to choose a method of obtaining coordinates from the data source. There are three methods for
this purpose (to learn more about how to choose the right method, see section Section 5.2.4.2 - Create Coordinates).
The best method for our Customers data source is to obtain the coordinates directly from the data source, so
click the From data source option.

How To Get Coordinates

Next step is to select data source fields that contain the coordinates.

Note
This step would be different if you chose some other method of obtaining coordinates (all possibilities
described in Section 5.2.4.2 - Create Coordinates).

Each Coordinates data record consists of latitude and longitude (obtained automatically or manually) and a Point
ID. The Point ID is an identifier of the place (e.g. city name, branch name, etc) and it is loaded from the data source
you chose to create Coordinates from. The Point ID can consist of several Point ID fields - each data source column
creates one field (except the fields, which contain longitude and latitude). Our data source has four columns City,
State, Longitude, and Latitude. Therefore, the Point ID will consist of two fields - City and State. The
upper option is labeled Longitude and the lower option is labeled as Latitude. Just set the upper field to data
source field that contains information about longitude (in this case, it is the Longitude field) and the lower field
to the data source field that contains latitude (Latitude). The following screenshot shows the correctly set dialog:
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Select Fields With Coordinates

Your dialog should look like the one in the previous screenshot. If it does, click the Apply button.

You can see a map with coordinates table in the right pane of the Coordinates Editor. When you move the mouse
arrow over one of the map markers or over a Point ID Table row, it will highlight the map marker and Point ID
Table row that match together. (For more information see Section 5.2.4.3 - Coordinates Editor Interface).

Coordinates Editor

Now you may save the coordinates file. To save, click on the  Save icon on the toolbar.
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Save Coordinates

Type CustomersCoordinates into the Enter Coordinates Name textfield and select the QuickStart Examples
Organizer folder created in Section Q.2.2.2 - Add a Project. Click OK to save the coordinates file.

Close the Coordinates Editor and go back to the Online Maps designer by clicking the Done button on the right
side of the toolbar.

Q.7.2. Create Online Map

Note
If you have not practiced creating coordinates, please do so. It may be extremely difficult to create
an Online Map without proper coordinates.

Open the Data Source Dialog by clicking the  New Map icon on the Online Maps toolbar. Select the Sample
data registry.

We will use a different data source than the one we used for the coordinates in previous section. Open the Databases
node, then the Woodview (HSQL) and the Query node and select the Customers query. Click OK to close the Data
Source Dialog.
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Selecting Data Source

Now, you will have to select a coordinates file from the Organizer. You will be able to see all projects, folders, and
coordinates that were inserted into EDAB Organizer. To select the coordinates file we created in previous section,
open the QuickStart Examples project (click on it), then select the CustomersCoordinates coordinates and
click Next.

Selecting Coordinates File

Next, you will need to set point mapping. To do this, you need to map at least one field from the EDAB Online
Maps data source to a Point ID field in the coordinates file data source. Both fields should contain the same type of
information (for example, city name). But you can map more than one field if that is required to uniquely identify
the location on the map (for example, city and state). When determining the map location of the EDAB Online
Maps data source record, the mapping function automatically searches for the same value of the mapped field(s)
in EDAB Online Maps data source and the mapped field(s) of the coordinates data source, and only the matched
points will be visible on the map. In a nutshell, the coordinates data source contains information about location of
data points on the map and EDAB Online Maps data source contains the data that you want to report on the map.
You may read more about point mapping in Section 5.2.5 - Coordinates Mapping.
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In this tutorial, we will map the City field to the CITY field and the State field to the STATE field. Just map
the fields and click Apply.

Set Point Mapping

Setting point mapping was the final step of the Maps Wizard. You should be able to see the Online Maps toolbar

and the Online Map with some marker on it (the left pane is collapsed by clicking the  Collapse button on the
screenshot).

Online Maps Designer

The Online Maps toolbar allows you to configure the Online Map. You can immediately see results of all changes
you make on the Online Map.

Save the map by clicking on the Save icon on the toolbar. Type CustomersOnlineMap into the Enter Map
Name textfield. Select the QuickStart Examples Organizer folder and click OK to save the map.

Q.7.2.1. Configure Tooltips
Tooltips show a brief report for a particular map marker. When the tooltips are enabled, each marker on the Online
Map has its own tooltip. After setting the tooltip template (report or chart) for the Online Map, upon mouse over any
map marker, the tooltip bubble will appear, displaying data relevant to the particular marker. Detailed information
about the tooltips can be found in Section 5.2.6.7 - Tooltips.
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Example: Google Map with Tooltip

Lets configure the tooltips for our CustomersOnlineMap that we created in the previous QuickStart section.

Click on the Tooltip template icon on the toolbar. The Add Tooltip Template dialog will appear.

Add New Tooltip

You can select an existing tooltip template or create a new chart or report tooltip template. When you choose to se-
lect new chart template, QuickDesigner Charts will launch. When you choose to select new report template, Quick-
Designer Reports will launch. The launched QuickDesigner Report or QuickDesigner Charts will use the Map Data
as a datasource to create a report or chart as a tooltip. In our example, Customer Query under Woodview(HSQL)
Query node is the datasource used by Quick Designer to create tooltip. For now, we will just make a very simple
report in QuickDesigner Reports. Visit Section Q.5 - QuickDesigner Reports, or the Section 4.2 - QuickDesigner
Reports for information about how to use QuickDesigner Reports.

Click the New Report Tooltip option to open QuickDesigner Reports.
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QuickDesigner Reports

Click Add All to add all columns to the report.

Tooltip Report

Click on the Save icon on the QuickDesigner Reports toolbar. Enter CustomersTooltip as the Name and
select the QuickStart Examples Organizer folder. Click OK to save the report.
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Save Report Dialog

Close QuickDesigner Reports by clicking the  Return to Map Designer icon on the toolbar.

Adding Tooltip

Move the mouse arrow over some map marker and a tooltip bubble will appear. As you can see, the bubble has

inconvenient dimensions for your report. To adjust the bubble dimensions, click on the  Tooltip Options icon
on the toolbar. Set width to 650 and height to 100 and click Apply.

Tooltip Option Dialog
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Close the currently open tooltip bubble (if any) and move mouse arrow over some marker. The tooltip should look
better now.

Online Map with Tooltip

Q.7.2.2. Setting Drilldowns

Click on the Drilldown Options icon on the toolbar. Select the Enable Drilldown option. The Available Tem-
plates treeview will open, showing all projects, folders and parameterized reports, charts and maps inserted in the
Organizer. Open the Examples project, then open the QuickStart and QuickStart Maps folder. Select
the GDrilldown report. This report has two parameters: CityName and StateCode. You have to select the
Online Map database fields containing corresponding data. In this case, map the CityName parameter to the City
field and the StateCode parameter to the State field. Click Apply. The drilldowns are configured now. Click
on a map marker, report will open in a new window. More info in Section 5.2.6.9 - Drilldowns.

Drilldown Options
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Q.8. SVG Maps
Unlike Online Maps, SVG Maps do not use map points. They use map areas. The map areas can be colored
according to some values from the map data source. Coordinates of the map areas are defined in SVG map image.
For more information see Section 5.3 - SVG Maps.

Q.8.1. Create a Map
To create a SVG Map, go to the EDAB Start page and click the link labeled SVG Maps. You can create a new SVG
map or open some existing SVG map.

New/Open Selection

Click the  Create New Map button on the toolbar. You will be taken to the Data Source Dialog, where you can
select a data registry and a data source for a new SVG Map. Select the Sample data registry (the left top corner of
the window). Open the Databases/Woodview (HSQL)/Query node, and select the OrdersCount query.

Data Source Dialog
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You can see records of the data source file in the DataSheet tab. Then click OK to close the Data Source Dialog.

The next dialog allows you to select a Map Image. Map Images are SVG image files with data structures containing
geographic data(see Section 5.3.3 - Area ID Mapping for more information about required image format), and must
be inserted into the Organizer before they can be used.

Select SVG Image Dialog

The Select SVG Image dialog contains a tree showing all Projects, Folders and SVG images inserted in the Orga-
nizer. Open the Examples project, then the QuickStart and the QuickStart Maps folder. You should be
able to see the SVG image named USA in the QuickStart Maps folder. Select it and click OK.

Now, you can set the connection between the data source and the SVG image. This is done by assigning a data
source field to the SVG map Area IDs (see Section 5.3.3 - Area ID Mapping to learn more about area ID mapping).
In this case, we have a map of the USA with state name abbreviations in its Area IDs. So we want to assign a field
containing the same type of data, which is the SHIPSTATE field. Set the Available columns drop-down menu to
SHIPSTATE and click OK.

Select Column with Area IDs

SVG map will open (Set Area ID Mapping dialog is colapsed on the screenshot).
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SVG Map Builder

As you can see, right now we have only the basic map with no data highlighted. There are two ways of adding data
to the SVG Map: Thresholds and Drilldowns.

Q.8.2. Set SVG Map Thresholds
Thresholds allow you to configure rules for coloring map areas according to its value in a particular data source
field (see Section 5.3.4.5 - Thresholds).

Example: SVG Map with Thresholds

To set thresholds, click on the  Set Thresholds icon on the toolbar. First of all, you have to select a data source
column containing numerical data that you want to report. We will use a column labeled as ORDERSCOUNT, which
holds information about number of orders made in a particular state.
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Set Threshold Dialog

Next, you can add some threshold value(s) in actual values, or percentage unit. We will use actual values for our

example. Click on the  Plus icon next to the blank field labeled as color. You will be prompted to enter
threshold value, which can be done by two ways – you can type it manually into the text field or you can select the
value from the drop-down menu. (There are three ways to enter threshold values for percentage units. The third way
is to enter a number of intervals.) Select the value 4 from the drop-down menu and confirm the dialog by clicking

OK. Click on the  Plus icon once again, and choose the value 11 from the drop-down menu and click OK.
EDAB has automatically set the ranges between values you added.

Setting Range

You can set color for each of the intervals. Click on the white color field next to the <=4 range. Click on some
yellow field in the swatches color table and click OK. Color of the <=4 range has changed to yellow. Click on the
color field next to the 4-11 range, choose a blue color and click OK. Click on the color field next to the >11 range,
choose a red color and click OK. The Set Thresholds dialog should look like the one on the following screenshot:



QuickStart

66

Setting Color

Confirm the dialog by the OK button. Areas of some states will be filled with the colors you previously set. Without
a legend, it can be unclear what the colors mean. So lets create one. Select the Enable legend option in the Set
Threshold dialog. The Thresholds table has changed. It has one more column now labeled as legend. You should
be able to write into the legend field. Fill in the column according to the following screenshot.

Set Thresholds- Legend

Set the Legend layout drop-down menu to Horizontal and set the Legend position to Bottom. Click OK. Then,
without map title, you have the same SVG Map image shown in the begining of this part.

Q.8.2.1. Add a Map Title

Click on the  Map Title icon on the toolbar. Select the Enable Map Title option. Type US Orders into the
Title text field, set Font Style to Bold and confirm by the OK button.
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Map Title

Q.8.3. Set SVG Map Drilldowns

Click on the  DrillDown Options icon on the toolbar. Select the Enable Drill-Down option. Organizer structure
will show up in Available Templates treeview. You will be able to see only folders and parameterized reports, charts
and maps inserted into Organizer. Open the Examples/QuickStart/QuickStart Maps folder and select
the SVGDrilldown report. Click OK.

DrillDown Options

When you click on a colored state area, a drilldown report should open in a new window.
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Map with Drilldown

To save the SVG Map, click on the  Save icon on the toolbar. Type OrdersSVGMap into the Enter Map Name
text field and select the QuickStart Examples folder from the Organizer treeview.

Saving Map

Q.9. Publishing
In the previous sections we looked at setting up EDAB and creating reports, charts, and maps. This chapter discusses
the automated publishing features in EDAB.

Q.9.1. Dashboards
In addition to URLs and the menu page, EDAB also allows you to publish reports and charts using a dashboard
interface. Dashboards can place multiple charts and report tables into a single presentation page. Users can define
common filters for the dashboard items and set up drill-down for individual dashboard items.
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Q.9.1.1. Create a Dashboard
Dashboards are created in the thin-client Dashboard Builder interface. To launch the Dashboard Builder, click the
Dashboard Builder link in the EDAB start page. The interface will allow you to build a new dashboard.

Dashboard Builder Interface

In this section we will guide you through creating a dashboard from report, chart, and map templates that come with
EDAB installation. At first we need to add some templates to the dashboard. To add reports, charts, or maps to the

dashboard, click the Add Report/Chart/Map icon  on the Dashboard Builder toolbar. After you have clicked
the button, the Insert Reports/Charts/Maps dialog will appear. The dialog contains a tree that mirrors the folder
structure in the Organizer. Next, expand the Examples node and then the QuickStart and QuickStart Dashboard
sub-nodes as shown on the image below.

Insert Reports/Charts/Maps Dialog

From the dialog click on all the templates (Sales By State map, Products Sales report, and Total
Sales By Category chart) in the QuickStart Dashboard node. This will insert the templates into the dashboard.
Once you have inserted the templates, close the dialog by clicking Close button.

Now move the Sales By State map template by clicking to the map header and drag it to the lower left position in the
dashboard. Then select the Total Sales By Category chart and drag it to the upper right position in the dashboard.
Finally, move Products Sales report and drag it below the chart. You can also resize the chart/report/map by clicking
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and dragging the sizing handle that appears in the lower right corner of the templates. After completing these steps,
the dashboard should look like the following image:

Dashboard with Added Templates

Next, we will add dashboard shared parameters that allow us to group common parameters from the chart, report,
and map into a single parameter. First open the Shared Parameters dialog by clicking on the Shared parameters

icon  on the toolbar. This will open the Share Parameters dialog that allows you to add shared parameters to
the dashboard.

Share Parameters Dialog

From the dialog, click Add Share button. This will open another dialog that allows you to specify a shared parameter.
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Shared Parameter Dialog

The left-hand side of the dialog shows all the available parameters from all the charts/reports/maps in the dashboard.
You can select which parameters you would like to add to the selected parameters list by selecting them in the
left-hand side and clicking the Add button. Note that all parameters in the selected parameters list must have the
same data type.

In this example, we will create two shared parameters (Start Date and End Date) and put them into a date
range panel. We will start with the first parameter (Start Date). First, enter the parameter name Start Date
to the Shared Parameter Name text box at the dialog top. Enter the same text to the Prompt Name text field and then
select all the Start Date parameters from the list on the left (you can select the parameters by CTRL+Clicking
on the appropriate items in the list). After you have selected all the Start Date parameters from the list, click
the Add button. This will add the selected parameters to the list on the right. At this moment the shared parameter
dialog should look as follows:

Shared Parameter Dialog - Start Date Parameter

Now click the OK button. This will put you back to the shared parameters dialog. As you can see the new shared
parameter Start Date has been added to the shared parameters list.
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Share Parameters Dialog - Start Date parameter added

Next, we will add the second shared parameter End Date in the same way as mentioned above. From the dialog
click the Add Share button again, which will open the shared parameter dialog. Enter the parameter name and the
prompt name End Date and select all the End Date parameters from the list on the left. After you have selected
all the parameters, click the Add button.

Shared Parameter Dialog - End Date Parameter

Click OK button. After adding both parameters you should see the same shared parameters dialog as follows:
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Shared Parameters Dialog - Added Parameters

In the dialog, select both parameters by CTRL+Clicking on the parameters as shown in the image below.

Shared Parameters Dialog - Selected Parameters

After selecting the parameters, click Set Range button. This will open the Range Param Attributes dialog that allows
you to specify ranges for the parameters.
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Set Date Range Dialog

As you can see there are lot of options in the dialog. Please note that we will describe only the options necessary
for the example. For more information about the rest of options, please see the Section 6.2.4.2 - Parameter Range.

First, specify the Range Name in the text box at the top of the dialog, e.g. DateRange. The name represents the
title for the Date Range panel. Next, specify the Prompt Text to be Date Range. This text will be then displayed
next to the selected date parameter drop-down menu in the Date Range panel. After entering the names, we will
proceed with creating date ranges.

For simplicity we will add only two date ranges (Year 2003 and Year 2002) in this example. The range Year
2003 will include all the dates in year 2003 (dates from 2003-01-01 to 2003-12-31 in the Year-Month-Day
format). Similarly, the range  Year 2002 will include all the dates in year 2002 (dates from 2002-01-01 to
2002-12-31).

Now specify the name for the first range in the Option Name text box to be Year 2003. Next, enter the expressions
for the Start Date and End Date parameters to be 2003-01-01 and 2003-12-31. Once you have entered
the Range Name as well as the expressions, click Add >> button. This will add the date range to the list of selected
ranges on the right.

Similarly, add the second date range Year 2002. As mentioned above, first specify the range name to be
Year 2002 and enter the expressions for the Start Date and End Date parameters as 2002-01-01 and
2002-12-31. After that, click the Add >> button to add the range to the list of selected ranges on the right.
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Set Date Range Dialog - Specified Ranges

Once you have added both date ranges into the selected date ranges list on the right, click OK button. After that
click somewhere to the Dashboard Builder, and the date range panel appears.

Date Range Panel

Now move the panel above the map as shown on the image below. To move the panel, just click on the panel header
and drag it to the desired location. You can also resize the panel by clicking and dragging the lower right corner of
the panel. The resizing rectangle will then appear, allowing you to adjust the size of the panel.
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Dashboard With The Date Range Panel

The last thing we will do in this example will be adding links from the map to the chart and report in the dashboard.
This will enable sending the State parameter from the map data points to the chart and report.

To set up links from the map, click the Add/Modify Link icon  from the map header. This will open the Set Up
Link dialog below. There are three lists in the dialog. The first list contains all the available data columns and their
data types in the source template (in our case ,Sales By State map). The second list shows all the available
destination templates in the dashboard (in our case, Product Sales report and Total Sales By Category
chart). Finally, the third column contains all the available parameters in the selected destinate template. Please note
that the third column will show the parameters only after selecting the destination template in the second list.

Set Up Links Dialog

To set up a link from the map to the Product Sales report, select State (String) item in the first list and the
Product Sales item in the second list. This will cause showing the parameters from the report in the third list. After
that select State(String) item from the third list. This should enable Set button as shown on the image below. Click
the button to set up the first link.
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Set Up Links Dialog - Link From The Map To The Report

Similarly, set up a link from the map to the Total Sales By Category chart. First, select State (String) item
in the first list and the Total Sales By Category item in the second list. This will cause the parameters from the chart
in the third list to be shown. From the third list select State(String) item. This should enable Set button as shown
on the image below. Set up the second link by clicking the button.

Set Up Links Dialog - Link From The Map To The Chart

Once you have set up both links, click OK button that will close the dialog. At this moment the links from the map
should be set up. So if you now click on a data point in the map, the chart and report should refresh according to
the data point parameter value.

To finish our dashboard, we will just add a dashboard title and choose a dashboard background color. To add the

title, click the Insert Label icon  from the toolbar. A small rectangle will then follow your mouse cursor. Position
the rectangle where you would like to insert the label and click. This should add the label panel into the dashboard.
Next, double click to the label panel to edit the label text. Enter e.g. SALES BY STATE DASHBOARD text and
click outside of the label panel. You may also want to resize the label because the label is now too small to be the
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dashboard title. This can be done from the label properties dialog that opens after clicking on the Edit icon 
on the panel header.

Set Label Properties Dialog

You can specify various properties for the label from this dialog. In the dashboard preview screen shot below, we
just increased the label font size to 36px in the Text tab, disabled the panel border in the Border tab (write 0 to
the Thickness option), and set up the label background color to be transparent in the Background tab. Click OK to
apply changes. Now, click and drag the bottom right corner of the label border to be the whole title in one line. For
more information about the label properties, please see Section 6.2.5 - Insert Labels.

To change the dashboard background color, just click the Add Dashboard Background icon  on the toolbar.
This will open the Set Dashboard Background dialog from which you can choose the dashboard background color.
Select the color and click Apply.

Set Dashboard Background Dialog
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Once you have chosen the dashboard background color, you may preview the dashboard by clicking the Preview

button  on the Dashboard Builder toolbar. The dashboard display will open in a new window. For more infor-
mation about dashboard features, see Section 6.1 - Introduction to Dashboards.

Dashboard Preview

Q.9.1.2. Save the Dashboard

Close the dashboard preview window to return to the main Dashboard Builder interface. Click the Save button 
on the toolbar. A dialog will open prompting you to specify a name for the dashboard.

Save Dashboard Dialog

Enter a name for your dashboard and then from the treeview pane select the project that you created in Sec-
tion Q.2.2.2 - Add a Project. Click Ok to save the dashboard. The window will then give you a message that the
dashboard was saved successfully. Click Ok to close the dialog.
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Q.9.1.3. Export Dashboard to PDF

Click the Options button  on the Dashboard Builder toolbar and check the option Show toolbar in preview (in
the Other section). Click Apply to apply the setting. Open the dashboard preview window by clicking the Preview

button . Then click the Unpack button  to open the preview toolbar. You can export dashboard to PDF

file by clicking Export Dashboard button  from the preview toolbar.

Export Dashboard from Preview

All the reports, charts, SVG Map and other objects in the Dashboard will be exported to PDF file with the exception
of Google Map due to licence restrictions.

Alternatively, you may open the same .dsb file in Published Files (for more information please see Section 7.1 -
The Menu Page ), open the Dashboard toolbar and Export PDF there.

Note: There may be small differences in the appearance of elements in export (e.g. radio button shape can change
from round to square).

Q.9.2. URLs
One automated deployment provided in EDAB is the ability to run dashboards via URL calls to the EDAB server.

To generate a URL, first log into the Organizer, using the steps described in Section Q.2.2 - Start the Organizer. With
the Organizer interface open, select the project you created in the left-hand side (Section Q.2.2.2 - Add a Project).
You will see a list of files added from the previous exercises. Select the QuickStart_Dashboard.dsb file in

the Organizer (dashboard created above), and click the Generate URL button on the toolbar . A dialog will
open, prompting you to specify option For Current User.

URL Options Dialog

In this dialog, disable the option marked For Current User. This will create the URL without encoding a username
and password, prompting users to login when running the URL. Click OK and the URL will be generated in the
Dashboard URL dialog.
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Generated URL

Now, select the generated URL and copy the text to the browser's location dialog. Hit enter to run the URL. You
will first be directed to a login dialog because you selected not to pass in the username and password in the URL.

URL Login Dialog

Enter your User Name and Password in the dialog and click the Login button. The dashboard will then load in
the browser.

Q.9.3. The Menu Page
Another way that EDAB automatically publishes reports, charts, maps, and dashboards is through the Menu Page.
The Menu Page is a thin-client interface that allows users to run/view the reports, charts, maps, and dashboards to
which they have access in the Organizer.

To launch the Menu Page, go to the EDAB Start page and click the link labeled Published Files. The Menu Page
will load.

Menu Page

The page contains a list of all the reports, charts, maps, and dashboards in your project and some examples. The
only option available is to run the file because you do not have any active schedule or archive jobs. To open a file,
expand respective project/folder nodes (in the left-hand tree-list) to locate the file and click on the file name. The
file will load in the right-hand DHTML Viewer panel.
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For more information about the options and functions available in the Menu Page, see Section 7.1 - The Menu Page.
After you have finished viewing your report/chart/map/dashboard, close the window that contains it, and click the
Home button in the menu interface to return to the start page.

Q.10. Alerts
In previous sections, you learned how to create reports, charts, and maps (let's call them “objects”), and how to
publish them in dashboards. This section describes how to add and manage alerts in objects, how to “watch” alerts
in dashboards and how to monitor alerts automatically.

An alert is a range of some indicator (for example, profits/losses, sales, up-time, etc) you want or do not want the
indicator to reach. If the indicator's value reaches into the alert range (in other words: if an alert was triggered), you
will be instantly informed about that, so you can fix issues in a timely manner. More detailed information about
alerts can be found in Section 11.1 - What is an Alert.

First of all, you have to create the alert. That means that you have to select which indicator you want to watch and
what values are critical for you. Each object (report, chart, or map) can have its own alerts.

Q.10.1. Alerts in Charts
In Section Q.4.3.2 - Control Areas, you learned how to add a “control area” into a chart. That is all you have to know
to add alerts into charts – just open a chart in Chart Designer and add one or more control areas into it. Basically,
you can think of a control area as an alert in a chart.

Launch EDAB Organizer (as described in Section 2.1.1 - Starting the Organizer), expand Examples/Dash-
boards/Alerts Components and double-click on the Sales By Employee Chart.

Sales By Employee Chart Location

The Enter Dialog will show up. You do not have to change any parameter values, so just click OK to continue. You
should be able to see a chart now. You may notice that at least one control area has been already added into the chart.
The existing control area represents minimal sales limit – no employee should sell less than the limit. We will add
another alert that will indicate that employee's personal sales are not optimal, although they are not critically low.

Open the Insert menu and choose the Control Area option. Control Area Options dialog has appeared.

Note
You may have noticed that the Control Area Options dialog contains two control areas, but you can
see only one control area in the chart. That is because one control area (No sales, to be specific) is
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so small that it cannot be seen on current axis scale. This does not affect the alert in any way, it will
still work as if the control area was visible.

To add a new control area, click the Insert button. Now, it is time to set up our new alert. The first option is called
Label. The Label is set to New Range by default. Delete the default label and set it to Not Optimal instead.

Now we will set up the alert range. Set the Value Axis Starting Scale to 20000 and the Value Axis Ending Scale
to 40000.

To include the control area in the legend, choose the Show Label In Legend option.

Control Area Options

Note
Complete description of this dialog can be found in Section 4.1.4.6.3 - Adding Control Areas

Click OK to close the dialog. As you can see, our new alert was created successfully. Now click the OK button
again to go back to the Chart Designer. The new control area has appeared in the chart. It is highlighted by a random
color. To change the color, click on the new area and then choose an indicative color (for example, light red) from
the Color panel on the right side of the window. Save the chart and close the Chart Designer.
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Sales By Employee Chart

Q.10.2. Alerts in Maps
In the Section Q.8 - SVG Maps, you created a SVG map with thresholds. This means that you have also created a
map with alerts because thresholds are equivalent to alerts in maps.

Let's add a threshold into an existing SVG map. Open EDAB main page and click on the SVG Maps link. Click on

the  Open Map icon on the toolbar. Expand Examples/Dashboards/Alerts Components nodes in
the Open Map tree-list, select the Sales By State map and click the OK button. Click Submit to use default

parameter values. To manage thresholds, click on the  Set Thresholds icon. To add a new threshold (alert), click

on the  Add Threshold icon. In the Enter threshold value dialog, type 60000 and click OK. As new thresholds
are added, some legend labels are not right. The legend labels are important for alerts because they also double as
alert names. Set the 40000 – 60000 legend to $40,000 - $60,000. Now set the > 60000 legend label to More
than $60,000. Click on the > 60000 color field. Select Color dialog should show up. Choose an appropriate
color (for example, green) and click OK.

Now, the Set Thresholds dialog should look like this:
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Set Thresholds Dialog

If it does, click OK to confirm the changes. The map has been changed since you added the threshold. Click on

the  Save icon and click OK to save the changes. Click  icon in the top-right corner of the window to go
back to the EDAB main page.

Q.10.3. Alerts in Dashboards
In previous paragraphs, you added alerts into few objects. Now we want to make use of those alerts. There are two
ways to utilize alerts – alert watching and alert monitoring. This paragraph describes how to set up alert watching.
Alert watching is set up in dashboards. The basic principle is quite easy: insert some objects (reports, charts or
maps) into a dashboard and pick the alerts you want to watch.

Log on to the EDAB main page and launch Dashboard Builder. Click  Open icon. Expand Examples/Dash-

boards nodes, select Alerts Dashboard dashboard, and click Ok. All dashboard objects have  Set Alert
icons in their header bars. That means that all dashboard objects have some alerts that can be watched.

Locate the Sales By Employee Chart chart and click on its  Set Alert icon. The following dialog should appear.

Sales By Employee - Watched Alerts

There is the list of all alerts that you saw in Section Q.10.1 - Alerts in Charts. One alert is set to be watched.
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The list also includes the Not optimal alert you created previously. Check the Not optimal checkbox and uncheck
the No sales check-box.

Click Ok to close the dialog and then click on the  Preview icon in the main menu. Notice that the chart's border
is not flashing. That means that the Not optimal alert was not triggered. Now locate following panel:

Parameter Panel

Change the Quarter parameter to Q2. The border started flashing, because the alert was triggered with current
parameters. In other words: at least one Sales By Employee Chart chart bar ends in the Not optimal control area.

You may also notice that the Sales Overview Report header is flashing. That is because the report contains
a watched alert which is triggered. You cannot see the report until you click on its tab header, but you can tell that
an alert is triggered in the report.

Please note that alert highlighting, blinking and alert messages are visible only in Preview of the Dashboard Builder.

Q.10.3.1. Sound alerts and alert messages
Border flashing is not the only way to alert you. You can also set alert messages and sound alerts. Close the Preview

window and click again on the  Set Alert icon for the Sales By Employee Chart. For our watched Not Optimal
alert, check Sound and enter any message into Alert Message textbox. Click on OK and use Preview button to
preview the dashboard.

Trigger the alert by changing the Quarter to Q2 in the Parameter Panel and an alert message with your entered

text will appear and you will also hear a beep sound. To mute the sound, click on the  Mute icon in upper right
corner of the chart. Please note that each template has its own Mute button. To close the alert message, simply
click on OK button.

Triggered alert message

For more information about alerts, please refer to Section 11.3 - Alert types.

Q.10.4. Alert Monitoring
Another way of using alerts is alert monitoring. Unlike alert watching, alert monitoring checks alerts even when
there is no dashboard running.

Lets set up a new alert monitoring job. Log on to the EDAB main page and click the Organizer button. Expand
Examples/Dashboards/Alerts Components nodes and select the Sales By Employee Chart file.
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Sales By Employee Chart Location

Select Set Alert Monitoring from the Schedule/Archive menu. The following dialog should show up:

Setup Alert Monitoring Dialog

Click the Add button. Expand Examples/Dashboards/Alerts Components nodes, select the Sales
By Product Report report and click OK.On the Set Alert Monitoring dialog select Low sales and Low
revenue alerts. Type Low sales into the Display Name field. The dialog should look like this now:
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Setup Alert Monitoring Dialog

If it does, click Next.

You should be on the Set Timing tab now. By default, the alerts would be checked just once, few minutes after
configuring it. Select the At a regular time interval option. Set Time Interval dialog should show up. Default time
interval is 1 minute, which is fine for us, so just click OK to confirm it. Uncheck the Run Indefinitely checkbox and
click the change button right next to it. Set the end time one hour to the future (so you do not have to delete the job
manually after you are done with this QuickStart chapter) and click Ok. The dialog should look like this:

Set timing

Click Next. Click Add to add new parameter set to the Sales By Employee Chart chart. Click OK to use default
parameters. Click on the Sales By Product Report tab header, click Add and OK again and then click Next. The
next step is configuring delivery options. This requires further knowledge and we will skip this step right now. If
you are interested in setting delivery options, see Section 11.4.3.1 - Create/Edit monitoring dialog. Click Next. The
following dialog should appear allowing you to check your settings before saving the alert monitoring job. Click
Confirm to save the alert monitoring job.
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Alert Monitoring Summary

You should be back in Organizer now. Click on the Schedule/Archive pull-down option in the main Organizer menu
and select View Alert Monitoring Tasks option. The following dialog should open:

Alert Monitoring Tasks Dialog

The Low sales task should be on the list. Check the Last check time value. If no check was performed until
now, it will show N/A. You can either wait for next automatic check (look at the Next check time if you want to
know when that's going to happen) and then click Refresh. You can also select the Low sales task and click
Run Now and then click Yes.

After the task was checked, click Refresh. You should be able to see the results.
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Alert Monitoring Tasks Dialog

The Last check result indicator is red. That means that at least one alert was triggered during last check. Also notice
that the Last triggered time is now the same as Last check time.

Select the Low sales task and click Edit. Select the Sales By Product Report and then click the Remove
button. Click Done and then click Confirm to save the changes.

Wait for the automatic check or click Run Now again. Click Refresh.

Alert Monitoring Tasks Dialog

Now, the Last check result indicator is green. That means that no alert was triggered during last check.

Note
Please, keep in mind that this is just a quick guide which should guide you through basic steps of
configuring alert monitoring. In reality, data in the database would be changing constantly; therefore,
you would not have to change alert monitoring job properties in order to trigger/not trigger an alert.



91

Chapter 1. Administration
1.1. Overview & Architecture

Welcome to EspressDashboard (hereafter referred to as EDAB). EDAB is a powerful, server-based information
presentation and delivery system. EDAB provides a fully secure environment where users can create and deploy
feature rich dashboards.

With EDAB, users can easily draw data from a variety of sources and create a wide range of charts, reports, and
maps using the integrated Chart Designer, QuickDesigner, and Map Builder. The Organizer interface provides a
virtual file management and permission system for all reports, charts, maps, and dashboards.

There are two visual design interfaces for creating charts, namely the applet based Chart Designer and the zero-client
QuickDesigner. Reports can be created and edited with the QuickDesigner only. Chart Designer is a full-featured
chart creation and editing tool that empowers the user with complete control of the chart type and features in editing
the chart, while the QuickDesigner provides a subset of the chart features and aims at zero learning curve and
quick turn around time. Since reports in dashboards are typically quite simple in nature, QuickDesigner is the only
interface for designing reports.

Deployment features allow users to automatically publish dashboards through the integrated menu features, and
by generating URL requests.

1.1.1. EDAB Components
EDAB is composed of 8 main components:

EDAB Server: The server is the back-end to EDAB. It deploys as a servlet collection within
an application server or servlet container, and manages design and deployment
for dashboards. The server handles user authentication and provides the data
access and file I/O for clients running the Chart Designer and QuickDesigner
components.

Organizer: The Organizer is a powerful graphical user interface that acts as a virtual file
management system. It allows users to organize charts, reports, maps, and dash-
boards in virtual folders, generate URLs deploying dashboards, and set file-lev-
el privileges. It also provides users with an interface for managing data sources,
and designing database queries.

Chart Designer: The Chart Designer is a graphical user interface, launched within the Organizer
that allows users to design and customize full featured charts. Its point and click
interface enables the swift and easy creation of charts with an almost infinite
degree of flexibility.

QuickDesigner Reports: The QuickDesigner Reports is a thin-client ad-hoc reporting tool. It allows users
to quickly design data view queries, to use existing data sources, and build re-
ports. Limited formatting options allow users to customize reports and save
them back to the Organizer.

QuickDesigner Charts: The QuickDesigner Charts is a thin-client ad-hoc reporting tool. It allows users
to quickly design data view queries, to use existing data sources, and build chart-
s. Limited formatting options allow users to customize charts and save them
back to the Organizer.

Online Maps: Online Maps is a thin-client tool that allows users to create online maps using
OpenStreetMap or Google© maps. The easy to use interface allows users to
create elegant maps with parameters, titles, legends, and drilldowns. For Online
Maps maps, reports and charts can be directly embedded into the tooltips.

Dashboard Builder: The Dashboard Builder is a thin-client tool that allows users to create custom
dashboard presentations. The simple interface allows users to select charts, de-
fine parameters and drill-down using elements deployed in the Organizer.
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Chart Viewer: The Chart Viewer is a Java Web Start Application allows charts to be viewed
remotely. It enables viewers to rotate, resize, zoom and pan a chart. Viewers
can click on individual data points to either recover the data associated with the
data point, or link to another chart.

EDAB API: The EDAB API is a Java application programming interface that allows users to
interface programmatically with the EDAB Server and Organizer. Users can get
a handle to the Organizer to retrieve information about files and permissions.

1.1.2. EDAB Architecture
The following diagram illustrates the basic architecture of an EDAB implementation/installation:

EDAB Architecture Diagram

The EDAB server deploys as a servlet collection within an application server/servlet & JSP container. Other servlet-
s/JSPs can be deployed in the server to connect to, and retrieve information from the EDAB server (like file names,
schedule information, and schedule reports/charts).

On the back end, information for EDAB including user/group information, the Organizer structure and files, and
security and privilege information are saved in a database. The server also performs data access and buffering for
reports and charts, and file I/O on the server-side.

Clients can be administrators modifying users, privileges, and server settings from the remote Admin Console, or
the Organizer. Clients can load the Chart Designer through the Organizer to create full featured charts, or load the
thin-client QuickDesigners for creating basic reports and charts. Clients viewing dashboards can access the menu
page and make dashboard URL calls to the EDAB server.

1.2. New Features List V7.0

1.2.1. New EspressDashboard Features

1. Unified data registry dialog in Quick Designers and Map Designers allows users to view query, query result,
and test with different parameter values, so users can locate the desired query easily (Section 3.2 - Data in
QuickDesigners and Maps).

2. Diagrams on start page of Quick Designers and Map Designers helps end-users to understand how to use the
tools quickly (Section 5.2.3 - Start Online Maps).
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1.2.1.1. Dashboard Builder (Chapter 6 - Designing Dashboards)

1. Being able to change chart type in dashboard preview gives end-users more control on dashboard contents (Sec-
tion 7.4.2 - Preview Options).

2. Directly opening report/chart/map designer from dashboard builder makes it much more convenient to edit ex-
isting components or add new components (Section 6.2.3 - Add Charts, Reports and Maps).

3. Besides original static dashboard, responsive dashboard is added as a new dashboard type. Responsive Dash-
board optimizes utilization of the display without exceeding the display width preset by user. Therefore, it’s
useful for mobiles (Section 6.2.2 - Responsive Dashboard).

4. Refresh Template icon on each report/chart/map makes it easier to test dashboard with real data (Section 6.2.3.3
- Chart/Report/Map Toolbar).

1.2.1.2. QuickDesigner Reports (Section 4.2 - QuickDesigner Re-
ports)

1. Simplified UI includes only two steps: Select Datasource and Construct Report.

2. Constructing and formatting report in only one interface makes it intuitive and easy to see what you get and
flexible to make changes (Section 4.2.4 - Format Report Elements).

3. Drag and drop to add report columns and order report column ease the work of report design (Section 4.2.4.1
- Add a Column, Section 4.2.4.5 - Column Order).

4. Right click on report column to do Aggregation/Format/Remove is straightforward (Section 4.2.6 - Aggrega-
tion/Group, Section 4.2.7 - Data Formating, Section 4.2.4.2 - Remove a Column).

5. ’Excel-like’ search icon on each column header allows data filtering by column (Section 4.2.9 - Data Filtering).

6. Parameters pane on the right makes report testing easy (Section 4.2.5 - Parameter Setting).

7. Less items on Toolbar reduces confusion and saves time (Section 4.2.3 - Toolbar).

8. Collapse Sidebars allow more space for report design (Section 4.2.4.3 - Collapse Sidebars).

1.2.1.3. QuickDesigner Charts (Section 4.3 - QuickDesigner Charts)

1. Simplified UI includes only two steps: Select Datasource and Construct Chart.

2. Setting pane and chart preview pane are on the same window, so all design steps can be done on one window
(Section 4.3.3 - Data Mapping and Ordering).

3. Improved toolbar shows Chart-Specific Options based on current chart type and combines settings to reduce
icons (Section 4.3.5.5 - Chart-Specific Options, Section 4.3.4 - Toolbar).

4. Parameters setting on Chart Preview pane makes chart testing easy.

5. Collapse Sidebar allows more space for chart design.

1.2.1.4. Online Maps (Section 5.2 - Online Maps)

1. Online Map is a newly designed Google Map. It is more straightforward to create a new map (Section 5.2.3 -
Start Online Maps).

2. Displaying setting on left pane, instead of popup dialog, makes UI more user-friendly.
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3. Save dialog shows Organizer node tree. It makes it easier to locate the desired organizer folder to save map file
(Section 5.2.7 - Save Map).

4. Heatmap feature provides visualization of data intensity (Section 5.2.6.6 - Heatmap).

5. Being able to set parameter values in Map Designer makes testing easier.

6. More map types satisfies different needs (Section 5.2.6.5 - Map Options).

7. Users can draw various shapes instead of simple map points. The shapes are drawn in Coordinates Editor (Sec-
tion 5.2.4.2 - Create Coordinates, Section 5.2.4.2.3 - Manually).

1.2.1.5. SVG Maps (Section 5.3 - SVG Maps)

1. Redesigned UI is more straightforward to create a new map.

2. Allow users to change SVG image after a map is created (Section 5.3.4.3.1 - Change SVG Image).

1.3. Installation and Configuration
There are many important installation and configuration options available in EDAB, so it is important to refer to
this section of documentation as you're starting out.

1.3.1. Installing EDAB
There are four versions of the installation program, one for Windows 10/8/7/Vista/XP/2003/NT/2000, one for So-
laris/Unix, one for Mac OS X, and a pure Java version.

Windows 10/8/7/Vista/XP/2003/
NT/2000:

To start the Windows installer, run the installEDAB.exe file and the
installer will launch.

Unix/Linux: To start the Solaris/Unix installer, execute the installEDAB.bin file,
and the installer will launch.

Mac OS X: To start the Mac installer, double click the InstallEDAB.zip file to ex-
tract the InstallEDAB.app file. Double-click on InstallEDAB.app,
and the installer will launch.

Pure Java: To start the pure Java installer, a Java Virtual Machine, the equivalent of
Java 1.8 or higher, must already be installed on the machine where EDAB
is to be installed. Make sure that the JVM is included in your path (or move
the installEDAB.jar file to the same directory as the JVM). From a
command prompt navigate to the directory where you have placed the in-
stallEDAB.jar file, and type the following command: java -jar
installEDAB.jar. The installer will then launch.

Each installer also comes with a console install mode where there is no graphical interface and the steps are per-
formed through a terminal/console window. To launch any installer in console mode, add -i console to the
end of the command. For example, for the Unix installer, you can execute the following command to run in silent
mode: ./installEDAB.bin -i console

Once the installation program has launched and you agree to the license agreement, the first option that is presented
asks you to specify the directory into which you would like to install EDAB.
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Choose EDAB Location Dialog

If the directory already exists and contains an installation of EDAB, the installer will give you the option to perform
a full or update install. If the directory doesn't contain EDAB, the installation will always be a full install. For more
information about update installs please see Section 1.3.1.1 - Re-Install/Update.

Install Type Dialog

For full installs, the next step will ask you whether you would like to install the evaluation or release version. The
evaluation version is fully functional. However, there will be a water mark on any report, chart, map, and dashboard
and the license will expire in 45 days. For update installs, it will always use an evaluation license. Please visit
https://www.quadbase.com/register/ to get the full license.

https://www.quadbase.com/register/


Administration

96

Install Version Dialog

If you select to install a release version, the next dialog will prompt you to enter your license key and verify the
host name of the machine on which you're installing EDAB.

Enter License Key Dialog

After you have entered the information, the installer will attempt to register the license key with Quadbase. If the
registration fails, you will be unable to continue installing the release version of EDAB. You will have the option
to continue installing the evaluation version. After the installation completes, you can register your key online at
https://www.quadbase.com/register/, or contact Quadbase Sales for additional help.

Note
After the installation completes, the release version will only run for the hostname specified in this
dialog, so double-check to make sure the host name is correct. You can also use the IP address of
the machine if you prefer.

https://www.quadbase.com/register/
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The next option that is presented is whether to install Tomcat with EDAB or not. As described in the previous
chapter, the EDAB Server deploys as a servlet collection in an application server/servlet container. For out-of-the
box functionality, you can install the Apache Tomcat server with EDAB already deployed. If you are installing
EDAB for the first time, or evaluating the product, it is recommended that you select this option.

If you select to install without Tomcat, the EDAB files will be installed in your system and you will need to manually
deploy it within your application server. Instructions for different server platforms are in Section 9.3 - Using Other
Application Servers.

Use Tomcat Dialog

The next dialog prompts you to select the directory into which you would like to install Tomcat. If you select not
to install Tomcat this option will be skipped. Tomcat and EDAB will be installed in different directories on the
system, and the EDAB directory will be mapped as a virtual directory in Tomcat.

Choose Tomcat Location Dialog

The next dialog prompts you to specify the connection options for the application server. This dialog appears
whether you choose to install EDAB with Tomcat or not. You will need to specify the machine name or IP address,
the port number, and the context for the application server on which EDAB will be running.
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Choose Tomcat Settings Dialog

After specifying the connection details for the application server, the next dialog asks you to choose whether to
auto start the EDAB Server, i.e., have the EDAB Server running whenever the application server is started.

Autostart EDAB Server

The next dialog asks you to choose the protocol you wish to use to access EDAB, i.e., do you wish to use http://
or https://?
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Specify Protocol for EDAB

If you choose https:// protocol and have selected to install Tomcat, the following two dialogs will appear. Note
that if you have chosen not to install Tomcat, you are responsible for setting the https connection details and the
certificate yourself.

The next dialog allows you to install Tomcat as a Windows service.

Install Tomcat as a service

If you choose to install Tomcat as a service, the next dialog will prompt you to select whether the service should
start automatically when the machine is started.
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Start Tomcat service automatically

The next dialog appears when the option to install Tomcat and the https:// protocol is selected. This dialog
obtains information to generate a generic SSL certificate for the installed Tomcat to use.

Specify User and Organization Information

For this dialog, you cannot leave any information blank nor can you use a comma. If either of the two happens or
if the two letter country code is not two characters in length, a error message is shown and you will be prompted
to enter the information again.

The last option in the installer is only available for the Windows 10/8/7/Vista/XP/2003/NT/2000 installation. It
allows you to specify where to create the program shortcuts in the Start Menu, on the Desktop, or both. Note that
shortcuts will only be created if you select to install Tomcat.

After you complete the last option you will be shown a summary of the options you've selected. Next, the program
will install.
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1.3.1.1. Re-Install/Update
If you select a destination directory for the EDAB files that already contains an EDAB installation, you will be
prompted as to whether you would like to update your existing installation, or create a new one.

Install Type Dialog

If you select to create a new installation, then the entire existing installation will be overwritten (and all settings will
be re-set to default values). If you select this option and click the Next button, the installation wizard will continue
as if you were installing EDAB for the first time (as described in the previous chapter).

If you select to update the current EDAB installation, only program files will be updated (thus enabling new EDAB
features and fixing corrupted files), but all EDAB settings and the EDAB database will be kept as they are (i.e.
with your current settings).

If you select to install an update and you are updating from a version prior to 7.0 (in other words: you are not re-
installing an existing EDAB 7.0 installation), you will be prompted whether you want to install EDAB with bundled
Tomcat 8.0. Please note that EDAB 7.0 requires Tomcat version 8.0 or higher. EDAB versions prior to 7.0 were
distributed with Tomcat version 6 and lower, so if you are currently using EDAB 6.6 or lower with bundled Tomcat,
you will need to install EDAB 7.0 with Tomcat, or update your Tomcat manually (not recommended). If you're just
re-installing EDAB 7.0, this step will be skipped, Tomcat will not be installed, and your deployment configuration
will not be changed.
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Install Tomcat Dialog

If you chose to install EDAB with Tomcat 8.0, the next step will be to select a directory for Tomcat. If you choose
a directory that doesn't contain an existing Tomcat installation and click Next (recommended), you will be taken
straight to the Tomcat configuration wizard step (as described in the previous chapter).

If you choose a directory that already contains the Tomcat installation, the following dialog will appear giving you
three options: to overwrite the existing Tomcat installation with a new one, to go back to the previous step, or to
tell EDAB to assume that the directory already contains Tomcat version 8.0 or higher.

Tip
If you want to use an an existing Tomcat 8.0 installation for running EDAB, select the existing Tomcat
installation directory and then select the Directory already contains Tomcat 8.0 option.

Install Version Dialog
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If you are upgrading from a previous version of EDAB, make sure to follow the steps in Section 1.3.2.1.3 - Up-
grading EDAB Database from previous version of EDAB to update your existing EDAB database.

1.3.2. Configuration
After you have completed the installation of EDAB there are several configuration options available.

1.3.2.1. The EDAB Database
Information about users and groups, files in the Organizer, and security/privilege information is stored in a database.
By default this is the HSQL Java application database which is included in the EDAB installation. Connection to
this database is transparent to users and will work out of the box. This database works fine for development or
evaluation environments, however, it is generally insufficient for production environments, as it will not scale to
large deployments and provides no failure/recovery features.

1.3.2.1.1. Using a Different Database
EDAB provides users the option of using a different database than the HSQL database provided with the installation.
To run with a different database, you will need to create the tables used by EDAB in your database. Create table
scripts are provided in the EDAB installation in the data directory, and are available for most major databases.

The database connection that the EDAB server uses to connect to the database is specified in the Admin Console,

under Setting Info → EDAB Repository. You can change the connection information to provide a JDBC connection
to the database that you would like to use. The JDBC driver for the database you're using will need to be added/
available to the classpath of the application server/servlet container where you have deployed EDAB. You can also
make a connection to the EDAB database using JNDI. You can pass in the JNDI connection details after pointing
your application server to the EDAB database.

Specific setup instructions for different databases are available in Section 9.1 - Using Other Databases.

1.3.2.1.2. Running HSQL in Client-Server Mode
Normally the HSQL database runs as an application process on the server-side and needs no user interaction to start
or stop the database process. HSQL can also be run in client-server mode. This mode can improve performance
and scalability for the database when run in a multi-user environment. To run the HSQL database in client-server
mode, open a console window and navigate to the /data/ directory of your EDAB installation. In this directory
run the following command:

java -classpath "../WEB-INF/lib/hsqldb.jar" org.hsqldb.Server -database
 quadbasedb -port 2857 (or whatever port you would like the database to
 listen on)
             

The database server process will then start. To configure the EDAB Server to connect to HSQL running in this

mode, log on as Admin and enter the Admin Console → Setting Info → EDAB Repository and change the entry in
Database URL to read jdbc:hsqldb:hsql://machinename:port where machinename is the name or IP
address of the server, and the port number is the port you selected for the HSQL server.

1.3.2.1.3. Upgrading EDAB Database from previous version of EDAB
In order to support new features, the EDAB database structure generally needs to be modified.

If you are running the EDAB database on HSQL, MySQL, Oracle, MS-SQL, Informix or Postgres database, the
database will be updated automatically during the EDAB installation process.

If you are using a different database, you need to run the upgrade program before you can start using the latest
version of EDAB. The upgrade programs are located in the <EDAB-INSTALL>/data/dbupgrade directory.

Currently, the upgrade programs support MS-ACCESS and DB2 databases (besides the six databases that are also
supported by the EDAB installer). If your database is not in the above list, please contact our technical support
staff for more details.

There are two versions of upgrade programs, namely, DBUpgradeGUI and UpgradeAppl.
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The former is the graphic user interface version, the latter the command line version.

Please note that EDAB log records are not preserved during the upgrade process.

Warning
As a precaution, you are recommended to backup your EDAB database before you proceed with the
upgrade. This is to safeguard the unlikely event that any abnormal situation may occur during the
upgrade process.

Upgrade User Repository Database Using Graphic Interface

1. Change directory to <EDAB-INSTALL>/data/dbupgrade/

2. Enter command:

java -classpath "<DB_Driver>;DBUpgrade.jar;.;" quadbase.DBUpgradeGUI
                     

The upgrade program graphic interface is shown below:

Upgrade DB Program GUI

You need to specify the database information so that the program can proceed to do the upgrade.

Please note that the default database connection information is provided only as a guideline, you need to fill in the
exact connection information for the upgrade program to run. Also, please make sure that the database driver is
included in the –classpath flag in the command.

For example, if you are using Oracle, you may run the command with classpath as follows:

java -classpath "c:\EDAB\WEB-INF\lib\jdbc_oracle.jar;DBupgrade.jar;."
 quadbase.DBUpgradeGUI
             

Press the Start button and the upgrade process will begin.

If you entered wrong database information, the program will prompt you with an error message complaining wrong
database connection settings.

After the upgrade program is finished, the status bar at the bottom of the window will show Done.

If you click the Cancel button during the upgrade process, it will terminate the upgrade program. But it will NOT
roll back to the original database. In such a case, you have to use your own backup data or use the backup SQL
file generated by this program to restore your database.

Upgrading EDAB Database Using Command Line:

To upgrade using the command line version, simply type the command as follows:
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java -classpath "<DB_Driver>;DBUpgrade.jar;." quadbase.UpgradeAppl
 <EDAB_config_file>
             

The program will use the file specified by <EDAB_config_file> to obtain connection information. The config
file should be written in the same format as the config.txt in <EDAB_INSTALL>/data/dpupgrade/.

1.3.2.2. Starting the Server
If you have selected the option to Auto-Start Server, then the EDAB Server is started the moment the application
server (Tomcat by default) is started. If the option was not selected, or you change the option in the Administration

Console → Server Options → Auto-Start, then you will have to start the EDAB Server manually.

The first step in running and administering EDAB is to start the server. To start the EDAB server, you will first
need to start the application server/servlet container in which the server is deployed. If you installed EDAB with
Tomcat, go to the /bin/ directory of the Tomcat installation and execute startup.bat/.sh to start Tomcat.

Next, load the start page for EDAB. This is the index.jsp page in the EDAB install directory. If you installed
EDAB with Tomcat then the virtual directory mapped to the EDAB install directory is /EDAB/ so to reach the
index page, you would use the following URL:

http://machinename:port/EDAB/index.jsp

Note
You must have cookies and javascript enabled in your browser in order to use the EDAB interfaces.

EDAB Start Page

You can start the server directly in the start page. If the “Autostart” feature has been enabled (see Section 1.3.1 -
Installing EDAB for more details), the EDAB server should be already running. If it's not, click the Start Server
button. Once the server is started, you can log-in to access other EspressDashboard functions (the default adminis-
trator login is username: admin password: admin).

Note
Any user can start the server, but only the administrator can shut down the server. Even with the server
running, the Shut Down button will only become active when you login as the system administrator.
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EDAB Server Running

1.3.2.3. Increasing maximum memory heap size for applets
All applets have a maximum memory heap size of 16 megs, by default. In Windows, this can be increased by going
to Control Panel and selecting Java (or Java Plugin). Click on the Java tab and then View under Java Applet Runtime
Settings. Enter -Xmx256M under Java Runtime Parameters and click OK.

1.3.3. Backward compatibility patches
If you upgraded from an older version, you may notice some changes in the default behavior. Although the backward
compatibility is kept as much as possible, sometimes a new behavior is preferred. The new behavior should be
better for most users, but if you already have some charts or reports from an older version, you may want to keep
the old behavior, so your charts and reports look exactly the same as before. That is why we provide backward
compatibility patches.

Caution
Patches are for advanced users only. Please apply them only if you need them and if you know what
you are doing. If you are not sure, please contact support.

The patches can be found in <EDAB_Installation_Directory>/lib/Patches directory. They are
stored in JAR archives. To apply a patch, you only need to add the appropriate JAR file to the classpath of your
application as described below.

If you want to apply a patch to all designers (Quick Designer, Chart Designer, Dashboard Builder,
etc.) and viewers (Dashboard Viewer, etc.), you have to copy the appropriate patch JAR file to
<EDAB_INSTALLATION_DIRECTORY>/WEB-INF/lib/ directory. Then you have to edit Organiz-
er.jnlp file in the EDAB installation directory and add relative path to the patch JAR file to the archive attribute
of the applet tag.

Below is a list of all available patches in the current version.

patch1.jar - turn off chart axis padding by default

• default behavior (without the patch) - axis padding is on by default

• behavior with the patch - axis padding is off by default

• new behavior has been introduced in version 4.0
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• this feature can also be set in the Axis Scale dialog in the Chart Designer

patch2.jar - add left margin for annotation text in charts

• default behavior (without the patch) - annotation text does not have left margin

• behavior with the patch - annotation text has left margin

• new behavior has been introduced in version 5.0

• annotation text is legend text, chart titles and any text inserted using Insert → Text in the Chart
Designer

patch3.jar - use 0 to 1 as min/max value when chart axis autoscale for axis pt less than 1

• default behavior (without the patch) - maximum and minimum are always set according to data
if autoscale is used

• behavior with the patch - if max-min is < 1 and autoscale is used, min is set to 0 and max is
set to 1

• new behavior has been introduced in version 5.4

• It is not recommended to use this patch. The original behavior is a bug.

patch4.jar - turn off new pie chart label placement algorithm (calculate label placement based on pie sector
position)

• default behavior (without the patch) - new pie label placement algorithm is used

• behavior with the patch - old pie label placement algorithm is used

• new behavior has been introduced in version 6.0

patch5.jar - always use integer value for chart axis auto scale

• default behavior (without the patch) - integer is always used for axis auto scale

• behavior with the patch - axis value data type is used for axis auto scale

• new behavior has been introduced in version 6.0

patch6.jar - disable minimum and maximum error check for chart axis scale

• default behavior (without the patch) - the error check is enabled

• behavior with the patch - the error check is disabled (so you can set maximum value lower than
the one set in your dataset - same for minimum)

• new behavior has been introduced in version 6.2

patch7.jar - turn off Single color for categories feature for columnar and bar charts by default

• default behavior (without the patch) - Single color for categories feature is turned on by default

• behavior with the patch - Single color for categories feature is turned off by default

• new behavior has been introduced in version 6.3

• this feature can also be set in the Chart Options dialog in the Chart Designer

patch8.jar - line chart end to end revert single point data to display on left axis
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patch9.jar - display stack label despite not having enough space in the stack to render it

1.3.4. Run Applets in WebStart with JNLP file
Trying to run Java Applets in newer browsers and/or with newer Java versions can lead to problems with Applets
being deprecated or not supported any more. Officially were Applets blocked to run in common browsers from
about year 2016. However, it is still possible to run Applets in a similar use case as before (open a Java application
from a remote server via your browser) thanks to Java WebStart technology that's supported by Java 8. Both Applets
and Java Web Start are marked as deprecated technologies from Java 9.

Applets vs WebStart

In this case, EDAB is Java 8 compiled application and is best to use it with Java 8. For using Applets with WebStart
in newer versions, you must use some different implementation of WebStart. Popular choices are OpenWebStart
or IcedTea-Web and it is already included in some newer Java distributions.

To run a Java Applet via a Java Web Start JNLP file, you have to specify the applet-desc parameter in the
JNLP file configuration file.

   <applet-desc
      name="Chart Viewer"
      main-class="quadbase.chartviewer.Viewer"
      width="800"
      height="600">
 <param name="filename" value="help/examples/ChartAPI/data/test.tpl"/>
 <param name="preventSelfDestruct" value="true"/>
  </applet-desc>

The param tags specify parameters for the applet. The parameters are different for each applet. The specific para-
meters are mentioned in the documentation chapter for each applet.

JNLP files can be either run locally when the required libraries (containing the compiled source code) are loaded
as a local file or remotely when the libraries are loaded via HTTP/HTTPS.

When running JNLP files remotely via HTTP/HTTPS, the parameters comm_protocol, comm_url and
servlet_context need to be added to the applet-desc element. You can either fill in the values manually
(as the following code example shows) or you can have the values filled automatically in a JSP file.

<applet-desc
  name="Espress Report Designer"
  main-class="quadbase.reportdesigner.designer.ReportClient"
  width="380"
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  height="160">
 <param name="comm_protocol" value="servlet"/>
 <param name="comm_url" value="http://127.0.0.1:8080"/>
 <param name="servlet_context" value="Espress70/servlet"/>
</applet-desc>

Note
If you want to pre-fil the values automatically in a JSP file, the actual values highly depend on your
server configuration. The previous example is just illustrative.

1.4. Administration
Major administrative functions in EDAB are handled in the Admin Console. The admin console is a thin-client
interface that can be launched from the EDAB start page. To start the Admin Console, start the server (see Sec-
tion 1.3.2.2 - Starting the Server), and login as the administrator. The administrator username is admin and the
default password is admin. This can be changed in the console.

Admin Logged into Start Page

Once you log in as the administrator , an Admin Console button will be displayed at the top right portion of the
page. Click this button to load the admin console.

1.4.1. The Console Interface
The top of the Admin Console interface contains five tabs. One is labeled User List, one Setting Info, one Server
Options, one LDAP Settings, and one Customization.
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Admin Console

1.4.1.1. User List
The User List tab of the Admin Console allows you to create and maintain users and groups that use EDAB to design
or view reports and charts. The left-hand side of the dialog contains a list of all the defined users, and the right-hand
side a list of all the defined groups. Normally these users and groups are stored in the EDAB database, however
EDAB can be configured to retrieve the users and groups from existing systems including LDAP servers. To add
a new user, click the Add New User button. This will bring up a new dialog allowing you to specify information
for the new user.

Add User Dialog

For each user, you need to supply a username, an email address (for schedule delivery), and a password. Each user
also has a primary role of a viewer or a designer which is assigned in this dialog. Viewers can see and run reports as
well as build ad hoc reports using the QuickDesigner, but they do not have access to the core design/development
tools, like Chart Designer, and Organizer. Designers have access to all the interfaces, but are restricted by licensing
and can't change server settings and user privileges. Each designer user must be licensed by a developer seat.
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Administrator can view all the interfaces, change server settings, view detailed logs and modify user privileges.
Each administrator must be licensed by a developer seat.

In the user list, you can quickly distinguish user roles by their color. There is a legend for that below the admin
console.

Once you have finished adding information for the new user, click Ok and the new user will be added.

You can edit or remove a user by selecting it in the user list, and clicking either Edit User or Delete User(s) button
below the user list. If you select to edit the user, a dialog will open allowing you to change the information for that
user. If you select to delete the user, it will be removed. The original administrator user (admin) can't be removed.

Note
You can't edit users that have been read from LDAP (see the Section 1.4.1.4 - LDAP Settings chapter
to learn more about LDAP users). If you select a LDAP user and click the Edit button, the following
dialog will open.

Edit LDAP user dialog

You are allowed to edit only the user attributes, that have not been read from LDAP. The rest of the user settings
can be edited on the LDAP server.

Also, LDAP user accounts can't be fully deleted. If you select a user that has been read from an LDAP server and
click the Delete User(s) button, the user will be deactivated, but it will not be removed from the user list - it will
be marked as LDAP user without access.

To add a new group, click the Add Group button under the group list. This will pop-up a new dialog prompting you
to specify information for the group and select members.
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Add Group Dialog

For each group, you need to name the group, and select members. Members can be individual users or other groups.
To add group members, select users and/or groups from the left-hand side, and click the Add button. You can make
multiple selections (or de-selections) by holding down the CTRL key when clicking on the user/group.

Once you have finished adding members to the group, click the Ok button and the group will be added.

You can edit or remove a group by selecting it in the group list, and clicking either Edit Group or Delete Group
button below the group list. If you select to edit the group, a dialog will open allowing you to change the information
for the group. If you select to delete the group, it will be removed.

There is also a button to set security levels for users and groups. Details for the security level dialog can ben found
in Section 1.4.1.1.3 - Setting User/Group Security Levels.

You can view all of the user and group relationships by clicking the View User/Group Relationships button. This
will bring up a new dialog that shows all of the users and which groups they belong to in a tree format. If the user
or group has a certain security level assigned to them, you will also see the name of the security level in brackets.
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User/Group Relationships Dialog

1.4.1.1.1. Importing Users and Groups
In addition to adding users and groups via the Admin Console manually, you can directly import users from a
delimited file. To import users, you must have a CSV file with the following structure:

[username],[password],[fullname],[email],[role],[groupname],[security level]
            

username is the user login name, password is the user password, fullname is the user's full name, email
is the users email address, and role indicates the user's primary role either designer, viewer or admin.
The groupname field indicates which group the user belongs to. If that group has already been defined then the
user will be added to the group. If the group has not been defined a new group will be created. A sample import
file might look something like this:

"amy", "12345", "Amy Swansen", "aswansen@quadbase.com", "admin",
 "Marketing","Security Level 1"
"tom", "12345", "Tom Weeks", "tweeks@quadbase.com", "designer",
 "Executive","Security Level 2"
"sarah","12345", "Sarah Jensen", "sjensen@quadbase.com", "viewer",
 "Marketing","Security Level 1"
            

In the case of importing user list for LDAP users, add one line with only "LDAP" at the beginning of the user-list
text file, then all the contents of the password column will be ignored, and the password of the individual user will
be obtained from LDAP Active Directory at run time.

If you have a convenient delimited file with users that you want to import into the EDAB, log in as an administrator
and then open the Admin Console. Make sure you are on the User List tab.

In the Import User List from Text File section, there will be a Choose File or Browse button allowing you to import
the delimited file. Click on the button.
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User List tab of the Admin Console

Note
The Choose File button may be different in other web browsers (the screen shot was taken in Safari),
but it will always do the same thing - if you click the Choose File (or Browse) button, a browse dialog
will pop up allowing you to select a file.

Select the delimited file and confirm the browse dialog. The following message should show up confirming that
the users, groups and security levels were imported successfully.

1.4.1.1.2. Using Existing Users/Groups
Instead of creating new users and groups in EDAB, you can re-use existing users and groups. EDAB allows you to
retrieve users and groups from an existing database, integrate with an LDAP server, or implement your own log-
ic/methods to supply EDAB with users and groups. The security provider interface provides an API that allows you
to implement any custom logic to return user's, groups, and user/group relationships. For more information about
configuring EDAB to use existing users and groups, please see Section 9.2 - Integrating Existing Users/Groups.
For more information about LDAP integration, please see Section 1.4.1.4 - LDAP Settings.

1.4.1.1.3. Setting User/Group Security Levels
On the User List page, there is also a button to Set Security Levels. When you click this button, a dialog will pop
up allowing you to create, remove, and configure security levels within EDAB. For more information regarding
security levels please see Section 2.2.3 - Security Levels.
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Set Security Levels Dialog

To add a new security level, click the Add Level button and provide a level name. You can add any number of
users and groups into each security level. To do so, click on the security level name in the list box and click the
Add Member button. This will present a dialog allowing you to select existing members and groups and add it to
the security level. You can also remove members and security levels by selecting the item and using the Remove
Member and Remove Level buttons respectively. Click Done when you are finished.

Please note that all security level changes will take effect immediately.

1.4.1.2. Setting Info
The Setting Info tab contains configurations and settings critical to the way EDAB functions.

Setting Info Dialog

The first category, System Settings, presents the server information.

EDAB Server Name/IP Address: This is the host name or IP address of the machine on which EDAB is in-
stalled. This is generally configured during installation, but can be changed
here if necessary.

Web Root: This is the web root for the server in which you've deployed EDAB. If you
installed EDAB with Tomcat, this should be configured automatically. How-
ever, if you use a different database than the default HSQLDB, this field
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will need to be reconfigured. For tomcat, the default web root is/webapp-
s/ROOT/.

EDAB Servlet Context: This is the context in which the servlet collection for the EDAB server, and
deployment options are deployed. If you installed EDAB with Tomcat, the
default context is EDAB/servlet. If you change this option, you will need
to re-start the server for it to take effect.

Google Map Key: This is the key used for designing and viewing Google Maps. Please note that
this must be changed to a key mapped for your machine, otherwise Google
Maps will not appear. Please see Section 5.2 - Online Maps for Google Map
details.

Protocol: This tells the system whether to use HTTPS with SSL or regular HTTP to
connect to the sever.

Please note that changing protocol here is not enough to setup the system to work with SSL. You also have to
configure your application server and update URLs of the existing files in Organizer. The recommended way is
to reinstall your product and use the HTTPS option in the installer that sets up everything automatically (see Sec-
tion 1.3.1 - Installing EDAB for more details). It is not enough to do upgrade install, you have to perform full
installation. Be aware that full installation overwrites internal EDAB database, so you loose all the files inserted in
Organizer. Please back them up before making the full installation.

If you cannot or do not want to make the full installation, you can still configure SSL manually. To do that, please
follow these steps:

1. Change the protocol in the Admin Console as described above.

2. Get (or generate) SSL certificate, install it on your application server (following instructions of your application
server) and set up your application server to use HTTPS.

3. Start your application server and access EDAB start page using the HTTPS (if you changed port number, do
not forget to use the new one).

4. Start Organizer and update your URL Mapping to use the new protocol (and new port if it has changed). See
Section 2.1.5 - URL Mapping for more details about URL Mapping.

5. Run Repair Broken Links to update URL Mapping for all files in Organizer. See Section 2.1.6 - Repairing Broken
Links for more details about this feature.

6. If you use the EDABHome.html shortcut to access EDAB start page, please also update the protocol (and port)
in your <EDAB_INSTALLATION_DIRECTORY>/EDABHome.html.

If you are switching from HTTPS to HTTP, use similar instructions. Just replace HTTPS with HTTP and skip
generating the SSL certificate.
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Database Repository

The second category EDAB Repository describes the current database configuration options. You can use either a
database connection or through JNDI. For database, you need to specify the following information.

Database URL: The JDBC URL to the database.

Database Driver: The JDBC Driver to the database.

Database Username: The username used to connect to the database.

Database Password: The password used to connect to the database. This field needs to be reentered in the
next line to ensure validity.

You can use the Database Syntax Assistance drop down box to help in set up the connection by setting up a template
of the URL and Driver.

Note that if you make a mistake while entering the database connection details, it may cause EDAB not to run
properly. In that event, the only way to correct it would be to be open <EDAB Install Directory>/WEB-
INF/classes/QB.properties file and edit the entries for DatabaseUrl, DatabaseDriver, DatabaseUserName
and DatabasePassword. Depending on how the file was generated, the entries may not be grouped together.

The following is an image of the JNDI connection options. Not all components need to be completed in order to
connect to the JNDI server.

JNDI Repository
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JNDI Initial Context Factory: The JNDI initial context factory specifies the class used to connect to the
JNDI server. If you wish to use the application server's default context fac-
tory, you can leave this field blank.

JNDI Provider URL: The URL to the JNDI Provider. If the provider URL is already set up in the
application server environment, you can leave this field blank.

JNDI Name: The name for the JNDI connection. Frequently, the name contains the prefix
java:comp/env/. This field is required.

Mail settings allow you to configure a SMTP server. You need to provide SMTP server details in order to enable
Email delivery in alert monitoring (described in Section 11.4 - Monitoring).

Mail settings

SMTP Host: This is the host or ip address of the SMTP server.

Use SSL: Enable this if the SMTP server uses SSL/TLS.

Secured SMTP: Enable this if username and password are required to send mail from this server.

SMTP Port: This is the port for the secured SMTP server.

SMTP Username: Specify the username to use to log into the server.

SMTP Password: Specify the password for the email account. Enter again on the next line to verify.

Clustering & Load Balancer Settings are used when you want to run EDAB in a Clustered environment.
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Clustering & Load Balancing

Server Host: This is the machinename or ip address of the load balancer.

Server Port Number: This is the port number for the load balancer.

Cluster Member List: This is the machinename or ip address of the cluster members. The first entry
should always be the load balancer.

Member Host: This is the machinename or ip address of current node in the cluster.

Member Port Number: This is the port number for current node in the cluster.

1.4.1.3. Server Options
The Server Options tab contains a number of server configuration options.

The following configuration categories are available from this tab:

User List: This category shows you which users are currently logged into EDAB, either viewing or creating
reports or charts.

User list Dialog

Auto-Start: These options allow you to specify whether the server should be started automatically and what
configuration should be used.
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Auto-Start Options

Database Buffer: These options allow you to set the database connection buffering feature. If a database
is being used as the data source for a report or chart, you can choose to buffer both
the database connection and the data used for the report or chart using this feature. The
number of connections and queries that will be stored, depends on the number of buffers
from 1 to 999. The number of buffers is set in the Buffer Number dialog.

Database Buffer Options

Buffer Number: The number of buffers to use ranging from 1 to 999.

Buffer Cleanup: You can also specify the clean-up interval for database buffers
in the Server Monitor. This interval indicates how often the
buffers will be flushed, and the queries re-executed when re-
ports/charts are run. You can specify the interval in days, hours,
and minutes, by specifying the values in the appropriate dialogs.

Clean Buffers: You can immediately clean the database buffers by clicking the
Clean Buffers button.

EDAB Logs: EDAB provides two levels of logging activities.
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EDAB Logs Options

Generate Server Logs: The Generate Server Logs option allows you to turn on/
off the EDAB Server logs. When this option is enabled,
EDAB writes a log file on the server-side that monitor the
EDAB installation. EDABServer.log monitors all of the
client-server communitcation for the system, as well as the
report generation. Any errors or exceptions are printed.

Generate Detail Logs (Write to
Database):

The Generate Detail Logs (Write to Database) option cre-
ates an in depth report of all activities related to EDAB. A
full list of logged activities are described in Appendix 1.A
- EDAB Details Log. To view this log, click on the View
Log icon. This will pop up a report of the recent EDAB
activities. You can adjust the refresh rate of this report by
entering a number in minutes for the refresh interval. By
default, the report will maintain the last 48 hours of events,
but you can adjust this duration by changing the Cleanup
value.

View Alert Monitoring Log: Pops up alert monitoring log. Monitoring log is described
in Section 11.4.4 - Monitoring log.

Default Report Settings: These options allow you to specify global formatting, and font mapping
XML files that will apply by default to new reports.
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Report Setting Options

Default PDF Font Mapping: The font mappings will be applied
by default anytime the report is ex-
ported to PDF. For more information
about PDF font mapping, see Sec-
tion 4.1.6.2.1 - PDF Font Mapping.

Export character encoding: Character encoding that will be used
for created reports. Default is UTF-8.

Default HTML DPI (System de-
fault: -1):

This argument allows you to set the
screen resolution that should be used
when reports are exported to various
format. By default, the system reso-
lution is used, however this can cause
some discrepancies when reports are
generated on a Linux or Unix serv-
er and viewed on a Windows clien-
t. Generally in these scenarios, set-
ting the DPI to 96 will produce a con-
sistent export. Setting -1 will use the
system default resolution.

Paper Size: This argument allows you to set the
default paper size. Available options
are LETTER or A4

Excel Export Fit Cell: This argument allows you to fit nu-
meric values into single cells when
exporting your report to Excel from
the Menu Page, DHTML Viewer, or
Dashboard. By default, this option is
unchecked.

CSV Newline Delimiter: This option allow you to set a default
delimiter for all CSV exports.

EDAB Server Extension Classes: These options allow you to specify classes that invoke the server extension
options for EDAB.
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EDAB Server Extension Options

EDAB Listener Class: The EDAB Listener Class allows
you to implement listeners for serv-
er-driven report and chart execution.
This includes reports and charts run
from the Menu Page repository or via
Dashboard URL calls. With these lis-
teners in place, reports and charts will
be passed to the custom code prior
to final execution. For more informa-
tion about the EDAB Listener, see
Section 7.3 - Menu Page Listener.

EDAB Login Listener Class: The EDAB Login Listener Class al-
lows you to modify the database users
connect to when they run reports and
charts in the dashboard. For more in-
formation please see Section 8.1.4 -
Login Listener.

User Security Provider Class: The User Security Provider class al-
lows you to specify the class which
implements the methods to return
your users, groups, and security re-
lationships for use with EDAB. For
more information about the security
provider interface, see Section 9.2.2 -
Implementing UserSecurityProvider.
Note that you do not have to setup the
security provider if you are connect-
ing to an LDAP server.

Virtual Memory/Paging Options: For reports with large result sets, the paging feature reduces the amount of
memory needed by using a virtual memory paging system. This system will
write the data to temporary files on the hard drive once the specified mem-
ory usage is reached. You can specify the parameters for the paging feature
using the options listed below. Please note that the older record set options
(Max Records in Memory, Max Characters Per Field, and Record Pag-
ing Buffer Size) are no longer available.
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Virtual Memory/Paging Options

Paging Threshold: This argument specifies when the
paging feature will be activated. If
this argument is set to “-1” then da-
ta will never be paged. This value is
independent of Page Buffer Size op-
tion. If this value is larger than the
Paging Buffer Size, then the system
will begin paging when the thresh-
old is reached, not when the Pag-
ing Buffer Size is reached. Therefore
each report or chart might use more
memory than the amount specified
in the Page Buffer Size. If this val-
ue is equal to or lower than the Pag-
ing Buffer Size, the paging feature
will begin when the Paging Buffer
Size is reached. This value is set in
Megabytes.

Max Field Size: This argument specifies the expect-
ed maximum field size for large field
types such as varchars. Fields that are
larger than this value are not nec-
essarily truncated. The behavior de-
pends on the current memory usage
in relation to the Total Paging Buffer
Size allowed. As the amount of avail-
able memory decreases the amount
of data stored for these large fields
will decrease until it reaches this val-
ue. For example, a user is running a
report with a field size that is larg-
er than the specified Max Field Size
value. When the server is not busy
and there is ample memory avail-
able, the report will generate the full
field without any truncation. Howev-
er, when the server is heavily loaded
and the available memory is near 0,
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the field in the report will be truncat-
ed to the Max Field Size. For numer-
ic, boolean, date, time, and character
datatypes, the data will never be trun-
cated. For those database fields that
are defined with a size limit small-
er than the Max Field Size (e.g. Max
Field Size = 500, but the field is de-
fined as varchar(20)), the database
limit will be used in place of the Max
Field Size. This value is set in Bytes.

Paging Buffer Size: This argument allows you to set the
amount of memory that each report
or chart will use when the paging fea-
ture is invoked. The size of the buffer
affects performance. The larger the
buffer size, the faster the report or
chart is generated, but more memo-
ry is used. When the amount of total
memory used by the paging system
approaches the Total Paging Buffer
Size, the Paging Buffer Size provided
to new reports will begin to diminish
in order to avoid exceeding the spec-
ified total amount. This value is set in
Megabytes.

Total Paging Buffer Size: This argument allows you to set the
total amount of memory used by the
paging feature across all reports and
charts. The memory allocated to each
report will diminish as the memo-
ry usage approaches this value. This
value is set in Megabytes.

Cleanup Paging Buffer: This argument allows you to speci-
fy the cleanup interval for the tem-
porary files used in the paging fea-
ture. Typically, these files are deleted
when the reports are finished, how-
ever under rare circumstances (e.g.
server crashed), these files are left on
the server. The cleanup thread takes
care of these rare scenarios. This val-
ue is set in hours.

Best Practice: Generally, if you have a lot of large reports, make sure to enable this feature
by setting an adaquate paging threshold. Specify the options based on the
amount of memory avaiable to your application server. For example, if you
are running Tomcat with 512 MB memory, start with 256 MB for the Total
Paging Buffer Size and around 10-20 MB for the Paging Threshold. This
way, between 10-20 users can be running the large reports without crippling
the performance. The reason you should not use 100% of the Tomcat mem-
ory is because there are other components that will require memory as well.
For instance, the POI libraries will require additional memory when export-
ing a report to Excel to generate the actual xls file. Each environment will be
different, the number of large reports, the size of the result sets, and the num-
ber of concurrent users will all affect the optimized option settings. Howev-
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er, as a general starting point, shoot for around 50% of application server
memory for the Total Paging Buffer Size. Then set the Paging Buffer Size
to be around 2-10% of the Total Paging Buffer Size. The Paging Threshold
should not be much greater than the Paging Buffer Size.

Security Options: EDAB also provides a set of sophisticated security options.

Security Options

Replace Column Info List XML: This argument allows you to turn on the au-
tomatic decryption feature in QuickDesigners
and menu page. The XML file must speci-
fy all the information for the column to be
decrypted, including database information, ta-
ble name, and column name. You can spec-
ify either an absolute path to the XML file
or a relative path to the EDAB install direc-
tory (i.e. help/examples/DataDecryp-
tion/QBReplaceColumnInfoList.xml).
You can find more details as well as an example
for this feature in Section 3.2.2.1.2 - Querying
Encrypted Data.

Enable Secured Parameters: This argument allows you to turn on the se-
cured parameters feature. This feature activates
a global security structure allowing you to spec-
ify the segments of data that each security level
is entitled to view. You can find more details as
well as interface for configuring Secured Para-
meters in Section 1.4.1.3.1 - Secured Parameter.

Query Limit Options: These options allow you to set strict limits to the all query execution.
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Query Limit Options

Max Query Records: This argument allows you to set a maximum limit
for the number of records the server will retrieve
from a database when executing a query. Once
the maximum is reached, the server will stop run-
ning the query. If this argument is set to -1 then
no query record limit will be applied.

Query Timeout (Sec): This argument allows you to specify a timeout in-
terval in seconds for report/chart queries. Once
the query execution time passes the timeout ar-
gument, EDAB will abort the query. This feature
prevents users from accidentally creating run-
away queries.

Date and Time Options: This section allows you to specify a default custom date, time, and timestamp
format used when parameters are mapped to a column in a database. When the
Custom Date Format option is checked, this is the default format presented to
the user.

Date and Time Options

Click the Build buttons to build the custom format. The date/time representa-
tions are listed on the right and optional spacers and symbols are shown as a
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collection of buttons on the bottom. Once you have finished creating the format,
click OK to save.

Custom Timestamp Dialog

QuickDesigner Options: Please note, these settings apply only to the old QuickDesigner (from version
6.6). To see how to enable the old QuickDesigner, visit Section 1.4.1.2 - Setting
Info.
This section provides several defaults for the QuickDesigner.

QuickDesigner Options

Resize to Fit Content Default: While resize to fit content can be
changed in any report within the Quick-
Designer, this option allows you to set a
default behavior. If you enable this op-
tion, all cells in the QuickDesigner will
have Resize to Fit Content enabled by
default.

Enable Dataview in QuickDe-
signer:

This option allows you to disable the da-
ta views in quick designers such that the
user can only make ad hoc reports based
on data view queries, but not from da-
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ta views. This feature can prevent users
from bypassing the data view secured
parameters.

Enable Save Query: To prevent users from creating too many
custom dataview queries, you can dis-
able this option so that users are forced
to work from the list of dataview queries
that you have provided.

Null Value Handler: This option allows you to control the dis-
play for null data in the QuickDesign-
er. The value can be any string that does
not contain spaces. To insert a space in-
to the null data handler, use the word
SPACE in uppercase. For example: -
SPACE- will replace all null values in
the QuickDesigner with - -.

Dashboard Options: This section provides several defaults for the Dashboard Builder.

Dashboard Options

Single page for report: While the single-page or multi-page layout can
be changed in any report within the Dashboard
Builder, this option allows you to set a default
behavior. If you enable this option, all reports
in the Dashboard Builder will have the sin-
gle-page layout enabled by default.

Use template original size: This option allows you to configure the origi-
nal size of the template to be used by default.

Use report original margin: This option allows you to configure the origi-
nal margin of the report to be used by default.

Use Flash for charts: This option allows you to specify whether
Flash should be used in charts by default.

Enable Flash chart animation: This option allows you to specify whether
Flash animation should be turned on in charts
by default.
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Auto refresh in preview: This option allows you to specify whether the
previewed dashboard should be refreshed au-
tomatically, and if it should be refreshed auto-
matically, you can configure the time interval
for refreshing the dashboard preview.

Miscellaneous Options: This section contains a number of general options available for EDAB.

Miscellaneous Options

Debug: When setting up the EDAB system, you
might need to enable the debug option
for some components to troubleshoot
problems. This option makes it easy to
enable the debug statements for Secure
Parameter, Replace Column, or Virtual
Memory features. Once you restart the
server, whenever the feature is invoked,
informative outputs will be printed to the
system console.

Single Table for Distinct Param
Value:

When you enable this argument, the pa-
rameter dialog for parameterized charts
and reports will be drawn differently.
When you map the parameters to a data-
base column, the distinct list will be
drawn be running a select distinct on on-
ly the mapped field from the table that
contains that field. The default behav-
ior (without this argument) will use the
joins and conditions in the original query
to constrain the distinct parameter list.

Show View Privilege in Organiz-
er:

By default, regular users (with design-
ers role) will not be able to configure file
privileges, but they can view them. Dis-
able this option if you do not want users
to see the privilege list for organizer files
and folders.

Once you've specified any changes to the options on this tab, click the Save Settings button to save the changes.
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Note
The changes will not take effect, nor will your changes display in the Server Options tab until the
server is re-started.

These options can also be directly entered into a Server Command text file. For more information for the Server
Commands, please see Appendix 1.B - Server Commands.

1.4.1.3.1. Secured Parameter
EDAB contains a feature which allows you to filter data based on a user's security level within the QuickDesigners,
Dashboard Builder, Dashboard Viewer and Published Files.

To set up and configure this feature, go to Server Options in the Administration Console, select the Security Options
category, Enable Secured Parameters (if it is not checked), and click the Update Secure Parameters button. This
will take you to the following dialog.

Secured Parameter Dialog

By default, there will be a secured parameter set up for Customers.Region in the HSQL database. You can add more
secured parameters at any time by using the Add or CopyDB option at any time. The Copy DB option will copy
the database connection information so you don't have to type it in again. Once you have created a new secured
parameter or selected an existing one, the options on the right will enable. Fill in each of the options.

Parameter Name: This is just a name for the Secured Parameter, you can give it any name.

Database Type: This is a syntax assistence drop down box. Selecting the database will place
default URL syntax and default JDBC Driver in the corresponding fields. You
can then go into the URL and fill in the server specific information.

Database URL: Specify the URL for the database you would like to apply the Secured Parameter
on. Use the Database Type drop down to assist in the syntax.

Database Driver: Specify the driver or use the Database Type drop down to use the default data-
base driver.
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Table Name Specify the table you would like to apply the Secured Parameter.

Column Name: Specify the column you would like to apply the Secured Parameter.

Data Type: This field will automatically be configured and is only displayed for verifica-
tion.

Allow Multiple Values: This will determine if security levels will each be able to access only one value
or multiple values. If you select multiple values, the Values drop down box will
become a list box allowing you to select multiple values.

Security Level: Go through the security levels on the system and specify a value or values for
each security level. The first time you select a security level, you will need to
click the Update Values List button to retrieve a list of available values for that
column.

Values: The Update Values List button will launch a prompt for username and password
to this database the first time it is run. Once you have supplied the information,
it will retrieve a list of available values for the specified column. You can map
a security level to one or more (if multiple is checked) values by clicking and
highlighting the row of data. You can also use the Grant All option which allows
that security level to view all data in that column.

Once you have set up mappings for secured parameters, click the Done button. That should bring you back to the
Admin Console. Click the Save Settings button. You will be reminded to restart the EDAB server. Confirm the
message, go back to the EDAB start page, shut down the server and then start it again.

After the server has been restarted, the secured parameters settings will carry through to most components in EDAB.
To illustrate the concept, let us walk through a simple example.

Suppose you have a secured parameter set up for the REGION column from the CUSTOMERS table in the Wood-
view sample database. It specifies the behavior of the filter for six different security levels. For level East the query
will be automatically filtered so that only rows where region is East will be returned. For level South the query will
be automatically filtered so that only rows where region is South will be returned. For the level Midwest only rows
where the region is Midwest will be returned. For the level West only rows for West region will be returned. The
Allow Multiple Values attribute allows you to indicate whether multiple parameter values can be specified for the
filter, like mapping the EastSouth security level to both East and South. For level Executive, Grant All is selected
and all values from the region column will be available.

With the options set up, any time a user creates or runs a query, data view, or data view query in the QuickDesigners
that includes the CUSTOMERS table, the filter defined for their security level will be applied. These settings reside
on the server, and are not saved into the report, chart, or dashboard. Therefore if the user then creates and saves a
report in QuickDesigner Reports and transfers the report to another machine, the security will not be apply. Instead,
it will follow the security settings sepecified on the new Server.

1.4.1.4. LDAP Settings
The LDAP Settings tab in the Admin Console provides options that allow you to configure EDAB to retrieve users
from an LDAP server. To set the LDAP connection, select Use LDAP Security Provider option. The following
dialog should open.
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LDAP Settings Dialog

The above dialog contains example LDAP settings of Microsoft Active Directory.

To the Storage Root field, enter the distinguished name of the AD node that contains all the users you want to import.

By default, only the given AD node (i.e. the Storage Root node) will be searched for users, excluding it's sub-nodes.
If you want to search for users in the storage root node and all of it's sub-nodes, select the Include Subtree option.

In order to connect with EDAB you will need to have an user in your LDAP server that can read from the Active
Directory. Enter the user's distinguished name in to the User DN field and then type the user's password to the
Password field.

Click the Save Changes & Test Connection button. If you set the LDAP correctly, the following dialog will show up.

Click OK. The LDAP users were imported, but haven't been activated yet. To activate the users, click on the Users
List tab.
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There are some users marked as LDAP users without access in the Users list (user roles are distinguised by their
colors - there is a legend for that below the AdminConsole).

Select one or more LDAP users without access. The Insert LDAP User(s) button will show up'. Click on it.

Note
If you include a non-LDAP user in the selection, the 'Insert LDAP User(s)' button will disappear.

A new window dialog will show up allowing you to select user role for the selected user(s). To learn more about
user roles, visit Section 1.4.1.1 - User List. Select a user role and click Ok.

The users will not be marked as LDAP Users without access any more. Their color changed from dark red to light
red (if you gave them admin privileges), blue (if they are designers) or black (if you gave them viewer rights). They
are valid EDAB users and they can start using the EDAB now.

1.4.1.5. Customization
EDAB can be customized to maintain a consistent look and feel for your web application. The customization tab
allows the administrator to change the appearance of many components in EDAB. When customizing, it is rec-
ommended that you save your images and files under different names rather than overwriting existing files in the
EDAB. This way, you will not have to worry about future updates overwriting your changes.
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The Customization Interface

The left window provides a tree of the different elements that can be customized. The customizable elements are
broken up into sections based on the components in the EDAB application. Most sections contain three types of
elements: images, text, and CSS files. By clicking on an image element, the page will display the description, an
image URL, and a target URL if available. You can change the image file by providing a different URL. Clicking
on the Preview button will display the image at the bottom of the screen. The preview window is only available for
images, clicking on a text or CSS element will disable the preview window. The target URL is only available for
certain elements. If the selected element allows for a target to be set, this text box will appear beneath the image
URL box. Enter a URL in this window if you would like to add a hyperlink for this image. If this link is provided,
when users click on the image, the browser will be redirected to the target URL.
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Preview Image

If you select a text node, the page will display the description and a text value. Change the text value to adjust the
message or link for this element. The text will be used directly in the EDAB application, so you can enter any html
tags in the tool. Certain elements also contain a link. You can utilize this to redirect the user to another URL if you
are not using the default components. For example, if you are using a customized Menu Page, you can modify the
link for the Published Dashboards element to point to your customized page. Editing the text value also gives you
the ability to add even more CSS to the page.

Customizing Text

Changing the CSS file is quite straightforward, simply enter the url for the new CSS file. It is recommended that
you make a copy of the original CSS file and edit the copied version so that future updates will not overwrite your
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changes. As mentioned earlier, you can specify new CSS elements in customized text elements and enter the style
in your CSS file.

When you change the values for any element, the Customized box for that element will automatically check. If
you wish to revert back to the default value for this element, simply uncheck the Customized box and choose Ok
from the pop up dialog. If you wish to reset all elements to their default values, click on the Reset to Default icon
at the bottom.

Once you are finished with your changes, make sure to click Apply Changes to save all changes. To see the changes
appear in the EDAB application, you will need to shut down the EDAB Server and restart it.

1.4.2. User Settings
In addition to the administrator, users can modify some of their own information/settings in EDAB. When a user
other than the administrator logs in in the Start page, the User Settings link will appear at the bottom on the left side.

User Logged into EDAB Start Page

When the link is clicked, a new window will open that allows the user to modify the email address and password
associated with his/her account.
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User Settings Dialog

After making the appropriate changes, clicking Ok will save the user changes and close the window.

1.A. EDAB Details Log
The EDAB Details Log Report maintains a record of many key events that take place. Administrators can use this
information to track what changes were made, which user made the changes, and when the changes took place.
This feature is also useful for troubleshooting issues and backtracking through events.

Here is a list of all events recorded in the EDAB Detailed Log Report:

EDAB Events

• Login

• Timeout

• Logout

• Set Webroot

• Set Server Name

• Set Protocol

• Set Port Number

• Set Web Server Port

• Set JSP Default Directory

• Set Servlet Context

• Set SMTP Hostname
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• Repair Broken Links

• Replace Directory

• Add New Node

• Remove Node

• Copy Node

• Move Node

• Set Name

• Set Node Description

• Set Node Filename

• Update Node Owner Id

• Add Schedule Task

• Add Report Schedule Task

• Add Chart Schedule Task

• Remove Schedule Task

• Modify Schedule Task

• Run Schedule Task

• Add Data Registry

• Remove Data Registry

• Set Data Registry Permission

• Delete Data Registry File

• Set User Data File

• Set User Permission

• Set Group Permission

• Insert Security Level

• Remove Security Level

• Set Security Levels

• Set Node Permission

• Set File Permission

• Set Data Registry Invisible Node

• Table Setvalue

• Table Add Item

• Table Remove Item

• Table Create Item
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• Urlmap Setvalue

• Urlmap Add Item

• Urlmap Insert Item

• Urlmap Move Item

• Urlmap Remove Item

• Urlmap Create Item

• Schedule Export

• Write Dataview

• Write Queryfile

• Menu Viewpage

• Menu Login

• Open Report

• Open Chart

• Export

• Set Cleanup Log Interval

• Get Cleanup Log Interval

Language Events

• User Language

Misc Events

• Get OS Name

• Data Registry

Report & Chart Designer Events

• Default Files

• Export

• Pageviewerhtml

• Stream

• Stream Read Only

• Pageviewer Stream

• Load View Page Slave

• Load View Page Export

• File Info

• License Info
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• Pageviewer File Info

• Fileinfo Root

• XML Report

• XML Report Data

• XML Data Parser

• XML Data Sheet

• XML Global Format

• XML Font Mapping

• Data File

• EJB Access

• EJB Metadata

• EJB Home Method Access

• XML Verify

• SQL

• Test Db Connection

• Url

• Rename

• Replace

• Export Barcode

• Server Directory

• Db Distinct

• Db First Value

• Db Param Meta

• Db Param Function Meta

• Db Param Type

• Db Query Meta

• Data File Meta

Query Builder Events

• Qb Product Name

• Qb Numeric Function

• Qb System Function

• Qb String Function
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• Qb Time Date Function

• Qb Table List

• Qb Table Info

• Qb SQL

Chart Generator Events

• Chart Export

• Filter Data File

• XML Chart

• XML Template

• Creat Chart

• Filter PPSQL

• Img Export

• Cht Export

• Delete

• Delete Temp File

• Release File

• Copy File

• Working Directory

• Outputstream Initialize

• Outputstream Write

• Outputstream Close

• Classfile

Here is a list of the possible products represented in the log.

Loginpage

Adminpage

Menupage

Dashboard

Organizer

Report

Chart

Scheduler

Lookupservlet

Dhtmlviewer
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Dashviewer

Soap

Designer

1.B. Server Commands
The configurations specified in the Server Options tab can also be set in a configuration text file. Under the
<EDABInstallDir>/WEB-INF/classes directory there is a file called QB.properties that contains
several arguments that control server settings. The QB.properties is a INI file. Server commands belong to the
"ServerCommands" property. Arguments in the text file assume the format of a dash “-” followed by a command.
Arguments should be added in a single line (starting with ServerCommands=) in the file separated by spaces.

-log: When you type the -log argument, this turns on the basic server
logging. This has the same effect as enabling the option in the Admin
Console.

-writeLogToDatabase: This turns on the detailed server logging feature. This has the same
effect as enabling the Generate Detail Logs option in the Admin
Console.

-cleanupIntervalForLog:hh: This is the cleanup interval for the detail logs. The value following
the colon is specified in Hours.

-recordLimit:nn: This argument allows you to set a maximum limit for the number
of records the server will retrieve from a database when executing
a query. This has the same effect as setting the record limit in the
Admin Console

-queryTimeout:sss: This argument allows you to specify a timeout interval in seconds
for report/chart queries. This has the same effect as setting the query
timeout in the Admin Console.

-DBBuffer:nnn: This allows you to set the number of database buffers for the server
to use. This argument is the same as the buffering feature available in
the Admin Console. The argument allows you to specify the number
of buffers from 1 to 999.

-DBCleanAll:ddhhmm: This allows you to set the clean up interval for the database buffer-
s. This argument is the same as the clean up feature in the Admin
Console. The value of ddhhmm means “dd” days, “hh” hours and
“mm” minutes. You can also use omitted format, meaning that the
server will translate the value with the assumption that the omitted
digits are the higher digits. For Example:

DBCleanAll:101010 means clean buffer every 10 days, 10 hours
and 10 minutes

DBCleanAll:1010 means clean buffer every 10 hours and 10 min-
utes

DBCleanAll:10 means clean buffer every 10 minutes

-RequireLogin: This argument is used in conjunction with the QbDesignerPassword
argument to apply security to Report Designer and Chart Designer
when they are launched via the API. Normally when Report or Chart
Designer is called via the API there is no user authentication. This
allows users to apply their own authentication to the programs, but
can also allow unauthorized users access to the server. To prevent
this, users can turn on this argument (values are true/false) to force
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authentication for Report and Chart Designer when they are called
from the API. This option cannot be set in the Admin Console

-QbDesignerPassword: This argument allows you to set the password to use when the -
RequireLogin argument is turned on. The password specified here
needs to be passed in via a method call when calling Report or Chart
Designer via the API. This option cannot be set in the Admin Con-
sole.

-globalFormat:<xmlfile>: This argument allows you to supply a global format XML file to set
the default look and feel of report elements. This argument is the
same as the default global formatting option in the Admin Console.
For this argument specify a file path to the XML file relative to the
EDAB install directory i.e. (-globalFormat:ReportFiles/
FormatFile.xml).

-fontMapping:<xmlfile>: This argument allows you to supply a font mapping XML file to
set the default font mapping for PDF export. This argument is the
same as the default font mapping option in the Admin Console.
For this argument specify a file path to the XML file relative to
the EDAB install directory i.e. (-fontMapping:Templates/
FontFile.xml).

-htmlDpi:nn: This argument allows you to hard-code the screen resolution that
should be used when reports are exported to DHTML format. This
argument is the same as the HTML DPI option in the Admin Con-
sole.

-ListenerManagerClass:<classfile>: This argument allows you to specify a class for the EDAB listener
mechanism. This argument is the same as the EDAB listener class
option in the Admin Console.

-LoginListenerClass:<classfile>: This argument allows you to specify a class for the EDAB login
listener mechanism. This argument is the same as the EDAB login
listener class option in the Admin Console.

-ScheduleCallBackClass:<classfile>: This argument allows you to specify a class for the scheduler call-
back mechanism. This argument is the same as the scheduler call-
back class option in the Admin Console.

-UserSecurityProviderClass:<classfile>: This argument allows you to specify a class file for the user security
provider interface. This argument is the same as the user security
provider class option in the Admin Console.

-singleTableForDistinctParamValue: When you use -singleTableForDistinctParamValue argument, the
parameter dialog for parameterized reports and charts will be drawn
using a select distinct on a single table. This argument is the same
as the Single Table for Distinct Param Value option in the Admin
Console.

-showViewPrivilege:true/false: This option determines if non-admin users will be able to view the
file and folder privilege in the organizer. By default this option is
true.

-schedulerThreadLimit:nn: This argument allows you to set the maximum number of schedule
jobs that can run concurrently. This argument is the same as the max
scheduler threads option in the Admin Console.

-runMissedScheduleJob: When you use the -runMissedScheduleJob argument, any schedule
jobs that were missed due to server down-time will be run when the
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server is re-started. This argument is the same as the re-run missed
schedule jobs in the Admin Console.

-batchDeleteForScheduler:TRUE/
FALSE:

This argument controls the process by which schedule job informa-
tion is removed from the EDAB database for expiring schedule jobs.
Setting this option to true can improve schedule performance if you
have large numbers of jobs that will expire at the same time. The
effects of this feature may vary depending on the EDAB database
platform. This option cannot be set in the Admin Console.

-xmlEncoding:encoding: This argument allows you to specify the encoding that EDAB should
use when writing XML. This includes data registry files, XML report
and chart templates, XML exports, and XML global formatting, and
font mapping files. This parameter needs to be set both in the server
and in the Organizer. For more information about XML encoding,
see Section 10.1.2.4 - XML Encoding.

QuickDesignerSecuredParameters:xmlfile: This argument allows you to supply a data view security XML
file to enable/apply security filters to data views and data
view queries. You can specify either an absolute path to the
XML file or a relative path to the EDAB install directory
i.e. (-QuickDesignerSecuredParameters:qDesigner/
WoodviewParameters.xml). For more information about se-
cured parameters, see Section 1.4.1.3.1 - Secured Parameter.

-debug:DVW_SEC_PARAM: Use this argument to troubleshoot the -QuickDesignerSecuredPara-
meters option. This debug statement will print multiple debug state-
ments to the server console specifying whether there is a match for
the column listed in the xml file. If you specify multiple debug op-
tions, only the last one will take effect.

-disableDataViewInQuickDesigner: This argument allows you to disable the data views in quick design-
ers such that the user can only make ad hoc reports based on data
view queries, but not from data views. This feature can prevent users
from bypassing the data view secured parameters.

-disableSaveQueryInQuickDesigner: This argument allows you to disable the save query option in quick
designers. This feature prevents users from creating and saving too
many queries in the data registry.

-ReplaceColumnInfoList:xmlfile: This argument allows you to turn on the automatic de-
cryption feature in QuickDesigners and Menu Page. The
XML file must specify all the information for the column
to be decrypted, including database information, table name,
and column name. You can specify either an absolute path
to the XML file or a relative path to the EDAB install
directory i.e. (-ReplaceColumnInfoList:help/exam-
ples/DataDecryp-
tion/QBReplaceColumnInfoList.xml). You can find
more details as well as an example for this feature in Sec-
tion 3.2.2.1.2 - Querying Encrypted Data.

-debug:REPLACE_SQL_COLUMN: Use this argument to troubleshoot the -ReplaceColumnInfoList op-
tion. This debug statement will print multiple debug statements to
the server console whether there is a match for the column listed in
the xml file. If you specify multiple debug options, only the last one
will take effect.

-debug:MEMORY_PAGING: Use this argument to troubleshoot the virtual memory/paging fea-
ture. This debug statement will print debug statements to the serv-
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er console regarding the amount of memory used, and the paging
process. If you specify multiple debug options, only the last one will
take effect.

-ExcelExportFitCell:true/false: Set this argument to true if you want to fit numeric values into single
cells when exporting your report to Excel from the Dashboard. By
default, this option is false.

-paperSize:LETTER/A4: Set this argument to define the default paper size. If this option is
not set, reports will default to Letter size.

-ExportNewlineDelimiter:windows/mac/
others/system:

Set this argument to specify a default newline delimiter for CSV
export. Use windows for any Windows version, it will use \n\r for
the delimiter. Use mac for any version of Mac, it will use \r for the
delimiter. Use others for any Unix/Linux variants, it will use \n for
the delimiter. You can also use system to allow the server to pick up
the system default value.

-QDResizeToFitContentDefault:true/
false:

Please note, this command applies only to the old QuickDesigner
(from version 6.6). To see how to enable the old QuickDesigner,
visit Section 1.4.1.2 - Setting Info.

When you set this argument to true, reports created in QuickDesigner
will automatically have the Resize to Fit Content option turned on
for all columns. By default this option is turned off.

-QDNullValueHandler:"<NullValue>": Please note, this command applies only to the old QuickDesigner
(from version 6.6). To see how to enable the old QuickDesigner,
visit Section 1.4.1.2 - Setting Info.

This argument allows you to control the display for null data in the
QuickDesigner. <NullValue> can be any string that does not contain
spaces. To insert a space into the null data handler, use the word
“SPACE” in uppercase. For example:

-QDNullValueHandler:"-SPACE-"

will replace all null values in the QuickDesigner with “- -”.
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Chapter 2. Organizer
2.1. Using the Organizer

The EspressDashboard Organizer is a powerful graphical user interface that allows users to design charts and reports
and organize them with other files in virtual folders. The Organizer contents are automatically published to the Menu
page and users can automatically generate URLs to run reports and charts. In addition, schedule and archive jobs
are created and maintained through the Organizer. The Organizer also includes the user permissions and security
level setting options.

2.1.1. Starting the Organizer
To start the Organizer, click the link labeled Organizer in the Start page. This will open a pop-up window. Confirm
ERES_Organizer.jnlp file open by Java Web Start Launcher. Then the Organizer will open.

Opening Organizer

If you use Chrome as a browser, you have to save EDAB_Organizer.jnlp at first, and then to open it from
your download directory. You will see the next dialog. Click Run and Organizer will open.

Opening Organizer in Chrome
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2.1.2. The Organizer Interface
Since the Organizer is at heart a file management system, it is no coincidence that the application window resembles
a file browser. The left-hand side of the window contains a list of projects and their associated sub-folders, while the
right-hand side lists the contents of a folder in the upper pane and the project/folder descriptions in the lower pane.

Organizer Interface

2.1.2.1. The Organizer Menus
Most of the Organizer functions can be controlled using the drop-down menus located at the top of the Application
window.

2.1.2.1.1. File Menu
This menu performs most of the file operations. Options in this menu include:

New If you select this option, another menu pops up.

Project Creates a new project in Organizer.

Folder Creates a new folder in current project/folder.

Chart Launches ChartDesigner. (see Section 4.1.1 - Introduction to Chart
Designer).

Dashboard Launches DashboardBuilder (see Chapter 6 - Designing
Dashboards).

Manage Data Sources: This option allows you to set-up and manage data registries, their associated data
files, and database queries.

Open File: This will open the currently selected file. If the file is a chart then the Chart De-
signer will open, allowing you to edit the chart. If the file is a report file then the
Report Designer will open allowing you to edit the report.

Create PAK: Pack a GXML (Online Map), SXML (SVG Map) or DSB (Dashboard) file and
its components (Templates, Tooltips etc.) into a single file (see Section 2.1.4.4 -
Dashboard and Map Packages).

Unpack File: Unpack a GPAK (Online Map), SPAK (SVG Map) or DPAK (Dashboard) pack
file into Organizer (see Section 2.1.4.4 - Dashboard and Map Packages).
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Delete: This will delete the currently selected project, folder, or file.

Refresh: This will refresh your Organizer window, allowing it to reflect the latest changes/
modifications performed by other users.

Exit: This will close the Organizer.

2.1.2.1.2. Edit Menu
This menu allows you to edit, and cut/paste files, folders and projects. Options in this menu include:

Insert File(s): This allows you to insert a report or chart into the selected project/folder.

Edit: This allows you to edit the currently selected project, folder, or file. For projects
and folders, you can change the project/folder name as well as its description. For
files, you can change the display name, the location path or URL, and the descrip-
tion.

Set User Privileges: This option is only available to the administrator. It allows you to set owner priv-
ileges for defined users and groups.

Set Security Levels: This option is only available to the administrator. It allows you to setup and main-
tain user/group security levels that are applied to reports.

Change Ownership: This option is only available to the admininstrator. It allows you to change the
owner of the selected file, folder, or project.

Cut: This removes the selected project, folder, or file, and places it on the clipboard.

Copy: This makes a copy of the selected project, folder, or file, and places it on the clip-
board.

Paste: This pastes the current clipboard project, folder, or file into the currently selected
project or folder.

2.1.2.1.3. Publish Menu
This menu allows you to setup and view published dashboards. Options in this menu include:

Preview Menu Page: This will load the EDAB Menu page in a new browser window.

Generate Dashboard URL: This option generates a dashboard URL for the currently selected dashboard.

2.1.2.1.4. View Menu
This menu allows you to search for files or edit charts. Options in this menu include:

Search: This allows you to search through projects, folders, and files.

Chart Designer: This will open the Chart Designer, allowing you to design or modify charts.

2.1.2.1.5. Monitoring Menu
Set up and manage alert monitoring tasks.

Set alert monitoring Create new alert monitoring task. See the Section 11.4 - Monitoring chapter
to learn more about alert monitoring.

View alert monitoring tasks Shows list of all active monitoring tasks and allows you to edit them. To
learn more, visit the Section 11.4.3.2 - Monitoring list chapter.

2.1.2.1.6. Option Menu
This menu allows you to set and view several of the Organizer options. Options in this menu include:
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Set Designer: This allows you to specify whether to open every chart in the same Chart Designer
window (thus closing the current chart), or to open a new Chart Designer window
for each chart opened.

Set URL Mapping: This allows you to set up and modify virtual directories.

Repair Broken Links: This allows you to search for, repair, or delete any broken links to files in the
Organizer.

Update Directory: This allows you to update the path of certain items in the Organizer. This is helpful
if you are moving files between installations or moving complete installations.

2.1.2.1.7. Help Menu
This menu allows you to view a version of the program and to open a documentation. Options in this menu include:

About: This brings you an information about the version of the program.

Contents: This opens the EspressDashboard User's Guide.

2.1.2.2. The Organizer Toolbar
The toolbar at the top of the Organizer window offers easy access to some of the most commonly used features.
The buttons perform the following functions:

Create a new project

Insert a new folder into the current project

Insert a new file into the current project or folder

Cut the currently selected project, folder, or file, and place on the clipboard

Copy the currently selected project, folder, or file, and place on the clipboard

Paste the current clipboard project, folder, or file into the currently selected project or folder

Delete the currently selected project, folder, or file

Set user privileges (Administrator only)

Manage Data Registries, files, queries, etc.

Search for projects, folders, or files

Edit the currently selected project, folder, or file

Preview the menu page
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Generate a URL for the currently selected file

Pack a map or a dashboard and it's components into a single file (see Section 2.1.4.4 - Dashboard and Map
Packages)

Unpack a GPAK (Online Map), SPAK (SVG Map) or DPAK (Dashboard) pack file into Organizer (see
Section 2.1.4.4 - Dashboard and Map Packages).

Go to Chart Designer

Refresh the Organizer window

2.1.3. Projects and Folders
Projects and their associated folders are the central part of the Organizer interface. They provide the primary means
of organizing charts and reports. Projects are the top level of organization. You can use different projects for dif-
ferent users, for different groups in your organization, or to group charts and reports representing different data
or information. You can insert many layers of sub-folders into the top-level project, creating just about any orga-
nizational structure.

It is important to note that all folders in the Organizer are virtual folders, meaning that they do not necessarily
have a physical location on the server machine or mirror an actual directory structure. Projects and folders in the
Organizer are pointers to real directories and files that may be stored in a variety of locations.

2.1.3.1. Creating and Modifying Projects and Folders
To create a new project, you can do one of the following: click the New Project button on the toolbar, select New
Project from the File menu, right click in the left-hand pane and select New Project from the pop-up menu, or press
Ctrl+P. A node labeled new project will appear at the top of the file tree in the left-hand pane.

To edit the project name and description, first select it, then you can do one of the following: click the Edit button
on the toolbar, select Edit from the Edit menu, press F2 key, or right click, and select Edit from the pop-up menu.
A dialog will then appear, prompting you to change the project name and description. Once you have entered your
desired changes, click Ok and the new project name and description will be displayed in the lower right-hand pane.

Edit Project/Folder Dialog

To insert a sub-folder into a project or folder, first select the project or folder in which you would like to place the
new sub-folder. Then you can either click the New Folder button on the toolbar, select New Folder from the File
menu, or right-click in the left-hand pane and select New Folder from the pop-up menu. A node labeled new folder
will appear under the currently selected project or folder.

To edit the folder name and description, first select it, and then you can either click the Edit button on the toolbar,
select Edit from the Edit menu, press F2 key, or right-click, and select Edit from the pop-up menu. A dialog will
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then appear prompting you to change the folder name and description. Once you have entered your desired changes,
click Ok, and the new folder name and description will be displayed in the lower right-hand pane.

2.1.4. Files
You can insert files of any type into projects and folders. However, if you want your files to be accessible to other
users or visible within the Menu, then files should be viewable within a web browser (i.e. HTML pages, image files,
etc.). They can also be chart, report, or dashboard files (CHT, TPL, RPT, EZR, QPT, QCH, DSB, or XML format).
Files added to the Orgnizer must be accessible via http protocol, and may need to be mapped via URL mapping.
For more about URL mapping in Organizer see Section 2.1.5 - URL Mapping.

2.1.4.1. Adding and Modifying Files
To add a file, first select the folder or project in which you would like to place the file. Then you can either click the
Insert File button on the toolbar, select Insert File from the Edit menu, or right click in the upper right-hand pane,
and select Insert File from the pop-up menu. A dialog box will appear, prompting you to enter a display name for
the file (by default the file name is used), the location of the file (a direct path) and a description of the file. (If you
select a path that is not the server root or a mapped virtual directory, you will be prompted to map one.) Click Ok
and the file will be inserted into the current directory or folder.

To insert more than one file at a time, click the Browse button on the insert file dialog, and use CTRL+Click to
select multiple files in the browse dialog. Then when you click OK all of the files will be added to the Organizer.

Insert File Dialog

The list of files in the currently selected folder will be displayed in the upper right-hand pane of the Organizer. Each
entry shows the file's display name, the file type, the file description, path, and URL.

To edit the file's display name, location, or description, first select the file that you would like to edit. Once you
have selected a file, you can either click the Edit button on the toolbar, select Edit from the Edit menu, press F2
key, or right click, and select Edit from the pop-up menu. A dialog box will appear allowing you to make changes
to the display name, location, and description. Click Ok and the changes will be reflected in the file list.

To open a file, double click on it, or first select it, and then you can click the Open File button on the toolbar, select
Open File from the File menu, or right click and select Open File from the pop-up menu. If the file is a chart (CHT,
TPL, or QCH) format, it will be opened in the Chart Designer. If the file is a report (RPT, QPT, or XML) format,
it will be opened in the Report Designer. If the file is a dashboard, the Dashboard Builder interface will open in a
new window. All other file types will be opened in a web browser window.

2.1.4.2. Arranging Files
To arrange files within folder or project, open the folder (click on it in the left-hand side tree-list) and then click
on a column header in the right-hand side. Files in the folder/project will be arranged by the content of the selected
column. To switch between ascending and descending order, click on the column header again.
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A folder arranged by the file names in descending order.

2.1.4.3. File Identification Icons
Each file type can be easily identified by its icon. You can see these icons next to file names in Organizer and all
dialogs in EDAB designers where you need to select some file.

Chart file created in Chart Designer (.cht). For more information see Section 4.1.2.3.1 - Saving Chart
Definitions.

Chart template created in Chart Designer (.tpl). For more information see Section 4.1.2.3.1 - Saving
Chart Definitions.

Chart file created in Chart Designer that contents supplementary files associated with it (.pac). For more
information see Section 4.1.2.3.1 - Saving Chart Definitions.

Report file created in QuickDesigner Reports (.qdr). For more information see Section 4.2 - QuickDe-
signer Reports.

Chart file created in QuickDesigner Charts (.qch). For more information see Section 4.3 - QuickDesigner
Charts.

Map file created in Online Maps (.gxml). For more information see Section 5.2 - Online Maps.

Packed map file created in Online Maps and packed in Organizer (.gpak). For more information see
Section 2.1.4.4 - Dashboard and Map Packages.

Coordinates file for Online Maps (.cxml). For more information see Section 5.2.2 - Data Sources.

SVG map file created in SVG Maps (.sxml). For more information see Section 5.3 - SVG Maps.

Packed SVG map file created in SVG Maps and packed in Organizer (.spak). For more information see
Section 2.1.4.4 - Dashboard and Map Packages.

SVG map image (.svg). For more information see Section 5.3.1 - Introduction to SVG Maps.

Dashboard file created in Dashboard Builder (.dsb). For more information see Section 6.1 - Introduction
to Dashboards.

Packed dashboard file created in Dashboard Builder and packed in Organizer (.dpak). For more informa-
tion see Section 2.1.4.4 - Dashboard and Map Packages.

2.1.4.4. Dashboard and Map Packages
A single map or a single dashboard usually consists of several files (for example, a dashboard needs several chart/
report/map templates, a svg map needs a svg image, drill-down template, etc) which could make moving maps
or dashboards to another machine very difficult, because you would have to move all the linked files as well.
Fortunately, you do not have to move each file manually. A dashboard or a map and can be packed into a single file
along with all the linked files (dashboard templates, drill-down templates, etc) without even knowing which exact
files are needed for the dashboard or map to work. The packed files can be moved or archived quickly and easily.
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To pack a dashboard or a map (both SVG and Online maps can be packed), select the dashboard (.dsb) or map

(.sxml or .gxml) file in Organizer and then click on the Create PAK icon on the main Organizer toolbar.
A dialog will pop up prompting you to select the pack file name. Enter a file name or use the default one and click
OK. Another dialog should show up confirming that the package was created successfully and showing you the full
file path. The packed file will be also automatically inserted into the current Organizer folder/project.

Packed files can be viewed in the Menu page without being unpacked, but they can not be modified in the SVG
and Online Maps designers or in the Dashboard Builder. In order to modify a packed dashboard or map, you need
to unpack the gpak, spak, or dpak file first.

To un-pack a dpak, spak, or gpak file that has not been inserted into Organizer, click on the Unpack File icon
on the main Organizer toolbar. A dialog will pop up, allowing you to choose the file on your hard drive and to enter
a name which will be used for the main unpacked file (.dsb, .sxml or .gxml file).

If you want to unpack a file that has been inserted into Organizer, select the file in Organizer and then click on the

Unpack File. The same dialog will pop up but the file path and the file name fields will be filled automatically.

To view the list of all files that are stored in the package, click on the Details button. A new window will open.

Unpack File List Dialog

In this window, you can edit both physical and Organizer file path of all files that can be un-packed from the package
(which also allows you to resolve potencial file name conflicts). After you are done editing the file paths, click the
Close and then click OK to unpack the package.

The EDAB will now try to unpack all files from the packed file to their original locations. If there are any filename
conflicts (i.e. there already is a file with the same name in the same path on your hard drive or in Organizer), the
following dialog will show up:

If you click Yes, all existing files will be overwritten by the files from the package without no further questions. If
you click No, the Unpack File List dialog will open again allowing you to edit the filename conflicts. Then click
Unpack to unpack the files into their locations and to insert them into Organizer.
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2.1.5. URL Mapping
Any report or chart that is added to the Organizer needs to be accessible via URL. This is so that reports can be
run/viewed through the menu page, using URLs, or retrieved through the API. In order for the Organizer to know
the URL path to charts and reports, you need to set the URL mapping.

The first, and most important, thing to map is your EDAB installation. You should have a virtual directory set-
up in the app server/servlet container where you have deployed the server that points to your installation. If you
selected to install Tomcat with EDAB then a virtual directory has automatically been setup where http://
MachineName:Port/EDAB points to the EDAB installation directory. In order for Organizer to read and write
files to your installation directory you will need to make sure that this mapping is correctly set.

URL mapping can also be used to set the URL path for other servers or virtual directories on your server whose
report/chart files you would like to import to the Organizer. Please note that only the admin can create and change
the URL Mapping entries. You will have to log in as the admin user to make changes to the URL Mapping.

To set up a virtual directory, select Set URL Mapping from the Option menu. A dialog will appear listing all of the
virtual directories that have been set up. (By default, the Web root for the app server/servlet container where you
have deployed the server is mapped to the URL http://machinename:port/ depending on your machine
name and specified port number. To add a virtual directory, click on Insert. A dialog will appear allowing you to
enter or browse to a direct path. Once you have specified the path, then enter the corresponding URL. Click Ok and
the virtual directory will be added. You can also edit and remove mapped URLs from the main dialog.

URL Mapping List & Add Mapping Dialog

You will also be prompted to specify URL mapping any time you add a file from a new location that has not been
mapped with a corresponding URL.

2.1.6. Repairing Broken Links
Because Organizer uses virtual directories, it is possible to have files in many different physical locations listed in
the Organizer. While this makes it easy to publish reports and charts, it can be difficult to manually keep track of
all the files. Specifically, if the files are moved or the directory structure is changed, then the Organizer will not be
able to find the files and the links within the Menu page may no longer work.

You can use the Repair Broken Links feature in the Organizer to automatically check the status of the listed files.
The Organizer will check all of the files within your projects and folders to check whether the path/URL specified
is still correct.

To check for broken links, select Repair Broken Links from the Option menu. The Organizer will then check all of
your files and pop up a list of any broken links found. You can then choose to repair any broken links by specifying
a new path or file/filename, or you can remove the files from the Organizer.
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Broken Links List

2.1.7. Update Directory
Sometimes you may want to update the directory path of certain items in the Organizer. The Update Directory
feature is helpful if you are moving files between installations or if you are moving complete installations.

In order to update the directory paths of items in the Organizer, select Update Directory from the Option menu.
The update directory dialog will then open.

Update Directory Dialog

The dialog allows you to specify the original directory (the directory you want to update) and the new directory.
You can either use the Browse buttons to select directories or just type directory paths manually.

Please note that when you are updating directories using the update directory feature, all the Organizer
items that contain the original path in their directory paths will be updated. For example, if you speci-
fy the original path as C:/EDAB and the new path as D:/Install/EDAB, all the items in the Orga-
nizer that contain C:/EDAB in their paths such as (C:/EDAB/Reportfiles/SalesReport.qrp, C:/
EDAB/ChartFiles/MonthSales.cht, C:/EDAB/DashboardFiles/Dashboards/SalesDash-
board.dsb, ...) will be updated to (D:/Install/EDAB/Reportfiles/SalesReport.qrp, D:/
Install/EDAB/ChartFiles/MonthSales.cht, D:/Install/EDAB/DashboardFiles/Dash-
boards/SalesDashboard.dsb, ...). Also note that the new directory (the updated directory) needs to be
added to your URL mapping. Otherwise, you won't be able to repair broken URL links after the update, so the
affected Organizer items won't work correctly. For more information about URL mapping and repairing broken
URL links, please see Section 2.1.5 - URL Mapping and Section 2.1.6 - Repairing Broken Links.

Example:

Imagine that you have three reports Customers.qdr, Details.qdr, and SalesGoal.qdr in the C:/
EspressDashboard/help/examples/Dashboard/sales directory, and assume that you have moved
them to the C:/Marketing/SalesReports directory. The following image shows the reports in the Organiz-
er before the updating process:
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Example - Reports in the Organizer - Before Directory Updating

Select Update Directory from the Option menu in the Organizer to open the update directory dialog. In the dia-
log, specify the original directory as C:/EspressDashboard/help/examples/dashboard/sales and
similarly the new directory as C:/Marketing/SalesReports.

Example - Update Directory Dialog

Once you have properly specified the directories, press the OK button. The following dialog will then appear show-
ing you the list of updated Organizer items as well as number of updated files.

Example - Update Results Dialog

Next, click the OK button in the dialog. This will bring you back to the Organizer. The image below shows updated
reports paths after the updating process.

Example - Reports in the Organizer - After Directory Updating

Now you have to repair the broken URL links. Otherwise, URLs of the affected Organizer items will remain mapped
to the original directory. In order to repair broken URL links properly, you have to add the new directory (the
directory you have specified in the Update directory dialog C:/Marketing/SalesReports) as new URL link
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to your URL mapping. To open the URL mapping dialog, select Setup Url Mapping from the Option menu in the
Organizer. The dialog will then appear.

Example - Setup URL Mapping Dialog

In order to add a new URL link, click the Insert button, another dialog will pop-up prompting you to specify the Vir-
tual Directory and Corresponding URL. Specify the virtual directory as C:/Marketing/SalesReports and
the corresponding URL e.g. as http://<MachineName>:<Port>/Marketing/SalesReports. After
that, click OK. For more information about URL mapping, please see Section 2.1.5 - URL Mapping.

Example - Inserting New URL Link

Example - Setup URL Mapping Dialog - New URL Link Added

Once you have specified the URL link, click the Done button again. The repair broken links dialog will then appear
prompting you whether you want to check for broken links now. Click Yes. Please note that if you click No, you
may check for broken URL links by selecting Repair Broken Links from the Option menu in the Organizer. For
more information about repairing broken URL links, please see Section 2.1.6 - Repairing Broken Links.

Example - Repair Broken Links Dialog

If you have correctly specified the URL mapping, you should get the following dialog that will inform you that
broken links have been successfully fixed. Clicking the OK button will bring you back to the Organizer.
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Example - Repair Broken Links - Links Successfully Fixed

Note
If you did not specify the URL link in the URL mapping or did not specify the URL link correctly,
the dialog below will appear informing you that broken URL links cannot be repaired. If you got this
dialog, return back to the URL mapping dialog and add/modify the URL link as described in previous
steps. After that try to repair broken links again.

Example - Repair Broken Links - Error During Links Fixing

Now you may check whether the URL fields of the organizer items have been correctly repaired. The URL fields
should be similar as the ones shown on the image below.

Example - Reports in the Organizer - After Repairing URL Links

2.1.8. Searching in Organizer
Often, if you have many files in many folders in the Organizer, it can be hard to find a specific file. To locate files

or folders, you can use the search function. To search, you can either click the  Search button on the toolbar,
select Search from the View menu, press Ctrl+F, or right click in the upper right-hand panel and select Search
from the pop-up menu. The search dialog will then appear.
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Search Dialog

The search dialog prompts you to enter a search string in the project or folder in which you would like to search. By
default, the currently selected project or folder is listed. If you leave the Look In field blank, it will search all projects.

Other options allow you to include sub-folders in your search, and to match the search string to filenames, descrip-
tions, and URLs. You can also match case in your search by selecting the Case Sensitive option.

2.1.9. Limiting Browse Directories
In EDAB, you can limit the open and insert dialogs in Organizer, Report Designer, and Chart Designer by adding a
parameter to the Organizer. If launching the Organizer through the Java Web Start Launcher, edit /EDABOrga-
nizer.jnlp and add the following line:

<argument>-BrowseRootDir:<Directory></argument>
        

For instance, the follow limits the browse directory to the EDAB root directory located under C:\EDAB

<argument>-BrowseRootDir:C:\EDAB</argument>
        

If starting the Organizer using the bat file, edit EDABOrganizer.bat and add the following option at the end
of the command.

... quadbase.reportorganizer.manager.OrganizerClient -
BrowseRootDir:<Directory>
        

2.2. Security and Security Administration
This chapter covers security concepts in EDAB and the administration of user privileges. Other security features
for data registries and deployment (menu page, URLs, and the API) are discussed in later sections.

There are two security concepts in EDAB:

User privileges This is the default security concept. User privileges are derived from relations between
users and groups (will be described later). Relations between users/groups can be mod-
ified.

File permissions You can disable the “User Privileges” mode for certain files/folders and set custom per-
missions for those files/folders.

2.2.1. Security Concepts
In EspressDashboard, privileges are based on the concept of ownership by default. This means that the privileges or
access to a particular folder, dashboard, maps, report, or chart stem from who is the owner or creator of that folder,
dashboard, maps, report, or chart. Each user (or group) has a set of privileges that apply to other users or groups
when accessing dashboards, maps, reports, or charts created by that user.

In this ownership approach, users belonging to the same group or subgroups of the same group have full access
privilege to items (folders, dashboards, maps, reports, charts) created by each other. For example, group A (group
structure A) has users a,b,c and sub-group B. Group B (as a sub-group of A) has users d,e, and f. The default
behavior is such that users a,b,c,d,e,f will have full access privilege to items created by each other. At the same
time, users outside of the group structure A have no access to the items created by users in this group structure.
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Users from group A and B will have access to each other's files.

With the “user privileges” setting functionality, you (as the administrator) can modify the default privilege granting
scheme. For example, you can grant users from group C and D read or read/write access to group B users' items
whereas group A's users have no permission to access group B users' items. Meanwhile, group B users still have
same access right to other group A users' items if group A is still using default privileges.

After setting group permission, groups C and D have access to group B's files, but group A does not.

In addition to the “user privileges” ownership model, the privileges for individual items can be modified to further
enhance the security settings. This function is called the “File permissions”. In this scenario, individual items can
be made accessible to groups and users independent of the ownership assigned scheme.

For example, an item created by user a is automatically fully accessible to users b,c,d,e, and f. But you can specif-
ically modify the permission setting such that user c has no access right to that particular item while the rest of the
users in the group structure maintain their access rights.

After setting file permission, user c does not have access to this particular report.
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2.2.2. Setting User Privileges
Privileges are set by the administrator in the Organizer interface (with the exception of the basic designer/viewer

role for users set in the Admin Console). To set user privileges in Organizer, select Edit → Set Privileges or click

the  Set Privileges button on the toolbar. This will bring up a dialog, allowing you to set owner permissions
for users and groups.

Permission Setting Dialog

The dialog contains two tabs one listing all of the groups currently defined for EDAB and the other listing all the
users. From either of these tabs you can select a user or group for which you would like to set owner permissions
by selecting it and clicking the Edit Privilege button.

Note
When you select a user or group, you are setting privileges for folders, reports, and charts that this
user, or users in this group create (or become owners of). You are not setting access levels for that
particular user or group, rather you are setting privileges for other groups or users who access reports
created by this user or group.

Group/User Permissions

Every group or user will automatically have read and write permissions for their own report and charts. You can
give other groups and users access, by clicking the Add button. This will bring up a list of users and groups allowing
you to select which users and/or groups you would like to add. For each additional user or group, you can set their
access to read-only, or read-write.

Read-only access allows the user or group to view the file using various EDAB tools. For example, when the user
opens the file from the EDAB Organizer, the program will launch the corresponding viewer (Chart Viewer for
charts, Page Viewer for reports, Dashboard Viewer for dashboards) rather than opening the Designer. The user can
also create schedules and archives for this file and access the file through the EDAB menu page. With read-only
permission, the user will not be able to edit the file using the Designers, nor will they be able to generate URL for
the file. In addition, the user cannot see the file and URL path in the Organizer.

Read-write access grants full privilege to the user. They can edit the file using the corresponding designer as well
as generate URL and see the file and URL path in the organizer.
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If the Use Default checkbox is checked then the user or group will inherit permissions from the group to which he/it
belongs. If the user or group does not belong to any other groups then they will have read and write permissions for
their reports but no other users will have access. This option is used by default in EspressDashboard. There users
will automatically inherit group permissions unless settings for that user are specifically modified.

2.2.2.1. Changing Ownership
Generally, a user is the owner of any folder, chart, or report he/she creates. However, the administrator can change
the owner of any folder or file in the Organizer. To change the owner of a folder or file, right click on it, and select
Change Ownership from the pop-up menu. This will bring up a dialog showing the current owner of the file or folder.

Change Ownership Dialog

To change ownership, click the Change button. This will bring up a list of all the defined users. Select the user
to which you would like to assign ownership and click Ok. The new owner will then be reflected in the dialog.
Click Ok again to apply the changes. Note that changing the owner of the file will generally effect which users
can access and edit the file.

2.2.2.2. Folder/File Permissions
By default, user privileges for files and folders in the Organizer are derived from the owner of that file or folder.
However, in certain circumstances you may want to set privileges for specific files or folders to be different from
those associated with the owner. To apply a different set of permissions to a file or folder, right click on it and select
Change Folder/File Permissions from the pop-up menu.

File/Folder Permissions Dialog

The Use Owner Permission checkbox indicates, if checked, that the folder or file is currently using owner permis-
sions. To add different levels of access for that particular object, first un-check this option, and click the Add button.
This will bring up a list of users and groups, allowing you to select which users and/or groups you would like to
add. For each additional user or group, you can set their access to read-only, or read-write. Once you have finished
adjusting access for the object, click Ok and the changes will be applied.
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Here is a practical example that illustrates how the file/folder permissions function. Suppose John, a member of
the marketing group, can only see the demo project, which is used during project demostrations. All other existing
projects that John does not have access to are automatically hidden from view.

John's Organizer

Suppose the administrator would like for John to edit and incorporate a dashboard into his presentations. To do
so, the administrator gives John read and write permissions for one dashboard in the Dashboard/DashDemo/
project. It is not necessary for administrator to set folder privileges since the change will be propagated through
the parent folders.

Setting File Permission

The next time John launches the Organizer, he will see the dashboard file that he has been given permission to
view and edit. However, John will not be able to see any other files in this folder nor any files in the Dashboard
folder (the parent folder).
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Dashboard File is Accessible

2.2.3. Security Levels
In addition to setting permissions and access for different dashboards, the administrator can also apply security
settings to the EDAB system, such that users and groups can get different views of the same report when accessing
it. This security feature is administered through security levels.

Security levels are created by the administrator in the Admin Console or in the Organizer, and applied to the server
using the Secured Parameter configuration in the Admin Console. To create or modify security levels, select Set
Security Levels from the Edit menu. This will bring up a dialog listing all the security levels that have been defined.
For more details regarding secured parameters, please see Section 1.4.1.3.1 - Secured Parameter.

Security Levels Dialog

To add a new security level, click the Add button. This will bring up a dialog prompting you to specify a name for
the new security level. There is no limit to the number of different security levels that can be defined.

2.2.3.1. Associating Security Levels with Users and Groups
In EDAB, users and groups can be associated with defined security levels to provide end-to-end security. When
a user accesses a report, the security level to which they are associated will be applied, and the view defined by
that security level will be presented to the user. To associate users and groups with security levels, select a security
level in the list and click the Assign Button in the Security Level Dialog.
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Assign Security Level Dialog

In the dialog that opens, click the Add button to associate a user or group with the selected security level. This will
bring up a dialog that contains a list of all the defined users and groups. From this dialog you can select groups and
users to associate with the security level. When you have finished, click Done to return to the security levels dialog.

You can assign more than one user or group to a security level, but users cannot be assigned to more than one
security level at a time. Security level associates, like permissions are applied at the lowest level. This means that
if an individual user is associated with a security level, it will take precedence over settings for their group.
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Chapter 3. Data Sources
3.1. Data in Organizer

EspressDashboard can draw data from JDBC compliant databases, text files, XML files, EJBs, and even bring in
object/array data through class files. Prior to creating reports, charts, or maps, users must first set up data sources
they want to use. Data source information, including database connection information, database queries, text file
location, XML file/DTD/Schema location, Java class location, and EJB connection information is stored in XML
registry files that are set up and defined within the Organizer interface.

3.1.1. Managing Data Registries
To edit or create a data registry, you can either select the Manage Data Sources option from File menu, or click on

the  Manage Data Sources icon on the toolbar. This will launch the Data Registry Manager dialog.

Data Registry Manager Dialog

From this dialog, you can add, remove, and edit registries, as well as assign user privileges for data registries.

To add a registry, click the Add button and a dialog will appear prompting you to specify a filename for the new
registry. Click the OK button and a new Data Source Manager window will open, allowing you to set up data
sources within the registry.

To edit a registry, first select it from the list on the left side and click the Edit button. This will bring up the Data
Source Manager window for the selected registry file.

3.1.1.1. Exporting/Importing Data Registries
A data registry consists of several files such as database queries, text files, xml files, etc. If you export a data registry,
all files will be packed in a single rpak file that can be archived or imported to another EDAB installation/server.

To export a data registry, select it and then click the Export Pack button. Enter a file name and click the OK button.

Note
Only administrators can export or import data registries.

To import a data registry, click the Import Pack button and then select a rpak file. You can insert the data registry
using its original name or you can change it in the New registry name field. If you want to choose which files should
be unpacked or change their path or file name, click the Details button.
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Unpack dialog

In this dialog, you can choose which files you want to unpack and you can also change their names and paths.

If you don't want to unpack any file, uncheck 'unpack file to disk' checkbox.

Note
File paths of some type of files (for example: sql queries) can't be changed. In such cases, the New
file path field and buttons will be disabled.

Click the Cancel button to get back to the Import Data Registry dialog.

Click the Unpack button. The data registry will now unpack all contained files. It is possible that some files from
the rpak file might have the same file names and paths as other existing files on your hard drive. If there are any
filename conflicts, the following dialog will pop up.

Data Registry Manager Dialog

If you click Yes, the conflicting files on your hard drive will be overwritten with the files from the rpak file.

If you click No, the Unpack dialog will open again allowing you to solve the filename conflict.

3.1.1.2. Data Registry Privileges
As with other objects in EspressDashboard, the administrator can also assign privileges to Data Registries. These
include access permissions (read/write) as well as content filtering (restricting which sources in the registry users
or groups can see).

To set privileges for a registry, select it in the Data Registry Manager and click the Privilege button. This will bring
up a dialog listing permissions for the file.
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Registry Privileges Dialog

To give users or groups access to the registry, click the Add button. This will bring up a list of all the defined users
and groups. From this dialog, select the groups and users you want to add. You can set access rights for each user
or group.

For each user or group that has access to the data registry, you can also customize their view of the registry. This
allows you to restrict access of a group of users to specific data sources or types of data sources. To customize the
registry display, select one of the users or groups in the registry privileges dialog and click the Customize button.
This will bring up a dialog showing all the data sources that have been defined in the registry.

Customize Registry Dialog

Each node (data source) in the registry can be set to visible or invisible by selecting it and checking the option at the
bottom of the dialog. Invisible nodes will be grayed out. Note that if you render a parent node invisible, all the sub-
nodes will also be invisible, so you can't make Queries node invisible and individual queries visible at the same time.

Once you finish, click the Ok button and the settings will be associated with the user or group. When they access
the registry, only the visible nodes will appear.

3.1.2. The Data Source Manager
When you edit or create a new data registry, the Data Source Manager window will open allowing you to add and
edit data sources. The Data Source Manager is a visual representation of the registry XML file.

Note
The XML data source repository only stores location and connection information, not the actual data.
It is not an XML file that contains data to be used in a report or chart.
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3.1.2.1. Using Data Source Manager

Data Source Manager

The left side of the window contains a tree listing all of the data sources in the registry file. Grouped under Databases
are individual databases and their associated queries and data views. Grouped under JNDIDataSources are database
sources that use JNDI (Java Naming and Directory Interface) name to connect instead of JDBC. Grouped under
XMLFiles are all XML files and their associated queries. Grouped under TXTFiles are all specified Text files.
Grouped under ClassFiles are all specified class files, and grouped under EJBs are all specified EJB connections.

Right side of the window contains a series of buttons controlling all of the functions of the Data Source manager.
Each button performs the following function:

Edit: This option allows you to modify attributes of a data source. For a database, it allows you to change
the connection information and modify queries/data views. For XML files, it allows you to change the
file and its location, and modify XML queries. For text files, it allows you to change the display name
and file location. For class files, it allows you to change the display name and modify the location.
And for EJBs, it allows you to change the display name as well as parameter values.

Copy: This option is not only available for database nodes and bigdata nodes but also for the specified query
or data view.

Add: This option allows you to add a data source. It will create a new source depending on which node is
selected on the left side of the window. Hence, if you select TXTFiles and click the Add button, you
will be prompted to add a new text file data source.

Remove: This option will remove the selected data source.

View: This will open a new window showing the tabular data from the selected data source, either query,
XML file, text file, class file or EJB. For data views, the data view query interface will start. From this
window, you can select to create a new report or a new chart by selecting the appropriate button.
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View Data Source Dialog

Cancel: This will cancel the wizard process.

Done: This will save any changes you've made in the registry and return you to the registry list.

3.1.2.2. Data Source Node Locking
The data registry has an automatic node locking system designed to block multiple users from editing related nodes
at the same time. The system utilizes your IP address, username, and a special security token to determine whether
you are allowed to add, remove, or edit a specific node. If you are currently editing a node, other users will not be
able to edit it. However, if you disconnect from the server or move to another computer and try to open the same
node from the same username, an option box will appear allowing you to override your previous lock.

Please note that administrator is capable of unlocking any node, even if they did not open it in the first place.

The data registry is a tree where data type is the root and queries and files are the leaves. Changing any node within
a particular branch will lock all parent nodes and all child nodes in that branch. Here are some examples of how
the node locking system works:

Locking Query

In the above image, you can see that the database Woodview (HSQL) and query Orders are part of the same branch.
So if you edit Orders query, it will lock both Orders and database Woodview (HSQL). If you edit Woodview (HSQL),
the database will be locked and all child nodes connected to this database will be locked as well, which includes
Orders, Products, State, and Region.



Data Sources

172

Locking Data Views

In the case of data views, there are three levels in the tree. In the above image, editing Orders data view query will
lock the query, data view Invoicing, and database Woodview (HSQL). If the data view Invoicing is being edited,
both queries Orders and Sales will be locked, as well as database Woodview (HSQL). However, in both of these
scenarios, other data views and queries can still be edited. If the database Woodview (HSQL) is being edited, all
data views as well as their queries will be locked.

3.1.3. Data from a Database
EDAB can draw data from any JDBC compliant database. In order to connect to a database via a 3rd party driver
(other than the JDBC bridge), you will need to add the classes for that driver to the classpath of the application
server/servlet runner where you have deployed the EDAB server. If you installed EDAB with Tomcat, then you
need to modify setclasspath.bat/.sh file in /bin/ directory of your Tomcat installation to add the driver
classes, or copy them to <EDABInstallDir>/WEB-INF/lib directory. Note that JDBC drivers for MS SQL
Server, MySQL, Oracle, Informix and PostgreSQL databases are included as a convenience. Other database JDBC
jar files are not included due to licensing, multiple drivers, and/or other concerns, although support for these data-
bases exist and the jar files can be explicitly added.

The first step in using a database as the data source is to set up a database in the registry and specify the connection
information. To add a database, click on the Databases node and click the Add button. This will bring up a window
prompting you to specify the connection information for that database. You can choose a database to connect to
from the Driver List or specify the information manually. Fields to enter are database name, URL, and driver.
You can also select whether the database requires a login and whether you want to save username and password
information. If you select to save login and password information, you can then enter these informations in User
Name and Password textboxes. Then click the Ok button and the new database will be added to the Data Source
Manager window.

Add Database Dialog
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In order for EDAB to create a connection to the database, the following information must be provided:

URL: This JDBC URL specifies the location of the database to be used. A standard JDBC URL has
three parts, which are separated by colons:
jdbc:<subprotocol>:<subname>

The three parts of a JDBC URL are broken down as follows:

1. jdbc - the protocol. The protocol in a JDBC URL is always jdbc.

2. <subprotocol> - the name of the driver or the name of a database connectivity mechanism,
which may be supported by one or more drivers. A prominent example of a subprotocol name is
odbc, which has been reserved for URLs that specify ODBC data source names. For example,
to access a database through a JDBC-ODBC bridge, you have to use a following URL:
jdbc:odbc:Northwind

In this example, the subprotocol is odbc and the subname Northwind is a local ODBC data
source, i.e. Northwind is specified as a system DSN under ODBC.

3. <subname> - a way to identify the database. The subname can vary, depending on the sub-
protocol, and it can have a subsubname with any internal syntax the driver writer chooses. The
function of a subname is to give enough information to locate the database. In the previous
example, Northwind is enough because ODBC provides the remainder of the information.

Databases on a remote machine require additional information to be connected to. For example, if
a database is to be accessed over your company Intranet, the network address should be included in
the JDBC URL as part of the subname and should follow the standard URL naming convention of

//hostname:port/subsubname

Assuming you use a protocol called VPN for connecting to a machine on your company Intranet,
the JDBC URL you need to use can look like this:

jdbc:vpn://dbserver:791/sales (similar to jdbc:dbvendorname://machine-
Name/SchemaName)

It is important to remember that JDBC connects to a database driver, not the database itself. The
JDBC URL that identifies the particular driver is determined by the database driver vendor. Usu-
ally, your database vendor also provides you with the appropriate drivers. It is highly recommend-
ed that users contact their database driver vendor for the correct JDBC URL that is needed to
connect to the database driver.

Driver: This is the appropriate JDBC driver that is required to connect to the database. If you are using
the JVM included within the installation (or Oracle's J2SE), use the following driver specification
to connect to an ODBC data source:
sun.jdbc.odbc.JdbcOdbcDriver

You can also specify a JDBC driver name specific to your database if you are NOT using the
JDBC-ODBC bridge. For example, the Oracle database engine will require oracle.jdbc.-
driver.OracleDriver.

User Name: This is the login used for the database.

Password: Password for the above user.

Once you specify the connection information, you can test the database connection by clicking the Test Connection
button. This will test the connection using the information you've provided and report any problems.

The Default Options portion of the dialog allows you to specify some properties for queries generated through the
Query Builder interface or data views. You can specify whether to auto-join selected tables. Auto-join will attempt
to join primary and foreign keys defined in the database. You can specify the table name format that should be used
for queries either unqualified (only table name), or 2-part or 3-part qualified. Properties specified here will become
the default setting for new queries and data views. They can also be modified for individual queries.

The Multiple Database Options portion of the dialog allows you to specify additional databases (i.e. additional
database URLs) to obtain data from within the query. This option is only available when the database (original and
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any additional database) is MS SQL Server and 3-Part Qualified Table Name option is chosen. Note that the same
login details as well as the same driver (as defined in the original connection) are used to connect to the specified
additional databases as well. The query can obtain data by referencing a column in the additional database using
a 3-Part table nomenclature.

There are two sample databases included within the EDAB installation. One is a HSQL (a pure Java application
database) database and the other one is a MS Access database. Both contain the same data and are located in help/
examples/DataSources/database directory. For details about how to set up connections to these sample
databases, please see Section Q.3.1.1 - Setup Database Connections of the Quick Start.

3.1.3.1. JNDI Data Sources
In addition to connecting to databases via JDBC, EDAB lets you use the JNDI (Java Naming and Directory Inter-
face) to connect to data sources. In EDAB, JNDI data sources are treated just like database data sources and support
the same functionality (queries, parameters, data views, etc.). The advantage of using a JNDI data source is that it
potentially makes it easier to migrate reports between environments. If data sources in both environments are set
up with the same lookup name, reports can be migrated without any changes.

To connect to a JNDI data source in EDAB, you must have a data source deployed in the same Web application
environment as you are running the EDAB server. To set up a JNDI data source, select the JNDIDataSources node
in the Data Source Manager and click the Add button. This will bring up a dialog allowing you to specify the
connection information.

JNDI Setup Dialog

The first option allows you to specify a display name for the data source. The second option allows you to specify
the JNDI lookup name for the data source. The third option allows you to specify the initial context factory for the
data source, and the last option allows you to specify the provider URL. This information will vary depending on
the application server you're using as different vendors implement JNDI data sources differently. You can test the
connection by clicking the Test Connection button.

3.1.3.2. Queries
Once you add a database, a new node for your database will appear in the Data Source Manager window. When
you expand the node, you will see two more nodes, one called Queries and one called Data Views. These are the
two ways to retrieve data from your database. To create a new query, select the Queries node and click the Add
button. A dialog will come up prompting you to specify a query name and select whether you would like to enter
SQL statement or launch the Query Builder.

If you select to enter an SQL statement, a dialog box will come up allowing you to type in your SQL statement.
From this dialog, you can also load a QRY or text file containing SQL text, or execute a stored procedure. If you
select to launch the Query Builder, the Query Builder will open in a new window, allowing you to construct the
query visually. After you finish building or entering the query, you will return to the Data Source Manager window
and the query will appear as a new entry under the Queries node for your database.

3.1.3.2.1. Using Query Builder
The Query Builder is an integrated utility that allows you to construct queries against relational databases in a visual
environment. To launch the query builder, add a new query within the Data Source Manager and select the Open
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Query Builder option. The Query Builder will then open in a new window. You can also launch the query builder
to modify an existing query by double clicking the query name in the Data Source Manager.

The main Query Builder window consists of two parts. The top half of the window contains all the database tables
selected for the queries and their associated columns. The top window also shows what joins have been set up
between column fields. The lower half of the main window or QBE (query by example) window contains columns
that have been selected or built for the query and their associated conditions.

Query Builder Window

There are three tabs at the top of the Query Builder window. These allow you to toggle between different views.
The Design View tab is the main designer window described above, the SQL View tab shows the SQL statement
that is generated by the current query and the Datasheet View tab shows the query result.

When you finish constructing the query, select Done from the File menu to return to the Data Source Manager.

3.1.3.2.1.1. Tables

When the Query Builder launches for the first time, a tabbed window will appear containing a list of all the tables
within the database. A second tab contains a list of all the views in the database, and the third tab contains a list of
other queries you have designed for the database under a heading called Queries. From this window, you can select
the tables/views/queries from which you would like to build the query. You can also load a previously designed
query as a table. To add a table, select it and click the Add button or double click on the table name. When a table is
added, it will appear in the main Query Builder window and will display all columns within that table. To remove
a table, right click within the table and select Delete from the pop-up menu. You can also specify a table alias and
sort the fields alphabetically from this menu. You can close the tables window by clicking the Close button. To re-
open it, select Show Tables from the Query menu.

Note
By default, the tables will appear using the name format you specified when setting up the database
connection. You can change the naming by selecting Table Name Format from the Query menu.
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Query Builder Tables Window

3.1.3.2.1.2. Joins
When you select database tables for the query, the Query Builder can auto-detect joins between column fields based
on primary key-foreign key relationships in the database. Auto-joins will be added depending on which option you
selected when setting up the database connection. Auto-joins will create a standard join between tables. A join is
represented by a line drawn between two fields in the top half of the design window. To remove a join or edit
its properties, right click on the line and select your choice from the pop-up menu. To add a join, click and drag
one column field to another in a different table. A join will then appear. You can change the auto-join settings by
selecting Auto Join from the Query menu.

Join Properties: Selecting Join Properties from the pop-up menu will bring up three options allowing you
to select the type of join used between the column fields. Query Builder only supports
equi-joins. Inequality joins can be easily accomplished using the conditions field. You
can specify inner joins, left outer joins, and right outer joins. See the examples below for
an explanation of the different join types.

Suppose you have the following two tables: Customers and Orders

CustomerID CustomerName

1 Bob

2 Ivan

3 Sarah

4 Randy

5 Jennifer

OrderID CustomerID Sales

1 4 $2,224

2 3 $1,224

3 4 $3,115

4 2 $1,221

An inner join on CustomerID on the two tables will result in combining rows from the Customers and Orders
tables in such a way that each row from the Customers table will be “joined” with all the rows in the Orders table
with the matching CustomerID value. Rows from the Customers table with no matching CustomerID fields from
the Orders table will not be included in the query result set.

Now suppose you create a query by selecting the OrderID, CustomerName, and Sales fields with an inner join
on the CustomerID field. The select statement generated by the Query Builder would look like this:

Select Orders.OrderID, Customers.CustomerName, Orders.Sales
From Customers, Orders
Where Customers.CustomerID = Orders.CustomerID
Order by Orders.OrderID;
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The result of the query is shown below:

OrderID CustomerName Sales

1 Randy $2,224

2 Sarah $1,224

3 Randy $3,115

4 Ivan $1,221

As you can see, the CustomerName entries “Bob” and “Jennifer” do not appear in the result set. This is because
neither customer has placed an order. There are situations where you may want to include all the records (in this
example customer names) regardless whether matching records exist in the related tables(s) (in this case the Orders
table). You can achieve this result using outer joins.

The Query Builder gives you the option of either right or left outer joins. The keywords “right” and “left” are not
significant. It is determined by the order that the tables are selected in the Query Builder. If the outer table (the
one that will have all records included regardless of matching join condition) is selected first, then Query Builder
will use a right outer join. If the outer table is selected after the other join table, a left outer join is used. In our
example, the Customers table has been selected before the Orders table, hence to select all of the records from the
CustomerName field, the Query Builder will use a right outer join on the CustomerID fields.

Join Properties Dialog

Now, using the previous example, suppose you create the same query as before, except this time you specify to
include all records from the Customers table. The select statement generated by the Query Builder would look
like this:

Select Orders.OrderID, Customers.CustomerName, Orders.Sales
From Orders right outer join Customers on Orders.CustomerID =
 Customers.CustomerID
Order by Orders.OrderID;
                    

The result of the new query is shown below:

OrderID CustomerName Sales

 Jennifer  

 Bob  

1 Randy $2,224
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OrderID CustomerName Sales

2 Sarah $1,224

3 Randy $3,115

4 Ivan $1,221

As you can see, all of the customer names have now been selected and null values have been inserted into the result
set where there are no corresponding records. If you specify an outer join, the join line connecting the two tables
in the Query Builder will become an arrow in the direction of the join.

3.1.3.2.1.3. Columns
The QBE window contains information on column fields selected for the query, as well as any conditions for the
selection.

Selecting Column Fields: You can add column fields to the query from any table that has been selected
in one of two ways. You can double-click on a field name within a table to
add it to the query, or you can double-click on the Table or Field fields to
bring up a drop-down menu with field choices. You can remove a column
from the query by right clicking in the lower window and selecting Delete
Column from the pop-up menu, or by selecting Delete Column from the Edit
menu. Once you select a column field, you can specify how you want to
sort the column, in ascending or descending order, by double clicking on the
Sort field. You can also specify group by or column aggregation by double
clicking on the Aggregation field. Aggregation options include: Group By,
Sum, Average, Min, Max, Count, Standard Deviation, Variance, First, Last,
and Where. If you select group by for one column, then you are required to
specify group by (or aggregation) for all of the other columns. To specify
a column alias, right click on the column and select Alias from the pop-up
menu. You can perform a SELECT DISTINCT operation by selecting the
Select Distinct option from the query menu.

Building Columns: To build your own column, right click on a blank column in the QBE win-
dow and select Build from the pop-up menu. This will launch the Formula
Builder. The Formula Builder allows you to construct columns in a visual
environment using the tables that you have selected and the formula library
for the database that you are using. You can click the Browse Data Field
button to see the first few records of data for any field in your query.

Formula Builder Window
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Conditions: You can place conditions on the query selection by entering them in the Condition or Or fields.
A condition placed in the Condition field creates an AND clause within the generated SQL. A
condition placed in the Or field creates an OR clause within the SQL. Right clicking in either field
and selecting Build from the pop-up menu will bring up the Formula Builder. In the Formula
Builder, you can specify standard conditions, =, <, >, BETWEEN, LIKE, NOT, etc., as
well as construct formulas to filter the query. You can also specify a query parameter here.

Note
EDAB can auto-correct items entered as query conditions by appropriately
appending the field name and encasing string arguments in quotes. For ex-
ample, if you enter = ARC, EDAB will change the query condition to
Categories.CategoryName='ARC'. If you're using complex functions
(i.e. database functions that take multiple string arguments), EDAB may not be
able to properly parse the function. You can turn off the auto-correct feature by
un-checking the box at the bottom of the formula builder window.

3.1.3.2.1.4. Using Database Functions

The formula builder component in the query builder allows you to use database specific functions when building a
column or condition for the query. You can use the functions that are supplied or add your own to the interface.

EDAB comes with the function libraries for Oracle, Access, MS SQL, and DB2 pre-loaded. They are stored in
XML format in DatabaseFunctions.xml file in userdb directory. For databases with functions not stored
in XML, EDAB will use default ones. You can specify different database functions by editing the XML file or
creating a new one based on DatabaseFunctions.dtd file in userdb directory. A sample database functions
file might look like this:

<DatabaseFunctions>
      <Database ProductName="ACCESS">
            <FunctionSet Name="Numeric Functions">
                  <Function>Abs(number)</Function>
                  <Function>Atn(number)</Function>
            </FunctionSet>
      </Database>
</DatabaseFunctions>
                    

3.1.3.2.1.5. Adding Extra SQL

Sometimes it is necessary to add extra SQL statements to run before or after a query. For example, you may need
to set a transaction level or call a stored procedure before executing a query and/or commit a transaction or drop
a temporary table after executing a query. The query builder allows you to specify these extra SQL statements by
selecting Extra SQL from the Query menu. This will bring up a window allowing you to write statements to execute
before and/or after a query.
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Extra SQL Dialog

You can enter any SQL statements you would like to run before and/or after the query in the appropriate boxes.
Once you finish, click the Ok button and the statements will be added to the query.

3.1.3.2.1.6. Query Output

The SQL View and Datasheet View tabs allow you to see two different views of the query.

SQL View: The SQL View tab shows you the SQL statement generated by the query in the design
view. It allows you to see how the Query Builder is translating different operations
into SQL. You can edit the generated SQL if you want, however, if you change the
SQL and then return to the Design View, all changes you made will be lost. If you
save a query after changing the SQL, the query will re-open in the SQL View tab if
you select to edit it.

Datasheet View: The Datasheet View tab shows you the query result in data table form (this tab is also
available in the Enter SQL dialog). The datasheet view will show you all the data that
is drawn as a result of executing the query. Going to the datasheet view will also test
the query to check for design errors. You can navigate the query result by using the
toolbar at the bottom of the window.

 Go to the first page of the data table

 Go to the previous page of the data table

 Go to a specific row of data

 Go to the next page of the data table

 Go to the last page of the data table
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 Set number of rows to display per page (default is 30)

Exporting Queries: You can export queries in one of two ways. You can output the SQL statement as a text
or you can output the query result as CSV file. To export a query, select Export from
the File menu. A second menu will appear giving you the option to Generate SQL or
Generate CSV. Select the desired option and a dialog box will appear prompting you
to specify the filename and location.

Note
To save the query and exit the Query Builder, select Done from the File menu.

3.1.3.2.2. Parameterized Queries
You can also use the Query Builder to design parameterized queries. This feature allows you to filter the data at
run-time.

Query parameters can be defined when typing an SQL statement or using the Query Builder. They can also be
defined when running data views (this is covered in the next section). A parameter is specified within an SQL
statement by the ":" character. Generally, the parameter is placed in the WHERE clause of an SQL Select statement.
For example, the following SQL statement

Select * From Products Where ProductName = :Name
                

specifies a parameter called Name. You can then enter a product name at run-time and only retrieve data for that
product.

Within the Query Builder, you can specify a query parameter by right clicking on the Condition field and selecting
Build from the pop-up menu. The Formula Builder will open, allowing you to place a condition on the column.

Specifying a Parameter in the Formula Builder

You can insert a parameter by clicking the PARAMETER button. A second dialog will appear prompting you to
specify a name for the parameter. Type the parameter name, click OK and then click OK again to close the formula
builder. You can specify as many different parameters for query as you like.
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3.1.3.2.2.1. Multi-Value Parameters

EDAB supports a special kind of parameter that takes an array of values as input rather than a single value. Mul-
ti-value parameters are useful when you want to filter the result set based on an unknown number of values. For
example, say a report is run to return a list of customers for a specific state/province. Users could select as many
different states/provinces as they wanted and return the relevant information.

To create a multi-value parameter, place a parameter within an IN clause in an SQL statement. For example, the
following query

Select Customers.Company, Customers.Address, Customers.City,
 Customers.State, Customers.Zip
From Customers
Where Customers.State IN (:State);
                    

will create a multi-value parameter named State. Multi-value parameters will only be created if there is only one
parameter in the IN clause. If you place more than one parameter in the IN clause, i.e. Customers.State IN
(:State1, :State2, :State3), it will create three single value parameters instead.

3.1.3.2.2.2. Initializing Query Parameters

When you attempt to save (by selecting Done from the File menu) or preview (by clicking the Datasheet View tab)
a parameterized query, you will first be prompted to initialize the parameter. You can also initialize it by selecting
Initialize Parameters... from the Query menu or by clicking the Initialize Parameters button in the Enter SQL
Dialog.

Initialize Parameter Dialog

From this dialog you can specify the following options:

Map to database column: This option allows you to specify a column from the database whose values
will be used for the parameter input. Selecting this option modifies the pa-
rameter prompt that the end user will get when previewing or running the
report in the Report Viewer. If you map the parameter to a database column,
then the user will be prompted with a drop-down list of distinct values from
which to select a parameter value. If you do not map, the user will have to
type in a specific parameter value.
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Tip
Normally, this drop-down list is populated by running a select
distinct on the column while applying the joins and conditions
from the query. If you prefer to get all data from the column
without constraints (sometimes this can improve performance
of the parameter prompts), you can set the Distinct Parame-
ter List Selection option in the Admin Console. This will re-
sult in selecting the distinct values of the mapped column from
the table that contains the column. For more information about
EDAB server options, see Section 1.4.1.3 - Server Options.

Map to database function: The map to database column feature is very handy if you want to enter a
valid value for a parameter from a list box, but sometimes you rather want a
computed value or a derived value from a database column. For example, you
want to find all orders from year 2007. However, OrderDate is a date. What
you want is to apply the Year function to the OrderDate column. This is the
impetus behind this feature. Mapping a parameter to a database function is
very similar to mapping to a column. In the formula builder, enter a condition
comparing a function result to a parameter as shown below:

Condition for Mapping to Database Function

In the initialize parameter dialog, check the Map to database function check-
box and the values will be automatically filled in.
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Map Parameter to Database Function

The list of custom functions is extracted from DatabaseFunction-
s.xml file located in <EDAB Install>/userdb/ directory. Modify
the .xml file if you wish to add a new database or custom functions. The
new functions will appear in this list after you restart the program.

If your database is not listed in the .xml file, the function list will be popu-
lated with functions listed in the JDBC driver. However, the function para-
meters are not provided. For example, the HSQL database will not be listed
in the .xml file.

An interesting example using the HSQL database is as follows. Suppose you
would like to create a report for orders that were delayed. You can utilize the
HSQL DateDiff function to find the number of days for the order to ship.

DATEDIFF('dd', ORDERS.ORDERDATE, ORDERS.SHIPDATE)
 >= :ShipDelay
                                

This function finds the difference between the order date and the ship date
and displays the result in terms of days. If you initialize the parameter and
check the map to database function, the following window will be displayed:
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No Parameter Types for HSQL Function

The DateDiff function requires a string and two date values for the para-
meters. Enter these parameter types in the parentheses. This will bring up
three set parameter value lists. Enter dd (day) for the first parameter, select
Orders.OrderDate from the list for the second parameter, and select
Orders.ShipDate from the list for the third parameter. The default val-
ues will be updated with the function results.

Map Parameter to HSQL Function

Map to SQL ResultSet: A parameter mapped to a database column will give you a list of distinct
values in a drop-down list box for the user to choose from when running
the report. However, to produce the list of values, a select distinct on the
column with the joins and conditions from the query will be run. In some
cases, this can be a time-consuming process. To obviate this problem, and
in fact gain complete control as to what and how to populate the drop-down
list box, you can write your own select statement to populate the drop-down
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list. An added bonus is that parameters that are in the query can be included
in this query. With proper joins and parameters included, you can use this
feature to facilitate cascading parameters (See Section 3.1.3.2.2.3 - Cascad-
ing Parameters). Below is an example:

Suppose you have two parameters in the query. So, your query is as follows:

SELECT CATEGORIES.CATEGORYID,
 PRODUCTS.PRODUCTNAME, PRODUCTS.UNITPRICE,
 PRODUCTS.UNITSINSTOCK
FROM PRODUCTS, CATEGORIES
WHERE ((PRODUCTS.CATEGORYID =
 CATEGORIES.CATEGORYID))
AND (((CATEGORIES.CATEGORYID =:category) AND
 (PRODUCTS.PRODUCTNAME =:product)))
                                

In the config prompt in initialize parameter, set the order for
parameter prompting to category first, then product.

The select statement for parameter category can be the following:

SELECT DISTINCT CATEGORIES.CATEGORYID
FROM CATEGORIES
                                

The select statement for parameter product will be as shown below:

SELECT DISTINCT PRODUCTS.PRODUCTNAME
FROM CATEGORIES, PRODUCTS
WHERE CATEGORIES.CATEGORYID = PRODUCTS.CATEGORYID
AND CATEGORIES.CATEGORYID = :category
                                

Select Statement for Product

When the user runs the template, category will be prompted first. Then
the value of category chosen will be used to filter for product.

The select statement mapped to a parameter can have either one or two
columns in the select list. It is clear that if one column is in the select list, it
must be the column that supplies list of distinct values for the parameter. An-
other useful feature provided here is that you can actually select two columns
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in the select list such that the first one of the columns will supply values
for the drop-down list while the second column will be the actual parameter
value for the filter condition. Consider the following example.

Suppose your database has a table with product ID as the primary key. When
your end user wants to search for products from the database, they want
to use the product name as parameter (therefore it is listed in the query as
first) since a product ID could be just a cryptic code (therefore it is listed
in the query as second). Using this feature, you can choose product name
for the values in the drop-down list and product ID as the actual value filter
condition.

Select Statement with Two Columns

Use custom selection choices: Rather than having a drop-down menu with all the distinct column values,
you can also create a custom list of parameter values. To create this list,
select this option and click the Setup Choices button. This will launch a new
dialog allowing you to create a list of choices.

Custom Parameter List Dialog

In this dialog, you can either enter custom values or select values from the
distinct values of a column in the database. Once you finish specifying the
values for the list, click the OK button and the choices will be saved.

Default Value: This allows you to specify a default value for the parameter. Although you
don't have to specify a default value, it is recommended that you do so. If
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you do not supply a default value, you cannot open or manipulate the report
template without the data source present.

You can either select a single value manually (either choose it from a list or
type it manually, it depends on the mapping method you chose) or map the
default value to a SQL query.

For multi-value parameters (see Section 3.1.3.2.2.1 - Multi-Value Parame-
ters), the SQL query can return more than one value. In such case, several
values will be chosen as default parameter values.

Date Variable: This option is only available when the parameter is not mapped to a database
column or function, or it's mapped to a SQL resultset and not set to a custom
selection choice. This option is only intended for parameters with variable
type date/time. When you click this button, the following panel will pop up,
listing all the supported keywords.

Enter Date Variable Dialog

This dialog allows you to select one of the three keywords: CurrentDate,
CurrentTime, and CurrentDateTime. You can add or subtract units
of time from the current date/time, allowing you to have a dynamic date
range. For example, a report can have the following default values:

StartDate: CurrentDate - 1 WEEK
EndDate: CurrentDate
                                

This would indicate that every time the report is run, the default prompt
should be one week ago to the current date. Other supported time units are
YEAR, MONTH, DAY, HOUR, MINUTE, and SECOND. This feature
only supports a single addition or subtraction, it does not support multi-value
parameters.

You can also use functions to define the parameter value:

FirstOfYear() Argument format: CurrentDate, Current-
DateTime, e.g.
FirstOfYear(CurrentDate)

This function returns a date of the first day of the
year from the argument. For example, when the
argument evaluates to 2012-08-14, the func-
tion returns 2012-01-01.
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LastOfYear() Argument format: CurrentDate, Current-
DateTime, e.g.
LastOfYear(CurrentDate)

This function returns a date of the last day of the
year from the argument. For example, when the
argument evaluates to 2012-08-14, the func-
tion returns 2012-12-31.

FirstOfQuarter() Argument format: CurrentDate, Current-
DateTime, e.g.
FirstOfQuarter(CurrentDate)

This function returns a date of the first day
of the quarter which includes the date from
the argument. For example, when the argument
evaluates to 2012-08-14, the function returns
2012-07-01.

LastOfQuarter() Argument format: CurrentDate, Current-
DateTime, e.g.
LastOfQuarter(CurrentDate)

This function returns a date of the last day
of the quarter which includes the date from
the argument. For example, when the argument
evaluates to 2012-08-14, the function returns
2012-09-30.

FirstOfMonth() Argument format: CurrentDate, Current-
DateTime, e.g.
FirstOfMonth(CurrentDate)

This function returns a date of the first day of the
month from the argument. For example, when the
argument evaluates to 2012-08-14, the func-
tion returns 2012-08-01.

LastOfMonth() Argument format: CurrentDate, Current-
DateTime, e.g.
LastOfMonth(CurrentDate)

This function returns a date of the last day of the
month from the argument. For example, when the
argument evaluates to 2012-08-14, the func-
tion returns 2012-08-31.

FirstOfWeek() Argument format: CurrentDate, Current-
DateTime, e.g.
FirstOfWeek(CurrentDate)

This function returns a date of the first day of
the week which includes the date from the ar-
gument. For example, when the argument eval-
uates to 2012-08-14, the function returns
2012-08-12 (Sunday is considered as the be-
ginning of the week).

LastOfWeek() Argument format: CurrentDate, Current-
DateTime, e.g.
LastOfWeek(CurrentDate)

This function returns a date of the last day of
the week which includes the date from the ar-
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gument. For example, when the argument eval-
uates to 2012-08-14, the function returns
2012-08-18 (Saturday is considered as the end
of the week).

StartOfDay() Argument format: CurrentTime, Current-
DateTime, e.g.
StartOfDay(CurrentDateTime)
This function returns a time of the start of
the day from the argument. For example,
when the argument evaluates to 2012-08-14
12:15:03, the function returns 2012-08-14
00:00:00.0.

EndOfDay() Argument format: CurrentTime, Current-
DateTime, e.g.
EndOfDay(CurrentDateTime)
This function returns a time of the end of
the day from the argument. For example,
when the argument evaluates to 2012-08-14
12:15:03, the function returns 2012-08-14
23:59:59:999.

Data Type: This allows you to specify data type for the parameter value(s). If you
mapped the parameter to a column, the data type is set automatically.

Allow Select All Option: Use this to add an option to the parameter prompt dialog that will allow
users to select all parameter values even for single-value parameters. See the
Section 3.1.3.2.2.4 - All Parameters for more details.

Custom Date Format: This allows you to set the format in which the date parameter should be
entered. This option is only available when the data type is either date, time,
or timestamp and the parameter is either mapped to column or not mapped
at all.
When you check this option, the default custom date format is shown. These
defaults can be changed in the admin console (See Section 1.4.1.3 - Server
Options). Please note that the default date format only applies to database
data sources. The date format is built using a combination of characters that
represent date/time elements. You can build the format easily using the date
format builder by clicking the Build button.

Date/Time Format Builder
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The builder contains a list of elements available on the right. You can mouse
over the elements to see an example of each presentation. The bottom section
contains a set of separators available for use.

You can also type in the format by hand either in the builder or directly in
the Custom Date Format input box. Formatting for this option is the same as
for the format argument of the function.

Prompt Name: This allows you to specify the prompt that is given to the user in the para-
meter dialog.

If you map the parameter, the user will see either a drop down box (single value parameter) or a list box (multi-value
parameter) containing various options. If you choose not to map the parameter, the user will see a textbox to enter
their own value. In case of a multi-value parameter, it is recommended to let the user inform in the parameter prompt
that this parameter accepts multiple values. Users can separate multiple values using a comma (e.g. ARC, DOD,
TRD). If the text requires the use of comma, the user can use quotes to include the comma within the filter string
(e.g. "Doe, John", "Smith, Mike").

Clicking the Previous Parameter and the Next Parameter buttons allows you to initialize each of the parameters
that have been defined in the query.

When you select to use a parameterized query to design a report, or open a report that uses a parameterized query,
the report will load/start with the default values. You will be prompted to provide parameter values when you
preview the report.

3.1.3.2.2.3. Cascading Parameters

By default, the user is prompted to enter all report parameters at once in the prompt dialog. This configuration,
however, may not be the best approach if some parameters are mapped to database columns with a significant num-
ber of distinct values. It can be difficult to select from a very large list and depending on the parameter combination,
users may be able to select parameters that do not return any data.

To assist with these problems, EDAB provides a feature that allows the user to configure the order in which the
parameters should be entered. With this feature enabled, the user enters parameters in the dialog in a pre-defined
order. As such, each selection will be applied as a filter to the next parameter prompt(s). Using cascading parameters
can limit the number of distinct values presented to the user and can prevent the user from selecting invalid parameter
combinations.

To enable cascading parameters, check the option marked Prompt parameter in sequence in the parameter initial-
ization dialog. Then click the Config button to set the order of the parameter prompts. A dialog will open showing
all the parameters defined in the query.

Parameter Sequence Dialog

Using the spin boxes, you can set the sequence for the query parameters. User will be prompted to start with the
lowest numbered parameter and work his/her way up to the highest one. If two or more parameters share the same
number, the user will be prompted to enter those parameters at the same time (in the same dialog).

By default, the parameter values for the next level are generated by rerunning the entire query with the previously
prompted parameters filled in. If the original query is slow to execute, you can improve performance by mapping
higher order parameters to SQL Queries. You can even include previously selected parameter values in the mapped
query. For more information, please see Section 3.1.3.2.2.2 - Initializing Query Parameters.
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Please note that this feature can only be used with reports.

3.1.3.2.2.4. All Parameters

Sometimes you want to select all parameter values at once. The All Parameters feature allows you to do so.

Single-value parameters It is possible to select all parameter values at once, even for parameters that
do not allow multi-value selection.

Note
There is a difference between multi-value selection and all-value
selection. See the Inner Workings chapter to learn more.

For example: Let's assume you have a condition like this:

WHERE column = :Parameter
                                

In such case, the parameter prompt dialog will not allow you to select more
than one value.

Typical single-value parameter

But you can use the Select All Values feature to add an option to the parameter
value list that will allow viewers to select all parameter values at once (even
if the parameter does not allow multi-value selection).

Single-value parameter with the Select All functions enabled

The Select all feature can be enabled in the Initialize Parameters dialog (see
Section 3.1.3.2.2.2 - Initializing Query Parameters for more details) by select-
ing the Allow Select All Option checkbox.
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This option is only available for parameters that meet the following require-
ments:

1. The parameter uses one of the following operators. If there are multiple
occurrences of this parameter in the query, all parameter comparison oper-
ators have to be one of these:

< less than

<= less than or equal to

> greater than

>= greater than or equal to

= equal to

2. The parameter is mapped to the same column as the column from the pa-
rameter condition or the parameter isn't mapped to anything.

After you select the Allow Select All option, the Select All Label field activates,
allowing you to enter a text that will be used for selecting all data from the
query. For parameters that are mapped to a column, this text will be displayed
in the parameter value list in 1st place. For parameters that aren't mapped to
anything, entering this text as the parameter value will result in selecting all
data.

Multi-value parameters Unlike single-value parameters, the Select All feature is enabled for all mul-
ti-value parameters by default (in fact, it can't be disabled, because disabling
it for multi-value parameters would make no sense). All you have to do to use

this feature is to click on the  Select All icon in the parameter prompt.
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However, multi-value parameters can work in two modes:

1. If the parameter meets the conditions from the previous paragraph and the
parameter is on the first cascading level (i.e. parameter cascading is dis-
abled or the parameter is on the first cascading level), it is parsed by the
SQL parser and the parameter condition is nullified. Nullifying the para-
meter optimizes the query and prevents it from causing performace issues
or even errors. See the Inner Workings to learn more about how it works.

2. If the parameter doesn't meet the conditions from the previous paragraph
or if it's not on the first cascading level, selected values will be injected to
the query as a list of values separated by comma. If there is a large amount
of values injected to the query as a list, the query can become quite long.
Long queries can cause performance issues or even errors, so it is not rec-
ommended to use this option for parameters with many values.

Inner Workings If a report/chart/map viewer chooses to select all parameter values for a sin-
gle-value parameter or for a multi-value parameter that meets the conditions
for parameter disabling, the query is then automatically parsed and a special
condition is added to the parameter which basically disables the parameter.

For example: The following query

select *
from table
where column > parameter_value
                                

Would be parsed and passed to the database as:

select *
from table
where ((column > parameter_value) OR (1 = 1))
                                

This example also demonstrates another important thing: selecting all values
for the < (less than) or > (greater than) operators returns all values from the
table (if there are no other conditions) rather than returning no data at all (be-
cause condition like WHERE <all data from the Date column>
> Date would return no data...).

Because EDAB allows you to use many database systems, parsing may fail
for certain complex queries in certain databases. In such case a warning dialog
will be displayed.
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In such situations, you have the following three options:

1. Try to modify the query so it can be parsed by our parser.

2. Add your own Select all parameters condition to the query.
For example:

WHERE ((column = :Parameter) OR (:Parameter
 LIKE 'selectall'))
                                        

Note
If you embed all parameters directly to the query, leave the
Allow Select All Option option disabled.

3. Contact Quadbase support [ https://www.quadbase.com/support-overview/
].

3.1.3.2.3. Entering SQL Statements
Typically, the Query Builder is recommended for creating queries. However, there are cases when it is necessary
to enter SQL statements directly: for example if the query is already created in a QRY file, if the query is built
into a stored procedure/function, or if the query requires commands not supported by the Query Builder. In these
situations, select Enter SQL statement to open the Set SQL Statement window. Here you can enter SQL statements
directly into the text area as shown below or you can load an existing QRY File.

Enter SQL Statement Dialog

To preview the result set, click on the Datasheet View tab.

3.1.3.2.3.1. Calling Oracle Stored Procedures
Compared to other database systems, Oracle uses a different approach when it comes to stored procedures and
functions. For example, on MS SQL Server, using the EXEC command will return a result set. However, Oracle
requires the use of an OUT parameter with a REF CURSOR type to return the result set. In addition, Oracle will not
accept multiple statements from a single query. Therefore, it is necessary to store the query within a stored function
and use special syntax to access the existing Oracle stored procedures.

To access your Oracle stored procedures, the first step is to define a weakly typed REF CURSOR using the following
PL/SQL statement:

CREATE OR REPLACE PACKAGE types
AS

      TYPE ref_cursor IS REF CURSOR; 

END;
                    

https://www.quadbase.com/support-overview/
https://www.quadbase.com/support-overview/
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This ref_cursor type will be used to store the query result set and return as an OUT parameter. The next step is
to create a function which calls your stored procedure and executes your query. The following skeleton code will
return a simple query using the ref_cursor type.

CREATE OR REPLACE FUNCTION my_function()

      RETURN types.ref_cursor

AS

      result_cursor types.ref_cursor;

BEGIN

      do_stored_procedure();
      OPEN result_cursor FOR
            SELECT * FROM Categories

      RETURN result_cursor;

END;
                    

Now that the Oracle stored function is set up, it can be easily called from ChartDesigner using a special PL/SQL
like syntax. In the Set SQL Statement window, enter the following syntax to call the Oracle stored function:

Calling simple Oracle stored function

The BEGIN ... END; syntax alerts the system that the user is trying to access an Oracle stored function. And
the “?” notifies the ChartDesigner that a variable is reserved for the OUT parameter. The JDBC syntax for calling
Oracle stored procedures is as follows:

( call ? := my_function() )
                    

However, EDAB does not support this format. Preview the results by clicking the Datasheet View tab.

Here is a more practical example to illustrate how stored procedures can be used with EDAB to develop useful
solutions. Suppose you have a table called employee_table that stores an organization's location hierarchy such as
the one shown below:

ID NAME PARENT EMPLOYEE

1 All NULL 0

2 America 1 0

3 Europe 1 0

4 New York 2 20
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ID NAME PARENT EMPLOYEE

5 Santa Clara 2 30

6 Dallas 2 12

7 London 3 14

8 Paris 3 11

The table lists the various corporate locations in a tree structure. The numbers of employees are stored in the leaf
nodes (e.g. New York, London, etc.) and each node contains information about its immediate parent. Suppose you
want to create a report that displays the number of employees in a certain region and information about the separate
branches within that region. For example, if the user inputs ID = 2 (America), you want the report to display the
total number of employees in America along with the branch locations. Using Oracle's CONNECT BY and START
WITH clauses, the problem can be solved with two simple Oracle Stored Functions:

CREATE OR REPLACE FUNCTION sum_employees(locID IN NUMBER)

      RETURN NUMBER 

AS

      sum_emp NUMBER; 

BEGIN

      SELECT sum(employee) INTO sum_emp
      FROM employee_table
      CONNECT BY PRIOR id = parent
      START WITH id = locID;

      RETURN sum_emp; 

END;

CREATE OR REPLACE FUNCTION regional_employees (locID IN NUMBER)

      RETURN types.ref_cursor 

AS

      result_cursor types.ref_cursor; 

BEGIN

      OPEN result_cursor FOR
            SELECT id, name, sumEmployees(id) AS Employees
            FROM employee_table
            CONNECT BY prior id = parent
            START WITH id = locID; 

      RETURN result_cursor;

END;
                    

The function sum_employees takes the starting node as an argument and finds the sum of all leaf nodes that are
descendents of that node. For example, sum_employees(3) returns 25 because there are 25 employees in Europe
(14 in London, 11 in Paris). The second function, regional_employees, traverses through the tree structure
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starting with the locID and builds a result set from the ID, Name and the result from the sum_employees
function. The result set is then returned through a REF CURSOR.

To call a stored function that requires an argument, enter the following statements in the Set SQL Statement window:

Calling regional_employees function

Preview the results by clicking the Datasheet View tab.

Result set from regional_employees

As seen in the results, the CONNECT BY clause traverses the tree recursively listing the American nodes together
before listing the European nodes. If the user is only interested in European locations, they can enter 3 for the
parameter and the following result set would return this:

Result set from regional_employees in Europe

To create a parameterized report, use the :param_name syntax. The SQL parser in EDAB will be able to dif-
ferentiate between the colon used for parameters and the one used for the assignment operator ( := ). Here is an
example of using the parameters:



Data Sources

199

Calling Oracle Stored Function using Parameter

When using IN parameters, it is necessary to initialize the parameters prior to executing the query. It is especially
important to set the correct default data type for executing stored procedures because the parameters cannot be
mapped to existing columns. You can find more information about initializing parameters in Section 3.1.3.2.2 -
Parameterized Queries.

To try this example, <EDABInstall>\help\examples\DataSources\database\locationHier-
archyExample.sql contains SQL commands to create employee_table as well as two stored functions.

3.1.3.3. Data Views
In addition to the query interfaces, EDAB provides another way of retrieving database data - data views. Data views
provide a simplified view of the database in which users can design queries by simply selecting fields without using
the Query Builder or having any knowledge of the underlying database structure. Using data views, administrators
can predefine tables, joins, and fields, creating a local schema for the user to select from.

For example, an administrator could set up a data view for the sales department. The appropriate database tables and
fields are pre-selected and grouped in a manner congruent with business users' logic. For example a group called
invoices would have the appropriate customer and order fields. End users would then select this data view, pick the
pertinent fields, specify a date range, and then begin designing a report or chart.

To create a data view, select the Data Views node in the Data Source Manager window and click the Add button.
A new window will open allowing you to select the database tables you want to use for the data view.

Data View Choose Tables Dialog

Left window contains all available database tables and views. You can add a table by selecting it in the left window
and clicking the ADD>> button. By default, the data view will use the name format you specified when setting
up the database connection. You can change the naming by clicking the Table Name Format button, or specify a
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table alias by clicking the Rename button. You can also import selected tables and joins from another data view
by clicking the Import Joins… button.

The Joins tab of this window allows you to specify the joins between the selected tables.

Data View Joins Dialog

The Joins tab shows all selected tables and their associated fields. The tables will be auto-joined depending on
which option you selected when setting up the database connection. These auto-joins create a standard join between
tables represented by a line. To remove a join or edit join properties, right click on the line and select your choice
from the pop-up menu. To add a join, click and drag one column field to another in a different table. A join will then
appear. Data views use the same join properties as the Query Builder. For more information about join properties,
please see Section 3.1.3.2.1.2 - Joins.

After you finish selecting and joining tables, click the OK button and a new window will open allowing you to
construct the data view.

Create Data View Dialog

The left window contains a list of tables you have selected and their associated fields. Each folder represents a
table and can be opened and closed by double clicking. The right window contains fields that have been selected
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for the data view. To add a field to a data view, select it in the left window and click the ADD>> button. Fields
can be removed from the data view in the same way by selecting a field in the right window and clicking the
<<REMOVE button. You can create a calculated column by clicking the Build Formula button. This will open the
formula builder, allowing you to build the column. You can also define an alias by selecting any of the view fields
in the right window and clicking the Rename button.

You can also group fields within the data view by adding headings. This allows you to create your own organi-
zational structure of virtual tables that group data from different database tables under one heading. To create a
heading, click the Add Heading button. You will then be prompted to specify a name for the heading. The new
heading will then appear as a folder in the right window. To add fields under a heading, first select the fields you
want to add from the right window and click the Group Fields button. You will then be presented with a drop-down
menu, allowing you to select the heading under which you would like to add the fields.

The Conditions tab contains a formula builder window that allows you to specify certain filtering criteria for end
users. Anything added in this window will be added to the Where clause of the generated SQL. For more information
about using the formula builder, please see Section 3.1.3.2.1.3 - Columns.

Once you finish creating the data view, click the OK button and the data view will be added to the Data Source
Manager. Users can now use this view to construct ad-hoc queries.

When you design a report or chart using a data view as the data source (by selecting the data view and clicking the
Create Report or Create Chart button), a window will open allowing you to select which fields in the view you want
to use for the report. From this dialog, you can also build computed fields based on the available view columns.

After you select the fields, click the OK button and a new window will open allowing you to specify sorting,
aggregation, and filtering conditions for the data view.

Data View Choose Fields Dialog
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Data View Conditions Window

You can specify sorting, aggregation, and conditions for every field in the data view by double clicking on the
respective field. Sorting and aggregation can be selected from drop-down menus. Double clicking on the Conditions
field brings up a new window that allows you to specify simple selection criteria like >, <, =, and between.
Users can build more advanced filtering criteria by right clicking on the Conditions field and selecting Build from
the pop-up menu. This will open the Formula Builder window allowing you to build a condition. You can also
display all of the unique values in the column by double clicking on the View Column button.

The Option menu in the upper left corner of the conditions window allows you to select a vertical/horizontal view
for the conditions window, initialize any parameters in the data view, or save the query.

The selection set and conditions that you specify will be saved as a data view query with the name that you specify
in the name field. Data view queries are saved under the node for the data view. A report created from the data view
will refer to the data view query for updating/modification.

3.1.3.3.1. Data View Parameters
As with Query Builder, users can specify query parameters in Data Views. To add a parameter to a data view, select
a data view in the Data Source Manager and click View to run the data view. After you select fields for the data
view and you are in the conditions window, right-click in the Condition field for a column and select Build from
the pop-up menu. This will bring up the formula builder, allowing you to specify a parameter in the same way as
in Query Builder. For more information about this, please see Section 3.1.3.2.2 - Parameterized Queries.

Once you enter the parameter, you will be prompted to initialize it if you go to the Datasheet View tab and then
click Ok to continue with the report wizard, or if you save the selections as a query. You can also initialize the
parameter by selecting Initialize Parameters from the Option menu.

3.1.3.3.2. Updating Data View Queries
Sometimes you may need to make changes to the structure/make-up of the data view as your data model or require-
ments change. Changes could include adding/removing fields or re-naming them. You can propagate changes from
the data view to its associated queries by selecting it in the data source manager and selecting Data View Queries
from the Update menu.

All of the queries associated with the view will be scanned and any inconsistencies in fields or field names will
be presented for you to update.
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Update Query Fields Dialog

For each query, you will be prompted to change any fields that no longer match the data view structure. For each
field, you can select a field from the data view to map it to, or remove the field from the query. If you do not want
to change anything in the query, you can click the Skip button. The query will continue to run, but it will refer to
the old data view structure. Click the Apply button to save the changes to the data view query.

3.1.3.4. Editing Queries
If you have selected to build a report using database data either by designing a query in the Query Builder, writing an
SQL statement, or running a data view, you can modify the query directly from the ChartDesigner without having
to go back to the Data Source Manager.

To modify a report or chart's query, select Modify Query from the Data menu in ChartDesigner. If you have designed
a query in the Query Builder, then the Query Builder interface will re-open allowing you to modify the query. If
you have entered an SQL statement, a text box will open allowing you to modify the SQL. If you have used a data
view, the data view conditions window will re-open allowing you to change the filters or pick additional fields.

Once you specify all the changes, you will be given an option to modify the query in the data registry, save a new
query in the data registry, or modify only the query in the template.

Saving Query Options

Once you specify the save options, the modified query will be applied to the report or chart. Note that if you made
significant changes to the query, you may need to perform the data mapping again.

3.1.3.5. Editing Database Connections
If you have selected to build a report or chart using database data, you can also directly edit a template's database
connection information from within the Chart Designer. To modify the connection information in the chart, select
Modify Database from the Data menu. This will bring up a dialog allowing you to specify a different setting for
the chart to use when connecting to the database or JNDI data source.
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Change Database Connection Dialog

In addition to manually entering the database information, you can retrieve the database connection information
from a data registry. To do this, click the Select button on the Database Connection dialog. This will allow you to
browse to XML registry file from which you want to pull the database connection. When you select a registry file,
you will be presented with a list of databases defined in the registry.

Select Database from Registry

Select the database that you want to use and click the Ok button. The connection information for that database will
be automatically applied to the connection dialog. After you set the connection information for the template, click
the Ok button to apply the changes. A dialog will open asking you if you would like to verify the new connection
information.

Verify Connection Dialog

Unless you know that data source isn't present, it's generally a good idea to check that the supplied connection
information is correct.

Unlike the modify query feature, changes to a template's database connection will only saved be to the template.
It will not be saved to the data registry.

3.1.3.6. Troubleshooting Database Connections
If you're having difficulty connecting to your database via JDBC, EDAB provides a small utility you can use to help
troubleshoot the problem. To launch the utility, point your Web browser to http://machinename:port/
EDAB/TestConnection.jsp. This page opens a small form that allows you to enter database connection
information as well as sample query.

The utility will directly contact the database (outside of any EDAB components) and execute the query, if provided.
Any connection/query errors and suggested fixes will be printed on the page.
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3.1.4. Data from XML and XBRL Files
In addition to relational databases, EDAB allows you to retrieve data and query XML files. XML data can be in
virtually any format, but you need to specify a DTD file or an XML Schema (XSD) along with the XML data. To
set up an XML data source, select XMLFiles node in the Data Source Manager and click the Add button. A dialog
will open prompting you to specify options for the new XML source.

Setup XML Data Source Dialog

The first option allows you to specify a display name for the XML data source. The second option allows you to
specify the location of the XML file from which you want to retrieve data. Note that you can also specify an XBRL
file in this field. You can set up a data source that retrieves XML data from an HTTP server here as well, by adding
the appropriate URL as the file location. The third option allows you to specify the location of a valid DTD or
XML schema file for the XML file.

The Quadbase Format checkbox allows you to indicate whether the XML file is in the form of an XML export
from EDAB. For example, if you choose to export a report's data in XML format, you can read it back in using this
format. When you use a file in this format, you do not have to specify a DTD or XML Schema.

The Verify XML against DTD/XML Schema checkbox will make sure that the supplied XML file/source complies
with the layout specified in the DTD or XML schema file. Because queries are designed based on the structure of
the DTD/XML Schema file, a non-conforming XML source could produce unexpected results. If the XML does
not conform to the DTD or XML schema, you will be given a warning. You can, however, continue setting up
the data source.

The Refresh Schema checkbox will only appear if you choose to edit an existing XML data source. Checking this
option will reload the schema or DTD definition to incorporate any changes to the structure in the XML data source
in the registry. This option is only necessary if the DTD or schema definition has changed since the data source
was first created.

Once you finish setting up the XML file and the DTD/XML Schema, a new dialog will open allowing you to specify
the data type for all the selectable elements in the XML data source. The dialog will be different depending on
whether you are using a DTD file or XML Schema.

DTD Data Type Selection Dialog
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Because DTD files do not specify a correct data type for elements, all elements are considered to be Strings by
default. To change the data type of an element, you have to select the element and pick a data type from the drop-
down window at the bottom of the dialog. To ensure proper results when you query the XML file, you should
set the data type for all selectable elements. This includes leaf nodes, parent nodes that contain data, and attribute
elements. The following data types are supported:

• String

• Integer

• Double

• Date (If you specify date as the data type, you will also be required to specify the date format.)

• Boolean

Once you finish specifying the data types, click the OK button and the XML source will be added to the Data
Source Manager.

If you're using an XML schema, a different data types dialog will open.

XML Schema Data Type Selection Dialog

Generally, the data types should already be defined in the XML schema file, but you can make any changes in this
dialog. Once you finish specifying the data types, click the OK button and the XML source will be added to the
Data Source Manager.

3.1.4.1. XMLQueries
Once you set up an XML data source, you can then create queries to select nodes, specify filtering conditions, and
transform the tree structure into the tabular form used by EDAB. To add a query, select the node for your XML
source and click the Add button. This will launch the XML query builder interface that allows you to construct
a query.
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XML Query Field Selection Tab

The first tab in the XML query builder allows you to select the fields/nodes from the XML file that you would like
to use. The left side of the window contains the tree structure from the DTD or XML schema file. You can pick
any selectable elements and add them to the query by clicking the Add button. Selected fields will appear in the
right side of the window. You can specify an alias for any field by double clicking the Alias field for a column
and typing the new column alias.

Note
Each selected element will become a column in the report or chart data. For results where a one-to-
one relationship cannot be determined, the tabular structure is built using all available permutations
in the data (similar to a cross-join in SQL). For best results, it is recommended that you select fields
for a query where a clear hierarchical relationship is present.

The Conditions tab of the XML query builder allows you to specify some basic filtering criteria for your selection.
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XML Query Conditions Tab

You can specify an equal, not equal, greater than, less than, less or equal to, or greater or equal to condition for any
selectable element in the XML file. You can also use the AND and OR operators to build compound conditions.
Fields are specified using a direct path down the XML tree. Currently, only direct path is supported. You cannot
use more complex XPath expressions. To add a field, you can double click on it in the left side, or you can select
it and click the Insert button.

After you finish writing the conditions, click the Test button to verify that the syntax is correct.

The DataSheet tab allows you to preview the query result and see how the XML data is converted to tabular form.
You can navigate through the result set the same way as in Query Builder (Section 3.1.3.2.1.5 - Adding Extra SQL).

Once you select the fields and specify the appropriate conditions, click the OK button. The query will then be added
as a new node under your XML source in the Data Source Manager and can now be used to create a report or chart.

There is a sample XML file with DTD and XML schema descriptions included in the EDAB installation. The files
are located in help/examples/DataSources/XML directory of your installation and are called Invento-
ry.xml, Inventory.dtd and Inventory_XSD.xml, Inventory.xsd for the XML schema example.
There is also a sample servlet that allows you to stream XML data to the Chart Designer. The servlet code and
instructions are located in help/examples/DataSources/XML/servlet directory.

3.1.4.1.1. XML Parameters
As with database queries, you can also specify parameters for XML queries. The same syntax “:” is used to denote
a parameter in the XML condition as it is in a query condition. So the following XML condition:

/Inventory/Category/@CategoryName = :category
                

would place a dynamic filter on the query for the CategoryName attribute. XML parameters are initialized in the
same way as query parameters. The initialization dialog will appear if you try to preview or close the query, or
you can trigger it by clicking the Initialize Parameters button. The only difference is that instead of mapping to a
database field, the parameter prompt can be mapped to a node in the XML file.
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XML Parameter Initialization Dialog

3.1.5. Data from Text Files
EDAB also allows you to retrieve data from flat text files. To add a text file as a data source, select the TXTFiles
node in the Data Source Manager and click the Add button. A dialog will open prompting you to specify a display
name and the location of the text file you want to use.

Add Text Data Source Dialog

Tip
The text file can be also retrieved from URL. To do so, enter the URL to the File text field. You have
to enter a full URL with protocol etc. (e.g. http://www.quadbase.com/textfile.txt).

After you specify the information, click the OK button and the text source will appear under the TXTFiles node
of the Data Source Manager window.

3.1.5.1. Formatting Requirements for Text Files
There are certain formatting requirements for the data within a text file in order make it readable by EDAB. Gen-
erally, data is expected to be in a form similar to the following:

String,date,decimal
Name,day,Volume
"John","1997-10-3",32.3
"John","1997-4-3",20.2
"Mary","1997-9-3",10.2
"Mary","1997-10-04",18.6
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The above data file is a plain text file. The first row specifies the data types and the second row specifies the field
names. The third row and so on are the records. Every text file must consist of these three parts. There are four
records, with three fields each in the example data file. The delimiter between the fields may be one of the following
characters: ",", ";", or " " (that is comma, semi-colon, or space). Each field can be put in quotes (single or
double).

3.1.5.2. Data Types and Format for Text Files
In text data files, the data type is specified using a keyword. The following is a list of recognized keywords and
their corresponding JDBC type and Java type.

Data File Keywords
(Not Case Sensitive)

JDBC Type Java Type in EDAB

Boolean, logical, bit BIT Boolean

tinyint TINYINT byte

smallint, short SMALLINT short

int, integer INTEGER int

long, bigint BIGINT long

float FLOAT double

real REAL float

double DOUBLE double

numeric NUMERIC java.math.BigDecimal

decimal DECIMAL java.math.BigDecimal

date DATE java.sql.Date

time TIME java.sql.Time

timestamp TIMESTAMP java.sql.Timestamp

string CHAR String

varchar VARCHAR String

longvarchar LONGVARCHAR String

For certain data types, the data in a text file must be presented in a specific format. The following is a list of the
data types that require specific formatting:

Data Type Format Example

Date yyyy-mm-dd
or yyyy-mm

2001-06-12 or 2000-06

Time hh:mm:ss 12:17:34

Timestamp yyyy-mm-dd hh:mm:ss 2001-06-12 12:17:34

Boolean true/false, t/f, 1/0
(case insensitive)

true

There is a sample text file included in the EDAB installation. The file is located in help/examples/Data-
Sources/text directory of your installation and is called Sample.dat.

3.1.6. Data from Class Files
For maximum flexibility, EDAB allows you to design reports and charts using object or array data by providing an
interface to pass data to the Chart Designer as an argument. Using the API, you can implement IDataSource to
return an IResultSet object similar to the java.sql.ResultSet interface used for JDBC result sets. Users
can provide their own implementation of IResultSet or use one provided by EDAB.

For more information about this feature, please see Section 8.5 - Class File Data Source.
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To add a class file as a data source, select the ClassFiles node in the Data Source Manager and click the Add button.
A dialog will open prompting you to specify a display name and the location of the class file you want to use.

Add Class File Dialog

There is sample code available in help/examples/DataSources/classes directory of the installation.
The complied code will generate a class file that passes the data array into Chart Designer. Note that in order to
use a class file as a data source, you must have the file or directory containing the package in the classpath of your
application server/servlet runner.

Here is a simple guide to use SampleData.class file available as datasource in EDAB Data Registry:

The most simple solution is to copy SampleData.class file from <EDAB install dir>/help/
examples/DataSources/classes into <EDAB install dir>/WEB-INF/classes/help/
examples/DataSources/classes directory (you will have to create help/examples/Data-
Sources/classes under <EDAB install dir>/WEB-INF/classes/ before copying the file).

Note
You can also change the app server CLASSPATH to include <EDAB install dir> instead. (Note
that in Tomcat, you have to include all the jars, as setting the CLASSPATH in Tomcat will not pick
up the jars under EDAB/WEB-INF/lib.)

Start or restart your Tomcat server and open EDAB Organizer - DataRegistry

Select ClassFiles and add the new classfile by filling in the dialog (as showed in the picture above):

Name: SampleData

File: help.examples.DataSources.classes.SampleData

Now you can view your ClassFile data and use it as datasource for reports and charts.

3.1.6.1. Parameterized Class Files
EDAB provides an additional API interface, IParameterizedDataSource, that allows you to define report/chart pa-
rameters within the context of a class file data source.

Parameters that are defined within the context of a class file work in the same way as query parameters. For more
information about setting up a parameterized class file data source, please see Section 8.5.2 - Parameterized.

3.1.7. Data from EJBs
Using Enterprise JavaBeans™ technology, developers can simplify the development of large enterprise applica-
tions. With EJB technologies, developers can rely on building business logic and allow the application server (EJB
container) to manage all system level services.

When working in the Java EE™ environment, persistent data interfaces are provided by entity beans. Although
the underlying storage mechanism might be a relational database, the application data model is the EJB and it may
not be desirable to have a reporting tool making redundant database connections. For this situation, EDAB allows
users to query data directly from an entity bean.

To add an EJB as a data source, the EJB must first be deployed in the application server and the client JAR file
containing the appropriate stub classes must be added to your application server/servlet runner's classpath. Select
the EJBs node in the Data Source Manager and click the Add button. This will bring up a dialog allowing you to
specify a display name and the connection information for the bean.
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Add EJB Dialog

To connect to an EJB data source, you must provide the JNDI lookup name for the bean (this is specified when
you deploy the bean). For EJB 1.1 users, specify the name for the home interface and the remote interface. For EJB
2.0 users, specify the local home interface and the local interface. Once you specify all the information, click the
Import button, which will analyze the home interface and retrieve all of the finder methods. Any methods found
will be populated in the List of Methods section in the dialog.

The same dialog can be used to filter the data being retrieved based on parameters that are present in the finder
methods. When you select a method in the left dialog, any parameters present will appear in the Parameter List
section. You can then click on a parameter to set its value.

Specifying EJB Parameter Values Dialog

When you select a parameter, the data type of the parameter will appear in the lower portion of the window. Below
that you will be able to specify a value for the parameter. Be sure to enter a correct value for the data type, and then
click the Set Value button. This will fix the parameter values. Once you finish setting up all parameter values, click
the Environment button. This will bring up a new dialog allowing you to specify environment properties for your
application server. This information is necessary for the EDAB Server to connect to the EJB.



Data Sources

213

EJB Environment Setup

The fields here are the available environment properties for the JNDI context interface. You don't have to specify
all values, only the information necessary for your environment (application server). Once you finish specifying
the environment variables, click the OK button. You will be returned to the EJB setup window. Click OK again to
finish setting up the EJB data source. A new node will appear under EJBs with your EJB.

You can modify the parameter values by selecting your EJB source, and clicking the Edit button.

There is a sample EJB data source included in the installation in help/examples/DataSources/EJB direc-
tory. The directory contains sales.ear and salesClient.jar files, as well as the source code for the Sales
entity bean. The sales.ear file is designed to be deployed in Java 2 Reference Implementation and uses the
Cloudscape database as the underlying storage mechanism. You can use SalesClient.java program to pop-
ulate the Cloudscape database. The salesClient.jar file contains the stub classes to connect to the deployed
Sales EJB and needs to be in the classpath.

3.1.8. Data from SOAP with WSDL support
EDAB also allows you to retrieve data using SOAP (Service Oriented Architecture Protocol). To connect to a SOAP
data source using WSDL, you don't need to know any URLs for the services, SOAP actions, operation names or
parameters. All you need to know is a location of WSDL file, which contains all the necessary information.

To set up a SOAP data source, select the SOAPServices node in the Data Source Manager and click the Add button.
A dialog will open prompting you to specify options for the new SOAP data source.

SOAP data source setup

The first option allows you to specify a display name for the data source. The second option allows you to specify
a location of the WSDL file. The location can be either absolute path on the server or path relative to your EDAB
installation directory or URL. Once you specify the connection information, you can test the connection to the
WSDL file by clicking the Test button. This will test retrieving the WSDL file from the URI you've provided, check
the file for any supported SOAP operations and report any problems. After clicking OK, a new SOAP data source
node will be added to the data registry.



Data Sources

214

To add a new SOAP View, select an existing SOAP data source and click the Add button. A dialog will open
prompting you for all the parameters necessary to make a SOAP query.

Setup SOAP View dialog

The first option in the dialog allows you to specify a display name in the Data Source Manager. Next, there are
three drop-down menus in the dialog. The first drop-down menu contains all the SOAP services described in the
WSDL file. Once you specify a service, the second drop-down list will be populated with all the ports of this service.
Selecting a port will populate the last drop-down list with all the operations of this port. If you move the mouse over
any drop-down list, a hint will appear with documentation for the service/port/operation (if the documentation is
provided in the WSDL file). After specifying the service, port and operation, all the parameters of the operation will
be read. If there are some parameters, they will be displayed in a table. The first two columns of the table are not
editable. They are read from the WSDL file. The next 2 columns are editable and allow you to specify parameter
prompts and default values. The last column contains a checkbox which allows you to choose whether the default
parameter value will always be used or not. This means that this parameter value will be fixed and you will not be
prompted for it. All the parameters that don’t have this checkbox checked will be used as report/chart parameters.

The Setup Data Types button is only available when editing the SOAP View from the Data Source Manager and
allows you to adjust data types when necessary. In order to verify result from the SOAP response, click the Preview
Result button. All the default values will then be tested to see if they have proper data type or not. In case they do not
match, you will be prompted to adjust them. After that, you will get the setup data types dialog (the same as for XML
data source). If the data source is parameterized, you will get the parameter prompt dialog before specifying data
types. Please note that in order to generate the XML schema properly, you have to specify existing parameter values.

Setup XML Schema Data Types dialog
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You can setup data types from this dialog. The behavior is exactly the same as for XML data source with DTD
schema (see Section 3.1.4 - Data from XML and XBRL Files). Once you finis specifying data types, click the OK
button. A dialog will open showing you the result preview.

Query Result Preview dialog

Clicking the OK button in this dialog will take you back to the Setup SOAP View dialog. Once you finish specifying
all necessary information, click the OK button in the dialog. A new node will be added under your SOAP data
source in the Data Source Manager and can now be used to create a report or chart.

3.1.9. Data from Salesforce
The Salesforce data source is designed for existing Salesforce users who want to display their Salesforce data in
EDAB. The connection to the Salesforce server is established via SOAP using Salesforce Partner WSDL (version
13.0). Users communicate with Salesforce server by SOQL (Salesforce Object Query Language) queries. Please
note that users must have valid Salesforce accounts with username and password to work with this data source.
Moreover, users who use the EDAB Salesforce data source must have access to Salesforce account from trusted
networks. To add your IP address to the trusted IP list, you have to activate your computer as described below.

For more information about SOQL queries and activating Salesforce user's accounts from trusted networks, please
visit the following Salesforce sites:

SOQL queries

https://developer.salesforce.com/docs/atlas.en-us.soql_sosl.meta/soql_sosl/sforce_api_calls_soql_sosl_intro.htm

Activating Salesforce user's accounts

https://help.salesforce.com/s/articleView?id=sf.security_networkaccess.htm

To set up a Salesforce data source, select the SalesForce node in the Data Source Manager and click the Add button.
A dialog will open prompting you to specify a display name for the data source, user name and password to your
Salesforce account. Once you specify the connection information, you can test the connection to your Salesforce
account by clicking the Test Connection button. This will test the connection using the information you've provided
and report any problems.

Setup SalesForce Data Source Dialog

Once you add a Salesforce data source, a new node will appear in the Data Source Manager window. To add a
new Salesforce query, click the Add button. A new dialog will open prompting you to specify a query name and
SOQL query.

https://developer.salesforce.com/docs/atlas.en-us.soql_sosl.meta/soql_sosl/sforce_api_calls_soql_sosl_intro.htm
https://help.salesforce.com/s/articleView?id=sf.security_networkaccess.htm
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Setup SalesForce Query Dialog

Please note that only child-to-parent relationship queries are supported in the current EDAB version. You cannot use
parent-to-child queries (using nested SOQL queries). For more information about Salesforce relationship queries
and their syntaxes, please visit the following Salesforce site: https://developer.salesforce.com/docs/atlas.en-us.so-
ql_sosl.meta/soql_sosl/sforce_api_calls_soql_relationships.htm

Moreover, this dialog allows you to initialize query parameters in case that your query contains single value or
multi value parameters. A parameter is specified within an SOQL statement using the ":" character. Generally the
parameter is placed in WHERE clause of an SOQL Select statement. For example, the following SOQL statement

Select Name, Type, Status, ActualCost From Campaign Where Name
 = :CampaignName
        

specifies a single value parameter called CampaignName. You would then be able to enter a campaign name at
run-time and only retrieve data for that campaign.

Another example of SOQL statement shows using of multi value parameters that take an array of values as the
input rather than single values.

Select Name, Description, Type, LeadSource, Probability From Opportunity
 Where Type IN (:OpportunityType) And LeadSource IN (:OppLeadSource)
        

The statement specifies two multi value parameters called OpportunityType and OppLeadSource. You would then
be able to specify opportunity types and lead sources at run-time and you will only retrieve data according to
specified parameters values.

In order to initialize SOQL query parameters, click the Initialize Parameters button. The initialize parameters dialog
will then appear allowing you to specify parameters mapping.

https://developer.salesforce.com/docs/atlas.en-us.soql_sosl.meta/soql_sosl/sforce_api_calls_soql_relationships.htm
https://developer.salesforce.com/docs/atlas.en-us.soql_sosl.meta/soql_sosl/sforce_api_calls_soql_relationships.htm
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Initialize Parameters Dialog

From this dialog, you can specify the following options:

Map to field: This allows you to specify a field from the Salesforce data source whose
values will be used for the parameter input. Selecting this option modifies
the parameter prompt that you will get when previewing or running the re-
port/chart. If you map the parameter to a Salesforce field, you will be prompt-
ed with a drop-down list of distinct values from which you can select a pa-
rameter value. If you do not map, you will have to type in specific parameter
value.

Use custom selection choices: Rather than having a drop-down menu with all the distinct column values,
you can build a custom list of parameter values. To set up the list, select this
option and click the Setup Choices button. This will launch a new dialog
allowing you to create a list of choices.

The rest of the options are basically same as for database query parameters. For further information about initializing
database query parameters, see Section 3.1.3.2.2.2 - Initializing Query Parameters. Once you specify mapping for
all available parameters, click the OK button and you will be taken back to the Setup Salesforce Query dialog.

From the Setup SalesForce Query dialog, you can also preview the query result using the Preview Result button to
verify output from your query. In case you have a parameterized query, the parameter prompt dialog will appear
prompting you to specify parameter values. Once you specify the parameter values, click the OK button and the
query result preview dialog will appear.
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Parameter Prompt

Query Result Preview Dialog

From this dialog, you can verify the query output. Clicking the OK button will take you back to the Setup SalesForce
Query Dialog.

Once you specify the query, click the OK button. The query will then be added as a new node under your Salesforce
data source in the Data Source Manager and can now be used to create a report or chart.

3.1.10. Data from Excel files
EDAB also allows you to design reports and charts using data retrieved from Excel files. To add an Excel file as
a data source, select the ExcelFiles node in the Data Source Manager and click the Add button. A dialog will open
prompting you to specify the data source name and to select the Excel file from which the data should be imported.
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Setup Excel Data Source dialog - Data

After selecting the Excel file, the imported data will be previewed in the dialog. If the checkbox Use Relative Path is
checked, the file path to the selected Excel file will be set as relative to the EDAB installation directory. Otherwise
the full path will be used. In case the Excel file is stored on a different disk drive from the one which EDAB is
installed on, this option is not available. You can select the sheet (if there is more than one in the file) and the cells
which are relevant for the data source being designed using your mouse or by specifying the range in the Range
box (for instance, you can specify that your source will use the data from the columns A and B and from the rows
2 to 12 by typing A2:B12 in the Range box; this is the format which is also used for ranges in MS Excel). You
can also select the data by clicking the row header or the column header. Hold Ctrl or Shift to select more rows or
columns. Click the top left corner to select all cells. Again, this behavior is similar to MS Excel.

Please note that EDAB can process both *.xls files and *.xlsx files. The *.xlsx files are used in Microsoft
Excel 2007 and newer and they are based on Open XML.

EDAB can also process basic Excel formulas. If it is not able to process the entered formula, an error message
will be displayed.

Empty rows (in case the data are in columns) or columns (in case the data are in rows) at the end of the sheet are
automatically removed from the data source, even in case they have been selected.

Click on the Options tab to specify whether the data are in columns or in rows to get the data structure correctly.
You can also specify whether table headers are included in your data selection. The option Include additional rows
or Include additional columns (depending on whether the data are in columns or rows) allows you to automatically
include data rows or columns into the Excel file after the data source has been created without the need to change
the data source in the Data Source Manager manually.

The bottom part of the dialog on the Options tab shows you the data source content following the current configu-
ration. You can change the data type for each column of the data source there, if desired. The data types are detected
automatically, therefore changing the type should not be necessary in most cases.
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Setup Excel Data Source dialog - Options

Click OK to save the data source when the configuration is finished.

3.1.11. Using Data for Charts
Once you set up a data registry, the sources defined in the registry can be used for charts, in the QuickDesigner for
reports and charts, and in the Map Builder for maps. The first time you select to start a new ChartDesigner chart,
you will be prompted to select a registry you want to use. If there are currently no available registries (meaning
that you haven’t created any, or you don’t have privileges to view any), you will be prompted to go to the data
registry manager to create one.

Once you select a registry, a data source manager window will open allowing you to select, add, or modify a data
source that you want to use for the chart or report.

Data Source Manager Window for Chart Designer

After you first select a registry, the next time you design a chart, it will automatically connect to that registry and
open the data source manager. You can change registries by clicking the Change Data button.
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3.1.11.1. Using Multiple Data Sources
Once you select the data source you want to use for a chart and click the Next button, the next screen will display
first twenty records from the data source (With the exception of data views, which will require you to select fields
and set conditions first). You can display all of the records by checking the Show All Records box.

EDAB allows you to construct charts from multiple data sources. Once you have selected your first source, and
click Next from the data table window, you will be presented with a dialog asking if you would like to process the
current data or select another data source.

Additional Data Source Dialog

If you select Process Data and click the Next button, you will continue to the next step in the chart wizard. If you
select Get Other Data Source, you will return to the Data Source Manager to select another data source for the
chart. You can repeat this process to select as many sources as you want.

Multiple data sources are combined sideways in the data table. This means that the columns from the second (or
third, fourth, etc.) data sources are placed to the right next to the columns from the first data source. If the columns
from one data source have more rows than the other ones, null values will be placed in extra rows.

For example, assuming you want to use two data sources to create a chart. The data table generated by the first
source will look like this:

Data From the First Data Source

The data from the second source will look like this:
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Data From the Second Data Source

When you combine two data sources, you will get the following data table:

Data From Combined Sources

As you can see, the two data sources have been placed side by side. Since the second source has more rows of data
than the first, additional rows of null data were added.

Note
You cannot use parameterized data sources to create a multiple data source.

3.1.11.2. Change Data Source
At any point during chart design, you can select to change the template’s data source. Since chart templates are saved
with their data source information, you must use the option within Chart Designer to change the template's data
source. Simply altering a data source in the registry will not affect the template unless you use the data source up-
dating feature (For more information about this, see Section 3.1.11 - Using Data for Charts). To change a template’s
data source, select Modify Data Source from the Data menu, or click the Modify Data Source button on the toolbar.
This will bring up the Data Source Manager allowing you to select a new data source or modify an existing one.

If the new data source is significantly different from the previous data source in number of columns or data types,
you might need to re-map the data to the chart. For more information about data mapping, please see Section 4.1.3
- Chart Types and Data Mapping for charts.
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3.1.12. Data Source Updating
There are many circumstances where you will want to move a group of templates or a complete installation of
EDAB from one location to another. For example an application can move from a development to a production
environment. In each environment, the location and connection information for data sources may be different. In
this scenario, updating report templates one by one as detailed in the previous section isn't a feasible way to change
the connection information for a large number of templates. Instead, EDAB allows you to quickly update a group
of templates based on information in the data registry.

Although chart templates maintain an internal copy of the data source information (allowing them to be deployed
independently), they also maintain information (location and source) about the data registry from which they were
created. Hence, when you modify a chart's query (as detailed in Section 3.1.3.4 - Editing Queries), you have the
option to save the changes back to the data registry. In order to use this feature, you will have to keep your data
registry up to date. This means that query changes should be saved back to the registry and changes in data view
structure should be propagated to data view queries.

To use this feature, first make any modifications to the data registry that you want to propagate to the templates.
These modifications can include database connection information, file locations for text, XML data files, and even
changes to data views or queries that you want to pass to the templates.

Note that if you're moving reports or charts between installations, the data registry file will need to be moved to the
same relative location in the new installation. In addition, the associated query files for that registry (.qry/.d-
vw/.ddt) will need to be moved to /queries/ directory of the new installation (Query file names begin with
the name of the registry).

From the data source manager, select Reports or Charts from the Update menu depending on whether you want to
update charts or reports. This will bring up a dialog allowing you to select which files you want to update.
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Select Reports for Data Source Updating

To select files to update, first browse to the directory that contains the reports/charts. After you select a directory,
any chart templates will appear in the left side of the dialog You can select any templates you want to update and
click the Add button. You can navigate to as many different directories as you want to select templates. Selecting
the Connection Info Only option will only update the connection information (database URL, driver, username,
password, and locations for XML files, text files and Java classes). Queries and data view information will not be
updated in the templates.

Once you finish selecting the templates you want to update, click OK and the updating process will begin. A dialog
will display the current progress and any errors.

Updating Data Sources Progress/Log Dialog

A log file named UpdateDataSources will also be written in the root directory of the installation with the
contents of the progress screen. Reports that fail the updating for various reasons can be updated manually using
the option in ChartDesigner.
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Note
Only reports or charts for the current data registry will be modified. If you select templates that do
not retrieve their data from a source in the current registry, they will be ignored.

3.1.13. CData JDBC drivers
If you want to connect to a data source driver that doesn’t ship with EspressDashboard, CData JDBC drivers are
an interesting option.

CData JDBC drivers can be also used to increase capabilities of non-database data sources like Excel or JSON.

Tip
Although CData JDBC drivers are a 3rd party commercial product, you can install a free trial version
to test the product before purchasing.

Note
CData JDBC drivers are a 3rd party product. If you want to use the drivers, you have to purchase
them at https://www.cdata.com

3.1.13.1. Supported CData Drivers
Currently, we support the following CData JDBC drivers:

• Salesforce

• BigQuery

• Excel

• JSON

• MongoDB

• Kintone

Other CData JDBC drivers might work too but we can not guarantee full functionality for unsupported drivers. If
you require a connection to a driver that is not listed here, please contact us at <support@quadbase.com>

https://www.cdata.com
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3.1.13.1.1. Excel
Download: https://www.cdata.com/drivers/excel/jdbc

Official CData Documentation (for the JDBC driver only): https://cdn.cdata.com/help/RXF/jdbc

After downloading the driver, see the following chapters: Section 3.1.13.2 - CData JDBC driver installation, Sec-
tion 3.1.13.3 - Deploying the CData JDBC Driver in EspressDashboard and Section 3.1.13.4 - Using the CData
JDBC drivers in DataSource Manager

The CData Excel driver allows you to run SQL queries on top of an Excel file just like it was a database. This
allows you to use the QueryBuilder, build Data Views in a graphical user interface as well as write SQL queries
manually (in Query Builder).

Tip
You can also write queries with parameters and multi-value parameters using Excel files as the data
source.

Since Excel does not have data types set for columns as a normal database has, determining the data type for the
columns can be a bit tricky at times.By default, we added the following parameters to the CData Excel driver
connection URL:

TypeDetectionScheme=RowScan;
RowScanDepth=10;
     

This makes the CData Excel driver scan the first ten rows when loading the selected Excel file and detect the data
source for each column automatically based on the data in the first ten rows.

However, there are multiple options of how to determine the data type for each column.

For more options, read the CData JDBC Excel driver documentation about the TypeDetectionScheme parameter:
https://cdn.cdata.com/help/RXH/jdbc/RSBExcel_p_TypeDetectionScheme.htm

You can change the TypeDetectionScheme value in the Setup Database… dialog in Data Source Manager in the
URL field (the field where you entered the Excel file path).

3.1.13.1.2. JSON
Download: https://www.cdata.com/drivers/json/jdbc

Official CData Documentation (for the JDBC driver only): https://cdn.cdata.com/help/DJF/jdbc

After downloading the driver, see the following chapters: Section 3.1.13.2 - CData JDBC driver installation, Sec-
tion 3.1.13.3 - Deploying the CData JDBC Driver in EspressDashboard and Section 3.1.13.4 - Using the CData
JDBC drivers in DataSource Manager

The CData json driver allows you to run SQL queries on top of a json file just like it was a database. This allows
you to use the QueryBuilder, build Data Views in a graphical user interface as well as write SQL queries manually
(in Query Builder).

Tip
You can also write queries with parameters and multi-value parameters using JSON files as the data
source.

3.1.13.1.3. Salesforce
To connect to Salesforce:

Download: https://www.cdata.com/drivers/salesforce/jdbc

Official CData Documentation (for the JDBC driver only): https://cdn.cdata.com/help/RFF/jdbc

After downloading the driver, see the following chapters: Section 3.1.13.2 - CData JDBC driver installation, Sec-
tion 3.1.13.3 - Deploying the CData JDBC Driver in EspressDashboard and Section 3.1.13.4 - Using the CData
JDBC drivers in DataSource Manager

https://www.cdata.com/drivers/excel/jdbc
https://cdn.cdata.com/help/RXF/jdbc
https://cdn.cdata.com/help/RXH/jdbc/RSBExcel_p_TypeDetectionScheme.htm
https://www.cdata.com/drivers/json/jdbc
https://cdn.cdata.com/help/DJF/jdbc
https://www.cdata.com/drivers/salesforce/jdbc
https://cdn.cdata.com/help/RFF/jdbc
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3.1.13.1.4. MongoDB
To connect to MongoDB:

Download: https://www.cdata.com/drivers/mongodb/jdbc

A bug fix was added to newer MongoDB driver from https://cdatabuilds.s3.amazonaws.com/support/DGR-
JV_8598.exe

Official CData Documentation (for the JDBC driver only): https://cdn.cdata.com/help/DGF/jdbc

After downloading the driver, see the following chapters: Section 3.1.13.2 - CData JDBC driver installation, Sec-
tion 3.1.13.3 - Deploying the CData JDBC Driver in EspressDashboard and Section 3.1.13.4 - Using the CData
JDBC drivers in DataSource Manager

3.1.13.1.5. BigQuery
To connect to BigQuery:

Download: https://www.cdata.com/drivers/bigquery/jdbc

Official CData Documentation (for the JDBC driver only): https://cdn.cdata.com/help/DBF/jdbc

After downloading the driver, see the following chapters: Section 3.1.13.2 - CData JDBC driver installation, Sec-
tion 3.1.13.3 - Deploying the CData JDBC Driver in EspressDashboard and Section 3.1.13.4 - Using the CData
JDBC drivers in DataSource Manager

3.1.13.1.6. Kintone
To connect to Kintone:

Download: https://www.cdata.com/drivers/kintone/jdbc

Official CData Documentation (for the JDBC driver only): https://cdn.cdata.com/help/DBF/jdbc

After downloading the driver, see the following chapters: Section 3.1.13.2 - CData JDBC driver installation, Sec-
tion 3.1.13.3 - Deploying the CData JDBC Driver in EspressDashboard and Section 3.1.13.4 - Using the CData
JDBC drivers in DataSource Manager

3.1.13.2. CData JDBC driver installation
The installation process of all CData JDBC drivers is basically the same for all the supported data sources. We’ll
guide you through the process of installing the CData Excel JDBC driver for example.

First, install the CData JDBC Driver of your choice. You will find the links to each supported CData JDBC driver
in the chapters below.

After downloading the installer, proceed with the setup according to the dialogs.

In the following dialog, you can choose to either install a paid version of the product or a free 30-day trial version.
In this example, we’ll use the trial version.

When the setup is complete, JDBC Driver will be created in "CData JDBC Driver for Microsoft Excel 2022\lib".

https://www.cdata.com/drivers/mongodb/jdbc
https://cdatabuilds.s3.amazonaws.com/support/DGRJV_8598.exe
https://cdatabuilds.s3.amazonaws.com/support/DGRJV_8598.exe
https://cdn.cdata.com/help/DGF/jdbc
https://www.cdata.com/drivers/bigquery/jdbc
https://cdn.cdata.com/help/DBF/jdbc
https://www.cdata.com/drivers/kintone/jdbc
https://cdn.cdata.com/help/DBF/jdbc
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Tip
Executing "cdata.jdbc.excel.jar" will launch the connection test tool. You can use this tool to test or
troubleshoot the CData driver.

Tip
The connection test tool also displays you the connection URL that can be used in EspressDashboard
Data Source Manager.

3.1.13.3. Deploying the CData JDBC Driver in EspressDashboard
Locate the "CData Installation Directory"\CData JDBC Driver for Microsoft Excel 2023\lib (for example: C:\Pro-
gram Files\CData\CData JDBC Driver for Microsoft Excel 2023\lib) on your hard drive.The directory should con-
tain three files: cdata.jdbc.excel.jar, cdata.jdbc.excel.lic, cdata.jdbc.excel.remoting
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Copy the three files to EDAB/WEB-INF/

After you've copied the files, restart The EspressManager (if it is running).

3.1.13.4. Using the CData JDBC drivers in DataSource Manager
Launch the DataSource Manager and open a data registry in it (existing one or a new one).

Select the “Databases” option in the tree-list and press the “ADD” Button.

In the “Driver List:” drop-down menu, select “CData Excel” (or any other CData JDBC driver you might be
installing).
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In the “URL:” text field, replace the placeholders (like "EXCEL FILE LOCATION") with real values.

Tip
Alternatively, you can replace the text in the “URL:” text field with the connection string obtained by
the CData Test Connection tool described in the previous chapter.

Click OK. You’re done. You can start using Excel files as if they were a database.

3.2. Data in QuickDesigners and Maps

3.2.1. Select a Data Source
QuickDesigner Reports, QuickDesigner Charts, Online Maps and SVG Maps use the same interface to manage data
- Data Source Dialog . The Data Source Dialog allows end users to select, filter, and present data without mastering
database structures, and all with zero client download. For full control of data sources, please see Section 3.1 -
Data in Organizer.

The Data Source Dialog prompts you to select the data registry and the data source that you would like to use.
A user must have read privileges to one of the registries defined in the Organizer. For more about creating and
managing data registries, please see Section 3.1.1 - Managing Data Registries.

Select the data registry from the drop-down menu in the upper part on the left. The pane bellow displays the content
of the selected registry. Select a data source you want to use.
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Data Source Dialog

Once a data source is selected, you can see records of the source in the right-hand side View DataSheet pane. If you
select a DataView as the data source, you will be able to create a new DataView query in the DataView Builder in
the right pane. You can also select an existing DataView query and modify it in the right pane.

3.2.2. Queries
Queries work in conjunction with Data Views. Data Views allow an administrator to pre-select tables and fields
from a database and create a local view from which end users can run queries. For more information about data
views and setup, please see Section 3.1.3.3 - Data Views.

If you select either a data view or a data view query as the data source, you will be taken to Data Source Dialog
query interface in the right-hand pane where you can create or modify a query based on the data view.

3.2.2.1. Select Fields
If you select a data view as the data source, the DataView Builder will open in the right pane allowing you to select
fields from the view for your query.
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Select Columns Dialog

A select list for each heading in the view is generated on the left-hand side of the DataView Builder. To select fields
for the query, click on a field on the left-hand side. The selected column will be added to the dialog on the right-
hand side. To remove fields, you can select the columns from the right-hand side and click the Remove button.

3.2.2.1.1. Build Columns
You can also create computed columns from the Choose Columns dialog. To create a computed column, click the
Build Formula button. This will launch the Formula Builder interface in a new window.

Formula Builder Window

The right-hand side of the Formula Builder contains a list of fields in the view, as well as the database functions.
The buttons at the bottom are available operators and conditionals. The Boolean and conditional operators are more
commonly used for building conditions which is covered in Section 3.2.2.2 - Set Conditions.

Once you have finished constructing the field, click OK to close the Formula Builder and return to the Choose
Columns window where the computed field is added to the Selected Columns list. You can edit the formula by
selecting it in the list and clicking the Modify Formula button.
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You can also create an alias for any expression column by selecting it and clicking the Rename button. This will
bring up a new window for you to specify the alias.

Rename Dialog

Once you have finished selecting the columns you would like to use, click the Next button to set conditions.

3.2.2.1.2. Querying Encrypted Data
Suppose you have a database that has encrypted fields, e.g. social security numbers, tax ID, passport numbers, etc
in a tax payer database or immigration database. How do you allow authorized users of your (EDAB) system to
make ad hoc reports or view reports online so that they can see the actual field values? The other concern is that
you do not want any users of your system to know the encryption/decryption key but you want them to be able
to see the decrypted data.

EDAB provides an advanced feature that allows you to run QuickDesigner Reports and Menu Page/report URL
with automatic decryption enabled.

To do this, you need to do two things:

1. You need to create an XML file that gives the database URL, database driver, name of column to be decrypted,
and the function to be applied when the data is being retrieved. An example file is as follows:

<?xml version="1.0"?>
<!DOCTYPE ReplaceColumnInfoList SYSTEM "QBReplaceColumnInfoList.dtd">
<ReplaceColumnInfoList>
      <ReplaceColumnInfo>
            <Driver>com.mysql.jdbc.Driver</Driver>
            <URL><![CDATA[jdbc:mysql://prodigy:3306/CAIT]]></URL>
            <TableName>user</TableName>
            <Pair>
                  <ColumnName>user.SSN</ColumnName>
                  <ReplaceValue><!
[CDATA[cast(AES_DECRYPT(user.SSN,'1111111111111111') as CHAR)]]></
ReplaceValue>
            </Pair>
      </ReplaceColumnInfo>
</ReplaceColumnInfoList>
                    

The DTD file used is shown below.

<?xml encoding="US-ASCII"?>
<!ELEMENT ReplaceColumnInfoList (ReplaceColumnInfo*)>
<!ELEMENT ReplaceColumnInfo (Driver, URL, TableName, Pair*)>
<!ELEMENT Pair (ColumnName, ReplaceValue)>
<!ELEMENT Driver (#PCDATA)>
<!ELEMENT URL (#PCDATA)>
<!ELEMENT TableName (#PCDATA)>
<!ELEMENT ColumnName (#PCDATA)>
<!ELEMENT ReplaceValue (#PCDATA)>
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In this example, we are using a MySQL database, the table name is user, the encrypted column is SSN. When a
query is run, the function AES_DECRYPT(user.SSN, '1111111111111111') will replace user.SSN
wherever it may appear in the SQL statement. The function AES_DECRYPT is the decryption function in
MySQL. The key for decrypting the data is '1111111111111111' in this example.

2. You need to set the path to the XML file in the Admin Console (Server Options tab, Security Options category
- see Section 1.4.1.3 - Server Options for more details) and then restart the EDAB server.

Once this is set up, when you run a report in Menu Page, using generated report URL or generating reports in
QuickDesigner Reports, you will be able to see the real (decrypted) values of the encrypted columns.

You can find the example XML and DTD files shown above under the <EDABInstallDir>/help/exam-
ples/DataDecryption/ directory. You will also find a script that you can use to generate some sample data
in MySQL.

When you run a report (in Menu Page, QuickDesigner Reports or with report URL) with the following query,

select user.firstName, user.lastName, user.SSN from user;
            

you will see the following result set:

firstName lastName SSN

John1 Smith1 1111

John2 Smith2 2222

John3 Smith3 3333

John11 Smith11 11111

This query below,

select user.firstName, user.lastName, user.SSN from user where SSN LIKE
 '1%';
            

should produce the following result in your report.

firstName lastName SSN

John1 Smith1 1111

John11 Smith11 11111

You can specify multiple fields in the xml file. To add another field from the same table, simply add another
<pair> element. To add a field from another table or datasource, add a full <ReplaceColumnInfo> element.
This feature also supports sub-reports and drill-downs. Any field in these components matching the information
in the xml will also be decrypted.

Note
If you are entering SQL for your query, you must use the full name for the field in order for this
feature to work. For example, SELECT user.SSN FROM user works, but SELECT SSN FROM
user will not.

3.2.2.2. Set Conditions
After selecting fields, or if you select a data view query as the data source, the conditions window opens allowing
you to set aggregation, grouping, and filtering for the selected columns.
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Conditions Dialog

Each selected column is listed along with several options:

Actions: Show Column Data: This will bring up a new window with column data.

Show Column Data

Condition Wizard: This will bring up a dialog allowing you to set basic conditions from a
field. The first dialog allows you to select whether you would like to enter values or select
them from a list.
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Condition Wizard

Once you have selected the condition, a new dialog opens allowing you to set the values
for the condition.

Condition Value Dialog

Select the values that you would like and click OK. The condition will automatically be
added to the Condition field.

Build Condition: This will bring back up the Formula Builder, allowing you to construct
an expression for the condition.

Condition: This allows you to type a condition for the column.

Sort: This allows you to indicate if the column should be sorted. You can select whether to sort in
ascending or descending order.

Sort Order: This allows you to specify the priority (order) for sorting columns.

Aggregation: This allows you to specify any grouping or aggregation in the query.

Show: This option indicates whether the column should be visible or not.

3.2.2.2.1. Parameterized Queries
Data Source Dialog also allows you to define query parameters. Parameters are defined in the same way as with
other query interfaces - using the ":" character. You can define parameters directly in the conditions field, using
the convention of :ParameterName to define a parameter.

Parameters can also be defined in the Formula Builder when building conditions. To define a parameter this way,

click the  Build Condition button to open the Formula Builder, click the Parameter button to insert a parameter.
This will bring up a new dialog allowing you to enter the parameter name.
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Specifying a Parameter in Formula Builder

For more information about query parameters, please see Section 3.1.3.2.2 - Parameterized Queries.

3.2.2.2.1.1. Initialize Query Parameters
Once you have specified parameters in the query, they will need to be initialized. You can initialize parameters
by clicking the Initialize Parameters button. The initialization dialog will also open if you preview the query by
clicking on the View DataSheet tab or if you click on the OK button closing Data Source Dialog.

Initialize Parameter Dialog

The drop-down list at the top of the dialog indicates which parameter is currently being initialized. You can access
and set the options for each parameter by selecting it from this list.

The following options are available for each parameter:

Map to database column: This allows you to specify a column from the database whose values will be
used for the parameter input. Selecting this option modifies the parameter
prompt that you will get when running the report or chart. If you map the
parameter to a database column, you will be prompted with a drop-down list
of distinct values from which to select a parameter value. If you do not map,
you will have to type in the specific parameter value.
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Initialize Parameter Dialog

Map to database function: Mapping a parameter to a database function is very similar to mapping to a
column. This feature allows you to map to the results of any function from
your database. For example, suppose you have the following condition in
your query:

Year({Orders.OrderDate}) IN (:OrderYear) 
                            

In the initialize parameter dialog, check the Map to database function box,
select the function from the list and enter the parameter value for your func-
tion. The default value and data type will be automatically updated

Initialize Parameter Dialog

For certain databases, you may notice that the functions available do not
specify the parameter types for functions. In this case, there will only be
one function parameter field and it will be longer than normal. Selecting a
column from the drop down list will be appended at the end of the field rather
than replacing the existing text. You must enter all parameter values for the
selected function, separating values with commas. Once you click away from
this field, the default value field will be filled with function results and the
data type will be automatically determined.

Default Value: This allows you to specify a default value for the parameter. Although you
do not have to specify a default value, it is recommended that you do so.
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 Date Variable:
This option is only available when the parameter is not mapped to a database
column or function, and is only intended for parameters with variable type
date/time. When you click this button, the following panel will pop up, listing
all the supported keywords.

Enter Date Variable Dialog

This dialog allows you to select one of the three keywords: CurrentDate,
CurrentTime, and CurrentDateTime. You may add or subtract units of time
from the current date/time, allowing you to have a dynamic date range. For
example, a report may have the following default values:

StartDate: CurrentDate - 1 WEEK
EndDate: CurrentDate
                        

This would indicate that every time the report is run, the default prompt
should be one week ago to the current date. Other supported measures are
YEAR, MONTH, DAY, HOUR, MINUTE, and SECOND. This feature only
supports a single addition or subtraction. This feature does not support mul-
ti-value parameters. Note: QuickDesigner Reports date values (in the right-
hand panel) correspond to the variable values entered here, not the keywords
themselves as in Report Designer.

You can also use functions to define the parameter value.

Data Type: This allows you to specify the data type for the parameter value(s). If you
have mapped the parameter to a column,the data type is set automatically.

Custom Date Format: This allows you to set the format in which the date parameter should be
entered. This option is only available when you have mapped the parameter
to a date/time column or when you not mapped the parameter at all and the
parameter data type is date, time, or timestamp. When you check
this option you can specify a date format by either using the builder interface
or by entering the date format in a combination of characters that represent
time elements.
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Date Format Dialog

If you click the Build button, the above dialog will appear. The date/time
representations are listed on the right and optional spacers and symbols are
shown as a collection of buttons on the bottom. Once you have finished cre-
ating the format, click OK to save.

The date and/or time format is a series of characters and delimiters. Letters
are used to represent different elements of date/time data. The characters and
what each represent are listed below:

Character Represents Out-
put (tex-

t/number)

Example

G era text AD

y year number 1996, 96

M month
in year

text or num-
ber (depends

on length)

July, Jul, 07

d day in
month

number 10

h hour am/
pm (1-12)

number 1

H hour 24
hr. (0-23)

number 18

m minute
in hour

number 30

s second in
minute

number 55

S millisecond number 978

E day in week text Tues-
day, Tue

D day in year number 189

F day of week
in month

number 2 (as in
2nd Wed.
in July)
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Character Represents Out-
put (tex-

t/number)

Example

w week in year number 27

W week in
month

number 2

a am/pm
marker

text AM, PM

k hour 24
hr (1-24)

number 24

K hour am/
pm (0-11)

number 0

z time zone text Pacific
Standard

Time, PST

You can piece together almost any combination of these characters to pro-
duce a date expression in the format that you would like. The count of groups
of characters determines the form that the element will take. For text ele-
ments 4 or more characters in a group will cause the full form of the element
to be used. If less than four characters are used the short form will be used if
one exists. For example, EEEE would return Monday and EE would return
Mon. For month M which can display as either text or a number, four or more
in a group will display the full version, three will display the abbreviation,
and two or less will display the number form.

For numeric elements, the count of characters is the minimum number of
digits that the element will take. Shorter numbers will implement leading
zeros. For example if the day of the date is 2, dd would return 02 and d
would return 2.

If the parameter is mapped to a column, once you have finished designing
the format, click on the update button to refresh the parameter prompt with
the new format.

Prompt Name: This allows you to specify the prompt that is given to the user in the para-
meter dialog.

Once you have finished setting values for all the parameters, click Ok to close the dialog and save the settings.

3.2.2.2.2. Save Queries
You can save the created query, or save the changes to the query if you selected a data view query to begin with
by clicking the Save Query option in the conditions window. This will bring up a dialog prompting you to specify
a name for the query.

Save Query Dialog

Once you have specified the name, click OK. The query will be saved in the data registry as a new node under
the data view.

3.2.2.2.3. Aggregation Alias
If you add aggregation and group bys to the query, you are also able to specify an alias for the aggregated field.
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Set Alias

Clicking on the underlined option next to the column name will pop up a dialog allowing you to specify a name for
the field. The name you specify here will replace the actual field name.

Alias Dialog

3.2.2.3. View SQL Query
You can view the constructed query in the SQL tab of the Data Source Dialog.

SQL View



Data Sources

243

3.2.2.4. Preview Query Results
You can preview the query at anytime by clicking the View DataSheet tab in the Data Source Dialog.

Query Results

You can navigate through the result set using the icons at the top of the window.

Go to the first page of the data table.

Go to the previous page of the data table.

Set the number of records to display per page. This will open a new dialog prompting you to specify the
record number.

Go to the next page of the data table.

Go to the last page of the data table.
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Chapter 4. Designing Reports & Charts
4.1. Chart Designer

4.1.1. Introduction to Chart Designer
The Chart Designer is a graphical user interface, launched within the Organizer that allows users to create and
customize charts. The simple drop and drag style interface and extensive editing/formatting capabilities, makes
chart design quick and easy.

4.1.1.1. Working with Charts
It is important to note that in EDAB there are two ways that you can use charts. Charts can either be placed within
reports or designed and run as stand-alone entities. A unique feature of charts placed in reports is that they can use
the report data as their data source. In this instance, the chart cannot be deployed outside of the report.

Charts that use their own data sources can be deployed independently from reports, either in menu pages or using
image URLs to embed them in web pages.

4.1.1.2. Starting Chart Designer
The Chart Designer interface is always loaded from within the Organizer. To start a new chart, you can click the

Chart Designer button on the toolbar or select View → Chart Designer. You can also start Chart Designer when
creating or editing data sources in the registry. The View button allows you to preview a data source and to build
a chart or report. In addition, you can open the Chart Designer to edit a chart template file in the Organizer. To do

so, first, select the file that you would like to open and then you can select File → Open File, right click on the file
and select Open File from the pop-up menu, or double-click on the file.

If you are creating or adding an embedded chart within a report, the Chart Designer is launched from within Report

Designer by either clicking on the Insert Chart button on the toolbar or by selecting Insert → Insert Chart.

4.1.1.3. Selecting a Data Source
The first step in designing a chart is to select the data source from which the chart is to be drawn. The first time
you select to start a new chart you will be prompted to select the data registry that you would like to use. If there
are not currently any available registries (meaning that you have not created any or you do not have privileges to
view any), you will be prompted to go the Data Registry Manager to create one. For more on data sources, please
see Section 3.1 - Data in Organizer

Once you have selected a registry, a Data Source Manager window will open allowing you to select, add, or modify
a data source that you would like to use for the chart or report. Note that the registry will not open if you are building
a chart from the registry in the Modify Data Sources dialogs.
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Data Source Manager Window for Chart Designer

4.1.2. Charting Basics
This section covers some of the basics of charts including the different parts of a chart and the way in which tabular
data either from the report or another data source is mapped to a chart.

4.1.2.1. What is a Chart
The following diagram illustrates the various components that make up a chart. Also, this diagram refers to various
terms that will be used throughout this guide.
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A. Main Title This is the main title for the chart.

B. Chart Canvas This is the background on which the chart is drawn. The canvas serves as the
size/boundary for the chart and it is generally the same size as any exported
image. You can modify the canvas color or place/add an image file as a back-
ground.

C. Legend This is the chart legend. The legend shows your category or series names along
with a color point. Secondary values, as well as added trend/control lines and
control areas, can also be displayed in the legend.

D. Category (X) Axis This is the X or category axis of the chart. Generally, the category axis plots
the distinct entries from the dataset for which you want to plot values in the
chart. (The values are generally plotted on the Y-axis.) Certain chart types
such as bar and Gantt reverse this by drawing the categories on the Y-axis,
and plotting the values on the X-axis. Other chart types like scatter and bubble
plots, plot values on each axis to create a point in 2D or 3D space.

E. X-Axis Labels These are the labels for the X-axis elements or categories.

F. X-Axis Title This is the X-axis title.

G. X Ticker These are the X-axis tickers. By default the tickers match each data point in
the chart.

H. Value (Y) Axis This is the Y or value axis of the chart. Generally, the Y-axis plots the values
for each of the categories. By default the scale of the Y axis is generated to
provide a best fit for the dataset; however, it can be manually adjusted. For
combination charts, the second value axis is drawn at the right-hand side of
the plot.

I. Y-Axis Labels These are the labels for the Y-axis values.

J. Y-Axis Title This is the Y-axis title.

K. Y-Axis Ticker These are the Y-axis tickers.

L. Y Grid These are grid lines drawn along each scale step in the Y-axis. Grid lines can
also be drawn for the points on the X-axis (and Z-axis for 3D charts).

M. Plot Area This is the area, bounded by the axes, where all the data points are plotted. You
can fill the area with color and/or draw a border around the area, along with
other options. The plot area can be moved and resized on the chart canvas.

N. Control Line This is one of the special types of lines that can be added to a chart. In this
instance, it is a control line that follows the highest value in a series. Control
lines can also be drawn for averages and multiples of standard deviation. Users
can also add a variety of trend lines to charts.

O. Floating Line A floating line is an arbitrary line added to a chart. In this case it is being used
as a pointer with an arrow. Floating lines move in relative position with the
chart plot. They can also be used to create filled shapes.

P. Annotation Text This is a piece of arbitrary text added to a chart (not labels or titles). You can
place text anywhere in the chart canvas. Like floating lines, annotation text
moves in relative position to the chart plot.

Q. Category Elements This is the plot for a category element. There are three points plotted for each
category because this chart has a data series.
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R. Data Series Elements These are the individual points that make up a category. A series allows groups
of data to be plotted on a single chart. For more about information about cat-
egories and series, see Section 4.1.2.2 - Basic Data Mapping

S. Data Top Labels These are labels placed at each data point in the chart that display the exact
value for each point.

4.1.2.2. Basic Data Mapping
Data mapping is the way that raw data is rendered in the chart. Although data can be drawn from many sources, a
chart looks for the basic structure of the data to be in the form of a table. Hence, data passed in as arguments, from
the report or from XML files is converted to a table structure before mapping.

A basic set of data might look something like this:

Product Sales

Chair 362

Table 862

Dresser 1052

Cabinet 1211

To plot this data in a chart, you would want to plot the Sales value for each entry in the Product column. Hence, the
products are your category and the sales numbers are your values. In a chart you would map the Product column
to the X (category) axis and the Sales column to the Y (value) axis. The resulting plot would look like this in a
column chart:

Here, a column is drawn to show the value for each distinct element in the category column. On top of the basic
category values, additional information can be displayed in the form of a data series. For example, say that there
is another element to our data that shows sales data not only for product, but also over a sales region. Our adjusted
table would look like this:

Product Region Sales

Chair East 114

Chair Midwest 131

Chair West 117

Table East 231
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Product Region Sales

Table Midwest 187

Table West 444

Dresser East 327

Dresser Midwest 469

Dresser West 256

Cabinet East 422

Cabinet Midwest 386

Cabinet West 403

In order to show the value for each region per product we could add the Region column to the data mapping as a
data series. Doing this gives us the following chart:

Now each category has three data points, one for each region. For two-dimensional charts the series is always
displayed in-line. In three-dimensional charts, the series is drawn on the Z-axis by default, although it can be drawn
in-line as well. Below, is the same chart show in 3D.
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In this chart, the data series is drawn along the Z-axis. Note that the order of the categories has been changed to
provide a better view of the data. This is the basic concept behind data mapping. Most chart types use this mapping
technique or mapping options similar to this. Detailed data mapping instructions for each chart type are available
in Section 4.1.3 - Chart Types and Data Mapping.

4.1.2.3. Saving and Exporting Charts
There are several options available both for saving chart definitions and exporting charts as image files. More
information on how to save and export charts in the Chart Designer can be found in Section 4.1.6 - Saving &
Exporting Charts.

4.1.2.3.1. Saving Chart Definitions
There are two primary methods which you can use to store chart definitions created in ChartDesigner: either as
chart or as template files.

Chart files Chart files save the chart in a binary file called filename.cht. A chart file stores both
the definitions of the chart (type, dimension, etc.) as well as the data that was used to create
the chart. Hence, chart files are portable. Any time you open a chart file, it will open with
the original data that was used to create the chart. After opening the chart, you can refresh
the data from the source or change the chart's data source entirely.

Template files Template files save the chart in a binary file called filename.tpl. A template file stores
only the chart definitions and stores only 10 records of data with the chart. Hence, any time
a template file is opened it will try to connect to the original data source to retrieve the data.
Because of this, template files can be less portable than chart files. Template files can also be
used to pass chart attributes from one chart to another. To do this, you can apply a template
to a chart. This will carry over many of the attributes of the template to the current chart.
For more information about applying templates, please see Section 4.1.6.1.1 - Working with
Templates.

In addition to saving chart definitions in binary format, chart files and template files can also be saved in XML
format. These XML chart definition files can be modified outside of Chart Designer or Chart API.

4.1.2.3.2. Generating Image Files
For image files, EspressDashboard can render charts in the following formats:

GIF EDAB can generate GIF images using one of two compression methods - RLE or LZW. The LZW method
is faster and produces smaller files; however, its use is protected by patent. You must obtain a license
from Unisys in order to unlock the LZW compression. By default, GIF files are generated using RLE
compression.

JPEG JPEG is another popular image format. It is a higher resolution image format than GIF and it is not patent
protected. When generating a JPEG file you can specify the quality and compression of the file. The higher
the quality, the larger the file.

PNG PNG is an image format that is less popular but it can be displayed in most browsers. It is a high-quality
image with a smaller file size than JPEG. There are three different compression options available for this
format.

SVG SVG (Scalable Vector Graphics) is a relatively new image format that saves the image as vectors in an
XML-based text format. Generally, you will need a browser plug-in to view these images.

SWF SWF is an Adobe Flash file. The flash format is vector based and it allows the chart to be resized after
export. Also, flash allows for high-resolution printing and produces a small file size.

BMP This is a Windows bitmap format.

WMF WMF is the Windows Meta File format. This can be used for import/export into MS Office documents.

In addition to static images, ChartDesigner also allows the chart data to be exported as a text file, PDF, or an XML
file.
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4.1.3. Chart Types and Data Mapping
Once you have selected the data that you would like to use for the chart, the next step in the Chart Wizard is to
select the chart type that you would like to use. You will be presented with a dialog that allows you to specify
the chart type.

Two-Dimensional Chart Types Selection Dialog

Each chart type represents a different way in which the data points are plotted to give a pertinent representation
to all kinds of data. The different types of charts are broken down by dimension. In addition to basic chart types,
users can create many different types of composite/combination charts by adding secondary values/series to the
chart. You can toggle between the chart categories by selecting either 2D, 3D or Gauges in the right-hand side of
the chart types dialog.

Three-Dimensional Chart Types Selection Dialog

This dialog enables you to select your chart type by either selecting the image and clicking Next or by double
clicking on the chart image. You can select from one of the following chart types:

• Column
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• Bar

• XY(Z) Scatter

• Line

• Stack Column

• Stack Bar

• Pie

• Area

• Stack Area

• High Low

• HLCO

• Percentage Column

• Doughnut

• Surface (Three-Dimensional Only)

• Bubble (Two-Dimensional Only)

• Overlay (Two-Dimensional Only)

• Box (Two-Dimensional Only)

• Radar (Two-Dimensional Only)

• Dial (Two-Dimensional Only)

• Gantt (Two-Dimensional Only)

• Polar (Two-Dimensional Only)

• Circular Gauge

• Square Gauge

• Semi Circular Gauge

• Square Gauge

• Quarter Circular Gauge

• Heatmap

Each of the chart types is described in detail later in this chapter, starting with Section 4.1.3.2 - Column Charts

For information on gauges, see Section 4.1.3.20.2 - Gauges

4.1.3.1. Data Mapping
After you have selected the chart type, the next step is to specify the data mapping for the chart. Data mapping is the
way that the selected data source is rendered in the chart. The basics of data mapping are described in Section 4.1.2.2
- Basic Data Mapping. The data mapping screen in the Chart Wizard allows you to set the mapping options and
also preview the results.
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Data Mapping Dialog

The left-hand side of the dialog shows a preview of your chart. The right-hand side shows which columns from
your data source have been selected to plot in the different chart elements (series, category, value, etc). By default,
EDAB will select the first available columns, based on the data type, to plot. Changing the data mapping is easy -
click on the down-facing arrow next to a data field and select a different field. The chart preview in the left-hand
part of the data mapping dialog will be updated immediately.

The specific mapping options vary for each chart type and are discussed later in this chapter starting with Sec-
tion 4.1.3.2 - Column Charts.

4.1.3.1.1. Data Transposition
You can also set data transposing from the data mapping dialog. Transposing allows you to plot multiple data source
columns in one chart without modifying the data source.

For example, we have a data source that looks like this:

Example Data Source

We would like to plot data from all regions in one chart. The default mapping without data transposing does not
allow us to do that. We would have to plot only one region in the chart or modify the data source, so we will have
to transpose the data source.
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Default Chart Data Mapping

To transpose the data, select the Multi Selection option next to the Data Series field. The field will change to a
list allowing us to select several columns at the same time. We will just select all region columns and the chart
will look like this:

Default Chart Data Mapping

Note
Only one chart element (such as data series, category, value, or second series) can be transposed at a
time. If you select the Multi Selection checkbox for one chart element, the Multi Selection checkboxes
will be deactivated for other chart elements.

Transposing is not available for drill-down charts.
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4.1.3.2. Column Charts

Column Chart (Without Data Series)

A column chart displays each row in the data table as a vertical bar (or column). The categories are listed along the
X-axis and the values plotted along the Y-axis. Column charts are good for comparing discrete values for different
groups. Each group is represented by a different color.

In a two-dimensional chart, if a data series has been selected then the entire series for a single category will be
displayed in the XY plane. If a three-dimensional column chart is being used then all the vertical bars in a given data
series are drawn using the same color along the Z-axis. If a data series is not present in the chart, the categories will
be represented by the same color by default. Different colors for the categories are possible to set by clicking the

 Change chart options icon on the toolbar (or selecting Format → Chart Options), and unchecking the Single
Color For All Categories option.

In the examples given, we have chosen Drink as the category variable and Value as the value variable (most ex-
amples use the Sample.dat file included in the EDAB installation). Year has been selected as the data series
variable for the chart below. Therefore, each name has two columns shown: one for last year and one for this year
which are the only two values present in the data series column.

Column Chart with Data Series

4.1.3.2.1. Data Mapping
Data mapping for column charts is fairly straightforward. It is similar to the examples first presented in Sec-
tion 4.1.2.2 - Basic Data Mapping. For column charts, the following options are available:
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Mapping Options for Column Charts

Data Series: Choose a data column whose distinct values will determine the number of data series in the
chart. Each element in a data series is drawn using the same set of colors and other attributes.

Category (X): Choose a data column whose distinct values will determine the categories.

Value (Y): Choose a data column to provide values for each category.

2nd value: Add a second value to create a combination chart.

2nd Series: Choose another column to be series for the secondary chart. This option is applicable only
if the secondary chart is an overlay chart.

Combo: Choose the chart type for the secondary chart. For column charts the combo options are Line
and Overlay.

The data mapping also allows you to transpose the data (in other words: to select several columns for a single
category). To learn more about data transposition, please see Section 4.1.3.1.1 - Data Transposition.

The last three data mapping options allow you to add a second value to the chart. ChartDesigner supports secondary
values for all chart types except pie, radar, bubble, dial, surface, and scatter charts. In the example below, a second
value of Quantity has been added to our column chart.

Column Chart With 2nd Value

As you can see, the second axis labels are drawn on the right-hand side of the plot area (you can choose to make this
axis visible). Usually, the second value will share the same categories and series as the primary value. However,
for two-dimensional column, stack column, stack area, high low, HLCO, and percentage column charts you can
specify an overlay combination, which allows you to specify a second series. For more on overlay charts, please
see Section 4.1.3.17 - Overlay Charts.
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4.1.3.3. Bar Charts

Bar Chart

A bar chart is essentially the same as a column chart, except that horizontal bars are drawn in the chart as opposed
to the vertical bars which are used in a column chart. In a bar chart, the categories are plotted along the Y-axis
and the values along the X-axis.

Just as for a column chart, if a data series has been selected then the entire series for a single category is displayed
in the XY plane. If a three-dimensional bar chart is being used, all the horizontal bars in a data series are drawn
using the same color. Each category is drawn using a different color. If the data series is not present in the chart, the
categories will be represented by the same color by default. Different colors for the categories are possible to set by

clicking the  Change chart options icon on the toolbar (or selecting Format → Chart Options), and unchecking
the Single Color For All Categories option.

4.1.3.3.1. Data Mapping

Mapping Options for Bar Charts

The mapping for this chart type is similar to that of a column chart, except the category (X) and values (Y) under
column chart become category (Y) and values (X) respectively. This is because values are represented vertically in
a column chart, but horizontally in a bar chart. Please note that the 2nd Series and Combo options are not available
for bar charts. This is because the only combination available with bar charts is a line.
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4.1.3.4. XY(Z) Scatter Charts

XY(Z) Scatter Chart

In an XY(Z) scatter chart, each selected row in the data table defines a point in two or three-dimensional space. Thus
each column must contain either numeric or date/time values. A marker represents each point. The data columns
that are in each row of the data table determine the spatial position of the marker.

Optionally, another data table column can be chosen to separate the markers into groups. Elements of each group
have the same value on this column which is referred to as the data series column. Markers in the same group are
drawn using the same drawing attributes; in other words, using the same shapes and colors. The X-axis scale of a
scatter chart is linear. This means that unlike other chart types, the data points may or may not be evenly spaced
along the X-axis.

4.1.3.4.1. Data Mapping

Mapping Options for Scatter Charts

In a scatter chart, the X-axis, Y-axis, and Z-axis values determine the X, Y, and Z coordinates of a point respectively.
The data series box allows you to choose a data column whose distinct values will determine the number of data
series in the chart. Each element in a data series is drawn using the same set of drawing attributes( e.g., colors
and markers).
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4.1.3.5. Line Charts

Line Chart

Line charts present data in a manner similar to column charts. For a two-dimensional line chart, a marker denotes
a data point for each category. The value column, which must be numeric, determines the height of a marker. Each
marker is joined with a line. If the chart has a data series, a separate line is drawn for each element in the series.
Please note, the markers (points) are not shown by default. You can enable showing markers (points) in the Line

and Point dialog. This dialog can be opened from the Format menu or by clicking the  Format line and points
icon on the toolbar.

ChartDesigner allows 2D line charts to be displayed vertically in addition to the default horizontal setting. To use

this feature in Chart Designer, create a line chart and then select Format → Chart Options. Next, select Vertical.
The chart is rotated clockwise 90 degrees.

Vertical Line Chart

A three-dimensional line chart is an extension of its two-dimensional counterpart. It contains no additional infor-
mation. The markers disappear (they are not available for 3D line charts) and thicker lines, spaced apart on the Z-
axis, replace the thin lines.
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4.1.3.5.1. Data Mapping

Mapping Options for Line Charts

Data mapping for line charts is almost exactly the same as for column charts (discussed in Section 4.1.3.2.1 -
Data Mapping). Line charts, however, do not have the 2nd Series and Combo options. This is because the only
combination available with line charts is a line. To create line combinations with other chart types (bar, column,
stack column, etc) select the other chart type as the primary chart, and select Line as the Combo option.

4.1.3.6. Stack Column Charts

Stack Column Chart

A stack column chart is a derivative of a column chart in which each vertical column comprises a stack of bars.
Each selected row in the data table is represented by a component of a chart column. For a two-dimensional stack
column chart, the categories are plotted on the X-axis and the values on the Y-axis. The value column, which must
be numeric, determines the length of each bar component. A third column, known as the sum-by column, represents
a group of values for each category. A stack for a given category value is built up stacking the sum-by values for
that category value. Each stack component of a chart column has a distinct sum-by value denoted by a distinct
color. Each row in the data table must have a unique pair of values on both the category and sum-by columns.
Components with negative values are separated from components with positive values and they are stacked up in
the “negative” direction below the X-axis.

In our example above, we have chosen types of drink as category value and day representing the sum-by values.
Another independent category (to be displayed on the Z-axis) may be optionally specified based on a fourth column
as a data series. In such a case, each row in the data table must have a unique triplet of values on the category, sum-
by and data series columns. In a two-dimensional chart, the entire data series for a single category is displayed side-
by-side in the XY plane. In a three-dimensional stack column chart, the data series is displayed along the Z-axis.

4.1.3.6.1. Data Mapping
In stack column charts, each category is further subdivided into components. Hence, there is an additional sum-by
option used to determine the sum-by values for the chart.
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Mapping Options for Stack Column Charts

The data mapping options are as follows:

Data Series: Allows you to choose a data column whose distinct values will determine the number of data
series in the chart. Each element in a data series is drawn using the same color.

Category (X): Allows you to choose a data column whose distinct values determine the categories. Values
from this data column are used to calibrate the X-axis. Each category in a data series is drawn
as a distinct column in the chart.

Sum-by: Allows you to choose a data column whose distinct values determine the components in
each category. Each distinct value in this column determines a distinct stack component of
a column.

Value (Y): Choose a data column to provide values for each category.

2nd value: Add a second value to create a combination chart.

2nd Series: Choose another column to be series for the secondary chart. This option is applicable only
if the secondary chart is an overlay chart.

Combo: Choose the chart type for the secondary chart. For stack column charts the combo options
are Line, Stack Area, and Overlay.

The data mapping also allows you to transpose the data (in other words: to select several columns for a single
category). To learn more about data transposition, please see Section 4.1.3.1.1 - Data Transposition.

Stack column charts have a unique combination option which allows users to plot a second value as a stack area
chart. Both values share the same category and sum-by values. This chart can compare component based categories
for different values in the data.
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Stack Column-Stack Area Combination Chart

With this combination chart you can specify to hide particular sum-by component in the chart to achieve a strip
area effect.

4.1.3.7. Stack Bar Charts

Stack Bar Chart

Like a stack column chart, the stack bar chart displays the chart categories as a sum of different stacked values -
the sum-by column in the data source. The difference for a stack bar chart is that the categories are plotted on the
Y-axis and the values are plotted along the X-axis.



Designing Reports & Charts

262

4.1.3.7.1. Data Mapping

Data Mapping Options for Stack Bar Charts

The mapping for this chart type is similar to that of a stack column chart, except the category (X) and values
(Y) under column chart become category (Y) and values (X), respectively. This is because values are represented
vertically in a column chart, but horizontally in a bar chart. Please note that the 2nd Series and Combo options are
not available for stack bar charts. This is because the only combination available with stack bar charts is a line.

4.1.3.8. Pie Charts

Pie Chart

In a pie chart, each row in the data is represented as a pie sector. The pie chart requires a category column and a
value column. The value column must be numeric. The number of distinct values in the category column determines
the number of pie sectors in the chart. All the values are summed up and each slice is assigned an angle according
to its share in the total. Thus, the value column for each category determines the size of the slice representing that
category.

A three-dimensional pie chart is simply an extension of its two-dimensional counterpart and contains no extra
information.

Pie charts can also have a data series. If you specify a series in the data mapping, a separate pie will be drawn for each
category element and it will be comprised of the series elements. A pie chart with a data series is displayed below:



Designing Reports & Charts

263

Pie Chart With Data Series

When a series is present, all the separate pies are drawn on a single plot area and resized in proportion with the plot.
You can choose to either stack the different pies or draw them in a line.

4.1.3.8.1. Data Mapping

Mapping Options for Pie Charts

For pie charts, the mapping is as follows:

Data Series: Allows you to choose a data column whose distinct values will determine the number of data
series in the chart. Each element in a data series is drawn using the same color.

Category (X): Allows you to choose a data column whose distinct values determine the various categories.

Value (Y): Allows you to choose a data column to provide values for each category.

There is no 2nd Value option, as you cannot make any combination charts with a pie chart.

The data mapping also allows you to transpose the data (in other words: to select several columns for a single
category). To learn more about data transposition, please see Section 4.1.3.1.1 - Data Transposition.
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4.1.3.9. Area Charts

Three-Dimensional Area Chart

A three-dimensional area chart may be viewed as a derivative of a column chart. A three-dimensional area chart
may be constructed from a three-dimensional column chart in the following manner. For each data series (Z-axis)
value, the tops of all the columns are joined together by a thick line. The columns are then removed and the area
(in the XY plane) under each line is filled with a distinct color.

Two-Dimensional Area Chart

A two-dimensional area chart is essentially a projection of its three-dimensional counterpart viewed along the Z-
axis. As a result, a two-dimensional area chart may sometimes hide a data series value altogether. Therefore, it
must be used with caution. The chart above illustrates this point: in a two-dimensional display some parts of each
series are concealed by a series in front. To ameliorate this problem, you can change the ordering of the data series
(see Section 4.1.4.8.3 - Data Ordering) or set the area translucent (see Section 4.1.4.1.3 - Format Menu) as in the
example above.
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4.1.3.9.1. Data Mapping

Mapping Options for Area Charts

Data mapping for area charts is almost exactly the same as for column charts (discussed in Section 4.1.3.2.1 -
Data Mapping). However, area charts do not have the 2nd Series and Combo options. This is because the only
combination available with area charts is a line.

4.1.3.10. Stack Area Charts

Stack Area Chart

A two-dimensional stack area chart may be viewed as a derivative of a two-dimensional stack column chart but
without a data series. This chart may be constructed from a stack column chart as follows: The tops of each stack
component that have the same color are joined together by lines. The stack columns are removed and the area
between each set of lines is filled with a distinct color.

A three-dimensional stack area chart can have a data series and can also be derived from a three-dimensional stack
column chart using the process stated above. In this case, the stack columns for each distinct data series value (a
fixed Z-axis value) are joined separately, giving rise to multiple stacks.

Both two-dimensional and three-dimensional stack area charts may be constructed using a similar set of data as
needed for their respective stack column chart counterparts. Note, as stated earlier, that a two-dimensional stack
area chart cannot have a data series.
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4.1.3.10.1. Data Mapping

Mapping Options for Stack Area Charts

Data Mapping for stack area charts is almost exactly the same as for stack column charts (covered in Sec-
tion 4.1.3.6.1 - Data Mapping). However, two-dimensional stack charts cannot have a data series, and the combo
options are Line and Overlay.

4.1.3.11. High-Low Charts

High-Low Chart

A high-low chart is also a derivative of a column chart, only that instead of one value column it uses two columns
for high and low bounds of values. The data for the chart must contain at least three columns: category, high, and
low. The category column can contain values of any type, while the high and low columns must be numeric.

Another option for a high-low chart is a data column called the close column. If a close column is also used, then
the close value will lie somewhere between the high and low values. The portion of the bar between the low point
and the lose point is rendered in a darker form of the same color as the portion between the close point and the high
point. As for many other types of charts, a high-low chart may include a data series column.
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4.1.3.11.1. Data Mapping

Mapping Options for High-Low Charts

Data mapping for high-low charts is similar to column charts. You can select series and category columns in the
same manner. The difference for high-low charts is that you need to specify at least two value columns - a high
and a low value. These are the two points that are plotted for each category. A third value called Close can also be
specified. Combo options for high-low charts are Line, Column, and Overlay.

4.1.3.12. HLCO Charts

HLCO Chart

A HLCO (High Low Close Open) chart is similar to the high-low chart described above, except that it also contains
an open column. It is useful in presenting data that fluctuates over discrete periods of time, such as stock prices or
inter-day temperatures. The HLCO chart can also be displayed in a Candlestick format for both 2D and 3D charts.
This feature is described in Section 4.1.4 - The Chart Designer Interface.
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4.1.3.12.1. Data Mapping

Mapping Options for HLCO Charts

Data mapping for HLCO charts is similar to that for High-Low charts. The only difference is that instead of speci-
fying two different value columns, you must specify four different columns - High, Low, Open and Close. Combo
options are Line, Column and Overlay.

A common kind of chart is a one that plots both stock price and trading volume in the same chart. This can be
accomplished using an HLCO-column combination in ChartDesigner.

HLCO-Column Combination Chart

This example plots stock price and volume data over a three month period.
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4.1.3.13. Percentage Column Charts

Percentage Column Chart

A percentage column chart may be viewed as a derivative of pie and column charts together. Each column in the
chart corresponds to one pie. A percentage column chart has a category column corresponding to the X-axis value.
A sum-by column represents the category in this case and the value column is the same as that of a pie chart.

4.1.3.13.1. Data Mapping

Mapping Options for Percentage Column Charts

Data mapping for percentage column charts is the same as for stack column charts (covered in Section 4.1.3.6.1 -
Data Mapping). The only difference is that the sum-by components are plotted as a percentage of the Value column
instead of discrete values. Combo options for percentage column charts are Line and Overlay.
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4.1.3.14. Doughnut Charts

Doughnut Chart

A doughnut chart is the same as a pie chart, except for the “hole” in the center.

Just as for a pie chart, if a data series is selected, a separate doughnut will be drawn for each category element and
each doughnut will be comprised of the series elements. When a series is present, all the separate doughnuts are
drawn on a single plot area and resized in proportion with the plot. You have an option to either stack the different
doughnuts or draw them in a line.

4.1.3.14.1. Data Mapping

Mapping Options for Doughnut Charts

Data mapping for doughnut charts is exactly the same as for pie charts (discussed in section Section 4.1.3.8.1 -
Data Mapping).
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4.1.3.15. Surface Charts

Surface Chart

A 3D surface chart is a scientific/business chart, which uses three sets of numeric data values to form a smooth
surface in a three dimensional space. For each data point, two of the three values represent the coordinates on the
horizontal plane and the third value is used to determine the vertical position of a data point. Input data can be in
a form of a rectangular matrix (as shown below) or arranged in three columns where each column represents an
axis. In the following sample data, the top row (column header) and the left column (row header) represent the
coordinate values of the axes that form the plane on which the surface will be drawn. When the chart is viewed
from above the plane, you can see a grid formed by joining every four adjacent points together. A given set of data
cannot plot a surface chart if this grid cannot be drawn.

Sample surface chart data:

 0 20 40 60 70 80 100

20 0 0 0 0 0 0 0

30 0 10 10 10 10 10 10

40 0 10 25 25 25 2 10

80 0 10 25 30 30 30 25

90 0 10 25 30 30 30 25

100 0 10 10 25 25 25 10

Note: Sample data for creating a surface chart can be found in surface.dat file, which is located in <EDAB
install dir>/help/examples/DataSources/text/ directory.

The values of the column header and the row header are not required to be equally separated because a surface chart
can properly scale the horizontal distances. This dataset can create a distorted inverted cone. A surface chart can
be very impressive when animation is turned on.

A surface chart uses a set of X, Y, and Z coordinates to plot a 3D chart. The vertical axis is called Y-axis and each
Y value is represented by a function of X and Z, f(X, Z). Data on XY plane (horizontal plane) simply looks like a
square matrix. Surface charts do not support data series and cannot be converted to a 2D chart.
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4.1.3.15.1. Data Mapping

Mapping Options for Surface Charts

The data mapping for a surface chart is similar to a three-dimensional scatter chart; the X-axis, Y-axis, and Z-axis
values determine the X, Y, and Z coordinates of a point respectively. However, unlike a scatter chart, surface charts
do not support data series and cannot be converted to a two-dimensional chart.

4.1.3.16. Bubble Charts

Bubble Chart

A bubble chart is used to represent data wherein the size of the bubble also provides information. A data point is
represented by an XY coordinate and a third point, which is the radius of a circle or bubble.

This chart is available in a two-dimensional form only. For more information about the bubble charts and their
display options, please see Section 4.1.4.9.1 - Bubble Charts.

4.1.3.16.1. Data Mapping
The data mapping for bubble charts is similar to three-dimensional scatter charts; however, instead of plotting a Z-
axis position, the third value determines the size of the bubble (specifically the radius).

Mapping Options for Bubble Charts

Note that similarly to a scatter chart, the columns have to be numeric in order to be mapped successfully.
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4.1.3.17. Overlay Charts

Overlay Chart

ChartDesigner supports a special chart type called overlay chart, which allows you to super-impose more than two
charts with a common category axis. A different chart can be used to represent each element of a data series. This
allows for more freedom while creating the chart and also allows more information to be represented. The chart
types supported in an overlay chart are column, area, and line charts. Only two-dimensional charts can be included
in an overlay chart.

4.1.3.17.1. Data Mapping

Mapping Options for Overlay Charts

The data mapping for an overlay chart is similar to a column chart (covered in Section 4.1.3.2.1 - Data Mapping),
except that the overlay chart plots each element in the data series as a separate chart. Please note that the 2nd Value,
2nd Series and Combo options do not apply to overlay charts. Overlay charts do not support secondary values.
However, the different series elements can be plotted on different axes. For more about plotting options for overlay
charts, see Section 4.1.4.9.3 - Overlay Charts.
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4.1.3.18. Box Charts

Box Chart

ChartDesigner provides a statistical chart type, the Box Chart, also known as Box and Whiskers Chart. Basically, the
box chart provides a quick visual realization of summary statistics. A histogram shows the distributions of observed
values so you can identify the peak(s), minimum, maximum values and clustering of data. A box chart, on the
other hand, displays a summary of data distribution in quarterly percentiles (Minimum data point, 25th percentile,
median, 75th percentile, and Maximum data point).

The middle line in the box represents the median. The other lines in each direction represent the 25th percentile
increment (decrement). The minimum and maximum points are the observed minimum and maximum which are not
outliers. The lines that extend from the edge of the box to the minimum/maximum are sometimes called whiskers.
Hence, the name box and whisker chart. Outliers are any values that are 1.5 times (or more) the length of the box,
that being the difference between the 75th and 25th percentiles. Outliers are calculated and shown as dots away
from the box. The other nice feature about box plot is that you can stack up the boxes in one chart to compare
summaries of different data sets.

ChartDesigner allows box charts to be displayed vertically in addition to the default horizontal setting. To use this

feature in Chart Designer, create a box chart and then select Format → Chart Options, and select Vertical.

Vertical Box Chart

This chart is available in two-dimensional form only.
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4.1.3.18.1. Data Mapping

Mapping Options for Box Charts

For box charts the mapping is as follows:

Category (X): Allows you to choose a data column whose distinct values determine the various categories.

Value (Y): Allows you to choose a data column to provide values for each category. These values are
used to calculate the minimum data point, the 25th percentile, the median, the 75th percentile,
and the maximum data point.

2nd value: Add a second value to create a combination chart.

Please note that the 2nd Series and Combo options are not available for box charts. This is because the only com-
bination available with box charts is a line.

The data mapping also allows you to transpose the data (in other words: to select several columns for a single
category). To learn more about data transposition, please see Section 4.1.3.1.1 - Data Transposition.

4.1.3.19. Radar Charts

Radar Chart

Radar charts are useful when you need to compare performance/measurement results, statistics, etc from different
sources. For example, we can compare median test scores of children in the industrial nations on subjects such as
math, computer science, and biology. A radar chart has multiple axes along which data can be plotted. Each axis
is a category. The data is shown as points on the axis. The points belonging to one data series can be either joined
or the enclosed area filled. A point close to the center on any axis indicates a low value while a point near the
end represents a high value. In some cases, low values may be more desirable than high values, e.g. price/earning,
price/sales, price/book of stocks.
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This chart is available in a two-dimensional form only.

4.1.3.19.1. Data Mapping

Mapping Options for Radar Charts

For radar charts the mapping is as follows:

Data Series: Allows you to choose a data column whose distinct values will determine the number of data
series in the chart. Each element in a data series is drawn using the same color along each axis.

Category (X): Allows you to choose a data column whose distinct values determine the categories. The
number of unique elements in this column determines the number of axes in the radar chart.

Value (Y): Allows you to choose a data column to provide the numeric value to plot against the category.

Please note that the 2nd Value, 2nd Series, and Combo options do not apply for radar charts. Radar charts do not
support secondary values.

The data mapping also allows you to transpose the data (in other words: to select several columns for a single
category). To learn more about data transposition, please see Section 4.1.3.1.1 - Data Transposition.

4.1.3.20. Dial Charts

Dial Chart

Dial Charts are used to build circular charts (such as temperature gauges, speedometers, and clocks), create dash-
boards, or balanced scorecard applications. Here the data is represented as a “hand” on a “dial”. You can either
use the whole dial (for instance for a clock) or just part of it (a semi- circular chart such as a gasoline gauge). Dial
Charts support pop-up labels, drill-down, and user interactions such as rotating the hands or sectors of a dial.

This chart type is available in a two-dimensional form only.
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4.1.3.20.1. Data Mapping

Mapping Options for Dial Charts

The data mapping of a dial chart is similar to a pie chart (detailed in Section 4.1.3.8.1 - Data Mapping). However,
instead of pie wedges, the categories become dial hands. Also, dial charts do not support data series or secondary
values.

4.1.3.20.2. Gauges
Gauges are special types of dial charts containing a plot background image and/or plot foreground image. To create
a new gauge, select the Gauges radio button on the Chart Type Selection dialog.

Selecting a Gauge Template

You can also create your own gauge by creating a template, saving the tpl file in the <EDAB Install>/gauges/
templates/Custom/ folder (please note that the Custom folder is not created automatically by the EDAB
installator so you will have to create it manually in your favorite file manager). To add this template to the Cus-
tom tab, you will also need to provide two images, a screenshot of the template placed in <EDAB Install>/
gauges/screenshots/selected/Custom/, and a dimmer version of the same template placed in <EDAB
Install>/gauges/screenshots/unselected/Custom/. An easy way to create the screenshot is to
export the template to gif for the regular screenshot and resize it to 100px by 100px. Then change the background
to a darker color, export and resize again for the dimmer version.

It is also possible to apply a gauge template onto an existing dial chart. Selecting apply template when the current
chart is a dial chart will display the gauge tabs just like when creating a new chart.
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Applying a Gauge Template

For more information regarding the dial background and foreground images, see Section 4.1.4.9.2 - Dial Charts.

4.1.3.21. Gantt Charts

Gantt Chart

A Gantt or time chart is used to represent data where a time factor is being measured. This is often used in project
or time management situations. A Gantt chart resembles a bar chart with the category axis on the Y-axis and the
value axis on the X-axis. The value axis uses date, time, or timestamp data (numeric values can also be used). Each
data point has a start and end time associated with it.

This chart type is available in a two-dimensional form only.

4.1.3.21.1. Data Mapping
The data mapping for Gantt charts is similar to high-low charts. However, instead of selecting a column for the
high and low values, you select the start and end values.
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Mapping Options for Gantt Charts

The mapping is as follows:

Data Series: Allows you to choose a data column whose distinct values will determine the number of data
series in the chart.

Category (X): Allows you to choose a data column whose distinct values will determine the categories.

Start: Allows you to choose a data column whose distinct values represent the starting time interval
for the category.

End: Allows you to choose a data column whose distinct values represent the ending time interval
for the category.

The data mapping also allows you to transpose the data (in other words: to select several columns for a single
category). To learn more about data transposition, please see Section 4.1.3.1.1 - Data Transposition.

4.1.3.22. Polar Charts

Polar Chart

Like a two-dimensional scatter chart, a polar chart plots points on a plane. However, instead of rectangular coordi-
nates, a polar chart plots points using polar coordinates (r, θ), where r represents the distance from the center of the
circular plot and θ represents the angle of a ray emanating from the center of the plot and passing through the point.
Like scatter charts, the data for polar chart coordinates must be numeric. The θ values can be supplied in degrees
or radians. A third data series column can be used to separate the data points into groups.
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4.1.3.22.1. Data Mapping

Mapping Options for Polar Charts

The data mapping for polar charts is similar to scatter charts. The angle and radius options allow you to select
the columns whose values will make up the polar coordinates. These must both be numeric. The data series box
allows you to choose a data column whose distinct values will determine the number of data series in the chart.
Each element in a data series is drawn using the same set of drawing attributes, e.g., colors and markers.

4.1.3.23. Heatmap Charts

Heatmap Chart

A heatmap is a data visualization tool that uses color to represent the values of a matrix. This method is particularly
effective for displaying large amounts of data in a way that is easy to understand at a glance. The colors in a heatmap
typically range from light (white) to dark (e.g.,red) along the color gradient, or from cool (e.g., blue) to warm (e.g.,
red), with each color representing a different value. This visual representation allows for quick identification of
patterns, trends, and outliers within the data. A simple example that shows the revenue of certain product category
in certain region is presented above. In this case, region is the X axis, product category is the Y axis and the plot
is (X,Y, value).

In addition to just plotting (X,Y. value) straight from the input data, there is a correlation option that you can apply
to the data. As such, you can easily visualize the correlation coefficients between pairs of columns from the data
source, i.e. each entry in the matrix is the correlation coefficient between the corresponding columns on the X axis
and the Y axis. Below is an example. In this example, the columns along the X axis are the same as those along
the Y axis. But they do not have to be the same.
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Correlation Heatmap Chart

Note
Heatmap chart is available in a two-dimensional form only.

4.1.3.23.1. Data Mapping
Data mapping of heatmap without applying the correlation function is straightforward.

Heatmap data mapping

Data mapping of heatmap with correlation function applied.

Correlation heatmap data mapping

Note that the “Correlation Coefficient” checkbox is checked, and the X-axis and Y-axis show all the available
numeric columns in the data source. You can select multiple columns in each of the axes.

In our earlier example, we selected all the columns for the X axis and all the columns for the Y axis. But you can
choose different columns for each axis.
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4.1.3.24. Changing Data Mapping or Data Source
Once you have finished setting the mapping options you will be taken to the main Chart Designer interface. Once

you are in the Chart Designer you can return to the Data Mapping window by selecting Data → Modify Data

Mapping, or by clicking the  Change data mapping icon. This will return you to the data mapping screen,
allowing you to adjust the mapping for the chart.

You can also change a data source directly from the Chart Designer by selecting Data → Modify Data Source, or

by clicking the  Modify data source icon on the toolbar. This will open the Data Source Manager.

4.1.4. The Chart Designer Interface
Once you have completed all the steps in the Wizard, the main Chart Designer interface will appear. Here you can
customize and modify the appearance of the chart by changing properties and adding new elements.

Chart Designer Interface

4.1.4.1. The Designer Menus
Most of Chart Designer's functions can be controlled from the menu bar at the top of the designer window. This
section provides a brief overview of the available options. All of the features here are discussed later in this chapter.

4.1.4.1.1. File Menu
This menu performs basic file operations such as opening, closing, and saving files. Note that saving and opening
options are not available when you use the report data as the data source for an embedded chart. For more informa-
tion about file options, please see Section 4.1.6 - Saving & Exporting Charts.

New: This will return you to the Data Source Manager to begin creating a new chart. If you have
not saved your current chart, you will be prompted to do so.

Open: This allows you to open a saved chart definition. Files that can be loaded by Chart Designer
include .cht, .tpl, and .xml chart definition files.

Close: This closes the current chart.

Apply Template: This option allows you to apply a template to the current chart. You can apply any chart
template in either .tpl or .xml format. For more information about working with chart
templates, please see Section 4.1.6.1.1 - Working with Templates.

Save: This saves the current chart.
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Save As: This allows you to save the current chart. You can save the chart as a .cht, .pac or
.tpl (a chart, a complete packed chart or a template file). The

Create XML

check-box allows you to create an XML chart definition file.

Export: This allows you to export the chart to a number of static image formats. The chart data
can also be exported as XML file.

Exit: This closes the Chart Designer with the possibility to save the current file.

4.1.4.1.2. Insert Menu:
This menu allows you to add various elements to a chart.

Titles: This option allows you to automatically add titles to the chart. A main title can be spec-
ified as well as titles for each of the axes. Unlike annotation text, titles will size and
position automatically with the chart.

Text: This allows you to add text or annotation to a chart. Text can be added anywhere on the
chart and can have a number of different formatting properties. Variables can be added to
the text for run-time substitution. For more on adding text to charts, see Section 4.1.4.6.1
- Adding Text

Background: This allows you to select an image to use as the chart background. Background images
can be tiled, centered, or stretched to fit the entire canvas.

Dial Foreground: This option is only available for dial charts. This allows you to select an image to use as
the dial chart foreground. The image can be stretched.

Dial Background: This option is only available for dial charts. This allows you to select an image to use as
the dial chart background. The image can be stretched.

Link: This allows you to add a hyperlink to a data point or a collection of data points in a chart.
To use hyperlinks in a chart, you will need to export a map file along with the image.

Line: This allows you to add an arbitrary floating line to a chart. These lines can be placed
anywhere and can be used to draw enclosed shapes as well. Floating lines are often used
as pointers and can be generated with arrowheads.

TrendLine: This allows you to add a trend line to the chart. ChartDesigner allows you to draw many
different types of trend lines including: linear, a polynomial of any degree, a power, ex-
ponential, logarithmic, a moving average, exponential moving average, triangular mov-
ing average, cubic B-spline, and a normal distribution curve.

Horz/Vert Line: This allows you to add a fixed horizontal or vertical line to a chart. You have the choice
of either adding a constant line (one that draws at a fixed value on the X or Y-axis)
or a control line (draws lines based on a certain value range either average, minimum,
maximum, or multiples of standard deviation).

Control Area: This allows you to draw a fixed area (either on the plot area of a 2D chart or on the face
of a dial chart) to compare against the data values of the chart.

4.1.4.1.3. Format Menu
This menu allows you to edit and modify the properties of many different chart components.

Undo: Cancels the last operation performed in the designer and reverts back to the
previous state. The designer will remember the last 10 actions made.

Redo: Reverses the action of the undo command. For example, if you change the
font color from black to red, you can undo this command to change it back
to black, and then redo this command to have it change to red again.
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Data Properties: This option allows you to control several options for how the data is dis-
played. You can control the thickness of columns/bars, how null data is dis-
played, whether to draw data top labels or not, as well as enable and select
a color for negative top labels.

Histogram Options: This allows you to specify if you want to draw the chart as a histogram and
display additional options to specify the frequency count.

Aggregation Options: This allows you to specify whether to aggregate the data before drawing the
chart and display additional options to specify type of aggregation.

Zoom Options This allows you to enable/disable and set options for time based zooming.
This option only applies if you have date/time data mapped to the category
axis.

3D Display Options: This allows you to set several options that control the display of 3D charts.
You can specify an inline series for 3D column (or similar) charts, as well
as specify rendering approximation for 3D scatter and surface charts. (This
improves performance for charts with a lot of data points.)

Rendering Options: This allows you to specify various rendering options for the chart for a better
presentation.

Rendering Options Dialog

Among the options available are:

Enable Anti-Alias: This allows you to specify anti-aliasing for the
chart. Anti-aliasing will smooth text and lines
in the chart, creating a smoother appearance.
This feature can be applied to either the entire
file or just to the chart, which will leave the
text unaffected.

Adjust Font: This allows you to specify the font size for text
in charts to be relative to the screen resolution.
This feature allows for more precise conver-
sions of charts to various export formats and
between installations.

Translucent This allows you to specify whether the
columns/bars/areas should be translucent. This
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allows any columns/bars/areas “hidden” be-
hind to show through. You can also specify
the opacity by adjusting the slider, where 0%
is completely opaque and 100% is completely
transparent. This option is available for all 3D
charts and for 2D Area, Radar and Gantt charts
with data series.

Gradient: This allows you to enable gradients. The gra-
dient can be applied either across the entire
canvas or to chart data points only. You can
change the gradient options by clicking on
Customize to show the following dialog:

Gradient Options Dialog

This dialog allows you to specify the start and
end points for the gradient (based on the x-y
plane), the gradient color scheme, and whether
the gradient should be cyclic. The start and
end points are represented as percentages with
(0,0) being the top left corner of the canvas and
(100, 100) being the bottom right corner of the
canvas. You can also specify whether the gra-
dient change is shading (becoming darker or
brighter) or a different color. Lastly, you can
specify the gradient to be cyclic i.e., toggle be-
tween the two opposites in the gradient. Note
that the start and end points represent the first
segment if the gradient is cyclic.

You can also enable 3D shading for certain
2D charts (Column, Bar, Stack Column, Stack
Bar, 100% Column and Overlay) by selecting
the Use 3D Shading Effect for 2D bar/column
option (please note that this option is available
for 2D bar/column charts only).

Font Mapping: This allows you to map system (true type) font files for the PDF export. For
more information about this feature, please see Section 4.1.6.2.1 - PDF Font
Mapping
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Chart Options: This brings up some specific options for the chart type that you are using.
Options vary depending on chart type.

Axis Scale: This allows you to adjust the scale for any value axes. Automatic (best fit)
scaling is used by default.

Axis Elements: This allows you to modify the appearance of the axes and axis labels. Options
here include axis thickness, grid lines, label steps, and data formatting.

Canvas: This allows you to adjust the background canvas size. You can also specify
whether to use scroll bars when the canvas size exceeds the view port.

Data Border: Add a border to data elements (columns, bars, etc).

Data Border Dialog

If you select the Draw border option, the Border thickness, and the Border
color fields will be enabled allowing you to configure the border properties.

The Black border for white area option can be selected even when the Draw
border is disabled. If you do so, a simple black border will be added only
to white data elements.

Column chart with the “Black border for white area” enabled

Note
This option is not available for Surface, Scatter, Line, Bubble,
Box, Radar, Dial, and Polar charts.

Legend: This allows you to modify the display properties of the chart legend.
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Lighting Model: This allows you to modify some of the lighting options for three-dimensional
charts. You can modify both the light ambient color and the intensity.

Line and Point: This allows you to modify the display properties of any lines in a chart.
For two-dimensional charts you can choose to display lines and points for
any dataset as well as customize their appearance. You can also use this
menu item to modify the display properties for any trend, floating, or hori-
zontal/vertical lines.

Plot Area: This option allows you to customize appearance of the area bounded by the
X and Y axes for two-dimensional charts.

No Data To Plot Message: This option allows you to set a message that appears if there is insufficient
data to plot the chart. By default, the “No Data To Plot” message appears.

Flash Hintbox Customization: This option allows you to specify the font properties as well as the border
and background color for the hint box in the flash export.

NULL Data Properties: This option allows you to show any category axis point that contains Null
data and replace it with a different string. By default, any Null data category
point is skipped.

Table: This allows you to add and configure a table displaying the chart data.

Text Properties: This option allows you to set a resize ratio for any text in the chart. From
this option you can also specify to use Java 2D rotate text. This option gives
rotated text a cleaner appearance. You can also specify any text replacement
options.

Viewer Options: This menu item allows you to specify some configuration options for the
Chart Viewer JNLP (More about Applets in JNLP: Section 1.3.4 - Run Ap-
plets in WebStart with JNLP file) when the chart is viewed. You can control
what options are available in the Viewer pop-up menu. These options can
also be controlled through HTML parameters.

4.1.4.1.4. Type Menu
This menu allows you to change the current chart and its dimension. You can switch between 2D and 3D for chart
types that support representations in each dimension. You can also change chart types. Note that as you switch
between chart types, some formatting information will be lost. Also, you cannot switch between Gantt charts and
other chart types.

4.1.4.1.5. Drill-Down Menu
This menu contains options allowing you to add and navigate drill-down layers in a chart. The drill-down features
are explained in Section 4.1.5 - Chart Drill-Down. Note that drill-down is only available (functional) when charts
are deployed independently from reports.

Add: This allows you to add a layer of data drill-down.

Remove This: This removes the current level of data drill-down.

Remove All: This removes all levels of data drill-down.

Previous This navigates to the previous layer of data drill-down.

Next: This navigates to the next layer of data drill-down.

Go To Top Level: This navigates to the top-level chart for data drill-down.

Dynamic: This allows you to enable dynamic data for drill-down.

Parameter Drill-Down: This brings up the parameter drill-down navigation window allowing you to edit,
add, and remove layers of parameter drill-down.
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4.1.4.1.6. Data Menu
This menu contains options that allows you to refresh, re-order or completely change the chart data.

Modify Data Mapping: This will bring back the Data Mapping Window, allowing you to change the
data mapping for the chart.

Modify Data Source: This will take you back to the Data Source Manager, allowing you to select a
new data source for the chart.

Modify Database: If the chart uses an independent data source that is from a database, this feature,
like in Report Designer, will allow you to modify the database connection that
the chart use. For more information about this feature, please see Section 3.1.3.5
- Editing Database Connections.

Modify Query: If the chart uses an independent data source that is from a database, this feature,
like in Report Designer, will allow you to modify the query that retrieves the
chart data. For more information about this feature, please see Section 3.1.3.4
- Editing Queries.

Query Parameters: This will allow you to re-initialize query parameters and change parameter val-
ues for the current chart. This option is only available if the chart uses a para-
meterized query as the data source.

Ordering: This option allows you to re-order the data points in a chart. You can arbitrarily
change the order of any of the category elements or you can sort the categories
by value.

Refresh: This will update the current chart with the latest data. The original data source
must be available for this option to work.

Schedule Refresh: This allows you to set a schedule to refresh the data. This option is for deploying
charts in the Chart Viewer JNLP (More about Applets in JNLP: Section 1.3.4 -
Run Applets in WebStart with JNLP file). You can set a periodic refresh interval
so that the chart will update itself with the latest data.

View Table: This option will bring up a window containing the data table from which the cur-
rent chart is generated. The table will initially display only the first 20 records.
Clicking on the Show All Records checkbox will display all of the records.

View Chart Data: Rather than viewing the entire data table you can just view the data points plot-
ted in the current chart.

View Data Source Info: If the chart contains an independent data source, this option will bring up a
dialog containing information about the data source that was used to create the
chart. The data source type and location are displayed.

Go Back: This will go back to the original chart if you have traversed a link.

4.1.4.1.7. Help Menu
This menu allows you to view a version of the program and to open a documentation.

About: This shows you information about the version of the program.

Contents: This opens the EspressDashboard User's Guide.

4.1.4.1.8. Layout Menu
The options in this menu allow you to toggle various elements in the Chart Designer interface. From this menu you
can turn on and off the font and color panel, the Chart Designer toolbar, and the navigation panel for 3D charts.

4.1.4.2. The Designer Toolbar
The toolbar at the top of the Chart Designer window offers easy access to the Chart Designer's most commonly
used features and functions. The buttons perform the following functions:
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Start a new chart

Open an existing chart

Save the current chart

Export the current chart

Undo the last change

Redo the last undone change

Change data mapping for the current chart

Modify data display properties

Modify chart-specific options

Modify line and point attributes

Change axis scale

Modify axis elements/display properties

Modify legend display

Change data ordering

Insert annotation text

Insert floating line

Add/change background image

Modify/change chart data source

Refresh chart data

Schedule periodic data refresh

4.1.4.3. Color, Color set, Pattern, and Font Panels
The color, color set, and font panels on the right-hand side of the Chart Designer window allow you to modify the
color of any chart object, as well as modify the font size and style for any text/labels in the chart. You can choose

not to display these panels by toggling the Layout → Show font/color panel option.
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For heatmap charts, you can use the Color Panel or Color Set Panel to set the colormap. The Select Axis option
in the Color Set Panel is not applicable to heatmap charts. Additionally, the Pattern Panel does not respond to
heatmap charts.

4.1.4.3.1. Color Panel
You can use the color panel to change the color of any element in the chart. To modify an element's color, first, click
on it. The status bar at the bottom of the Chart Designer window will indicate which element has been currently
selected. After you have selected the object, click on one of the panels in the color panel and the color of the object
will change to reflect the color you selected.

Color Panel

To create a custom color for the object, first select it, then click the More button. This will bring up a new dialog
allowing you to pick a color from a larger palette or to create a new color.

Additional Colors Dialog

From this dialog you can pick a new color from swatches or configure a custom color using HSB values or RGB
values.

4.1.4.3.2. Color Set Panel
The color set panel allows you to choose a color scheme for your chart. It contains predefined color sets that can
be applied to chart data points on the value or the second value axis.
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Color Set Panel

In order to change a color set for the value or the second value axis, first select the Color Set tab. Then select the
axis (Value or 2nd Value) from the Select Axis select box and click the appropriate color set radio button. After
that chart data points will get colors from the selected color set. Note that the Select Axis select box is only visible
when the chart has the second value axis. By default, the value axis uses the first color set while the second value
axis uses the seventh.

Please note that if you change a color of a data point manually, it will automatically unselect the selected color set.
This is because of the color set that no longer corresponds to colors of data points in the chart. It is also important
to note that if chart data points have more different colors than there are colors in the color set, it will automatically
use colors from the beginning of the next color set, and so on. If there is no next color set available, it will use
the first one instead.

4.1.4.3.2.1. Save Colors for Categories feature

Data points colors are closely related to the Save Colors for Categories feature that is available in the Data Prop-

erties dialog. The dialog can be opened by clicking the  Change data properties icon on the toolbar, or by using

Format → Data Properties. (Please note that this feature is not available for Stack charts and it is disabled if the
chart has Single Color for All Categories.) If the feature is turned on, colors of chart data points are assigned to
names of categories (or series for charts with series). If such categories (or series) then appear in the chart, it will
automatically use their assigned colors. If the feature is turned off (default), colors are assigned by data points order
(i.e. the first data point will get the first available color from the color set, the second will get the second color,
etc.). Save Colors for Categories setting is automatically saved in the .pac file. The following example shows
scenarios with the feature on and off:

Assume that a chart has three categories (“A”, “B”, and “C”) with colors taken from the following color set (blue,
green, yellow, red).
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Image 1 - Example Chart

Image 2 - “Save Colors for Categories” Feature On

Image 3 - “Save Colors for Categories” Feature Off

Save Colors for Categories fea-
ture on

We saved the chart with the “Save Colors for Categories” feature enabled
(see Image 1), so the following categories and colors were saved to the list
of saved categories:

category A ... blue color

category B ... green color

category C ... yellow color

Now if you open the chart and data changes (e.g. there will be only categories
A and D in the data - see Image 2), categories will have the following colors:

category A ... blue color (category A has blue color, because the category
name A is present in the list of saved categories)

category D ... red color (category D has the next available color in the
color set, because the category name D isn't present in the list of saved cat-
egories. In this case, the category will have red color, because blue, green,
and yellow colors are already assigned to categories A, B, and C.

For this scenario, the color set will not be selected under the Color Set tab
because colors of data points do not correspond to the color set.

Save Colors for Categories fea-
ture off

Here is the same situation, but assume that the chart has been saved with
the “Save Colors for Categories” feature off (see Image 3). The list of saved
categories will be empty this time.
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After opening the chart, the categories will have the following colors:

category A ... blue color (category A has blue color, as it is the first
available color from the color set)

category D ... green color (category D has the second color from the color
set, because the first is already assigned to the category A)

For this scenario, the color set will be selected under the Color Set tab be-
cause colors of data points correspond to the color set.

4.1.4.3.3. Pattern Panel
Unlike color and font panels, the pattern panel can only be applied to data points. There is a predefined pattern
palette available for you to use. Similarly to how the color panel is used, you will need to first pick the data point
you would like to change and then pick any pattern from the pattern palette. The pattern will be applied to the data
point directly.

If a pattern has already been defined for a data point, the user can still change the color by selecting the color panel
tab and picking a different color from the color palette. The color on the pattern will be changed to the new color
immediately. The patterns shown on the pattern palette will change to the new color as well.

Pattern Example

4.1.4.3.4. Font Panel
You can use the font panel to modify the font, the font style, font size, and the font angle for labels, titles, or other text
in a chart. To modify the font, you must first select the text object whose font you would like to change by clicking
on it. The status bar at the bottom of the Chart Designer window will indicate which is the currently selected object.

Font Panel

The first drop-down box allows you to select the font that you would like to use. The second drop-down box allows
you to select the font style either plain, bold, italic, or bold and italic. The third box allows you to select the font
size. The last box allows you to specify the angle of the text.
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Certain groups of text (i.e. axis labels or data top labels) will all have the same properties. Hence, if you select one
of text and modify the font properties it will apply to all of them.

ChartDesigner allows you to use the Java graphics libraries to give your text a cleaner appearance. For regular text

you can use the chart anti-alias feature by selecting Format → Rendering Options. For rotated text (i.e. text not

a 0 degrees), you can use the Java 2D rotate text feature by selecting Format → Text Properties. Note that these
methods require Java 1.2 or higher.

4.1.4.4. The Navigation Panel
The navigation panel provides options for controlling a number of the properties specific to three-dimensional
charts. It does not appear for two-dimensional charts and it can be hidden for three-dimensional charts by toggling

the Layout → Show Navigation Panel option.

Navigation Panel

There are six controls and five buttons in the Navigation panel. Starting from the left, the six controls are step size,
light position for X, Y and Z axes, navigation, zoom, scale and navigation speed. The buttons on the right control
wire frame/solid mode, on/off border drawing, on/off inline series (for columnar and bar charts with series), on/
off Gouraud shading, and on/off animation.

Step size: This slide bar allows you to set the incremental amount used by the naviga-
tion control to rotate or move the 3D chart. The higher the position of the
horizontal bar, the larger is the increment for each step.

Light position for X, Y, and Z: User-defined light position is useful to control the position of the light and
therefore the direction from which it will shine on each axis.

Navigation: This control allows you to rotate or translate the chart. The center button is a
toggle switch. When it is in a depressed state (denoted by the red color of the
button), clicking on any of the four triangular buttons moves the chart in the
direction indicated by that button. When the center button is in an elevated
state, clicking on any of the four triangular buttons rotates the chart in the
direction indicated by that button. The speed of navigation may be controlled
by the Navigation Speed control.

Zoom: This control allows you to effectively move the chart closer to or farther
away from the viewer. To operate, you point the mouse to the control and
click on the left mouse button. Then, while holding down the button, you
drag the mouse to the left or right. When you drag the mouse to the right,
the red area is extended to the right, and the chart will appear to be closer
to you (zoom in to blow up the chart). When you drag the mouse to the left,
the red area will move to the left, and the chart will appear to move farther
away from you (zoom out to shrink the chart).

Scale: This is a set of four slide bars. The first three bars allow you to change the
scale factors for the X, Y, and Z axes respectively. The fourth bar determines
the thickness of a three-dimensional column, bar, line, or pie (depending
upon the chart type). The higher the position of the horizontal bar, the larger
the value. For two-dimensional charts, you can adjust the bar width for bar,
column, stack bar, stack column, high-low, and HLCO charts by selecting

Format → Data Properties.

Animation speed: This allows you to set the speed for chart navigation. This control is useful
with the Navigation control and the Animation On/Off switch. It determines
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how fast the chart moves or rotates. To operate, click and drag the indicator
needle to the desired position. Moving the indicator needle to the right will
speed up the translation or rotation and moving the needle to the left will
slow it down.

In addition, the five buttons do the following:

Wire frame/ solid mode On/Off:  This toggle switch allows you to view the three-dimensional chart as
a wire frame when the switch is on or as a solid object when the switch is off.

Border Drawing On/Off:  This toggle switch will draw a black outline on each edge of the chart when
the switch is on.

Inline Series On/Off:  This toggle switch will draw the series column in the same XY plane. This option
is only available for columnar and bar charts with a data series and it does not appear on the navigation
panel if the chart type is not applicable.

Gouraud Shading On/Off:  Gouraud shading is a sophisticated and very realistic shading feature for
three-dimensional charts. When the switch is on it will begin rendering the chart to shade each individual
surface.

Animation On/Off:  This toggle switch allows you to start/stop the animation of a three-dimensional
chart. The speed of animation may be set using the Navigation Speed control. During animation, all panel
controls except the animation speed control are disabled.

4.1.4.5. The Viewport
The viewport compromises the central portion of the Chart Designer window. Within the viewport you can select,
move, and size all of the various chart elements on the canvas.

4.1.4.5.1. The Chart Canvas
The chart canvas is the background on which all of the chart elements are drawn. Its dimensions are the size of the

finished chart. You can modify the size of the chart canvas by selection Format → Canvas. This will bring up a
dialog prompting you to specify the new canvas dimensions.

Canvas Formatting Dialog
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You can specify the canvas size in pixels, inches, or centimeters. From this dialog you can also specify when to
use scroll bars in the viewport. By default the viewport will display scroll bars when the canvas is larger than the
window. When the canvas is smaller than the viewport window, a dark gray area will appear around it.

If you're creating an embedded chart in a report, the canvas will resize to match the space that you have defined for
the chart in the Report Designer. For example, if you set the space in the report to be 3 inches by 4 inches, the next
time you edit the chart, the canvas will automatically size to 3 inches by 4 inches.

On this dialog, you can also set up gradient background for the canvas. The gradient settings are the same as in the
Rendering options described in the Section 4.1.4.1.3 - Format Menu.

4.1.4.5.1.1. Background Images

You can add an image as the background of the chart instead of having a plain or a colored canvas.

Radar Chart with Background Image

You can add a background image by selecting Insert → Background or by clicking the  Background button on
the toolbar. This will bring up a dialog allowing you to specify the background image for the chart.
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Add Background Image Dialog

To insert a new image, select the Enable Background Image option. If you want to remove an existing background
image and use simple background color instead, unselect this option.

There are two ways of inserting background images: either locate the image on the hard drive or retrieve it from
an URL.

To locate an image on the hard drive, click on the Browse button.

To retrieve image from an URL, enter the URL in the Image URL text field. After that, click on the Refresh Preview
button to verify the URL. If the image from the URL appears in the Preview section, the URL is correct.

If you add a background image and save the chart as TPL or CHT, the image itself is not stored with the chart.
Only the path or URL is saved. If you move a TPL or CHT chart, you need to be sure that it can still access the
image along the path specified. If you save the chart as PAC, the background image will be stored in the PAC file
along with the chart.

4.1.4.5.2. Moving and Sizing Chart Elements
You can select any element in the chart by clicking on it. The status bar at the bottom of the Chart Designer window
will indicate which object has been currently selected. Clicking and dragging on an object will move it around the
chart canvas. Note that some objects like axis or data top labels move in tandem, while other objects like legends
move independently.

You can move the entire chart plot by clicking in the plot area and dragging the mouse. This will move the entire
chart around the canvas. To resize a chart click the plot area and 8 points will appear in the corners and on the sides
of the plot area. Drag any of those points using the mouse to enlarge or shrink the plot area. You can also resize
three-dimensional charts by using the zoom control in the navigation panel.

4.1.4.6. Adding Chart Elements
In addition to the default chart elements, ChartDesigner provides a number of additional elements that you can
add to a chart.

4.1.4.6.1. Adding Text
There are two ways to add text to a chart: as titles or as plain text elements.

Adding Titles: To add titles to a chart, select Insert → Titles. This will bring up a dialog prompting you
to enter titles for the chart.
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Add Titles Dialog

The dialog allows you to specify a main title for the chart and a title for each of the axes.
Pie and dial charts, which do not have axes, prompt you for the chart title only. After you
have finished specifying the titles click OK and they will be added to the chart. Titles
are placed and sized automatically. However, they can be moved and the fonts can be
changed.

Adding Text:
To add individual text fields to the chart, select Insert → Text or click the  Add Text
button on the toolbar. This will bring up a dialog prompting you to add text to the chart.

Add Text Dialog

From this dialog you can specify the text and configure some display options. You can
specify whether to draw a border around the text or around a background. You can also
specify what effect you want to apply to the background.

On this dialog, you can also set up gradient background for the text label. The gradient
settings are the same as in the Rendering options described in the Section 4.1.4.1.3 -
Format Menu.

Once you have finished specifying the text, click OK. You will then be able to place
the text in the chart. A small rectangle will follow your pointer around the chart canvas.
Click the mouse where you would like to place the text.

Annotation Text: ChartDesigner also supports annotation. Annotation allows you to attach labels or text
fields to a particular element, such as a line or the chart plot. For example, you can
insert a control line showing the maximum value to a chart and attach a text label called
MAX to this control line. Each time the maximum value changes, the label will adjust its
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position along with the control line. For more information about the control lines, please
see Section 4.1.4.6.2.3 - Fixed Horizontal/Vertical Lines.

You can specify text to be annotation in two ways. To attach the text to the chart plot,
select the Attach to Chart option when adding text. To attach the text to a specific object

like a control line, first select the object, and then select Insert → Text or click the 
Add Text button on the toolbar. The option for Attach to selected object will be automat-
ically checked. Leave it checked and any text you add will be automatically attached to
the object.

Add Text (Annotation) Dialog

4.1.4.6.1.1. TextVariables
ChartDesigner allows you to specify certain variables within text that allow for run time substitution based on
certain values/objects in the chart. For example, if your chart uses a parameterized query as the data source, you
could use the &paramInfo variable to display which parameter value(s) were selected at runtime.

Both the insert titles dialog and the add text dialog have a button marked Variables at the bottom. This will bring
up a dialog with a list of variables you can use and it will allow you to select one to add to the title or to the text.

Variables Dialog
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The following text variables are supported:

&drillInfo: This displays which data point is being drilled on for drill-down charts. This
variable does not work for parameter drill-down.

&paramInfo: This displays the parameter value(s) that were selected. You can use this vari-
able instead of &drillInfo for parameter drill-down charts.

&date: This displays the date when the chart was last drawn/redrawn.

&time: This displays the time when the charts were last drawn/redrawn.

&category: This displays the name of the category column.

&series: This displays the name of the data series column.

&sumby: This displays the name of the sum-by column.

&value: This displays the name of the value column

&subvalue: This displays the name of the secondary value column

&xaxis: This displays the name of the column that is mapped to the X-axis. This is
for charts that map a value instead of a category to the X-axis like scatter or
bubble charts.

&yaxis: This displays the name of the column that is mapped to the Y-axis. This is for
scatter, bubble, and surface charts.

&zaxis: This displays the name of the column that is mapped to the Z-axis. This is for
scatter, bubble, and surface charts.

&2ndaxis: This displays the name of the column that is mapped to the 2nd-axis.

&paramInfoName<index>: If the chart contains parameters, this displays the name of the parameter for
the selected index.

&paramInfoValue<index>: If the chart contains parameters, this displays the supplied parameter value for
the selected index.

&<paramName>>: If the chart contains a parameter with this name, this will display the value
selected for that parameter.

4.1.4.6.1.2. Text Replacement

ChartDesigner allows you to overwrite a particular piece of text in a chart. This can be useful if the data source
does not use particularly intuitive column names. Note that this feature will replace all instances of the text. For
example, if you have a column chart without a series that displays a column name for both the X-axis label and the
legend item, you cannot use text replacement to change only the label and not the legend item. The text replacement
feature will also change only whole strings and not instances where there is a partial match.

To use text replacement, select Format → Text Properties. This will bring up a dialog allowing you to specify
replaced text.
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Text Properties Dialog

Please note that when making successive changes to the same text, the original text must be used. For example,
assume you replaced the word “coffee” with “water”. Now if you want to change “water” to “soft drink” the text
replacement should have the original text, which is “coffee” and then “soft drink” as the replacement. To remove
any text replacement, simply replace the original string with itself. Hence, using the same example, you would
replace “coffee” with “coffee”.

You can see a list of all the original text and the replacements by clicking on the List button. This will bring up a
dialog listing all of the text replacement in the chart.

Replaced Text List

From this dialog you can select any of the replaced text and modify or undo the replacement by clicking the buttons
at the bottom of the dialog.

4.1.4.6.1.3. Automatic Text Resizing

ChartDesigner has the ability to automatically adjust the font size of the text in a chart as it is resized. This is useful if
you're using the same chart template to produce a number of charts in different sizes. You can specify a ratio for the

font size to adjust based on changes in the chart canvas. To specify a resize ratio, select Format → Text Properties.
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Text Properties Dialog

The ratio dictates the relative percent that the font should resize in regards to the canvas. For example, say you
resize a chart from 500 x 500 pixels to 250 x 250. With a resize ratio of 1 then text with 12 point font would decrease
to 6 point, decreasing by the same percent as the canvas. However, with a resize ratio of 0.5 the font would decrease
half as much as the canvas so our 12 point font would only decrease to 9 point.

4.1.4.6.1.4. Text Cropping

Long labels or text in a chart can sometimes take up too much space in the chart plot, leaving little room for the
actual chart. For situations like this, ChartDesigner offers a text cropping feature for chart text. Text that is longer
than a user-supplied threshold will be truncated with “...”. The hint box for the chart will show the whole label. To

specify text cropping, select Format → Text Properties.

Text Properties Dialog

To enable text cropping, check the Set Max Display Characters option and specify the maximum character length
in the dialog. Any text longer than the specified number of characters will be truncated.

4.1.4.6.2. Adding Lines
ChartDesigner allows you to add and format a number of different types of lines for charts.

4.1.4.6.2.1. Line and Point Formatting

You can choose to display lines and points for all the data points in the chart for any two dimensional chart type.
Note that some chart types already use this representation (i.e. line or scatter charts).
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Column Chart with Lines and Points Defined

Line and point display is controlled by selecting Format → Line and Point, or click the  Line and Point button
on the toolbar. This will bring up a dialog presenting several options.

Line and Point Dialog

The first three options allow you to specify whether you would like to show lines, points, and a points border for the
chart. For radar charts you also have the option of showing areas. The remaining options allow you to customize
the line and point displays for each element in the data series.

For each data series element, you can specify the point shape that you would like to use. You can also control the
size of the points. The default point size is 0. You can specify point sizes of -1, -2, & -3 which represent sizes of
0.75, 0.5, and 0.25 respectively. At -3 (0.25), the point will be drawn as a dot regardless of the selected point shape.

For lines you can specify the line thickness, as well as customize a dash pattern. The dash pattern is created by
specifying the number of filled pixels and the number of empty pixels (between 0 and 255). The line is then drawn
by dividing into segments - the number of filled pixels followed by the number of empty pixels. Setting 0 for both
will result in a solid line. Setting 255 for both will result in no line being drawn.

The last option allows you to change data point symbol border color to black or darker shade of symbol color.

4.1.4.6.2.2. Floating Lines
Floating lines are free-form lines that can be arbitrarily added to any place on the chart canvas. Often floating lines

are used to point to a specific element in a chart. To add a floating line select Insert → Line, or click the  Insert
Line button on the toolbar.
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When you select this option, your mouse pointer will change to a cross. Click within the chart canvas where you
would like the line to begin. Each additional click will add a point to the line, allowing you to add another segment.
This way you can use floating lines to draw shapes as well. Once you have finished, right-click to stop drawing.
The line will then be added.

Once a line has been placed on the canvas, it cannot be moved individually. It will move with the chart plot, like

annotation text. To specify options for a floating line, first select it, and then select Format → Line and Point or
click the Line and Point button on the toolbar. This will bring up a dialog allowing you to format various properties
for the floating line.

Line and Point Dialog for Floating Lines

The dialog allows you to specify a standard line style or to create a custom dash pattern in the same manner as
line and point formatting. You can also specify the line thickness in pixels. The checkboxes at the bottom of the
dialog allow you to place an arrowhead at the start and/or end of the line, as well as fill the area enclosed by the
line to create a solid shape.

Floating lines can be deleted by selecting them and hitting the delete key.

4.1.4.6.2.3. Fixed Horizontal/Vertical Lines

Fixed horizontal or vertical lines are lines that are drawn on one of the chart axes. These lines can also be drawn
on three-dimensional charts where they appear as planes. There are two types of fixed lines: constant lines and
control lines. Constant lines are lines that are fixed to a certain value in an axis. Control lines are drawn based on
computed values that allow you to spot data points that are outside of certain value ranges. To add either type of
line to a chart, select Horz\Vert Line from the Insert menu. This will bring up a dialog showing the list of existing
horizontal/vertical lines, allowing you to edit the selected line, remove the selected line, and/or create a new line.

Define Horizontal/Vertical Lines Dialog

Clicking on Insert or clicking on Edit when an existing line is selected, respectively, will bring up a dialog allowing
you to configure the selected line.
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Constant Line Dialog

For constant lines you need to specify a label for the line, as well as the numeric value to use for the line. Note that
for the category axis, the data points start with 0.5. You can also specify the line thickness and whether the line is
horizontal or vertical. The last two options allow you to add an item to the chart legend for the line and whether
to display any annotation for the line.

For Gantt charts, there is one extra option called Current Date for Gantt Chart. If you choose this option, the
Constant line value field will deactivate and the current date will be used as the line value (the line position will
be updated every time you run the chart).

For radar charts, the horizontal/vertical option is disabled. Radar charts draw constant/control lines at the same
point around all the chart axes (in a similar manner to the radar grid). In addition, for radar charts, an additional
option named Circular Style is present. By default, lines in radar charts are drawn in a segmented fashion - straight
lines connect the points on each axis. Selecting this option will draw the constant/control as a circle.

Note
If you have not specified any annotation for the line then none will appear if you select the last option.
For more on adding annotation to a chart, please see Section 4.1.4.6.1 - Adding Text.

To add a control line, click on the Control Line tab in the dialog.

Control Line Dialog

For control lines you need to specify which series element you want to compute the value for (this option does
not appear if no series is present) and how to compute the value. Options for control lines are average, minimum,
maximum, and multiples of standard deviation.
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After you have specified all of the options, the line will be added to the chart or the selected line will be changed,

respectively. To edit any of the properties specified in the previous dialogs, you can select Insert → Horz/Vert Line
again and select the line from the list. You can also double-click on the line that you want to modify.

You can change the appearance of fixed lines by first selecting the line and then selecting Format → Line and Point,
or clicking the Line and Point icon on the toolbar. This will bring up a dialog allowing you to customize the line.

Line and Point Dialog for Fixed Lines

This dialog allows you to specify a standard line style or to create a custom dash pattern in the same manner as
line and point formatting.

4.1.4.6.2.4. Trend Lines

A powerful feature of ChartDesigner is the ability to add trend lines to charts. Trend lines can help to show more
details of a chart's data by exposing and highlighting certain trends.

Chart with Trend Lines

To add a trend line to a chart, select Insert → Trendline. This will bring up a dialog showing the list of existing trend
lines, allowing you to edit the selected trend line, remove the selected trend line, and/or create a new trend line.
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Trend Line Options Dialog

Clicking on Insert or clicking on Edit when an existing trend line is selected, respectively, will bring up a dialog
allowing you to configure the selected trend line.

Define Trend Lines Dialog

In this dialog you can specify a label for the line, as well as what element of the data series to base the calculation
on. The following types of trend lines are supported: a polynomial of any degree (please note that a linear trend
line is a polynomial trend line of the 1st degree, i.e. the Polynomial curve order option has to be set to 1 ), a power,
exponential, logarithmic, a moving average, an exponential moving average, an triangular moving average, cubic
B-spline, and a normal distribution curve. For moving averages you will need to specify the average period and for
a polynomial you will need to specify the curve order. You can also specify the thickness of the line and configure
whether a label in legend and the attached text should be shown. In case the chart has data series, you can configure
the trendline for a specific series.

After you have specified all of the options, the trend line will be added to the chart or the selected trend line will
be changed, respectively. To edit any of the properties specified in the previous dialog, you can select 'TrendLine'
from the Insert menu again, and select the line from the list. You can change the appearance of the trend line by

first selecting it, and then selecting Format → Line and Point, or clicking the Line and Point button on the toolbar.
This will bring up a dialog allowing you to customize the lines.
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Line and Point Dialog for Trend Lines

This dialog allows you to create a custom dash pattern in the same manner as line and point formatting.

4.1.4.6.2.4.1. Normal Distribution Curve

A special type of trend line that allows you to draw a normal distribution curve for the data in the chart. In order
to plot a normal distribution curve, the chart must either be a two-dimensional column or bar chart, it cannot have
a data series, and the category should be numeric. Assuming these conditions are met, you can specify a normal
distribution curve as one of the trend line options.

Chart with Normal Distribution Curve

Since the scale for the curve is usually different than the scale for the value axis, the curve is shown on a secondary
axis. You can modify the scale by changing the scale for the secondary axis.

4.1.4.6.3. Adding Control Areas
Control areas are useful for comparing the chart data against a certain range of data. For most two-dimensional
charts, control areas are drawn as filled areas on the chart plot between a range of values on the chart's value axis
and/or category axis. The data points are then drawn over top of the control areas giving you a quick visual reference
to see which data points fall within the designated range. Instead of drawing a background area on the plot, the
control areas can also be shown only where the data points intersect the control area. This feature gives users a clear
visual reference when specific threshold values are reached.



Designing Reports & Charts

309

Two-Dimensional Area Chart with Control Areas

Column Chart with Control Area Drawn for Data Points

A special instance of control areas can be used for dial charts. For dial charts control areas are drawn as arcs on
the face of the dial, allowing you to see if the dial hands (data points) fall within the range. Note that control areas
are not available for radar and pie charts.

Dial Chart with Control Areas



Designing Reports & Charts

310

To add a control area to a chart, select Insert → Control Area. The following dialog will appear showing the list
of existing control areas, allowing you to edit the selected control area, remove the selected control area, and/or
create a new control area.

Control Area List

Clicking on Insert or clicking on Edit when an existing control area is selected, respectively, will bring up a dialog
allowing you to configure the selected control area. If your chart is not a dial chart, the following dialog will open.

Control Area Configuration Dialog

The following options are provided for control areas:

Label: This option allows you to specify a label for the control area.

Absolute Values: This option allows you to specify the scale in absolute values.

Percentage: This option allows you to specify the scale in percentage.

Use Value Axis Scale: This option allows you to specify whether the control area should be bounded
by values on the value axis of the chart.

Value Axis Starting Scale: This is the lower bound for the control area on the value axis.

Value Axis Ending Scale: This is the upper bound for the control area on the value axis.



Designing Reports & Charts

311

Use Category Axis: This option allows you to specify whether the control area should be bounded
by values on the category axis of the chart.

Category Axis Starting Scale: This is the lower bound for the control area on the category axis.

CategoryAxis Ending Scale: This is the upper bound for the control area on the category axis.

Area Depth: This option specifies the depth for any of the appearance styles. If no style
is selected, the depth will have no effect.

Appearance: This option allows you to specify a 3D or shadow effect for the control area.
If the area depth is specified as zero, the appearance will not take effect.

Enable Gradient: Enable color gradient for the control. Gradient settings are described in Sec-
tion 4.1.4.1.3 - Format Menu

Show Label In Legend: This option specifies whether or not to show the control area label in the
chart legend.

Highlight Overlap Area: This option will only show the control area where the data points overlap
the control area boundaries.

If your chart is a dial chart, then a different dialog will appear when you select Insert → Control Area and then
click on the Insert or Edit button.

Control Area Dialog for Dial Charts:

The following options are provided for dial chart control areas:

Label: This option allows you to specify a label for the control area.

Absolute Values: This option allows you to specify the scale in absolute values.

Percentage: This option allows you to specify the scale in percentage.

Starting Scale: This is the value where the control area begins.

Ending Scale: This is the value where the control area ends.

Area Thickness: This option allows you to set the thickness for the control area

Area Offset: This option allows you to specify the offset in pixels from the edge of the dial
chart



Designing Reports & Charts

312

Center X: This sets the X coordinate for the center of the control area. 0 shares the same
center point as the dial face. You can specify a new number (either negative or
positive) pixels to specify an offset position from the center of the dial.

Center Y: This sets the Y coordinate for the center of the control area. It works in the same
way as the previous option.

Show Label in Legend: Specifies whether to show the control area label in the chart legend.

Draw Border: This option allows you to draw a border around the control area.

Show Axis: This option allows you to show or hide the axis for the remaining area not covered
by the control range.

After you have specified all of the options, the control area will be added to the chart or the selected control area
will be changed, respectively. To edit any of the properties specified in the previous dialog, you can select Insert

→ Control Area again, and select the control area from the list. You can also double-click on the control area that
you want to modify.

4.1.4.6.4. Adding Tables
In addition to displaying charts, you can also display a table showing the data points displayed in the chart. The
table can be placed below or to the right of the chart plot.

Chart with Table

To add a table to a chart, or to modify the various display options for a table, select Format → Table. This will
bring up a dialog allowing you to customize various options for the table display.
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Format Table Dialog

From this dialog you can specify whether or not to display the table, as well as what relative position to give the table
either to the bottom or right-hand side of the chart plot. You can also specify a 3D effect for the table and its depth.

The Transpose checkbox allows you to swap the columns and rows of the table. By default, the category elements
are drawn as columns and the data series elements as rows.

The Show Color Symbols option allows you to show/hide color boxes for data series in the table.

Chart table with color boxes

The Alignment options allows you to specify horizontal alignment of the text in the table cells, either left, center,
or right. The alignment can be set for row headers, column headers, and inner table cells.

Note
If there isn't enough room in the chart canvas, not all data points will be displayed in the table. The
table size adjusts with the canvas size and also with the font size in the table cells.

4.1.4.6.5. Adding Hyperlinks
ChartDesigner has an capability to add hyperlinks to any data point in a chart. Links can be specified for either
single data points or multiple elements. Any added hyperlinks will be applied to both the data points on the chart

and to their respective fields on the legend. To add a hyperlink to a chart, select Insert → Link or right-click on
a data point and select Insert Link from the pop-up menu. This will bring up a dialog showing a list of existing
hyperlinks which you can configure, remove, and/or create new ones.
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Insert Link Dialog

Clicking on Insert or clicking on Edit when an existing hyperlink is selected will bring up a dialog allowing you
to configure the selected hyperlink.

Define Link Dialog

The URL field allows you to specify a Web page that you want to link.

The Series and Category drop down menus allows you to select an element in the data series and category elements
for the hyperlink. You can also link to all data series elements or all category elements.

You can specify the Target parameter recognized by HTML when specifying a hyperlink to be attached to a data
point or data series. This can be used to determine whether the new HTML page should open in a new browser
window, in the same browser window, or whether the new page should occupy the same portion of the page as
the current page.

The Hint field allows you to enter text that will pop-up when you move your mouse cursor over a data point. If you
want to create pop-up labels without hyperlinks, you can leave the URL field blank and only specify the hint.

4.1.4.6.5.1. Viewing Hyperlinks

If you specify hyperlinks for charts, they will be active only when the chart is exported to Flash format*. For
most image formats such as PNG, JPG, GIF, etc, an image map file containing information for the link will be
automatically generated when you export the chart. You can insert the image and image map into an HTML file
to view the image with clickable links.

Note
* For Flash export, when the user clicks on the hyperlink, there will likely be a warning message
prompted by Flash saying that there was a potentially unsafe operation. You can turn this warning off
by clicking on settings and adding the chart into the list of trusted locations.
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Export Dialog

4.1.4.7. Formatting Chart Axes
ChartDesigner provides a number of extensive formatting capabilities for the chart axes. Users can customize every-
thing from the axis scale to the way how axis labels should be displayed.

4.1.4.7.1. Axis Scale
By default, the scale of any value axes in the chart is calculated to provide a 'best fit' for the data being plotted.
This is often a useful feature if the data being displayed can change radically. However, you may often want to set

the scale of the axes manually. To modify the axis scale, select Format → Axis Scale, or click the  Axis Scale
button on the toolbar. This will bring up a dialog allowing you to format the scale for any value axes in the chart.

Axis Scale Dialog

The following options are provided:

Automatic: This turns on automatic scaling for the axis. This is the default option.

Manual: This turns on manual scaling, allowing you to set the axis scale to your preference.

Maximum: This is the highest value on the axis scale.

Minimum: This is the lowest value on the axis scale.

Unit: This is the step interval between successive labels.

Add Padding: This will raise the highest value of the axis to create a cushion between the max value
of the data and the top of the chart.
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Best fit: This will automatically place the origin of the chart based on the minimum and max-
imum values of the data.

Origin: This allows you to specify where the X and Y axes should intersect. This is usually
set to zero.

Logarithmic Scale: This option creates a logarithmic scale for the given axis. It's valid only if the axis in
question contains positive values.

Log Base: This allows you to specify the base for the log value.

Show Log Value: This specifies whether to show log values in the axis labels
or not.

The axis scale dialog will have a tab for each axis in the chart. There's a unique option available for secondary
axes which allows you to align the axis scale. It will apply all options from the primary axis to the secondary axis,
giving both axes the exact same scale.

Axis Scale Dialog for Secondary Axis

The axis scale dialog is different for a Gantt chart. You can still select the Automatic option to have the scale
configured automatically or the Manual option to set the scale manually. The Automatic axis scale has a few Auto
Scale Step Options: Auto, Day, Month, Year, and Dynamic. The auto option always finds a best fit. The dynamic
option also finds a best fit, but unlike the auto option, it uses standard step intervals only (for example: 1 month,
1 year etc...). When the Manual axis scale is chosen, the Maximum, Minimum, Unit and Origin are replaced with
Maximum Date, Minimum Date, Scale Step and Origin Date respectively and these new settings take in a Date/
Time (represented by yyyy, MM, dd, hh, mm).
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Axis Scale Dialog for Gantt Chart

4.1.4.7.2. Axis Elements
The appearance properties of the axes and the axis labels are controlled through the axis elements dialog. To invoke

the axis elements dialog, select Format → Axis Elements or click the  Format Value Elements button on the
toolbar. This will bring up the following dialog, allowing you to customize elements in all chart axes. You can also
customize the appearance of dial and pie chart labels from this dialog.

Axis Elements Dialog

A tab will appear in this dialog for each axis in the chart. The dialog allows you to perform the following options.
Note that some options are only available for certain chart types, certain data types, and on certain axes.

Grid thickness: This allows you to specify the thickness of any grid lines along the axis.

Grid step interval: This option allows you to set the grid step interval for any grid lines along
the axis.
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Grid line style: This option allows you to select the grid line style (solid, dotted, dash).

Label rows: This option allows labels to be displayed in alternating rows. This can pre-
vent overlapping. This option is only available for X-axis.

Axis thickness: This option allows you to set the thickness of the axis in pixels. Note that
this setting is applied to all axes in the chart.

Label step interval: This option allows you to set the label step interval for the data. For example,
setting this to 2 will draw the label for every other data point in the chart.

Label interval unit: This option allows you to select the unit to be used when sorting and rep-
resenting time-based data (date, time, or timestamp). Selecting tickers will
use the data as it is read by Chart Designer. You can also select Dynamic
for time-based data and that will choose an appropriate scale (depending on
number of data points and range of data).

Max number of labels: This option allows you to select the maximum number of labels and tickers
displayed on the axis. If the number of labels exceeds the max count, the
label step will be re-calculated.

Ascending/Descending: This option allows you to order and filter time-based data. You can sort the
data in ascending or descending order, as well as specify the starting (or
ending) point for the data.

Show labels: This option allows you to remove or display the labels for each axis.

Show ticker: This option allows you to remove or display the axis tickers.

Draw ticker inward: This option will draw the axis tickers inside the plot area instead of outside
(default).

Show sub-tickers: This feature is only available for the value axis when the axis scale is set
to logarithmic with a log base of 10. This feature will draw interval tickers
(non-uniform) between the points on the value axis.

Show grid: This option allows you to remove or display the grid for each axis.

Grid to front: This option allows you to draw the grid lines on top of the data elements in
the chart. By default the data points are drawn on top of the grid.

Show 2D arrow: This option allows you to remove or display the arrowhead at the end of the
axis. Note that this option applies to all chart axes and it is only available
for two-dimensional charts.

Show axis: This option allows you to remove or display the axis (for two-dimensional
charts) or the wall (for three-dimensional charts).

Show 3D frame: This option allows you to remove or display a frame around the chart. Note
that this option applies to all chart axes and it is only available for three-
dimensional charts.

Label outside plot area: This option sets the labels to be placed outside of the plot area, irrespective
of where the axis is. This feature can be useful for category axis labels if
you're plotting data with both positive and negative values.

Align grid with ticker: This option aligns the grid line with the ticker instead of placing it between
tickers. This places the ticker and the corresponding grid line along the same
line. This option only applies to the category axis of column-type charts.

Swap Y-axis position: This option will swap the primary and secondary value axes. This option can
only be found under the 2nd Axis tab.
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Draw X-axis at top: This option allows the X-axis to be positioned at the top of the chart instead
of the default bottom position. This option is available for two-dimensional
column, bar, scatter, high-low, HLCO, bubble, and Gantt charts.

4.1.4.7.2.1. Axis Label Formatting

The axis elements dialog also allows you to format the appearance of the axis labels, depending on what type of
data is plotted on the axis. The Format Options portion of the dialog contains the label formatting dialog.

Formatting Numeric Data For numeric data there are three primary options for display formatting: lo-
cale-specific fixed point, fixed point, and scientific. Additional options will
be displayed if you click on the Format button.

Numeric Data Format Options

Locale-Specific Fixed Point This will change the format of the da-
ta depending on the locale in which
it is being viewed. Additional for-
matting for this option allows you to
specify whether the data should be
displayed as a number, currency, or
percentage. In addition, you can set
the maximum and minimum number
of integer digits and fraction digits.
Other display attributes will vary de-
pending on locale.

Locale-Specific Formatting Options

Fixed Point: This will keep the data format consis-
tent, regardless of locale. Additional
formatting for this option allows you
to set the number of decimals, round-
ing for digit number, unit symbols,
negative sign position, decimal and
thousands separator, and enable lead-
ing zeros for fractions
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Fixed Point Formatting Options

Scientific: This will display the data in scientif-
ic notation. Additional formatting for
this option allows you to set the num-
ber of decimals.

Scientific Formatting Options

Formatting Date/Time Data For date/time data there are two primary options for display formatting: lo-
cale specific and standard. Additional options will be displayed if you click
on the Format button. The available options will vary depending on the na-
ture of your data. Date, time, and timestamp data will bring up date, time,
and date & time options respectively.

Date/Time Data Format Options

Locale-Specific: This will change the format of the data depend-
ing on the locale in which it is being viewed. Ad-
ditional formatting for this option allows you to
select full, long, medium, or short notations for
date and time information. Other display attribut-
es will vary depending on locale.
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Locale-Specific Formatting Options

Standard: This will keep the data format consistent, regard-
less of locale. Additional formatting for this op-
tion allows you to select year and month displays,
as well as the order in which month, day, and year
information is presented. You can also select the
characters that you want to be used as separators.
Time options allow you to display hours, minutes,
and/or seconds and also to select the separators
between them. For timestamp data, you can select
to display the time before or after the date, as well
as the separator to be used between them.

Standard Formatting Options

Formatting Logical Data: There are five options available for displaying logical or Boolean data: T/F,
True/False, Yes/No, Y/N, and 1/0.
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Logical Data Formatting Options

Any changes you make to the data formatting will take effect after you click on the OK button in the axis elements
dialog. Note that there are no additional formatting options for string data.

4.1.4.8. Formatting Plot/Data Elements
ChartDesigner provides a number of ways to customize and configure the way data points are drawn and annotated
on the chart, as well as the chart plot itself.

4.1.4.8.1. Data Properties
Many of the data display options are controlled through the data properties dialog. From this dialog you can control
the size of bars/columns, set display options for null values, and specify options for data labels. To invoke the data

properties dialog, select Format → Data Properties or click the  Data Properties button on the toolbar. This
will bring up the following dialog:

Data Properties Dialog

This data properties dialog contains the following options:

Column width: This specifies the ratio of the bar/column width with respect to the gap be-
tween successive bars in the chart. Each unit represents 1/10th of the space
between data points. Therefore, entering 9 would leave 10% of the space
between data points blank, while 10 would eliminate all space between bars/
columns. This option only pertains to two-dimensional bar, column, stack
bar, stack column, high-low, HLCO, and Gantt charts. To control the column
thickness in three-dimensional charts, you can use the thickness of shape
slider in the navigation panel.

Show data for nulls: This option will connect lines when null data is present. For example, if you
have three points and the value of point 1 is 4, point 2 is null, and point 3
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is 6, then a line will be drawn from 4 to 6. This option is only available for
line charts and other two-dimensional charts with lines. All other chart types
will not plot null data.

Use dotted lines for nulls: You can use this option to replace the full line with a dotted line. Like the
show data for nulls option, this property is only available for lines.

Draw from end to end: This option allows you to draw two-dimensional line and area charts across
the entire plot area, rather than offsetting to the first and last data points on
the chart.

Show shadow on line: This option allows you to use shading on two-dimensional lines. However,
the line must be thicker more than one pixel.

Show primary: This option will display data top labels for the primary values in the chart.

Show stack section: This option will display individual labels for each stack section for stack bar,
stack column, and stack area charts.

Negative Label Color: This option will display the top labels with a value smaller than that of the
origin in a different color that can be selected using the Color button after
enabling the feature.

Chart with Colored Negative Top Labels

Show secondary: This option will display data top labels for the secondary values in the chart.

Top label position: This option allows you to specify where the data top labels should be drawn.
By default, they are drawn above data points if they are positive and below
data points if they are negative. Other options allows you to draw the labels
to either positive or negative side.

Label Alignment: This option allows you to set the alignment for the data top labels. You can
draw them at the top, bottom, or middle of the data points. In addition, you
can select to draw the label inside the data point at the top or bottom. An
additional option stack charts offers you to set the alignment for stack section
labels.

4.1.4.8.1.1. Data Properties for Heatmap Chart
For heatmap charts, the Data Properties dialog allows users to configure the values displayed in the cells in the
matrix.
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Data Properties for Heatmap Chart

4.1.4.8.2. Date/Time Based Zooming
For charts displaying date or time data on the category axis, ChartDesigner provides a unique feature allowing users
to perform date/time based zooming. Using this feature, you can group the category elements into user-defined
intervals and aggregate the points in each group. You can also filter the data by specifying upper and lower bounds
for the results.

For example, suppose your data contains daily sales volume for the past two years. Using zooming, you could
aggregate the data to look at average volume per month, quarter, or year. Using the upper and lower bounds, you
could narrow the range to look at weekly sales volume within a specific quarter.

Zooming is available for all chart types except scatter, surface, box, dial, polar, radar, bubble, and Gantt.

4.1.4.8.2.1. Adding Zooming
When you create a new chart with date, time, or timestamp data in the category axis, you can specify zooming

options by selecting Format → Time Zooming Options.

Zoom Options Dialog

This dialog allows you to specify a lower and upper bound for the data, as well as the interval by which you would
like to group the data. The scale specified here must be within the maximum and minimum scale specified in the
aggregation options dialog.

This dialog also allows you to preserve a linear scale for the chart. By setting the Linear option to true, the chart
will always display points for the grouped intervals, even if there is no data associated with a particular group. For
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example, say again that you are measuring sales volume over a three month period - April, May, and June. If the
input data has no records for May and you set the Linear option to true, a point will be drawn for May with a value
of zero. If you set the Linear option to false, the data point for April will be immediately followed by June.

You can disable/enable zooming, as well as the lower and upper bound restrictions by using the checkboxes at the
bottom of the dialog.

If you enable zooming (if you check Enable Zooming option), the dialog Aggregate Options will appear, prompting
you to specify aggregation options for the grouped data points.

Aggregation Options Dialog

In this dialog, you can specify the Primary Aggregation, as well as the maximum and minimum scale increments
that can be used when zooming the data. After you have specified your desired options, click on the OK button
to return to zooming options.

Once you have finished specifying all the options, click on the OK button and the zooming will be applied to the
chart.

4.1.4.8.2.2. Zooming In Chart Viewer
When deploying charts using Chart Viewer, end users can perform dynamic zooming. To perform a time-series
zoom in the Chart Viewer, Ctrl+Click on a point on the chart and drag it to another point in the chart. This will
automatically zoom in based on the lower and upper bounds selected using the mouse. The aggregation is performed
according to the options that were set during design time. You can undo the zoom by Ctrl+Right-Click.

The scale interval is chosen automatically, depending on the data and chosen bounds (as long as minimum 2 data
points can be shown). The scale interval can also be changed in the Chart Viewer by pressing Alt+Z. This will
bring up a dialog allowing the user to change the zoom settings.

4.1.4.8.3. Data Ordering
ChartDesigner allows you to change the order of the category and series elements. To modify the ordering, select

Data → Ordering or click the  Change Data Ordering button on the toolbar. This will bring up the following
dialog:

Data Ordering Dialog
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There is an Order By list which contains category element, series element, and an option marked VALUES. You
have the following options for the category and series elements:

DataSource Order: This option turns the ordering off. The categories/series order will depend on the data
source only and will not be altered by the EDAB at all.

Ascending: This option will arrange the categories/series elements in ascending order. For example,
if the category elements are strings, they will be arranged alphabetically.

Descending: This option will arrange the categories/series elements in descending order.

Customize: This option allows you to customize the categories/series order. To customize the order,
select an item from the list of Categories/Series items and then move it upwards or
downwards in the list by clicking on the Up or Down button (the buttons are inactive
until you select the Customize option).

You can also sort the category elements based on their corresponding values. To do this, select the VALUES option
in the data ordering dialog.

Value Data Ordering Dialog

If you choose the VALUES option, the entire dialog changes. From this dialog, you can specify to sort the category
elements based on their corresponding values in the value, or secondary value axis. You can also specify whether
to sort them in ascending or descending order. This type of ordering is called a Pareto chart and is often used in
process control applications.

Pareto Chart
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Please note that any sorting set will be re-applied if the chart is refreshed and/or if the data changes.

4.1.4.8.3.1. Top/Bottom N Charts

Sometimes you want to plot only a few highest or lowest values. To do that, you can use the Top/Bottom N function.

To enable this feature, choose Data → Ordering, or click the  Change Data Ordering button on the toolbar.

If the chart doesn't have any data series, the Ordering dialog will show the Limit Number Of DataPoints option.

This option can only be enabled if you sort the chart by categories or values, or by the values in ascending or
descending order. If you have such chart, you can enable this function by selecting the Show first option. Then you
can specify the maximum number of items that will be shown in the chart. If the data source returns more items
than you specify in this option, excessive items will not be shown in the chart as if they didn't exist.

4.1.4.8.4. Histograms
Histogram is a useful analysis tool that allows you to track how often events occur and when and how a set of data
falls into specific ranges. ChartDesigner allows you to plot histograms based on the category elements in a chart.
You can plot histograms for all category data types except time-based data (date, time, or timestamp).

Histograms are calculated by counting data points or instances of each category element. For numeric categories,
you can further specify upper and lower bounds, as well as the number of bins or bin width to create ranges for
the frequency counts.

To create a histogram, you must start with a 2D column chart, bar chart, line chart or area chart. In the Data Mapping
dialog, make sure DataSeries is set to None and the field you want to plot in the histogram is set in the Category axis.

Once you click Done in the Data Mapping dialog and the chart is shown on the canvas, select Format → Histogram
Options. A dialog will appear allowing you to select a histogram plot. By default, the histogram is displayed as
frequency count. You can choose to change it to display probability by checking the Show probability check box.

Select Histogram Dialog

If the values in the Category axis is numeric, you will see that the Options button is enabled. When you click Options
button, another dialog will appear, allowing you to specify options for the histogram plot.
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Histogram Options Dialog

From this dialog, you can set a lower or upper bound for that data being plotted. When you place bound restrictions,
the histogram will not count data that falls outside of the range specified by the upper and lower bounds. If you
select Enable Bins, you can specify the number of bins or set width of each bin. The default number of bins is 10.
You can also click Use suggested Number of Bins if you wish to use a value calculated by the system. If Enable Bins
is deselected, the frequency count will be performed on each Category value instead of a range of values for a bin.

If you enable scale, you can specify the number of bins or set width of each bin.

4.1.4.8.5. Formatting Plot Area
The plot area is the plane on which the data points are drawn for two-dimensional charts. You can customize the

appearance of the plot area by selecting Format → Plot Area. Assuming the current chart is a two-dimensional
chart, the following dialog will appear.

Plot Area Dialog

This dialog allows you to draw a border around the plot area, or fill it with a background color. If you fill the area,
you can also specify certain 3D effects like raising, lowering or shadow.

On this dialog, you can also set up gradient background for the plot area. The gradient settings are the same as in
the Rendering options described in the Section 4.1.4.1.3 - Format Menu.

4.1.4.8.6. Formatting Chart Legend

You can control and modify the display of the chart legend either by selecting Format → Legend, or by clicking on

the  Format Legend button on the toolbar, or by selecting Legend properties from legend pop-up menu (which
pops up when you right-click on the legend). This will bring up the following dialog, allowing you to customize
the legend properties.
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Format Legend Dialog

The dialog contains the following options:

Display: These options allow you to turn on or off the legend border and background. This also allows you
to display the point symbols instead of lines or blocks in the legend.

Effect: This allows you to add a 3D effect to the legend. You can raise it, lower it, or draw a shadow. In
addition to the 3D effects, you can also display the legend with cut corners.

Layout: This allows you to change the legend from vertical, horizontal, square, or fixed column layout.

Gradient: Allows you to configure gradient for the legend background. The gradient settings are the same as
in the Rendering options described in the Section 4.1.4.1.3 - Format Menu.

Other: This allows you to choose whether or not to display the legend, or to draw the legend in reverse
order. You can set the fixed number of columns in legend in the Number of columns field. This
field will be active only if you choose the Fixed columns layout option in the Layout section. You
can set trend/control lines and chart data legend drawn as One Legend Set. You can also change
the size of the symbols in the legend.

Additionally, you can remove specific category/series elements from the legend by clicking on the Hide button.
This will bring up a list of the legend items, where you can select which elements you would like to hide.

The legend for heatmap charts differs from those of other charts, and some legend options in the Legend dialog are
not applicable to heatmap charts. By default, the legend for heatmap charts is displayed vertically.

Heatmap Vertical Legend

In the horizontal layout, you can choose to display tickers and labels below the legend by selecting the Labels
Below option.
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Heatmap Horizontal Legend

4.1.4.8.7. 3D Display Options
ChartDesigner renders three-dimensional charts in true 3D, allowing light source modification, panning, zooming,
and rotation. However, 3D rendering can be very memory and CPU intensive. When charts have a lot of data points
(like 3D scatter and surface charts), it's possible to run out of memory when generating the chart. To solve this
problem, a rendering approximation feature is provided. Using this algorithm the chart is not rendered perfectly,
but it's usually acceptable when a lot of points have to be shown.

By default, approximation is turned on at a threshold value of 100 points. This means that if a 3D chart has more
than 100 data points, the approximation will be used. You can turn this feature off, or change the threshold value

by selecting Format → 3D Display Options. This will bring up the following dialog.

3D Display Options Dialog

The two options for 3D approximation allows you to turn on/off the approximation and set the threshold value. The
other option in this dialog allows you to draw the series in-line (the same option is in navigation panel).

4.1.4.8.8. Data Border
For column, bar, stack column, stack bar and HLCO charts, ChartDesigner allows you to configure a border around

the columns. To set the border option, select Format → Data Border. This will bring up a dialog allowing you to
set border options.
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IData Border Dialog

The first option allows you to turn on/off the data border. The second option allows you to set a black border for
any white areas in the chart. Please note that the border is black only if the first option is unchecked and will only
appear around white areas in the chart. The third and fourth options allows you to set border thickness and border
color. If you click on the Click button, a new dialog will appear allowing you to select or enter a new color.

For heatmap charts, you can configure a border around the data rectangles. This is particularly useful when there
are many light-colored cells.

Heatmap Data Border

The following is an example heatmap chart with border thickness set to one.
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Heatmap chart with light gray colored border

4.1.4.8.9. Aggregation
ChartDesigner allows you to aggregate data if there is more than one data point associated to a given category (and
its series and/or stack, if a series and/or stack is present). This allows for a broader look at the data rather than just
a single data point (out of many).

To aggregate the data, select Format → Aggregation Options. A dialog will appear allowing you to enable aggre-
gation.

Select Aggregation Dialog

When you select Enable Aggregation, a second dialog box will appear, asking you which type of aggregation should
be applied. You can choose from minimum, maximum, average, sum, count, first, last, sumsquare, variance, stddev,
and countdistinct for the aggregates. You can specify a primary aggregate (aggregate applied to the column mapped
to the primary axis) as well a secondary aggregate (aggregate applied to the column mapped to the secondary axis),
if a secondary axis exists.

Aggregate Options Dialog

For heatmap charts, the aggregation option can be used when there are multiple data values at a single (x, y) point.



Designing Reports & Charts

333

Aggregate Options

By default, no aggregation is applied to heatmap charts, and the first data value is always selected if there are
multiple values at the same (x, y) point.

4.1.4.9. Chart-Specific Options
There are a number of formatting options that are unique to certain chart types. These options can be modified by

selecting Format → Chart Options, or clicking the  Chart Options button on the toolbar. This will bring up a
dialog that varies depending on the type of the current chart. Some chart types have no additional options.

4.1.4.9.1. Bubble Charts
For bubble charts, the following dialog is displayed:

Bubble Options Dialog

The following options are available for bubble charts:

x-axis unit length: radius This option specifies the ratio of X-axis unit length to the radius of the bub-
ble.

Fill Bubble: This option allows you to specify whether or not to fill the bubble area.

Draw Border: This option allows you to specify whether or not to draw a border around
the bubbles.

3D Shading: This option allows you to add 3D shading to the bubbles. You can also spec-
ify the light intensity for the shading.
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Bubble Chart with 3D Shading

4.1.4.9.2. Dial Charts
For dial charts, the following dialog is displayed.

Dial Options Dialog

The following options are available for dial charts:

Starting Angle: This option specifies the angle where the first axis label is to be set. This
property also determines where the border and dial area will start if the Draw
Full Circle option is unchecked. The angle is represented in degrees and is
0 by default. Assuming the dial chart is a clock face, 0 degrees is 12 o'clock.

Ending Angle: This option specifies the angle where the last axis label should be set. This
property also determines where the border and dial area will end if the Draw
Full Circle option is unchecked. The angle is represented in degrees and is
360 by default. Hence by default the labels (and data points) encompass the
entire circumference of the dial.

Center Point Radius: This option specifies the radius for an inner circle, which starts from the
center of the dial chart. The radius is specified as a ratio to the radius of the
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dial plot. Hence, a value of 1 will make the inner circle encompass the entire
dial. If the Draw Full Circle option is unchecked, only the portion of the
center point that is within the starting and ending angles will be shown.

Dial Chart with Center Point Radius

Needle Style: This option specifies the type of needle to draw.

The Pointed Blade is a smooth line with a thick base. It be-
comes slightly thinner as it extends outwards, but finishes
with a very sharp pointed tip.

The Round Headed Blade is similar to the Pointed Blade ex-
cept for a round tip.

The Triangular Pointer is sharp and resembles a very thin tri-
angle.

The Pointer is a step ladder pointer with three segments.

The Rectangular Pointer (as shown above on the picture) is
a simple straight needle.

Default needle is Pointed Blade.

Draw Border: This option specifies whether or not to draw a border around the dial.

Draw Arrow: This option specifies whether or not to draw arrowheads at the end of the
dial hands.

Draw Full Circle: This option specifies whether to draw the dial as a complete circle (360 de-
grees) or only draw the portion of the circle determined by the starting and
ending angles.

Needle Length and Thickness: This option specifies the length and thickness of the needle. The needle
length is measured from the center of the dial. The range is from 0 (center
of the dial) to 1 (the end of the dial). The thickness determines the width of
the needle, larger values results in a wider pointer. When creating a chart,
the needle length is randomly generated. Default thickness is 2. Each cat-
egory element is represented by a different needle. You can either change
properties individually or change multiple categories at once. To change the
property of each needle individually, directly change the values to the right
of the category. To make changes to multiple needles, check each category
or check the Select All option, set the properties in the lower right corner
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and then click on the Apply Now button for each property changed. This will
modify all checked categories to new values.

4.1.4.9.2.1. Gauge Images
Dial charts have an additional option to display a foreground or background image for the dial plot area. To add a

foreground or background image, select Insert → Dial Foreground... or Insert → Dial Background.... These options
are only enabled for dial charts.

Dial Chart Background Image Dialog

Selecting an image works in the same way as the background image dialog, see Section 4.1.4.5.1.1 - Background
Images. In the dial chart image dialog, there is also an option to specify the radius of the image. Specifying 1 for
the radius will make the image the same width and height as the plot area. Increasing or decreasing this value will
enlarge or shrink the images.

4.1.4.9.3. Overlay Charts
For overlay charts, the following dialog is displayed:

Overlay Options Dialog

From this dialog, you can specify which chart type you would like to use for each element of the data series.
Available chart types for the series elements in an overlay chart are column, area, and line. You can also choose
not to display certain series elements.

From this dialog, you can also specify which axis you would like to use to plot a series element. You can place
elements on the primary or secondary axes, or you can create new value axes for the series elements. To create a
new value axis, select New Axis from the drop-down menu. Once you specify to use a new axis, a new option will
be added to the drop-down menus for the other data series elements, allowing them to be drawn on the same axis
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that you previously specified. Using a variety of axes allows you to precisely tune the scale that the different series
elements use. Each of these axes will have its own tab in the Axis Elements window, where you can change the
label step interval for each axis independently of the others.

Axis Options Dialog for Multiple Value Axes

Overlay Chart with Multiple Value Axes

If one of the chart types used by the overlay chart is a line, you can specify whether or not to draw the line as a step
line using the Combo Line tab. For more about step lines see Section 4.1.4.9.5 - Line Charts:



Designing Reports & Charts

338

Combo Line Options for Overlay Charts

4.1.4.9.4. Pie Charts
For pie charts, the following dialog is displayed. (Note that different options will appear/disappear depending on
whether the chart has a series, and if it's a 2D or 3D chart.) Here are the options available for a 2D chart with series:

Pie Options Dialog (With Series)

Here are the options available for a 2D chart without series. Notice that the formation options are removed and the
% in legend and Value in legend options are added:
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Pie Options Dialog (Without Series)

The following options are available for pie charts:

Explode: This option allows you to pick one or more category/series elements whose
sections are to be drawn at a certain distance away from the center of the pie.

Sector Gap: This option allows you to pick one or more category/series elements whose
sections are drawn at a certain distance away from the center of the pie and
still maintain the same distance between pie slices and a circular boundary.

Distance from origin: This option allows you to specify how far the exploded/sector gap sections
are to be drawn away from the center. This number, represented as a per-
centage of the radius, indicates the distance between the center and the tip
of the pie slice to be exported.

Rotate pie: This option allows you to specify the number of degrees that the chart should
be rotated in a clockwise direction. Available values are between 0 and 360

Place label: This option indicates the distance of the labels from the center of the pie.
The position of an individual label can also be adjusted by dragging the text.

“Others” % Threshold: This feature is useful for pie charts that have a large number of small cate-
gories. Rather than draw a slice for each category, users can select a thresh-
old value. Any category whose percentage of the value column is less than
the threshold value will be lumped into an “Others” slice.

Display Name for “Others”: This option allows you to set the display name for the “Others” slice that is
created for categories that fall below the supplied threshold value. This label
will appear in the legend, and/or for the slice label.

Label: This option determines whether a category/series label should be drawn for
each pie slice. By default, these only appear as legend items. Note that the
label will not appear if the data for the slice is 0 or null.

Value: This option allows you to specify whether to display the actual value of each
pie slice. Note that the value will not appear if the data for the slice is 0 or
null.

Category: This option allows you to specify whether to display the category of each
pie slice.
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Percentage: This option allows you to display the percentage for each pie slice. The per-
centages are calculated by dividing the value of each section by the sum of
all the values. Note that the percentage will not appear if the data for the
slice is 0 or null.

% in legend: This option allows you to display the percentage represented by each slice
in the pie in the legend. This can be a preferable presentation if the pie slices
become too thin. This option is only available if the pie chart does not have
a data series.

Value in legend: This option allows you to display the value represented by each slice in the
pie in the legend. This can be a preferable presentation if the pie slices be-
come too thin. This option is only available if the pie chart does not have
a data series.

Border: This option specifies whether to draw a border around each pie slice. This
option is only available for two-dimensional pie charts. For three-dimension-
al pies, you can use the border drawing option on the navigation panel. Note
that the border will not appear if the data for the slice is 0 or null.

Slice-to-Label Line: This option will draw a line from any label(s) to it's corresponding pie slice.
Note that the slice-to-label line will not appear if the data for the slice is 0
or null.

Label at the Side: This option will place labels for the pie chart away from the plot around the
outside of the chart. When used with the Slick-to-Label Line option, it gives
users a way to display the pie labels for charts with many small categories
without any text overlapping. Note that the label will not appear if the data
for the slice is 0 or null.

Pie Chart with Side Labels and Lines

Best Fit: This option will arrange multiple pies in best configuration to fit the chart
canvas. It's only available for pies with data series.

Draw Linearly: This option will arrange multiple pies in a straight horizontal line. It's only
available for pies with data series.

Number of Pies Per Row: This option allows you to create a custom arrangement of multiple pies, by
specifying the number of pies to draw in each row of the arrangement.
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Gap between pies: This option allows you to specify the gap between the multiple pies. The
number is a multiple of the pie radius, so the gap will adjust with the size
of the chart plot.

4.1.4.9.5. Line Charts:
For two-dimensional line charts, one of two different dialogs will be displayed depending on whether the chart has
a data series or not. If the chart has a data series then the following dialog is displayed.

Line Options Dialog (with series)

Line charts with data series have a specific option that allows you to draw drop bars between two series elements.
The dialog options are as follows:

Series A: This option specifies the first series element for the drop bar.

Series B: This option specifies the second series element for the drop bar.

Draw Drop Bar: This option specifies whether or not to draw drop bars.

Draw Border: This option specifies whether or not to draw a border around drop bars.

Set Layout: This option specifies whether to draw a line chart in vertical or horizontal orientation.

Step Line: This option allows you to draw line chart as a step line. You can also specify the step line
ratio to use.

Line Chart with Drop Bars
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Note that the color of the drop bar will vary depending on which series has the higher value
for a given point. If the line chart does not have a series, then the following dialog will
appear.

Line Options Dialog (without series)

The dialog options are as follows:

Set Points Uniform: This option specifies whether the point shapes and colors
are uniform or not. Un-checking this option allows you to
set multiple colors and point shapes for the data points. The
points can be customized in the line and point dialog.

Set Layout: This option specifies whether to draw the line chart in verti-
cal or horizontal orientation.

Step Line: This option allows you to draw the line chart as a step line.
You can also specify the step line ratio to use.

Line Chart with Step Lines

The step line ratio allows you to specify how far between
points the horizontal portion of the step line should be
drawn. A ratio of 1 draws the line horizontally to the next
point on the chart and then draws vertically to that point,
while a ratio of 0.5 draws the horizontal portion halfway be-
tween the two points. A ratio of 0 will result in the vertical
portion of the line drawn first and then connect to the next
point horizontally. Values for the ration are between 0 and 1.

There are no additional options for three-dimensional line charts.
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4.1.4.9.5.1. Double Value Line Charts

ChartDesigner contains a special option for line charts that allows you to have two values shown for the same line.
Here the secondary axis is used to plot the second value (as in a line-line combination) and then combined with
the line on the primary axis.

Double Value Line Chart

To create a double value line chart, design a line-line combination chart (a line chart with primary and secondary

values). Then select Format → Axis Elements. This will bring up the axis elements dialog.

Axis Elements Dialog for Line-Line Combination Charts

Under the 2nd Axis tab, there is a checkbox marked Show using primary axis. Check this box and click on the OK
button. Your chart will now be drawn as a double value line chart.

4.1.4.9.6. HLCO Charts
For HLCO charts, the following dialog is displayed:
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HLCO Options Dialog

The Show Hi-Low As Candle Stick option will turn the HLCO chart into a candle representation. A candle HLCO
chart blends high, low, close, and open data into a single object that resembles a candlestick.

HLCO Candlestick Chart

4.1.4.9.7. Box Charts
For box charts, the following dialog is displayed:

Box Options Dialog

This dialog allows you to specify whether to display the box chart in a horizontal or vertical orientation.

4.1.4.9.8. Stack Area Charts
For stack area charts, the following dialog is displayed:
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Stack Area Options Dialog

You can choose to hide any of the stacks in the chart by clicking on the corresponding check box. The Combo Line
tab allows you to specify step lines if the chart is a line stack area combination. There are no additional options
for three-dimensional stack area charts.

4.1.4.9.9. Gantt Charts
For Gantt charts, the following dialog is displayed:

Gantt Options Dialog

The following options are available for Gantt charts:

Draw Arrows: This option will draw connecting arrows between category elements of the
Gantt chart. This allows you to illustrate a sequence between scheduled
events. The arrows are drawn in the order the category elements appear in
the data source.

Gantt Chart with Arrows

Display X-Axis in Time: This option shows the ticker labels as time values instead of numeric values
for the X-axis.
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Display X-Axis in Day of Week: This option shows the ticker labels as days of the week with the date for each
Sunday shown as well.

4.1.4.9.10. Radar Charts
For radar charts, the following dialog is displayed:

Radar Options Dialog

By default, the scale is same for all axes in the radar chart. Unchecking the Synchronize All Axes option will allow
each axis in the radar chart to be scaled independently. You can select to use auto-scaling for each axis, or you can
set the scales manually by invoking the axis scale dialog.

The second option allows you to set how the grid is drawn for the radar chart. By default, if the grid is enabled, it
is drawn in straight lines that connect the tickers on each axis. Enabling the Draw Circular Grid option will draw
the grid in a circle, similar to the polar chart grid.

The third option allows you to specify a cut-off point for the data points (areas) in the radar chart. You can enter a
maximum value that should be shown in the chart. The areas bounded by the data points will not be drawn beyond
the specified cut-off point.

4.1.4.9.11. Scatter Charts
For scatter charts, the following dialog is displayed:

Scatter Options Dialog

The Combo Line tab allows you to set Draw Lines In Data Source Order, Draw Arrows on lines or Draw the
connecting lines as a Step Lines, as well as specify the step lines ratio.

The Cut Off Point tab allows you to specify a maximum value for the Y point of the scatter coordinates. Any
coordinates that fall beyond this threshold will not be plotted. Connecting lines will draw up to the edge of the
threshold and continue to the next data point.

4.1.4.9.12. Polar Charts
For polar charts, the following dialog is displayed:
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Polar Options Dialog

Scale: This option allows you to specify whether the input data for the angle (θ) portion of
the data points is in radians or degrees. The chart will always display angles from 0
to 360. If the input data is in radians, it will be displayed as degrees.

Direction This option allows you to specify whether the circular plot should be drawn clockwise
or counter-clockwise.

Start Angle: By default, the top of the polar chart plot is 0 degrees. This option allows you to
specify a different angle for the top of the plot. The argument for this angle is supplied
in degrees or radians, depending on the scale you have chosen.

Number of Sectors: This option allows you to select number of sectors you'd like to show in the chart.
Sectors are created by drawing additional polar axis lines at specified angle intervals.
By default, four sectors are shown.

4.1.4.9.13. Column Charts with Series
For column charts with data series, the following dialog is displayed:

Column Options Dialog

Normally, when column charts have data series, each series has it's own color that is applied for every category
in the chart. If you want to assign different colors to the columns in the chart regardless of the series, you can
enable the Unique Color Column option in this dialog. When it's turned on, you can set color for each column in
the chart individually.

4.1.4.9.14. Column/Bar Charts without Series
For column/bar charts without data series, the following dialog is displayed:
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Column/Bar Options Dialog

Normally, when column/bar charts don't have data series, all categories in the chart have single color. If you want
to assign different colors to the categories in the chart, uncheck the Single Color For All Categories option in this
dialog.

4.1.4.9.15. Two-Dimensional Line Combination Charts
For any other two-dimensional line combination chart, the following dialog is displayed:

Line Combination Chart Options

This dialog allows you to specify whether to draw the combo line as a step line, as well as specify the step line ratio.

4.1.4.9.16. Doughnut Charts
The chart options for a doughnut chart are almost exactly the same as the options for a pie chart. You can refer to
the options under Section 4.1.4.9.4 - Pie Charts for more details.

Doughnut Chart Options

The only option unique to doughnut charts is the Arc Length Ratio (%) which specifies the size of the hole at the
center of the chart. A higher number results in a smaller hole.
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4.1.5. Chart Drill-Down
Like with reports, it is also possible to add layers of drill-downs to charts. All of the drill-downs added will be
applied to both data points on the plot area and their respective fields in the legend. Using chart drill-down, you
can create a top-level chart that displays summarized data and allows users to click through specific data points
to see underlying details.

The charting engine in EDAB contains several different built-in drill-down mechanisms that allows you to create
only one chart template for each level of drill-down. All of the drill-down options are available from the Drill-
Down menu in Chart Designer.

Warning
It is important to note that you can only use drill-downs in charts when the chart is deployed inde-
pendently from the report (in the Chart Viewer, its own servlet, etc). If a chart template that includes
drill-down is placed in a report, only the top-level chart will display. Users will not be able to click
through to the lower-level charts.

4.1.5.1. Data Drill-Down
Data drill-down allows you to group and display information that is based on a single data source. The advantage
to this form of drill-down is that it works with any data source. However, it does not allow you to display loosely
related information because all levels of drill-down will share the same value column from the input data.

For example, assume you have the following table as the chart data:

Category Product Sales

Chairs Elm Arm
Chair

$8,216

Chairs Pine Side
Chair

$7,611

Chairs Redwood
Arm Chair

$8,625

Tables Elm Round
Table

$10,241

Tables Pine Oval
Table

$9,663

Tables Oak Oval
Table

$11,261

Dressers Oak Sin-
gle Dresser

$16,442

Dressers Elm Dou-
ble Dresser

$17,148

Using this data, you could create a top-level chart that displays total sales for each distinct product category and
then create a lower-level chart that shows individual sales for each product in a category. The number of drill-down
levels available depends on the number of groupings that are present in the input data.

4.1.5.1.1. Adding Data Drill-Down
To add layers of data drill-down to a chart, you must first create a top-level chart. In the above example, we would
create a chart with “Category” mapped to the category axis and “Sales” mapped to the value axis. In a column
chart, it would look like this:
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Top-Level Chart

To add a layer of drill-down, select Drill-Down → Add. This will bring up a dialog prompting you to specify
the aggregation you want to use for the value axis. For example, selecting sum will display the total for each
category in the top-level chart. Available aggregate functions are minimum, maximum, average, sum, count, first,
last, sumsquare, variance, stddev, and countdistinct.

Aggregation Dialog

After you select the aggregation you want to use, click on the OK button. A new dialog will appear prompting you
to specify a name for the drill-down chart. This name will be assigned to the chart templates that are created by the
drill-down process. Note that all sub-level drill-down templates are saved in the /drilltemplates/ directory.

Drill-Down Name Dialog

Once you have specified a name you want to use, click on the OK button. You will then be prompted to specify
the chart type and data mapping for the sub-level chart.
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Data Drill-Down Mapping Dialog

The options in the dialog are similar to those for normal data mapping. The major difference is that the first option
allows you to select a chart type. Available chart types for data drill-down are column, bar, line, stack column,
stack bar, pie, area, doughnut, overlay, radar, and dial. The data mapping options will change depending on the
type of chart that you select.

Once you have finished specifying the mapping options, click on the Done button and you will go back to the Chart
Designer where you can customize and modify your sub-level chart. You can add additional layers of drill-down

by selecting Drill-Down → Add again.

You can navigate to a particular drill-down chart by selecting Drill-Down → Previous or Drill-Down → Next or
by double clicking a data point. The Previous selection takes you up a level, while the Next selection goes down
a level using the left-most category as the data to be drilled on. You can also go from any drill-down chart to the

top-level chart by selecting Drill-Down → Go To Top Level. You can customize (i.e. assign colors, add title, axis
labels, background image, ...etc.) the drill-down chart in the same way as the top-level chart. Everytime you change
and leave a level, you will be prompted to save the chart. Make sure that you answer yes if you want the attributes
of the drill-down level to be saved, otherwise you will you lose all the changes.

You can insert a drill-down chart between two other drill-down charts by going to the higher level drill-down chart

and selecting Drill-Down → Add. The drill-down chart that you create will be inserted between the two previous
drill-down charts.

You can remove a level of the drill-down by navigating to that level and selecting Drill-Down → Remove This.

The entire drill-down chart can also be deleted by selecting Drill-Down → Remove All. Selecting Drill-Down →
Previous brings the drill-down chart to a higher level, which is the same as right clicking and selecting Back from
the pop-up menu. The Next selection brings the drill-down chart to a lower level, which has the same function as
double clicking on an item in the chart.

Once you have finished creating and editing all the levels of the drill-down chart, you can save it by navigating to

the top-level chart and selecting File → Save or File → Save as.

4.1.5.2. Dynamic Data Drill-Down
Usually, mapping and drill options for data drill-drown are fixed during design time. Dynamic drill-down is an
additional option that allows you to select the mapping. The only thing specified during design time is the top-
level chart and aggregation.

To create a chart with dynamic drill-down, first create a chart you want to use as the top-level chart (for example,

you can create the same top-level chart as before) a then select Drill-Down → Dynamic. A dialog will appear
allowing you to enable dynamic drill-down.
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Enable Dynamic Drill-Down Dialog

Check the Enable Dynamic Drill-Down box and a new dialog will pop-up prompting you to select the aggregation.

Aggregation Dialog

Options for this dialog are the same as for regular data drill-down. Once you specify the aggregate you want to
use, click on the OK button. Another dialog will pop-up, allowing you to specify a template you want to use for
the sub-level charts.

Select Dynamic Drill-Down Template Dialog

If you do not select to use a template, the sub-level charts will be generated using default appearance properties.
After you finish selecting these options, your chart will change to display aggregated data on the value axis. You

can change the option by selecting Drill-Down → Dynamic again and then clicking on the Advanced button.

Dynamic drill-down charts can only be viewed in the Chart Viewer JNLP (More about Applets in JNLP: Sec-
tion 1.3.4 - Run Applets in WebStart with JNLP file). There you can configure setting of the next drill-down chart
by right clicking on the desktop area which will bring up a pop-up menu. If the dynamic drill-down is enabled and
the chart still has some unused fields (columns) to plot, the item Drill-Down will be displayed in the pop-up menu.
Upon selecting Drill-Down in the pop-up menu, you can view the current setting for next drill-down. If Category
is None, it means you have not configured the next drill-down chart yet. To configure the drill-down chart for next
level, you must select Category (Type, Series and SumBy can be selected once Category has been set). After you
create a drill-down chart, you can navigate to different levels in the Chart Viewer by either left clicking on a data
point if you want to go down one level, or by right clicking and selecting Back from the pop-up menu if you want
to go up one level, or by repeating the previous step to create another drill-down chart for next level.

Tip
After traversing to a lower-level of drill-down, right clicking on a data point will navigate you back
to the top-level chart. To bring up the pop-up menu, right click on the chart canvas away from the
chart data points.
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Dynamic Data Drill-Down in Chart Viewer

4.1.5.3. Parameter Drill-Down
The third type of a drill-down you can use for charts is a parameter drill-down. Parameter drill-down is the most
flexible implementation because you can relate the data between drill-down levels in any way you like. Specifically,
you do not need to use the same value element for each level. Instead, parameter drill-down uses parameterized
query feature to relate various chart levels and since it uses queries, the data source for the sub-level charts must
be a database or parameterized class file.

For example, using our previous scenario, rather than always looking at sales, you want your top level chart to look
at aggregated sales by category (same as before), then on the next level, you want to look at sales volume for each
product, and from there, you want to look at inventory levels for each product by region. This can be accomplished
with parameter drill-down.

With parameter drill-down, the category value of an element you click to drill on will be passed to the sub-level
chart as the parameter value. Hence, if you click on the “Chairs” column, the value of “Chairs” would be passed to
the query. Therefore, anything in the database that could be filtered by category name could be retrieved.

4.1.5.3.1. Adding Parameter Drill-Down
To add and edit various layers of a parameter drill-down, select Drill-Down → Parameter Drill-Down. This will
bring up a navigation window that shows various levels of drill-down.

Parameter Drill-Down Navigation Window

Left-hand side of the navigation window displays the hierarchy of drill-down levels. The “ROOT” node is the top-
level chart. The level you are currently editing is marked with **. To edit a different level, select it and click the
SWITCH TO button on the right-hand side. The chart will then open in the Designer. Levels of drill-down can also
be removed by selecting the node in the Navigation window and then clicking on the REMOVE button.

To add a new level of drill-down, select the chart under which you would like to add the layer (if you have only the
top-level chart, then only the “ROOT” node will be visible), and click ADD. You will then be prompted to create
a new chart or to use an existing chart for the drill-down layer. You can use any existing chart; however, any chart
for a drill-down layer must have a parameterized query as the data source. If you select to create a new chart, the
Data Source Manager will reopen, allowing you to select a data source for the chart and to continue through the
Chart Wizard steps.
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The next step is to map the category and/or series columns from the top-level chart to the query parameter(s) in the
sub-level chart. You will be prompted to do this when you select an existing chart for the drill-down layer or when
you select the data source for a new chart for the drill-down layer. In either case, a dialog will appear prompting
you to map the fields.

Parameter Mapping Window

Available options in the drop-down menus are based on data type. For example, if your parameterized query has
string as the parameter, only fields containing string data can be mapped. Hence, it is important to consider what
type of data will be passed from the top-level chart to the lower-level charts because if your category or series are
not of the correct data type or if you do not have enough fields to pass to the lower-levels, the drill-down will not
work correctly.

Once you correctly specify the parameter mapping, you will be prompted to specify a display name for the drill-
down level. After you select a name, the sub-level chart will appear in the Designer, allowing you to customize it.
You can navigate through the layers of drill-down using the Navigation window, or like data drill-down, you can
double click on a data point to go down a level and right click and select Back from the pop-up menu to go up a level.

4.1.6. Saving & Exporting Charts
After you finish designing a chart, you can save the definition as a chart or as a chart template, and provide XML
definitions for both. You can also generate a number of static image exports of the chart or create a JSP/JNLP page
with the Chart Viewer JNLP (More about Applets in JNLP: Section 1.3.4 - Run Applets in WebStart with JNLP file).

4.1.6.1. Saving Charts
If your chart uses an independent data source from the report, it can be saved in any place with any filename. To

save the current chart, select File → Save or File → Save As, or click on the  Save button on the toolbar.

Assuming you have not saved the chart before, or selected File → Save As, the following dialog will appear:

Save As Dialog

The first option allows you to specify a name and file path for the saved chart. You can browse to the appropriate
file path by clicking on the Browse button at the bottom of the dialog. The second option allows you to specify
which format you would like to use when saving the chart. As detailed in Section 4.1.2 - Charting Basics, there are
two principle ways in which chart definitions can be saved.

Chart format: Chart files save the chart in a binary file called filename.cht. A chart file stores
both the definitions of the chart (type, dimension, etc), as well as the data that was used
to create the chart.

Template format: Template files save the chart in a binary file called filename.tpl. A template file
only stores chart definitions. It doesn't store any chart data. Hence, any time a template
file is opened, it will try to connect to the original data source to retrieve the data.
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PAC format: PAC files save the chart in such a way that makes them ready for deployment. A .PAC
file takes the chart and all the supplementary files associated with it, such as background
images, dynamic drill-downs, or parametric drill-downs, and places them in a single
binary file.

Once you select a format you want to use, click on the OK button and the chart will be saved.

4.1.6.1.1. Working with Templates
Chart templates are a special format in which chart definitions can be saved. Unlike chart files (.cht format) which
saves both the chart definitions as well as the data for the chart, templates only save the definitions (i.e. the chart
attributes and the layout of the individual components), and the data source information. This means that templates
store the location/connection information for the data source that was used to create the chart, but they store none
of the actual data in the file. (Templates do keep 10 records of back-up data, allowing them to be opened when
the data source is not present).

Template files can be used in two ways. First, it can be opened, viewed, or exported, allowing you to see a chart
with fresh data. This way data for the chart are retrieved based on the data source specified in the file. If the original
data source is not accessible, this method cannot be used. The second way in which templates can be used is to
apply its attributes to other charts. In this scenario, the chart to which the template is applied will inherit appearance
properties of the template (including colors, fonts, size of chart components, position of legends, etc). This feature
allows you to produce a consistent look and feel among charts.

You can apply a template in Chart Designer by selecting File → Apply Template. This will bring up a dialog
prompting you to specify the template file you want to use.

Apply Template Dialog

The dialog allows you to specify the template file and its location. You can browse to a file by clicking on the
Browse button.

Note that when the chart and the template being applied are different sizes (i.e. chart canvas size), the resulting
chart may not display correctly. This is because the text size will not change between template and chart to which
it is applied. While the other components will adjust to the size of the new canvas, the font will not. To keep a
consistent look, the size of your template should be close to the size of the chart to which it will be applied.

Hyperlinks, floating lines, floating text, and axis scales defined in the template files carry over. You may have to
redefine them in the chart, if necessary. Chart type and dimension are not modified by the template. For example, a
three-dimensional chart will not be changed to a two-dimensional chart if the template is a two-dimensional chart.
Likewise, a pie chart remains a pie chart when a template of a bar chart is applied. Although the chart type does not
change when you apply a template, some appearance properties will not translate very well from a template with
another chart type. For best results, try to apply templates of the same type and dimension to a chart.

4.1.6.1.2. Saving XML Templates
In addition to the two binary chart representations, you can also save the chart definitions in XML format. This
option allows you to have a text-based chart template that can be used to modify chart properties outside of Chart
Designer.

To create an XML file when saving the chart, check the Create XML File box in the save as dialog when saving
the chart. This will create an XML file for the chart. Note that the XML file is a representation of the .tpl format
and not the .cht format.

4.1.6.2. Exporting Charts
From the Chart Designer, you can generate a number of static image exports for your chart. To export the current

chart, select File → Export, or click the  Export button on the toolbar. This will bring up a dialog allowing
you to specify options for the generated file.
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Export Chart Dialog

The first option allows you to specify a name and the file path for the generated file. You can browse to the appro-
priate file path by clicking the Browse button at the bottom of the dialog. The second option allows you to select
what type of export you would like. The following options are available:

GIF EDAB can generate GIF images. GIF has 256 color limit which keeps image file sizes small.

JPEG JPEG is another popular image format. It is a higher resolution image format than GIF and it is not patent
protected. When generating a JPEG file, you can specify quality/compression of the file. The higher the
quality, the larger the file.

If you select JPEG as the export format, after clicking OK you will be prompted to specify the quality. The
higher quality image you select, the larger the generated file size. It is recommended that with the JPEG
export, you use specify a high-quality image, as the low-quality results will most likely be undesirable.

PNG PNG is an image format that is less popular, but can be displayed in most browsers. It is a high-quality
image with a smaller file size than JPEG. It also provides transparent image background option.

SVG SVG (Scalable Vector Graphics) is a relatively new image format, which saves the image as vectors in an
XML-based text format. Generally, you will need a browser plug-in to view these images.

SWF SWF is an Adobe Flash file. The flash format is vector based and allows the chart to be resized after export.
Also, flash allows for high-resolution printing and produces a small file size. When selecting this export
type, you can also specify the frame count (number of frames in the animation) and the frame rate (number
of frames shown per second) or choose to disable the animation.

BMP This is a Windows bitmap format.

WMF WMF is the Windows Meta File format. This can be used for import/export into MS Office documents.

PDF This will generate the chart in Adobe Portable Document Format. The chart will be generated as a one-
page PDF document.

XML This will generate an XML data file containing the chart's data. This will not generate an XML chart
attribute file, only the data will be written into XML format.

XLS Will generate an XLS (MS Excel) file and insert the chart as an image to the first XLS sheet.

TXT This will generate a text data file containing the chart's data.

In addition, if your chart contains hyperlinks, you can choose to export a map file along with any of the generated
images. The map file contains an HTML image map with the links for the generate chart. Map files are generated
in the same location as the image file, and have the same file name. To generate a map file, check the Generate
Data Map File box prior to exporting.

4.1.6.2.1. PDF Font Mapping
As with reports, you can use any font in the system for the labels, text, and titles in a chart. For most image exports,
the text is written in the image and no additional configuration is necessary. For PDF export, however, you will
need to specify a .ttf (true type font), .ttc (true type collection), .pfb, or .afm file for any system font you
want to use in the chart.
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To set font mapping for PDF export, select Format → Font Mapping. This will bring up a dialog allowing you to
specify font files.

Font Mapping Dialog

For each font and style combination, you can select a specific .ttf, .ttc, .pfb, or .afm file for that font. You
can either type the full path or browse to the font file. If you are using a .ttc file you will need to specify the
font index in the box provided (.ttc files contain more than one font). Once you have specified the correct file,
click the 'Add' button to save the mapping to the list. You can edit or delete existing mappings by selecting them
in the list and then clicking the appropriate button.

Note
You only need to apply font mapping when exporting the chart by itself. If the chart is in a report, it
will inherit the font mapping defined in the report.

4.1.6.2.1.1. PDF Font Mapping Import/Export

You can pass the font mapping from one chart to another using the Import/Export feature. You can export the font
mapping by clicking on the Export button on the font mapping dialog. This will bring up a dialog box prompting
you to specify a file name. The font mapping will then be saved as an XML file. You can load a font mapping
XML file by selecting the Import option from the dialog. This will bring up a dialog box prompting you to specify
the XML file that you would like to import. Click on OK and the mapping stored in the XML file will be applied
to the current chart.

4.2. QuickDesigner Reports
QuickDesigner Reports is a thin-client ad-hoc reporting interface. It provides users a scaled-down design tool to
create reports. With QuickDesigner Reports, end users can easily select, filter, and present data without mastering
database structures, all with zero client download.

4.2.1. Start
QuickDesigner Reports can be started from the EDAB Start page. If you have logged in as a user with design
privileges, then you can follow QuickDesigner Reports link to begin using QuickDesigner Reports.

When the QuickDesigner Reports launches, the first page that appears prompts you to select between opening an
existing report, or creating a new one.
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QuickDesigner Reports Start Options

4.2.2. Select a Data Source

If you want to create a new report, click on the  Create New Report icon on the toolbar. The Data Source
Dialog will appear and prompt you to select data registry and data source you want to use with QuickDesigner
Reports. In order to use QuickDesigner Reports, a user must have read privileges to one of the registries defined
in the Organizer. For more about creating and managing data registries, please see Section 3.1.1 - Managing Data
Registries.

Select data registry from the drop-down menu in the upper left corner. The tree-list bellow displays the content of
the selected registry. There are all of the data sources that have been defined in the registry that the user has access
to. Select a data source you want to use for the report.

Data Source Dialog

Unlike Report Designer or Chart Designer where the user can select to create new data sources or modify the
existing ones, the only option is to select a data source for the report. The only exception to this is for Data Views or
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Data View Queries. If data sources of this type are selected, you will see the DataView Builder on the right side of
the Data Source Dialog. The DataView Builder allows you to build or modify queries against the View. For more
about managing data sources in QuickDesigner Reports, please see Section 3.2 - Data in QuickDesigners and Maps.

Once you finish selecting a data source, click on the OK button to close the Data Source Dialog.

QuickDesigner Reports

You can see columns of the data source on the left side, the central part for creating reports, and parameters pane
on the right side (this pane is visible only if the data source has some parameter(s)).

4.2.3. Toolbar
A lot of formatting actions for reports in QuickDesigner Reports are accessed through the toolbar. The icons perform
the following actions:

Start a new report

Open an existing report

Save the current report

Save report as

Export the current report

Set style for the report

Pagination/Scrolling options

Insert/Edit report title
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Insert report logo

Modify DataView Query - This option allows user to modify the DataView and DataView query used for the
report. The icon is only visible in toolbar when a DV query is used as data source for the report (otherwise
it's hidden).

Refresh the report

4.2.4. Format Report Elements

4.2.4.1. Add a Column
To insert a column to the report, double-click on the column in the left Columns pane, or click on the column and
drag it to the report. You can also add all columns to the report in one step by clicking the Add All button.

Add a Column

4.2.4.2. Remove a Column
To remove a column from the report, right click on the column header and select Remove or drag the column back
to the Columns pane. The column is removed from the report.

Remove a Column

4.2.4.3. Collapse Sidebars
When you add columns to the report, you can colapse the Columns pane to have more space for designing the report.

To do this, click on the  Collapse button at the top of the Columns pane. You can also collapse the Parameters
pane on the right side (if the report has some parameters).
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Collapse Sidebars

4.2.4.4. Column Width
You can simply resize a column width to fit the content or to see the whole column header. Move the mouse over
the right side of the column header to see double arrow, left click and drag to set the column width.

Column Width

4.2.4.5. Column Order
You can also reorder the columns. Left click on the column header and drag it. When you see the arrows, release
the mouse button.

Column Order

4.2.4.6. Show More Rows
By default, only the first 50 rows will be displayed in the report. You can display more or less rows by clicking on
the show 50 more or show 50 less buttons under the report.

Show More Rows

When all rows are displayed, you will also see the total number of rows.
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Show Less Rows

4.2.4.7. Report Style

You can choose from five pre-defined report styles. Click on the  Styles icon on the toolbar to open the Styles
dialog. Select the style you would like to use and close the Styles dialog by clicking on the Hide button.

Styles Dialog

4.2.4.8. Pagination/Scrolling

Click the Pagination/Scrolling icon on the main toolbar  to open the Pagination/Scrolling dialog. You can
choose fixed pagination, dynamic pagination that automatically keeps the height of your screen, scrolling, or disable
this feature.

Fixed Pagination For fixed pagination, you can select a number of rows per page and a paginator po-
sition on the page.
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Pagination Dialog

Paginator divides the report data into separate pages. Once you set pagination to be
active, you can switch to any page of the report using buttons with page numbers.

You can also switch to the first page by clicking on the  First Page button, to

the last page by clicking on the  Last Page button, or to the previous and next

page by clicking on the  Previous Page and the  Next Page buttons. Next
to the buttons you can see which rows are displayed/total number of rows.

Report with Pagination Buttons

Dynamic Pagination Dynamic pagination does not require any further setting. It will automatically adjust
number of rows per page to the height of your screen. As a result, no scroll bar will
appear in QuickDesigner Reports, Dashboard Builder, and Published Files. The num-
ber of rows per page may be different for different machines.

Scrolling Scrolling allows you to display all the report data on a single page while not taking up
too much space. All the displayed data is placed into a scrollable table with scrolling
height of your choice. The scrolling height in pixels can be set in the Scroll Height
section of the Pagination/Scrolling dialog.
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Scrolling Dialog

Report with Scrolling

4.2.4.9. Report Title

You can add a report title. Click the  Report Title icon on the toolbar, and the Report Title dialog appears. Write

a title of the report and click on the  Apply button or press Enter to insert the title.

Report Title Dialog

The report title is on the left by default. You can move it to the center or right side of the report. Click on the title,
hold down the mouse button and move the mouse slightly. You can see three dashed rectangles that represent three
positions of the title - left, center, right. Move the title to the position you want to use and release the mouse button.
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Report Title Moving

You can edit or remove the report title via the pop up  Edit button when the cursor is pointed over the title, or via

the  Report Title icon on the toolbar. Both will open the Report Title dialog. There you can rewrite the title and

apply it with the  Apply button, or remove it by clicking on the  Remove button. Then close the Report
Title dialog by clicking on X in the upper right corner. You can also remove the report title directly via the pop up
X button when the cursor is pointed over the title.

4.2.4.9.1. Report Title with Variables
If the data source is parameterized, you can add variables to the report title. Variables display the current parameter
value in the report title and change dynamically according to which parameter value is selected.

Variables for Report Title

To add a variable, click on the Variables button in the Report Title dialog, select a parameter from the list, then it
will be displayed in this format &<parameterName> in the textfield.

Report Title with Variables
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4.2.4.10. Report Logo

You can add a logo to your report. To do this, click on the  Report Logo icon on the toolbar to open the Report
Logo dialog. This dialog allows you to choose a logo from your local directory. Once a logo is selected, it is inserted
to the top left.

Report Logo Choose

You can move the logo to the center or right side of the report. Click on the logo, hold down the mouse button
and move the mouse slightly. You can see three dashed rectangles that represent three positions of the logo - left,
center, right. Move the logo to the position you would like to use and release the mouse button.

Report Logo Placement

You can remove the report logo via the pop up  button when the cursor is pointed over the logo. If you want

to change the logo, just click on the  Report Logo icon to choose a new image. The new image will replace
the old one.

4.2.5. Parameter Setting
If the report uses a parameterized data source, you can see the Parameters pane on the right side of the designer
window. You can select parameter(s) value(s) and apply it (them) by clicking on the Submit button.
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Parameters Pane

You can collapse or open this pane by clicking on the  or  Collapse buttons.

4.2.6. Aggregation/Group
You can add an aggregation or group to each column of the report. To do this, right click on the column header and
move the mouse cursor over Aggregation button. The Aggregation/Group list will appear. Select an aggregation by
clicking on it in the list. The aggregation will be assigned to the appropriate column. After you finish this setting,
an extra line of the aggregation value will appear after each group (row break) and after the last aggregation value
line, an extra line with a grand total value will appear.

Aggregation/Group Setting

Once the aggregations are set, you can set label for the row break and grand total. The grand total label is called
Report Footer label. To set a label, right click on an empty cell next to the value you want to describe and then
click on the pop up Label button.
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Aggregation Label Button

The Footer Labels dialog will appear. You can insert a text and decide how to align it in a cell - left or right. Then
click on the OK button to apply the label.

Footer Labels Dialog

To edit or remove a label, right click on it and then click on the pop up Label button and edit the text or click on
the Remove button in the Footer Labels dialog.

The next image shows a sample of the report with Row Break, SUM aggregation, group footer label, and report
footer label.

Aggregation and Label

If the data source is parameterized, you can add variables to the footer labels. Variables display the current parameter
value in the selected footer label(s) and change dynamically according to the selected parameter value.

Footer Labels Variables
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To add a variable, click on the Variables button in the Footer Labels dialog and select a parameter from the list.
It will be displayed as &<parameterName> in the textfield.

Report Footer Label with Variables

If you add a variable to the label, the text may not fit the cell. In this case it is advisable to use text alignment.

4.2.7. Data Formating
Right click on the column header and select Format from the pop-up menu.

Format Button

When you select the Format option, the Set Format dialog will appear. The Set Format dialog is dependent on what
type of data is present in the selected column: numeric, string, date/time, or logical/boolean.

Formatting Numeric Data: The dialog for numeric data contains three primary options for the data: Lo-
cale-Specific Fixed Point, Fixed Point, and Scientific. Each option opens a
different tab.

Locale-Specific Fixed Point: This will change the format of the da-
ta depending on the locale in which
it is being viewed. Additional for-
matting for this option allows you to
specify whether the data should be
displayed as a number, currency, or
percentage. In addition, you can set
the maximum and minimum number
of integer digits and fraction digits.
Other display attributes will vary de-
pending on locale.

Locale-Specific Formatting

Fixed Point: This will keep the data format consis-
tent, regardless of locale. Addition-
al formatting for this option allows
you to set the number of decimals,
rounding for digit number, unit sym-
bols, negative sign position, decimal
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and thousands separator, and specify
leading zeroes for fractions.

Fixed Point Formatting

Scientific: This will display the data in scientif-
ic notation. Additional formatting for
this option allows you to set the num-
ber of decimals.

Scientific Formatting

After you finish selecting options, click on the Ok button to apply formatting
and close the Set Format dialog.

Formatting String Data: In this dialog, you can change maximum characters for the string format. To do
this, uncheck the Show Original Text option and then set maximum characters.

String Data Format

Click on the Ok button to apply changes and close the Set Format dialog.

Formatting Date/Time Data: The dialog for date/time data contains two tabs: Locale-Specific and Stan-
dard.

Locale Specific: This will change the format of the data depend-
ing on the locale in which it is being viewed. Ad-
ditional formatting for this option allows you to
select full, long, medium, or short notations for
date and time information. Other display attribut-
es will vary depending on locale.
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Locale-Specific Formatting

Standard: This will keep the data format consistent, regard-
less of locale. Additional formatting for this op-
tion allows you to select year and month dis-
plays, as well as the order in which month day
and year information is presented. You can also
select which characters should be used as sepa-
rators. Time options allow you to display hours,
minutes, and/or seconds, and select the separators
between them. For timestamp data, you can select
to display the time before or after the date and the
separator to be used between them.

Standard Formatting

After you finish selecting options, click on the Ok button to apply formatting
and close the Set Format dialog.

Formatting Logical Data: The dialog for Logical or Boolean data contains five options for displaying
the data: T/F, True/False, Yes/No, Y/N, and 1/0.
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Logic Format

Select a format you want to use and then click on the Ok button to change
the data format and close the Set Format dialog.

4.2.8. Sorting
When you hover your mouse cursor over the column header, you will see a label Sorting: NONE. Left click on the
column header to apply the sorting. First click causes ascending sorting, second click causes descending sorting
and third click cancels the sorting.

Sorting

Sorted columns have arrow icons on the column header. The  Up Arrow icon indicates ascending order and the

 Down Arrow icon indicates descending order.

Sorting Arrow

4.2.9. Data Filtering

You can filter data by clicking on the  Filter Column icon on the column header. A pop-up dialog will appear,
which will allow you to select data for filtering. To select values which you want to be displayed in the report,
check off the box next to the desired value(s). You can narrow down the values shown in the Filter dialog or search
for particular values by typing them into the text field at the top of the dialog. To select all available values within
the column, check the box in the upper left corner (next to the search field). Click on the OK button to apply the
filtering and close the dialog.
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Filter Column

If there are several columns applying data filters, the report will display all filter conditions, i.e. different column
filters has “AND” relationship.

4.2.10. Save the Report

You can save the report by clicking on the Save button on the toolbar . This will bring up a dialog allowing
you to specify a name for the report. Enter a name for the report, select the project where you want to save it and
click on the Save button.

Save Dialog

After saving or opening existing report, the  Save As button allows you to save the existing or modified report
under a different name or into a different location.

4.2.11. Export the Report

You can also export the report in several file formats. To do so, click on the  Export icon on the toolbar. A
pop-up dialog will appear, prompting you to specify the export format. Available options are PDF, XLS, XLSX,
DHTML, RTF, Text, XML Data, and CSV.
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Export Options

Select the format and then you can save the generated file to your local system.

4.2.12. Open the Saved Report

You can open the saved report by clicking on the  Open icon on the main toolbar. The Open dialog will appear.

Open the Report

Here you can see all reports from Organizer created in QuickDesigner Reports. Select a report and click on the
Open button to open it.

4.2.13. Exit

You can exit QuickDesigner Reports either by clicking on the  Home icon in the upper right corner, or by

clicking on the QuickDesigner Reports title, or by clicking on the  Logo icon in the upper left corner. Before
closing, you will be prompted if you want to save an unsaved report.

4.3. QuickDesigner Charts
QuickDesigner Charts is a thin-client ad-hoc charting interface. It provides users a scaled-down design tool to create
charts. With QuickDesigner Charts, end users can easily select, filter, and present data without mastering database
structures, all with zero client download.
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4.3.1. Start
QuickDesigner Charts can be started from the EDAB Start page. If you have logged in as a user with design privi-
leges, you can follow QuickDesigner Charts link to start using QuickDesigner Charts.

When QuickDesigner Charts launches, the first page that appears prompts you to select between opening an existing
chart or creating a new one.

QuickDesigner Charts Start Options

4.3.2. Select a Data Source

If you want to create a new chart, click on the  Create New Chart icon. The Data Source Dialog appears and
prompts you to select data registry and data source you want to use with QuickDesigner Charts. In order to use
QuickDesigner Charts, a user must have read privileges to one of the registries defined in the Organizer. For more
about creating and managing data registries, please see Section 3.1.1 - Managing Data Registries.

Select data registry from the drop-down menu in the upper left corner. The pane bellow displays the content of the
selected registry. Select a data source you want to use for the chart.
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Data Source Dialog

You can see the records of the data source in View DataSheet pane on the right. If you select DataView as the
data source, you will be able to create a new DataView query in the DataView Builder in the right pane. You can
also select an existing DataView query and modify it in the right pane. For more about managing data sources in
QuickDesigner Charts, please see Section 3.2 - Data in QuickDesigners and Maps.

Once you have finish selecting a data source, click on the OK button to close the Data Source Dialog.

4.3.2.1. Change a Data Source
After you return to the main QuickDesigner Charts window (after you created a new chart or opened an existing

one), you can change the chart's data source by clicking on the  Change Data Source button on the toolbar.
This will take you back to the Data Source Dialog and allow you to pick a new data source.

4.3.3. Data Mapping and Ordering
Once you select a data source or finish building a query and close the Data Source Dialog by clicking on the OK
button, you will see Chart Mapping dialog in the left pane of QuickDesigner Charts.
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Chart Mapping Dialog

4.3.3.1. Mapping and Ordering Options
The Chart Mapping dialog allows you to select which chart type you want to create and which fields from the data
source you want to map to the chart elements.

Chart Mapping Options

The Chart Type options allows you to select between two-dimensional and three-dimensional chart types, and the
chart type you want to use. The Data Mapping options allows you to select data mapping for the chart. The Data
Ordering options allows you to sort data in ascending or descending order. For a detailed description of all available
charts and mapping options, see Section 4.1.3 - Chart Types and Data Mapping.

Once you select the type and mapping options, click on the OK button and the chart will appear in the right pane,
as well as all icons.



Designing Reports & Charts

378

QuickDesigner Charts Main Page

4.3.3.2. Change Data Mapping

You can change the mapping options and the chart type by clicking on the  Change Mapping/Chart Type icon
on the toolbar. This will open the Chart Mapping dialog in the left pane.

4.3.3.3. Parameter Setting
If the data source is parameterized, you can see Parameter button above the chart.

Parameter Button

After clicking on it, the Parameter Dialog will open allowing you to set parameter values. To apply a parameter
value, click on the Apply button (the dialog stays open) or OK button (the dialog will be closed).

Parameter Dialog

4.3.4. Toolbar
All of the formatting actions for charts in QuickDesigner Charts are accessed through the toolbar. The icons perform
the following actions:
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Create a new chart

Open an existing chart

Save the chart

Save chart as

Export the chart

Set data properties for the chart

Chart-specific options (This option is only available for Pie, HLCO, Dial, Gantt, Polar, and Doughnut chart.)

Line and point settings

Trend line settings

Format axis scale

Format axis elements

Format chart legend

Format plot area

Add/Edit chart titles

Set chart colors

Set color gradient

Set chart canvas size

Set label/legend font

Change chart type/mapping

Change chart data source

4.3.5. Data Formatting
Once you finish specifying all the mapping options, you can format chart elements.
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4.3.5.1. Position and Size
There are several options available in QuickDesigner Charts that allows you to control the size and position of
the chart.

4.3.5.1.1. Canvas Size

The chart canvas size can be adjusted by clicking on the  Canvas Size button on the toolbar. This will bring up
a dialog in the left pane allowing you to specify the size of the chart.

Chart Canvas Dialog

The dialog allows you to specify the width and height of the canvas in pixels, inches, or centimeters. Once you
specify the new dimensions, click on the OK button and all changes will be applied. You can also change the canvas
size freely using drag & drop. In this case, you can see the exact size in the Chart Canvas Size dialog.

4.3.5.1.2. Chart Position and Size
You can set the position of the chart within the canvas freely using drag & drop. You can set the canvas size or
plot area size by dragging the sides or dragging the corner.

Setting Size

4.3.5.2. Font and Color Options
QuickDesigner Charts interface allows you to add/edit chart titles, set title/label font, and chart colors.

4.3.5.2.1. Chart Titles

To add or edit the chart titles, click on the  Add/Edit Chart Titles button on the toolbar. This will bring up a
dialog in the left pane.
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Insert/Edit Titles Dialog

You can add a main title to the chart, as well as one for each of the chart axes. Once you finish adding titles, click
on the Ok button to apply the changes.

4.3.5.2.1.1. Text Variables

As with the Chart Designer, you can also add text variables that will provide run-time substitution based on certain
values in the chart. To bring up a list of variables, click on the Variables button in the Chart Titles dialog. The
variables list will open in a new window.

Text Variables Dialog

The following text variables are supported:

&date This variable displays the date when the chart was last drawn/redrawn.

&time This variable displays the time when the chart was last drawn/redrawn.

&category This variable displays the name of the category column.

&series This variable displays the name of the data series column.

&sumby This variable displays the name of the sum-by column.

&value This variable displays the name of the value column.

&subvalue This variable displays the name of the secondary value column.

&xaxis This variable displays the name of the column that is mapped to X-axis. This is for charts
that map a value instead of a category to the X-axis like scatter or bubble charts.

&yaxis This variable displays the name of the column that is mapped to Y-axis. This is for scatter,
bubble, and surface charts.

&zaxis This variable displays the name of the column that is mapped to Z-axis. This is for scatter,
bubble, and surface charts.

&2ndaxis This variable displays the name of the column that is mapped to 2nd-axis.
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&paramInfoValue If the chart contains a parameter, this displays the parameter value(s) that were selected.

&paramInfoName If the chart contains a parameter with this name, this will display the name of that para-
meter.

To add a text variable to a title, select it from the list and click on the OK button.

4.3.5.2.2. Chart Fonts

To set the font for chart labels and titles, click on the  Font Settings button on the toolbar. This will open a
dialog in the left pane.

Font Settings Dialog

To set the font for a title or label, select it in the drop-down list at the top of the dialog. Then select font face, style,
size, and angle using the options in the lower dialog. Once you finish setting up fonts, click on the OK button to
apply the changes.

4.3.5.2.3. Chart Colors

You can set color for all chart elements by clicking on the  Set Chart Colors button on the toolbar. The Chart
Colors dialog will open in the left pane.

Chart Colors Dialog
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To set the color for a chart element, first select it from the drop-down list at the top of the dialog. Then select a new
color either by clicking on one of the swatches, entering RGB values for the color, or entering HEX code to the #
field. Once you finish setting up the colors, click on the OK button to apply the changes.

Please note that some elements are not visible by default (e.g. data border). In this case, first make the element
visible (see Section 4.3.5.4.1 - Data Properties) and then use Chart Colors dialog for setting a color of the element.

4.3.5.2.4. Color Gradient

You can set the color gradient for the chart by clicking on the  Set Color Gradient button on the toolbar. The
Color Gradient dialog will open in the left pane.

Chart Colors Dialog

Select a gradient you want to use and click on the OK button to apply the changes. You can apply the same gradient
to the canvas background.

4.3.5.3. Chart Axes
In QuickDesigner Charts, you have several formatting options for the chart axes. You can customize the axis scale
as well as label/axis appearance options.

4.3.5.3.1. Axis Scale
By default, the scale of any value axes in the chart is calculated to provide the best fit for the plotted data. This
is especially useful if the data change often. However, there are many times when you may want to set the scale

of the axes manually. To modify the axis scale, click on the  Axis Scale button on the toolbar. A new dialog
will open in the left pane.
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Axis Scale Dialog

You can select the axis for which you would like to set the scale by selecting it in the drop-down list at the top of
the dialog. The following scaling options are provided for each value axis:

Automatic: This option turns on automatic scaling for the axis. This is the default setting.

Manual: This option turns on manual scaling to set the axis scale to the options provided.

Maximum: This is the highest value on the axis scale.

Minimum: This is the lowest value on the axis scale.

Unit: This is the step size of the axis scale.

Add Padding: This option will add padding to the top of the automatic scale. If this option is disabled, the
maximum scale will match the largest data point.

Best Fit: This option will automatically place the origin of the chart based on minimum and maximum
values of the data.

Origin: This option allows you to specify where the X and Y axes should intersect. This is usually
at zero.

Once you finish specifying the axis scale options, click on the OK button to apply the changes.

4.3.5.3.2. Axis Elements
Additional appearance properties for the axes and axis labels can be set in the Format Axis Elements dialog. To

change these settings, click on the  Axis Options button on the toolbar. This will open the dialog in the left pane.
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Axis Elements Dialog

To change the settings for an axis, first select it in the drop-down Select Axis list and then set the available options
below. The dialog allows you to perform the following options. Note that some options are only available for certain
chart types, certain data types, and on certain axes.

Show 2D Arrow: This option allows you to remove or display arrowhead at the end of the axis.
Note that this option applies to all chart axes and is only available for two-
dimensional charts.

Axis Thickness: This option allows you to set the thickness of the axis in pixels. Note that
this setting is only available for two-dimensional charts and it is applied to
all axes in the chart.

Show Labels: This option allows you to remove or display the labels for each axis.

Label Rows: This option allows labels to be displayed in alternating rows. This can pre-
vent overlapping. This option is only available for the X-axis.

Label Step Interval: This option allows you to set the label step interval for the data. For example
setting this to 2 would draw the label for every other data point in the chart.

Label Outside Plot Area: This option sets the labels to be placed outside of the plot area, regardless of
where the axis is. This feature can be useful for category axis labels if you
are plotting data with both positive and negative values.

Label Interval Unit: This option allows you to select the unit to be used when sorting and repre-
senting time-based data (date, time, or timestamp). Selecting tickers will use
the data as it is read by Chart Designer.

Show Grid: This option allows you to remove or display the grid for each axis.
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Chart With and Without Grid

Grid Thickness: This option allows you to specify the thickness of any grid lines along the
axis.

Grid Step Interval: This option allows you to set the grid step interval for any grid lines along
the axis.

Align Grid With Ticker: This option aligns the grid line with the ticker instead of placing it between
tickers. This places the ticker and corresponding grid line along the same
line. This option only applies to the category axis of column-type charts.

Show Tickers: This option allows you to remove or display the axis tickers and draw them
inward or outward.

Tickers Drawn Outward and Inward

Draw Tickers Inward: This option will draw the axis tickers inside the plot area instead of outside
(default).

Show Axis: This option allows you to remove or display the axis (for two-dimensional
charts) or the wall (for three-dimensional charts).

Draw X Axis at Top: This option allows the X-axis to be positioned at the top of the chart instead
of the default bottom position. This option is available for two-dimensional
column, bar, scatter, high-low, HLCO, bubble, and Gantt charts.

Swap Y Axis Position: This option will swap the primary and secondary value axes. This option can
only be found under 2nd Axis tab.

4.3.5.3.2.1. Axis Label
The Format Axis Elements dialog also allows you to format the appearance of the axis labels, depending on what
type of data is plotted on the axis.

• Formatting Numeric Data:
For numeric data, there are three primary options for display formatting: locale-specific fixed point, fixed point,
and scientific. Additional options will be displayed when you click on the Format button.
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Numeric Data Format Options

Locale-Specific: This will change the format of the data depending on the locale in which it is being
viewed. Additional formatting for this option allows you to specify whether the data
should be displayed as a number, currency, or percentage. In addition, you can set the
maximum and minimum number of integer digits and fraction digits. Use Grouping
brings space as the thousands separator. Other display attributes will vary depending
on locale.

Please note that if you select Currency as Type, local-specific format will automati-
cally take currency symbol from your system settings (e.g. it will add “$” to the label
if you're in U.S.A.).

Locale-Specific Formatting Options

Fixed Point: This will keep the data format consistent, regardless of locale. Additional formatting
for this option allows you to set the number of decimals, rounding for digit num-
ber, unit symbols, negative sign position, decimal and thousands separator, and to use
Leading Zero For Fractions which determines whether it should display 0 before dec-
imals for numbers from -1 to 1 (e.g. 0.15/ .15).

Fixed Point Formatting Options

Scientific: This will display the data in scientific notation. Additional formatting for this option
allows you to set the number of decimals.
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Scientific Formatting Options

• Formatting Date/Time Data:

For date/time data, there are two primary options for display formatting: locale specific and standard. Additional
options will be displayed if you click on the Format button. The available options will vary depending on the
nature of your data. Date, time, and timestamp data will bring up date, time, and date & time options.

Date/Time Data Format Options

Locale-Specific: This option will change the format of the data depending on the locale in which it
is being viewed. Additional formatting for this option allows you to select full, long,
medium, or short notations for date, and time information. Other displayed attributes
will vary depending on your locale.

Locale-Specific Formatting Options

Example of Long/Medium/Short Time Format

Standard: This option will keep the data format consistent, regardless of locale. Additional for-
matting for this option allows you to select year and month displays, as well as the
order in which month, day, and year information is presented. You can also select the
characters to be used as separators. Time options allow you to display hours, minutes,
and/or seconds, and select the separators between them. For timestamp data, you can
select to display the time before or after the date and the separator to be used between
them. Fix Digit Length option adds zeros to days and months between 1 – 9 to keep
the length of the date consistent (two digits for both day and month).
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Standard Formatting Options

• Formatting Logical Data:

There are five options available for displaying logical or Boolean data: T/F, True/False, Yes/No, Y/N, and 1/0.

Logical Formatting Options

4.3.5.4. Plot/Data Elements
In QuickDesigner Charts, there are many ways to configure how data points and chart plot should be drawn.

4.3.5.4.1. Data Properties
Many of the data display options are controlled through the data properties dialog. From this dialog, you can control
the size of bars/columns, set display options for null values, and specify options for data labels. To invoke this

dialog, click on the  Data Properties button on the toolbar. The dialog will open in the left pane.
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Data Properties Dialog

This data properties dialog contains the following options:

Column Width: This option specifies the ratio of the bar/column width relatively to the gap
between successive bars in the chart. Each unit represents 1/10th of the space
between data points. Therefore, entering 9 would leave 10% of the space
between data points blank, while 10 would eliminate all space between bars/
columns. This option only pertains to two-dimensional bar, column, stack
bar, stack column, high-low, HLCO, and Gantt charts.

Column width 9 vs 10

Show data for nulls: This option will connect null data with lines. For example, if you have three
points and the value of point 1 is 4, point 2 is null, and the value of point 3
is 6, then a line will be drawn from 4 to 6 for the three points. This option
is only available for line charts or other two-dimensional charts with lines.
All other chart types will not plot null data.

Connected line with null data used.

Use dotted lines for nulls: Instead of drawing a whole line through null values in the chart, you can use
this option to draw a dotted line. Like the show data for nulls option, this
option is only available for lines.
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Dotted line with null data used.

Draw from end to end: This option allows you to draw 2D line and area charts across the entire plot
area, rather than offsetting to the first and last data points on the chart.

End to end disabled/enabled.

Draw shadow for lines: This option specifies whether to draw shadow on 2D lines. In order for shad-
ing to apply, the line must be thicker than one pixel.

Connected line with shadow.

Show null as zero: This option will display 0 for null data.

Set translucent: This option will draw all data points in translucent color, allowing over-
lapped elements to be visible. This is useful for radar charts and two-dimen-
sional area charts with data series. This option is also available for bubble
and Gantt charts. Note that because this feature requires Java 1.2 or higher,
the translucent elements will not display if you are deploying charts in ap-
plets and the client is not using the Java plugin.

Show data border: This option will draw a border around columns and areas.

Draw Series In-Line: This option will display series in one line. It only pertains to three-dimen-
sional column, stack column, percent column, and bar charts.

Show primary: This option will display data top labels for the primary values in the chart.

Show secondary: This option will display data top labels for the secondary values in the chart.

Show stack section: This option will display individual labels for each stack section for stack bar,
stack column, and stack area charts.

Top label position: This option allows you to specify where the top labels should be drawn. By
default, they are drawn above data points if they are positive and below data
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points if they are negative. Using these options, you can force the data points
to always draw to the positive or negative side of the data.

Label Alignment: This option allows you to set the alignment for the data top labels. You can
draw them at the top, bottom, or middle of the data points. In addition, you
can select to draw the label inside the data point at the top or bottom. An
additional option for stack charts allows you to set the alignment for stack
section labels.

Once you finish setting up the options, click on the OK button to apply the changes.

4.3.5.4.2. Line And Point
For any two dimensional chart type, you can choose to display lines and points for all data points in the chart.
Note that some chart types already use this representation (i.e. line or scatter charts). Line and point settings can be

adjusted by clicking on the  Line and Point Settings button on the toolbar. The dialog will open in the left pane.

Line and Point Dialog

The first three options allows you to specify whether you want to show lines, points, and points border for the chart.
For radar charts, you also have the option of showing areas. The remaining options allows you to customize the
line and point displays for each element in the data series.

For each data series element, you can specify the point shape you want to use. You can also control the size of the
points. The default point size is 0. You can specify point sizes of -1, -2, & -3 which represent sizes of 0.75, 0.5, and
0.25. At -3 (0.25), the point will be drawn as a dot regardless of the selected point shape.

For lines you can specify the line thickness as well as customize a dash pattern. The dash pattern is created by
specifying the number of filled pixels and empty pixels (between 0 and 255). The line is then drawn by dividing
into segments - the number of filled pixels followed by the number of empty pixels. Setting 0 for both will result
in a solid line. Setting 255 for both will result in no line being drawn.

Once you finish setting up the options, click on the OK button to apply the changes.

4.3.5.4.3. Trend Line
A powerful feature in QuickDesigner Charts is the ability to add trend lines to charts. Trend lines can help you show
more details of a chart's data by exposing and highlighting certain trends. Trend lines settings can be adjusted by

clicking on the  Trend Line button on the toolbar. The dialog will open in the left pane.
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Trend Line Dialog

There is a list of existing trend lines at the top of the dialog. You can select existing trend line and edit it, remove
the selected trend line, and/or create a new trend line.

You can specify a label for the line as well as on which element of the data series the calculation should be based. The
following types of trend lines are supported: polynomial of any degree, exponential, logarithmic, power, moving
average, exponential moving average, triangular moving average, and cubic B-spline. For moving averages you
will need to specify the average period and for a polynomial you will need to specify the curve order. You can also
specify the thickness of the line and configure whether a label in legend and the attached text should be shown. In
case the chart has data series, you can configure the trendline for a specific series.

Please note that there is a Stack line option in the Trend Line dialog. This option is only available for Stack Column,
Stack Bar, and Stack Area chart. You can select whether the line will be drawn for positive or negative values.

Once you finish setting up the options, click on the OK button to apply the changes.

4.3.5.4.4. Plot Area
The plot area is the plane on which the data points are drawn for two-dimensional charts. You can customize the

appearance of the plot area by clicking on the  Format Plot Area button on the toolbar. The dialog will open
in the left pane.

Plot Area Dialog

This dialog allows you to draw a border around the plot area or fill it to provide a background color. If you fill the
area, you can also specify several 3D effects like raising, lowering, or drawing a shadow. You can emphasize the
3D effect by increasing the Depth option.
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Once you finish setting up the options, click on the OK button to apply the changes.

4.3.5.4.5. Chart Legend

You can control and modify the display of the chart legend by clicking on the  Format Legend button on the
toolbar. The dialog will open in the left pane.

Format Legend Dialog

The drop-down list at the top of the dialog allows you to select which legend (primary or secondary) you want to
modify. The formatting options are as follows:

Display Legend: This option allows you to turn on or off the legend.

Layout: This option allows you to change the legend from vertical to horizontal layout.

Display: This option allows you to display border, background, and symbols for the legend.

3D Effect: This option allows you to add a 3D effect to the legend. You can raise it, lower it, or draw
a shadow. The 3D effect can be emphasized by increasing the Depth option.

Hide Elements: This option allows you to select certain category/series elements to hide in the legend.

Other Options: This option allows you to choose whether or not to draw the legend in reverse order.

Once you have finish seting up the options, click on the OK button to apply the changes.

4.3.5.5. Chart-Specific Options
There are a number of formatting options that are unique to certain chart types - Pie Chart, Dial Chart, HLCO

Chart, Gantt Chart, Polar Chart, Doughnut Chart. These options can be modified by clicking on the  Chart
Type Options button on the toolbar in these types of charts. This will bring up a dialog in the left pane that varies
depending on the type of the current chart. Besides the chart types listed here, other chart types have no additional
options.

4.3.5.5.1. Dial Charts
For dial charts, the following dialog is opened:
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Dial Chart Options Dialog

The following options are available for dial charts:

Starting Angle: This option specifies the angle of the first axis label. The angle is represented in degrees
and is set to 0 by default. Assuming the dial chart is a clock face, 0 degrees is 12 o'clock.

Ending Angle: This option specifies the angle of the last axis label. The angle is represented in degrees
and is set to 360 by default. By default, the labels (and data points) encompass the entire
circumference of the dial.

Draw Border: This option specifies whether or not to draw a border around the dial.

Draw Arrow: This option specifies whether or not to draw arrowheads at the end of the dial hands.

Draw Full Circle: This option specifies whether to draw the dial as a complete circle (360 degrees) or
only draw the portion of the circle determined by the starting and ending angles.

Circular Sector

Needle Style: This option allows you to set style of the needle. The default one is Pointed Blade.
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Needle Options: This option specifies the distance of the hand for each needle (if multiple needles exist)
from the center of the dial. The range is from 0 (center of the dial) to 1 (end of the dial).
You can adjust the needle length for each category by selecting the category from the
drop-down list.

4.3.5.5.2. Pie and Doughnut Charts
Please note that doughnut chart specific options are exactly same as for pie charts, so even though the next section
will only mention pie charts, the same options also apply for doughnout charts.

The following dialog is opened for pie charts:

Pie Chart with Series Options Dialog

Different options will appear in this dialog depending on whether the pie chart is two-dimensional or three-dimen-
sional and whether or not it has a series. The following options are available for pie charts:

Explode: This option allows you to pick one or more category/series elements whose
sections are to be drawn at a certain distance away from the center of the pie.

Exploded Slices

Sector Gap: This option allows you to pick one or more category/series elements whose
sections maintain the same distance from the center of the pie. This option
creates a gap between the slices.
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Sector Gap Applied on Slices

Distance From Origin: This option allows you to specify how far the exploded sections are to be
drawn away from the center. This number, represented as a percentage of the
radius, indicates the distance between the center and the tip of the pie slice
to be exploded. For sector gap, this option is used to define the gap between
the slices representing selected categories/series.

Rotate Pie: This option allows you to specify the number of degrees that the chart should
be rotated. To rotate the pie in a clockwise direction, use negative values
(i.e. -90). To rotate it in a counter-clockwise direction, use positive values
(between 1 - 360).

Place Label: This option indicates the distance of the labels from the center of the pie.

'Others' % Threshold: This feature is useful for pie charts that have a large number of small cate-
gories. Rather than drawing a slice for each category, you can select a thresh-
old value. Any category with less than the threshold value will be moved
into “Others” slice.

Display Name for 'Others': This option allows you to set the display name for the “Others” slice that is
created for categories that fall below the set threshold value. This label will
appear in the legend and/or for the slice label.

Label: This option determines whether a category/series label should be drawn for
each pie slice. By default, it only appears as legend.

Value: This option allows you to specify whether to display the actual value of each
pie slice.

Percentage: This option allows you to display the percentage for each pie slice. The per-
centages are calculated by dividing the value of each section by the sum of
all the values.

Percentage in Legend: This option allows you to display the percentage in the legend represented
by each slice in the pie. In case a pie slice is too thin, this can be a preferable
presentation. This option is only available if the pie chart does not have a
data series.

Border: This option specifies whether to draw a border around each pie slice.

Slice-to-Label Line: This option will draw a line from any label(s) to its corresponding pie slice.

Label At Side: This option will place the labels for a pie chart away from the plot around
the outside of the chart. When used with the "Slice-to-Label Line" option,
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it gives you a way to display the pie labels for charts with many small cate-
gories without any text overlapping.

Explode Others: This option allwos you to draw the “Others” segment at a certain distance
from the center of the pie chart.

Best Fit: This option will arrange multiple pies in best configuration to fit the chart
canvas. It's only available for pie charts with data series.

Draw Linearly: This option will arrange multiple pies in a straight horizontal line. It's only
available for pie charts with data series.

Number of Pies Per Row: This option allows you to create a custom arrangement of multiple pies by
specifying the number of pies to be drawn in each row. It's only available
for pie charts with data series.

Gap Between Pies: This option allows you to specify a gap between multiple pies. The number
represent multiple of the pie radius, so the gap will adjust with the size of
the chart plot. It's only available for pie charts with data series.

4.3.5.5.3. HLCO Charts
The following dialog is opened for HLCO charts:

HLCO Chart Options Dialog

The Draw Hi-Low As Candle Stick option will turn the HLCO chart into a candle representation. A candle HLCO
chart blends high, low, close, and open data into a single object that resembles a candlestick.

4.3.5.5.4. Gantt Charts
The following dialog is opened for Gantt charts:

Gantt Options Dialog

The following options are available for Gantt charts:

Draw Arrows: This option will draw connecting arrows between category elements of the
Gantt chart. This allows you to illustrate a sequence between scheduled
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events. The arrows are drawn in the order the category elements appear in
the data source.

Display X-Axis in Time: This option shows the ticker labels as time values instead of numeric values
for the X-axis.

Display X-Axis in Day of Week: This option shows the ticker labels as days of the week with the date for each
Sunday shown as well.

Minimum Date: This option specifies the beginning date for the X-axis. The format is year,
month, day, hour, and minute.

Maximum Date: This option specifies the end date for the X-axis. The format is year, month,
day, hour, and minute.

Scale Step: This option specifies the scale step for the X-axis. The format is year, month,
day, hour, and minute.

4.3.5.5.5. Polar Charts
For polar charts, the following dialog is opened:

Polar Chart Options Dialog

The following options are available for polar charts:

Scale: This option allows you to specify whether the input data for the angle (θ) portion of
the data points is in radians or degrees. The chart will always display angles from 0
to 360. If the input data is in radians, it will be displayed as degrees.

Direction: This option allows you to specify whether the circular plot should be drawn clockwise
or counter-clockwise.

Start Angle: By default, the top of the polar chart plot is 0 degrees. This option allows you to
specify a different angle for the top of the plot. It can be displayed either in degrees
or radians, depending on the scale you chose.

Number of Sectors: This option allows you to select the number of sectors you want to show in the chart.
Sectors are created by drawing additional polar axis lines at specified angle intervals.
By default, four sectors are shown.

4.3.6. Save the Chart
Once you create a chart in QuickDesigner Charts, you can share it with other users by saving it on the server and
inserting it into the Organizer.

To save a chart, click on the  Save (or  Save Chart As for saving the file under a different name that is
already saved) button on the toolbar. A dialog will open in the left pane.
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Save Chart Dialog

Here you can see all Organizer projects and folders you have access to. Select the project or folder you want to save
the chart into. Specify a name for the chart at the bottom of the dialog. The chart will be saved with .qch extension.

Once you finish specifying the options, click on the OK button to save the chart. The new file will be saved in the
ChartFiles folder in the EDAB installation directory as ChartNameInOrganizer_Username_TimeStam-
p.qch. This should help to avoid unintentional overwriting of chart files.

If you try to save a file with the same name as another file, you will be asked to confirm overwriting it or using a
different name. If you wish to save the changes in the currently opened chart, do not change the chart name and the
Organizer folder in the Save Chart dialog. Click Yes in the dialog and the chart file will be updated.

Chart Overwrite Dialog

4.3.7. Export the Chart

You can export a chart in a number of different formats. To do so, click on the  Export button on the toolbar
and a dialog will open in a new window prompting you to specify the export options.



Designing Reports & Charts

401

Export Chart Dialog

The first option allows you to specify the format in which to export the chart. The available formats are GIF, JPEG,
PNG, BMP, PDF, SVG, SWF (Flash), Text, XML, and Chart Image Map.

The second option allows you to set the dimensions of the exported image. By default, these will match the canvas
dimensions of your chart.

The last options allow you to set some image type-specific options. (The options appear only for appropriate format.)
You can set the background transparent for GIF files (please note that the result is not good for more than 256 colors
- e.g. with Color Gradient), set the quality for JPEG files, as well as specify compression for PNG files.

For more information about the chart export options, please see Section 4.1.6.2 - Exporting Charts.

Once you finish specifying the options for the exported chart, click on the OK button and a new window will open
containing the exported chart. You can save the generated file to your local system by clicking on the Download
Image button.

Exported Chart

4.3.8. Open the Saved Chart

You can open a saved chart by clicking on the  Open icon on the main toolbar. The Open Chart dialog will
appear.
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Open Chart Dialog

Here you can see all charts created in QuickDesigner Charts. Select a chart and then click on the OK button to open it.

4.3.9. Exit

You can exit QuickDesigner Charts either by clicking on the  Home icon in the upper right corner, clicking on

the QuickDesigner Charts title, or by clicking on the  Logo icon in the upper left corner. Before closing, you
will be asked if you want to save an unsaved chart.
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Chapter 5. Designing Maps
5.1. Introduction to EDAB Maps

EDAB Maps are designed to report geographical data from data sources. They fetch geographical data from data
source and mark them on a map. There are two types of maps: Online Maps and SVG Maps.

Online Maps The Online Maps feature in EDAB displays geographical data using high quality on-line maps
made by Google and Open Street Maps. Online Maps provides street maps and satellite maps,
spanning over the entire world. By using high quality satellite imagery, a very wide zoom range
is possible, making it possible to display every imaginable area of the world. Online Maps are
useful for displaying exact spots on the maps. These spots are called map points and they are
marked with map markers. A powerful tool provided by EDAB Online Maps is Geocoding.
Geocoding can locate buildings/cities on map by knowing only their addresses. Usage of Online
Maps is limited by Online Maps Terms of Service (To see the current version, visit Google Maps
API Terms of Service [ https://developers.google.com/maps/terms.html ], Open Street Maps API
Terms of Service [ https://www.openstreetmap.org/copyright/en ]).

Online Maps can contain tooltips and drilldowns. Tooltips are small reports or charts which are
displayed on mouse over a map marker. They display brief summary information related to the
selected map point. Drilldowns are links to parameterized charts, reports or other maps that open
when you click on a map marker. They are usually used to display more detailed information
about the selected map point.

SVG Maps SVG Maps display data on SVG (Scalable Vector Graphics) maps. They differ from EDAB
Online Maps in two ways. First, SVG Maps work with geographical areas (e.g. a state is marked
by the whole territory, not just by a point in the middle of the state). These areas can be colored
according to set criteria. Second, the SVG Maps feature requires SVG images as the map source
and do not use any online map source. The SVG Maps feature may be used to display spatial
(non-geographic) and customized maps (e.g. maps of buildings, floor plans, mine maps, etc.).

5.2. Online Maps
EDAB Online Maps use two types of files: Coordinates and Map Files. Coordinates contain location of individual
map points (e.g. cities, company branches). Coordinates have to be created before creating a map. One set of
Coordinates can be shared by several maps, so you do not have to store the same file several times. It is enough
to add a map point in the Coordinates and it is added to all maps that use these Coordinates. For more information
about Coordinates, see Section 5.2.4.2 - Create Coordinates. Map File displays map markers based on Coordinates
and defines Drilldowns, Tooltips, and Heatmaps.

5.2.1. Generating Google Maps API Key
It is possible to use EDAB Maps without Google API Key if you don't select either Google Street Map, Google
Satellite Map or Geocoding.

Tip
You can use Open Street Maps even without the API key

Open Street Maps are a free alternative to Google Maps. Select Open Street Map in the Map Options dialog if you
don't need Google Maps.

Since the time Google Maps were embedded into our products, Google has change their ToS. To keep the EDAB
Maps compatible, our developers added the option to use your Google API Key in EDAB.

To use Google geocoding and Google Maps, you have to get the correct Google API key set up.

All the steps necessary for enabling Google Street Map, Google Satellite Map or Google Geocoding:

https://developers.google.com/maps/terms.html
https://developers.google.com/maps/terms.html
https://developers.google.com/maps/terms.html
https://www.openstreetmap.org/copyright/en
https://www.openstreetmap.org/copyright/en
https://www.openstreetmap.org/copyright/en
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1. If you don't have a Google Cloud Platform account, create one https://cloud.google.com/console/google/maps-
apis/overview

2. Log in To Google Cloud Platform here https://cloud.google.com/console/google/maps-apis/overview

3. Create a new project there

4. Select the project

5. Select APIs & Services → Credentials

6. Create credentials → API key

Then enable the services you need.

For using Google Maps without geocoding, you have to have “Maps JavaScript API” enabled

For using Geocoding, you have to have both Maps “JavaScript API” and “Geocoding API” enabled

To enable Maps JavaScript API

1. Click APIs

2. Click Maps JavaScript API

3. Click ENABLE

To enable Geocoding API

1. Click APIs

2. Click Geocoding API

3. Click ENABLE

To check quotas and billing:

• Click APIs again

• In the list of enabled APIs, select the Geocoding API

• Click Quotas

• Scroll down to Requests

• Find “Requests per day” and click the pencil Edit icon

• As you can see, you cannot increase the limit for more than 1 request per day unless you enable billing

• Click Enable billing for this project.

• Then you can either use an existing credit card information saved in Google or create a new one.

5.2.2. Data Sources
Each EDAB Online Map uses data from two data sources - the first one is used for Coordinates and the second one
is for the map itself. This chapter explains where and how these data sources are used.

The Coordinates data source is used when you are creating Coordinates. It is used for obtaining all the Point IDs.
The Point ID is an identifier of a place (e.g. city name, branch name etc.) and it is loaded from the data source
where you selected to create the Coordinates. The Point ID can consist of several Point ID fields - each data source
column creates one field (except the fields which contain longitude, latitude, or WKT). For example, if your data
source contains two columns - City and State, the Point ID will consist of two fields - City and State.

https://cloud.google.com/console/google/maps-apis/overview
https://cloud.google.com/console/google/maps-apis/overview
https://cloud.google.com/console/google/maps-apis/overview
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Each map point should have its unique Point ID, so any map point can be distinguished from the others. The data
source should be chosen wisely to fulfill this condition (each row of data should be unique, there must not be
duplicates).

It is recommended not to use parameterized data source for Coordinates, because there is no way to set parameter
values for Coordinates. If you use a parameterized data source for Coordinates, the default parameter values are al-
ways used. This does not apply to multivalue parameters which use all the values (e.g. if you use CustomersIn-
States HSQL query (Databases/Woodview/Query/CustomersInStates) to create coordinates using
geocoding - all param values (states) will be used).

The Point ID is used for mapping map markers to the map data source in the Map File, so it should contain data
which occurs in the map data source and which uniquely identifies map points. For example, if you want to display
cities where your company has some customers, you should use City name and State name as the Point ID fields. The
State name is useful in case when there are more cities with the same name in several different states. Optionally,
you can add more Point ID fields for more detailed specification of city. For example if there are two cities with
the same name in the same state, you should use more Point ID field(s) which will distinguish between these two
cities, a ZIP code for instance.

The Coordinates data source can also contain coordinates (longitudes, latitudes, or WKT) of the map points. The
longitudes and latitudes have to be stored in two separated columns of double data type, while WKT is a text field.
These columns are not used as Point ID fields. If the coordinates are read from the data source, they are fetched
every time the map is generated, so if there is a change in the Coordinates data source, it will be reflected in the
map immediately. If the coordinates are not read from the data source, they are stored directly in the Coordinates
file. In this case, the Coordinates data source is accessed only when you are creating or editing the Coordinates in
the Coordinates Editor. When you are creating or displaying a map that is using this Coordinates, the data source
is not accessed at all, because all the necessary information is in the Coordinates file, so it is not necessary for this
Coordinates data source to be available when the map is created/displayed.

The map data source has two purposes. The first one is that it contains data that are used for Tooltips and Heatmaps.
The second purpose is filtering. The map data source is mapped to the Coordinates as described in the Section 5.2.5
- Coordinates Mapping and only those map points from the Coordinates that have at least one associated row in
the map data source are displayed. The map data source can be parameterized. In this case, the whole map is
parameterized. If you create/open map that is using parameterized data source, there will be a filter icon in the map
which opens parameters dialog that allows you to enter parameter values.

5.2.3. Start Online Maps
Online Maps can be started by clicking on the Online Maps link on the EDAB Main page. After launching Online
Maps, you will see a diagram that shows how to work with Online Maps. You can choose to create a new map,
open an existing one, or open the Coordinates Editor where you can create/edit Coordinates.

Online Maps Start Options
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5.2.4. Coordinates Editor

Click on the  Coordinates Editor/Edit Coordinates icon on the toolbar. The Coordinates Editor will open.

Coordinates Editor Start Options

5.2.4.1. Select Data Source

Open the Data Source Dialog by clicking on the  New Coordinates icon on the toolbar. Select the data registry
in the upper left corner of the dialog and then select the desired data source (For more information about managing
data registries, visit Section 3.1.1 - Managing Data Registries). A view of the data will appear in the right pane,
which will allow you to check whether you chose the right data source. Click on the OK button to close the Data
Source Dialog.

Data Source Dialog

5.2.4.2. Create Coordinates
The Coordinates file contains the coordinates of map points. Each Coordinates data record consists of WKT (ob-
tained automatically or manually) and Point ID (for more information about Point ID, see Section 5.2.2 - Data
Sources). Note: Existing coordinates files or data sources with longitude and latitude columns are still supported,
but only WKT will be generated by geocoding or manual entry.

After selecting the data source, you will be prompted to select a method for obtaining Coordinates from the data
source.
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Get Coordinates

There are three ways how to get Coordinates, which are described below. Status of each pointID is determined by
colors in the pointID table (For more information about colors, see Section 5.2.4.3 - Coordinates Editor Interface):

5.2.4.2.1. From Data Source
This option requires two numeral data source columns containing information about the latitude and longitude or
WKT of particular map point. Latitude and longitude have to be in different columns. The data type of these columns
should be double and they should contain latitude and longitude in decimal degree notation. Positive longitude
means East longitude, negative means West. Positive latitude means North latitude, negative means South.

In this case, map point latitudes and longitudes are read from the data source every time a map, which is using this
Coordinates, is open. If the data source changes, the change is reflected in the map (e.g. if a new map point is added,
it will be displayed on the map). It is not necessary to edit the Coordinates, updating the data source is good enough.

If Geocoding or Manual insertion of the map point coordinates is used, it is necessary to edit the Coordinates every
time you want to add or modify (move) a map point.

If the Coordinates are obtained from a data source, all map points will be placed automatically according to the data
from the data source. These rows will have white color. In this case, the Coordinates are read-only - you can only
check which map marker belongs to which Point ID by holding mouse over a map marker/Point ID. The associated
Point ID/map marker will be highlighted with yellow color. If you want to change the position of a map point,
you have to modify the data source directly (i.e. change the longitude and latitude or WKT in the appropriate data
source column).
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Coordinates from Data Source

5.2.4.2.2. Geocoding
Positions will be determined automatically using point addresses. The addresses can consist of several data source
columns. You can select columns, which contain Address 1, Address 2, City, Postal Code, State, Province, and
Country. Some of the fields may already be pre-selected when there is a convenient column in your data source (e.g.
if the data source contains a column called City, it will be pre-selected in City field). You do not have to fill all the
fields. If you do not fill any field, you will be automatically switched to manually option (see the next chapter). The
name of the Geocoding fields are only illustrative, they do not have to be filled with exactly this information. The
only rule you should keep in mind is to use the more specific information (e.g. street address) before the less specific
(e.g. state). If your data source column contains more then just one field, use the first suitable field (e.g. if there is
column with full address, you should use Address 1 field and leave the rest empty). Geocoding is very adaptive as
it does not require any specific format of addresses and is able to find even inaccurate or incomplete addresses.

Please note that Geocoding may not be supported for all countries. To see the list of currently supported countries,
visit Google Maps Coverage [ https://developers.google.com/maps/coverage ] and find your country in the list.

If you selected Geocoding, the Geocoding process is started automatically. It goes through all Point IDs and tries
to determine positions of the corresponding points from their addresses. If it finds exactly one result, the map point
is inserted automatically. The new point and the corresponding Point ID will turn yellow for a moment and then it
will turn white, which indicates that the position is already determined. The toolbar is disabled during Geocoding,
so you have to wait until it is finished before performing other actions. You can watch the Geocoding progress on
the status bar. After the Geocoding is done, you should insert points that were not inserted automatically. These
points had either no Geocoding results or more than one Geocoding result. The process is same as inserting the
point manually and it is described below.

https://developers.google.com/maps/coverage
https://developers.google.com/maps/coverage
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Coordinates by Geocoding

If you used Geocoding and you insert the rest of the points manually, the Point ID row may turn green instead of
dark red after you click on it. This occurs when there is more than one Geocoding result. These results are displayed
on the Online map with green markers so you can select the right one by clicking on it. If the desired map point is
not among the Geocoding results, you can still add the map point manually on the correct place in the same way
as manual inserting. If you hold mouse over a Geocoding result (green map marker), the full address of this map
point is displayed to help you identify the correct place.

Selecting Geocoding Result

Please note that the Geocoding is not 100% accurate, so you should check all results that were inserted automatically.

5.2.4.2.3. Manually
This option does not require any geographical data at all. Coordinates of map points are determined manually by
clicking on the map.

In the Manually case, all the Point IDs are light red at the beginning, which means that their position is not deter-
mined. To place a map point, click on a Point ID (row in the table) first. The Point ID row will now turn dark red.
Point option should be active as default on the map toolbar (Point is blue). Mouse over the map and you will see
a small blue circle under your mouse pointer. Then click on the location where you want to place your map point.
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A new map marker will be placed on the selected map point and the appropriate row will become white. Then you
can place another map point in the same way. To freely navigate across the map, select Move option on the toolbar.
Now you can move and zoom the map any way you need. You can also use another shapes to define a location on
the map - Polygon, Square, and Box on the map toolbar. To use these options, select the shape, place the first point
on the map by clicking the mouse, move the mouse and place another point(s).

Selecting Location

Selected Location

The following images show the formation of shapes (blue color) and their final form (red color).
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Polygon

Square
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Box

You can move any of the already existing map points by dragging the appropriate map marker with mouse. You
can also resize a shape by dragging the edge of a side to any direction.

5.2.4.3. Coordinates Editor Interface
After choosing a method of obtaining coordinates, you will get a map with a point ID table.

Coordinates Editor

The following buttons are on the toolbar:

New: Creates new Coordinates.

Open: Opens existing Coordinates.
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Save: Saves current Coordinates to a file and Organizer. Note that all saved files will include userID and
timestamp in addition to the name you provided. If an Organizer item with the supplied name already exists
in the folder, you will be given a choice to override the existing item or create a new entry.

Save As: Allows you to save the existing or modified Coordinates to a different file or location.

Change Point Mapping: Allows you to change point mapping.

The left part of the window displays the Online Map, which displays individual map points using the map markers.
The Online Map can be scrolled and zoomed to find a specific object.

Point ID table in the right part of the window shows all the Point IDs, which were read from the data source,
and longitude and latitude of map points. Each row represents one Point ID and can have one of the following
background colors:

White: Location of the corresponding map point has been successfully determined.

Light red: Location of the corresponding map point has not been determined yet. There are multiple locations
for the point. This is not static status color.

Grey: Location of the corresponding map point has not been determined yet. There is no location for the
point. When you click this grey-colored row, it turns into dark red. This is not static color.

Dark red: Marks the point ID, which is currently under mouse cursor. If you click on it, it will either change
into green (multiple locations), or grey (No location found), waiting for users to enter the location manually.

Yellow: Highlights the row with Point ID of the map point under mouse cursor on the map (this is used to
determine which Point ID belongs to which map marker).

Green: Indicates that there are Geocoding matches for the selected Point ID.

5.2.4.4. Save Coordinates

If you want to use the Coordinates for creating maps, be sure to save it to Organizer (click the  Save icon, enter
a Coordinates name, and select any Organizer folder). Then click the Done button on the right side of the toolbar
to close the Coordinates Editor and go back to Online Maps main window.
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Save Dialog

5.2.4.5. Open, Edit Coordinates

To open a saved coordinates file, first open Coordinates Editor by clicking the  Coordinates Editor/Edit Coor-

dinates icon on the main toolbar of the Online Maps designer. Then click the  Open icon on the main toolbar
of Coordinates Editor.

Open Coordinates

You can see all coordinates files from Organizer. Select a coordinates file and click the Open button.

Now you can edit coordinates obtained via geocoding or manual insertion. Coordinates obtained from data source
are not possible to edit. You can change a point when you click the respective row in the pointID table - then you
can either select again one of the geocoding results (applies only to geocoding coordinates) or replace a current
point/shape with a new one in the map.

You can directly edit a map point using the drag and drop feature or edit a shape by stretching its sides.
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Shape Editing

Please note that if the coordinates obtained via geocoding are not complete (not all rows are white), the geocoding
process starts each time the file is opened.

Once you finish editing the coordinates, save the file and click the Done button to close the Coordinates Editor.

5.2.5. Coordinates Mapping
EDAB Online Maps needs Coordinates to map the data source records to map points. When creating Online Maps,
you have to map the Point ID fields from the Coordinates file to the map data source columns. According to this
mapping, data source rows are associated with map points. There can be more data source rows associated with one
map point but not vice versa (because Point IDs must be unique). The rows associated with a map point are used
to generate Tooltips (see Section 5.2.6.7 - Tooltips) for the appropriate map marker.

Not all the Point ID fields have to be mapped. For example, if your Point ID has three fields - City, State, and
Country, you can map only Country and State. But you have to keep in mind that any map point should be uniquely
determined by the mapped Point ID fields. So if there are two Point IDs in your Coordinates, which differ only
in City, but have equal Country and State, you have to use the City as well to distinguish between those two map
points. You will get no error message if you use wrong mapping, but the data can be displayed incorrectly.

Some map points from the Coordinates may not have any associated rows. These map points are not displayed
on the map using map markers. Only the map markers, for which some data was found in the data source, are
displayed. So you can have Coordinates containing all the major cities in USA, but you can display only the one you
are interested in. And you can use the same Coordinates for different map, which will show different set of cities,
because the data source will contain data for different cities, so you do not have to maintain too many Coordinates
files if you choose suitable Point ID fields.

Example:

Your data source contains the following data and you want to display data grouped by cities on a map:

Row # City State Customer
Name

Sales

1 San Fran-
cisco

CA Company A $152,560

2 New York NY Company B $240,468

3 Los Angeles CA Company C $335,256

4 San Fran-
cisco

CA Company D $80,381
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Row # City State Customer
Name

Sales

5 Boston MA company E $23,540

6 Chicago IL Company F $124,532

You will have to create the Coordinates first. In this case, only the City name could be used as the Point ID because
it is unique, but we will use two Point ID fields instead - City and State, in case that there will be more cities with
the same name in different states in the future. So we will create a data source with two columns - City and State.
This data source has to contain all the listed cities (and could contain some more). We can either write a suitable
query to obtain these two columns from the original data source (if using a database for the data source) or we can,
for example, create a simple text file data source with these two columns.

Next, we can start Coordinates Editor and create the Coordinates. Assuming we have a data source that does not
contain data for longitudes and latitudes or WKT, so we cannot use coordinates from data source but we know
part of an address, we will use Geocoding. Using Geocoding, we will assign WKT to every city, so the table in the
Coordinates Editor will look like this (note that there is one extra city - Orlando, which is not in the map data source):

Now you can create a map from the data source using these Coordinates. You map City Point ID field to the City
data source column and State Point ID field to the State data source column. The Point IDs will be paired with
the data source rows - San Francisco with the first and fourth, and Chicago with the sixth. Orlando does not have
any matching row in the data source, so it will not be displayed at all. If you add a Tooltip, the associated rows
will be used to generate it. For example, the Tooltip for San Francisco will be created using data from the first and
fourth row of the data source.

If you add a new city to the data source and you want to display it too, you have to edit the Coordinates data source
first and add the city there. Next, you can open the Coordinates in the Coordinates Editor and there will be one new
row in the table with this new city. This enables you to add the new map point for this city. You do not have to
modify anything in your map. Therefore, if this Coordinates is shared among several maps, the map point is added
automatically to all these maps.

5.2.6. Create Online Maps
EDAB Online map is a special kind of report that allows displaying geographical data on map. It points out the
reported geographical data on a map using map markers. Markers can be used as drill-down links to parameterized
reports, charts, or maps. Markers may also have tooltips. Tooltips look like bubbles, containing a report or chart.
When tooltips are enabled, every map marker has its own tooltip bubble, which displays data associated to this map
point. Only one tooltip bubble can be displayed at the time. A tooltip appears when you move your mouse cursor
over a map marker. It closes automatically when you open a different tooltip, or it can be closed by clicking on the
X sign in the upper right corner of the tooltip bubble.

To create a Online Map, launch Online Maps from the EDAB main page.

5.2.6.1. Select Data Source

To create a new Online Map, click on the  New Map icon on the toolbar. The Data Source Dialog will appear.
Select a data source for your map and click OK.
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Data Source Dialog

5.2.6.2. Select Coordinates
Once you select a data source for your map, you will be prompted to select Coordinates file.

Select Coordinates

Select a Coordinates file and click the Next button. You can also launch the Coordinates Editor from this dialog
by clicking the Create Coordinates button and creating a new coordinates file. Once the new coordinates file is
saved, click the Done button in the upper right corner of the Coordinates Editor. You will be brought directly to
Coordinates Mapping which is described in the next chapter.

5.2.6.3. Coordinates Mapping
You will be prompted to select point mapping, i.e. you have to pair columns that will enable EDAB Online Maps
to assign records from maps record's data source to suitable Point ID fields from the Coordinates (e.g. if you want
to show cities with your affiliates on map, your Coordinates may contain a column called City which is mapped to
Affiliates_City from the map's data source). For more information, see Section 5.2.5 - Coordinates Mapping. Please
note that Online Maps designer automatically recognizes which columns are the most suitable for Coordinates
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mapping. Therefore, some of the fields may already be pre-selected when there is a convenient column in your data
source (e.g. if the data source contains a column called City, it will be pre-selected in City field).

Coordinates Mapping

You have to map at least one column. Then click Apply and the Online Map will appear.

Online Maps Designer

You can change the Coordinates mapping by clicking the  Change Point Mapping icon on the toolbar.

5.2.6.4. Toolbar
These buttons are on the Online Maps toolbar:

New Map:  Creates a new Map.

Open Map:  Opens an existing Map.

Save Map:  Saves the current Map to a file and Organizer. Note that all saved files will include userID and
timestamp in addition to the name you provided. If an Organizer item with the supplied name exists in the
folder, you will be given a choice to override the existing item or create a new entry.

Save Map As:  Allows you to save the existing or modified Map to a different file or location.

Set Map Options:  Allows you to change the way the Online Map is displayed.
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Map Title Options:  Allows you to set map title and its options.

Set Heatmap:  Allows you to color-code map markers.

Tooltip Template:  Adds/Modifies report/chart templates used as tooltips.

Tooltip Options:  Allows you to change dimensions of tooltip bubbles.

Drilldown Options:  Configures drill-downs.

Change Point Mapping:  Changes the point mapping.

Change Data Source:  Changes the data source of current map. Note that changing data source will result
in loosing tooltip and drill-down settings.

Refresh:  Refreshes the map data (if the data source changed).

Coordinates Editor/Edit Coordinates:  Opens Coordinates Editor that allows you to create/edit coordinates.

Home:  Closes Online Maps designer. Before closing, you will be asked if you want to save an unsaved map.

5.2.6.5. Map Options

To set map options, click on the  Set Map Options icon on the toolbar.

Map Options

Dimensions: Allows you to set width and height of the map (in pixels).

Zoom: Allows you to set minimal and maximal zoom of the map (in the range 1-17).

Map Controls: Zoom Control - shows/hides the zoom controls in the upper left corner (large, small, none).
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Zoom Control Large

Map Type - allows you to set map type (Open Street Map, Google Street Map, Google
Satellite).

Google Satellite

Map Scale Control - shows/hides the scale control in the lower right-hand corner.

Scale Control

5.2.6.6. Heatmap
Heatmaps allows you to display map points in different colors based on values from a column in the data source.
You can choose between two heatmap types - transition or thresholds.

Please note that some of the data sources have multiple records belonging to single map points in coordinates file.
The Aggregation option allows users to choose a preferred way on how to aggregate values in the given heatmap
column. The default aggregation value is set to First and this value is recommended only for maps where multiple
records for one point in the map are not expected. In other cases, it is better to choose a more appropriate aggregation.
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To set a heatmap, click on the  Set Heatmap icon on the toolbar. The Set Heatmap dialog appears in the left
pane. At first check off the Enable Heatmap option and select a type of the heatmap - Transition or Threshold. The
Set Heatmap dialog will be adjusted accordingly:

Transition Heatmap: Select a Heatmap Column from the drop-down list, select an Aggregation, and set
minimal and maximal value of the selected column values. You can also choose a
value from the drop down lists which contain the precise values from the selected
column. Select a color gradient and click Apply to apply your settings on the map.

Set Transition Heatmap

You can enable/disable a heatmap by checking/unchecking Enable Heatmap option.

Threshold Heatmap: Select a Heatmap Column from the drop-down list, select an Aggregation, and click
the Add button to add a threshold. Add Threshold dialog will appear.

Set Threshold Heatmap

Type a threshold value or choose a value from the drop-down list which contains
precise values from the selected column and click the OK button. Set another thresh-
olds in the same way and set colors for each threshold by clicking on the color square
and selecting the color. Then click Apply to apply the heatmap.
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Set Threshold Heatmap

You can remove each threshold by clicking the Remove button next to the threshold.
To enable/disable a heatmap, check/uncheck Enable Heatmap option.

5.2.6.7. Tooltips
Tooltips may contain a report or chart that shows up when you move your mouse cursor over any map marker
on the Online Map. Tooltips display single or multiple-row data that is related to the particular map point. As an
example, a report tooltip will display data from the map datasource using parameter(s) from the Map Data of the
corresponding map point. The Map Data is the same as the list in the Change Point Mapping dialog box. The report
or chart file that is displayed in the tooltip bubble is called Tooltip Template.

Online Map with Tooltip

To enable tooltips for EDAB Online Map, open the map in Online Maps and click on the  Tooltip Template
icon. The Add Tooltip Template options will appear in the left pane.
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Add Tooltip Template

You can select an existing tooltip, create chart tooltip, or create report tooltip.

Select Existing: To select an existing Tooltip Template, select it from Available reports/charts list
and click the Select Existing button. Using this option, you can also use the re-
port/chart templates created in the Report Designer/Chart Designer, so you are not
limited to use just the QuickDesigner Charts or QuickDesigner Reports to design
Tooltip Templates. In this case, it is recommended to use exactly the same data
source for creating this Tooltip Template report/chart as for the map, otherwise there
might be a problem with data mapping.

New Chart Tooltip: Launches QuickDesigner Charts that will allow you to create a new chart file. Cre-

ate a chart, save it, and leave QuickDesigner Charts by clicking the  Return to
Map Designer icon on the toolbar. (For more information about working in Quick-
Designer Charts, see Section 4.3 - QuickDesigner Charts.)

New Report Tooltip: Launches QuickDesigner Reports that will allow you to create a new report file.

Create a report, save it, and leave QuickDesigner Charts by clicking the  Re-
turn to Map Designer icon on the toolbar. (For more information about working in
QuickDesigner Reports, see Section 4.2 - QuickDesigner Reports.)

To edit, select, or remove the current tooltip, click on the  Tooltip Template icon. The Edit Tooltip Template
options will appear in the left pane. Please note that from this dialog, you can only directly edit files created in
QuickDesigner Reports and QuickDesigner Charts (.qdr or .qch).
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Edit Tooltip Template

Select Existing: Allows you to select other Tooltip Templates.

Edit Tooltip: Launches QuickDesigner Report or QuickDesigner Chart where you can edit the current
tooltip template if it's a .qdr or .qch file (i.e. files from one of the QuickDesigners).

Remove Tooltip: Removes current Tooltip Template.

Note
To create a new chart/report tooltip you have to remove current tooltip at first and then will be New
Chart Tooltip and New Report Tooltip options available.

To configure dimensions of the tooltip bubbles, click on the  Tooltip Options icon on the toolbar. Set new
dimensions and click Apply.

Tooltip Options

Changes will take effect after closing the current tooltip bubble (if a bubble is open, otherwise the changes will
take effect immediately). It is not necessary to close the current tooltip bubble, you can just mouse over some other
map point.

5.2.6.8. Parameter Setting

You can change parameters directly on the map by clicking the  Set parameters icon in the upper left corner
of the map (The icon is displayed only if the data source is parameterized). A new dialog will open where you can
select parameter value(s).
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If the parameter is single-value, the next dialog will display a drop-down list. Select a parameter value and click
the Submit button to apply it on the map. (You can reset your selection by clicking the Reset button.)

Parameter Setting

If the parameter is multi-value, the next dialog will display a list of parameter values. You can select parameter

values by clicking on them (use Ctrl+click for multiple selection), select all parameter values by clicking the 

Select All icon, deselect all parameter values by clicking the  Select None icon, and reset your selection by clicking
the Reset button. Then apply your selection to the map by clicking the Submit button.

Parameter Setting

5.2.6.9. Drilldowns

To enable drilldowns in a map, click on the  DrillDown Options icon. Check the Enable Drilldown checkbox
which will show you all parameterized reports, charts and maps saved in Organizer. Click on a suitable parameter-
ized report, chart, or map and select parameter mapping. All drilldown parameters have to be mapped to some Point
ID field from the Coordinates. Mapping in this case means that the Point ID values of the selected map point will
be used as drilldown parameter values (each map marker has unique Point ID). When you click on a map marker
on the map, the drilldown report/chart/map will open in a new browser tab.
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Drilldown Options

If all the drilldown parameters are multi-value (see Section 3.1.3.2.2.1 - Multi-Value Parameters), you will be al-
lowed to select multiple map markers at once. For example, you can use Examples/QuickStart/Quick-
Start Maps/MultiValue data source, map MULTIVALUE parameter to STATE column, and then click Apply.

Multi-value Data Source

Selecting multiple map markers can be done by clicking the multi-value Drilldown button (see the image below;
the button is displayed only if the map contains multi-value Drilldown).
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Multi-value Drilldown Button

After clicking the Multi-value drilldown button, the Multivalue drilldown dialog will appear.

Multi-value Drilldown Dialog

You can choose a shape of the bounding box (rectangle or circle). The circle can be fixed or drawn. Once you select
a shape, click the OK button. Then you can select multiple map markers by dragging using bounding box. Left click
on the map (this determines rectangle corner or circle center), hold mouse button down and drag it, and then release
the mouse button to determine size of the bounding shape.

Bounding Box

If you select fixed circle as a bounding box, you can set a diameter of the circle. Write a diameter value and click
the OK button. You will see a circle with the diameter you just set. Then click to the map. Your click is a center of
the circle bouding box. A new tab with a drilldown of your selection (markers within the circle) will appear.
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Fixed Circle Bounding Box

5.2.6.10. Map Title

To enable map title, click on the  Map Title Options icon and check the Enable Map Title checkbox. Then
you can insert the map title text and select various options - font, text alignment, font style, title position, font
size (positive integers only), and text color. The color can either be chosen from swatches or inserted manually by
entering red, green and blue components (all the values has to be integers from 0 to 255).

Map Title Options

5.2.7. Save Map

You can save the Online map by clicking the  Save button on the toolbar. This will open a dialog allowing
you to specify a name for the map. Enter a name for the map, select a project where you want to save it, and click
the OK button.
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Save Dialog

After saving or opening an existing Online map, the  Save As button allows you to save the existing or modified
map into a different name or location.

5.2.8. Open Saved Map

You can open a saved map by clicking the  Open icon on the main toolbar. The Open Map dialog will appear.

Open a Map

All Online maps created in Online Maps designer are visible in Organizer. Select a map and click the OK button
to open it.
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5.2.9. Exit

You can exit Online Maps designer either by clicking the  Home icon in the upper right corner, clicking the

Online Maps title, or by clicking the  Logo icon in the upper left corner. Before closing, you will be asked
if you want to save an unsaved map.

5.3. SVG Maps
5.3.1. Introduction to SVG Maps

Unlike Online Maps, SVG Maps do not use map points. They use map areas. The map areas can be colored based
on values from the map data source. Coordinates of the map areas are defined in SVG map image. Virtually any
SVG image can be used for SVG Maps, but it usually requires some modifications, which can be done in any
graphical editor with SVG support. EDAB does not contain any integrated graphical editor, so you have to use
third party software. The recommended software is Inkscape, which can be downloaded at www.inkscape.org [
https://inkscape.org/ ]. Inkscape is released under GPL license version 2 [ http://www.gnu.org/licenses/old-licens-
es/gpl-2.0.html ], so it is free for commercial and non-commercial use.

SVG (Scalable Vector Format) images consist of objects. These objects can be used as map area. To distinguish
among individual map areas, EDAB uses Area ID. Each map area must have an Area ID, but unlike Point ID, Area
ID does not take up more than one field (it always consists of only one field). The Area ID has to be unique for
every area and they are read from the SVG Image object ID attribute. This attribute can be set in most graphical
editors. Please see the next chapter for a step-by-step guide for the recommended tool - Inkscape.

EDAB is distributed with several SVG images that are already prepared to be used for creating SVG Maps without
any modification. These images can be found in <EDAB_Installation_directory>/MapFiles/SVG.
They are also included in Organizer in SVGMaps project. You can find the list of all these maps in the Appendix 5.A
- List of SVG Map Images.

5.3.2. Set Area IDs Using Inkscape Editor
Download the Inkscape editor (http://www.inkscape.org/ [ https://inkscape.org/ ]) and install it on your computer.
Open an SVG image. Complex SVG Images may consist of groups, each consisting of several elements (areas).
Right click on the area you want to change the ID of. At the bottom of the pop-up menu, notice an option called
Enter group [name of the group] (see the screenshot below) and click on it to enter the group.

Inkscape - Entering Object Group

https://inkscape.org/
https://inkscape.org/
http://www.gnu.org/licenses/old-licenses/gpl-2.0.html
http://www.gnu.org/licenses/old-licenses/gpl-2.0.html
http://www.gnu.org/licenses/old-licenses/gpl-2.0.html
https://inkscape.org/
https://inkscape.org/
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Right click on the area you wish to change the ID of again and select the Object properties option. Fill in the new
Area ID in the ID field and confirm it by pressing the Set button. Close the Object properties dialog. You can now
set Area IDs for other objects in a similar way.

Inkscape - Editing ID Attribute

If your map area consists of several unconnected SVG objects (like Alaska and Hawaii for USA), you can group
them in one group and assign the Area ID to the whole group. To do that, do not enter the group as described above,
but instead go to the Properties dialog for the whole group and assign the ID there. If a group has Area ID assigned
and there are objects inside this group that also have Area IDs assigned, there could be conflicts if the both Area
IDs (ID of the whole group and ID of an object from this group) are present in the map data source. In this case,
the behavior is undefined, so you can get unexpected results. It is OK to have groups with Area IDs that contains
objects with Area IDs, unless you use both IDs simultaneously in your data source. It can make sense in some cases
(e.g. you can have a world map with continent names as well as country names. You can safely use this map if you
use either continent names or country names separately.

To save the changes, open File menu (upper left corner) and select Save. Note that SVG images that you want to
use for creating SVG Maps have to be inserted in Organizer.

5.3.3. Area ID Mapping
SVG Map needs an SVG image that defines the map areas. All SVG objects in the SVG image can be used as map
areas. The only requirement is that they must have an Area ID assigned as described in the previous section. These
Area IDs are used for mapping the map data source rows to map areas (SVG objects). Unlike the Point IDs, Area
IDs cannot have multiple fields, so the mapping is much simpler. It is enough to select just one data source column,
which will be mapped to the Area ID. A map area is associated with the data source row, which has the value of
the mapped column equal to the Area ID (comparison is case sensitive).

In the SVG Maps, the map data source is used for coloring areas according to numerical value of a data source
column. It brings one more limitation for the map data source compared to Online Maps. There has to be at lest one
matching data source row for one Area IDs. If there is no matching row, the area will have original (unchanged)
color. If there is exactly one, the fill color of the matching map area will be changed according to Thresholds (see
Section 5.3.4.5 - Thresholds). If there is more than one matching row, the behavior is undefined. There will be no
error message, but the data displayed may not make sense.

5.3.4. SVG Maps Designing

5.3.4.1. Start
SVG Maps can be started from the EDAB Start page. If you have logged in as a user with design privileges, then
you can follow SVG Maps link to begin using SVG Maps.
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When the SVG Maps designer launches, the first page that appears prompts you to select between opening an
existing map, or creating a new one.

SVG Maps Start Options

5.3.4.2. Select Data Source

If you want to create a new SVG map, click on the  Create New Map icon on the toolbar. The Data Source
Dialog appears and prompts you to select data registry and data source you want to use with SVG Maps. In order
to use SVG Maps, a user must have read privileges to one of the registries defined in the Organizer. For more about
creating and managing data registries, please see Section 3.1.1 - Managing Data Registries.

Select data registry from the drop-down menu in the upper left corner. The tree-list bellow displays the content of
the selected registry. There are all of the data sources that have been defined in the registry that the user has access
to. Select a data source you want to use for the SVG map.

Data Source Dialog

Unlike Chart Designer where the user can select between creating new data sources or modifying the existing ones,
the only option is to select a data source for the map. The only exception to this is for Data Views or Data View
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Queries. If data sources of this type are selected, you will see the DataView Builder on the right side of the Data
Source Dialog. The DataView Builder allows you to build or modify queries against the View. For more information
about managing data sources, please see Section 3.2 - Data in QuickDesigners and Maps.

Once you finish selecting a data source, click the OK button to close the Data Source Dialog.

5.3.4.2.1. Change Data Source

To change a data source (for SVG maps that have already been created), click the  Change Data Source icon
on the toolbar. The Data Source Dialog will open and you will see current data source. Select other data source
from the tree list and then click the OK button to apply it.

5.3.4.2.2. Parameterized Data Source
You can use parameterized data source for SVG maps. For more information about parameterized data source in
SVG maps, please see Section 5.3.5 - Dynamic SVG Maps.

Selecting Parameterized Data Source

To change a parameter from the toolbar of the SVG Maps designer, click the  Refresh/Set Parameters icon on
the toolbar. You will see available parameters. Set the parameter(s) and click Submit to apply this setting.

5.3.4.3. Select SVG Image
Now you can see the Select SVG Image dialog on the left side of the SVG Maps designer. This dialog prompts
you to select a Map Image. Map Images are SVG image files with data structures containing geographic data (see
Section 5.3.3 - Area ID Mapping for more information about required image format) and must be inserted into the
Organizer before they can be used.
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Select SVG Image Dialog

The Select SVG Image dialog contains a tree-list showing all projects, folders, and SVG images inserted in the
Organizer. Select an SVG image you want to use as the map image and click the OK button. The Set Area ID
Mapping dialog appears. Select a data source column that should be mapped to the Area IDs and then click the
OK button.

Select Column with Area IDs

SVG map will open (Set Area ID Mapping dialog is collapsed on the screenshot).
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SVG Maps Interface

As you can see, right now we have only the basic map with no data highlighted. There are two ways of adding data
to the SVG Map: Thresholds and Drilldowns.

5.3.4.3.1. Change SVG Image

To change an SVG image (for SVG maps that have already been created), click the  Change SVG Image icon
on the toolbar. Select an image from the tree list and then click the OK button to apply the image.

Changing SVG Image

5.3.4.4. Toolbar
A lot of formatting actions for reports in SVG Maps are accessed through the toolbar. The icons perform the
following actions:

Start a new SVG map
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Open an existing SVG map

Save the current SVG map

Save the SVG map as

Set a map size

Insert/Edit a map title

Set thresholds

Insert/Edit a tooltip

Insert a drilldown

Change area ID mapping

Change SVG image

Change data source

Refresh/Set parameters

5.3.4.5. Thresholds
Thresholds allow you to differentiate areas by color based on value in a particular data source column. If a threshold
is set, all the map areas (i.e. objects with a record in the map data source) are colored with color assigned to the
appropriate value range.

Example: SVG Map with Thresholds
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To set the thresholds, click on the  Set Thresholds icon on the toolbar and select a threshold column (i.e. column
that will be compared to the ranges defined below). Only numerical column can be selected. You can add a threshold

value(s) in actual values or percentage unit. To add a threshold value, click the  button next to the empty table
field. A dialog box will open prompting you for the new threshold value.

Entering Threshold Values

You can either enter it manually or select one of the suggested values from the drop-down list at the bottom of the
dialog. This list contains all the values from the selected threshold column rounded to integers (There is a third way
to enter threshold values for percentage units. It is an option to enter a number of intervals). After adding the first
threshold value, two ranges are added - one for values below and one for values above the given threshold. Any
threshold value added after that will create only one new range by splitting one of the old ranges in two. You can
edit any of the existing thresholds by clicking on the appropriate range (the first column in the table).

To change the color assigned to a value range, click on the empty table field next to the value range you want to
change the color of. You can then select one of the predefined colors or choose any color by entering its red, green
and blue component values (each value is an integer within the 0-255 range). To remove a threshold value, click

on the red  button next to the value you want to remove. Changes will take effect after you confirm the Set
Threshold dialog by clicking the OK button.

To remove all thresholds and disable coloring of areas, delete all threshold values or select an empty field for the
threshold column.
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Set Threshold Dialog

5.3.4.5.1. Legend
The Set Threshold dialog also allows you to add a legend to describe the value ranges. To enable it, check the
Enable Legend checkbox. Then you can select a layout and position of the legend. If the legend is enabled, legend
input fields next to the value ranges will appear. Insert a description of the ranges in these fields. If the legend is too
large to fit one column (for vertical layout) or row (for horizontal layout), it will be split into several columns/rows.
If it still does not fit the map canvas even after splitting, it will not be displayed at all. If this ever happens, you can
try to resize the map or change the position or layout of the legend.

Setting Legend

5.3.4.6. Drilldowns

Click on the  Drilldown Options icon on the toolbar and select Enable Drilldown option. The Organizer structure
will show up in the Available Templates treeview. Select a parameterized report, chart, or map. All parameters
will be automatically mapped to the Area ID. This means that all parameters of the drilldown report, chart or map
will be set to the Area ID of the selected area. It is not possible to change the mapping. SVG map also does not
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support multi-value drilldowns (multi-value parameters are treated as single-value). Once you select a file, click
the OK button to open it.

Drilldown Options

When you click in an area matching the ID mapping (e.g. a colored state), a drilldown report will open in a new
window.

Map with Drilldown

5.3.4.7. Tooltips
Tooltips in SVG maps are different than tooltips in Online maps. In SVG maps, there are no reports in tooltips, just
data from data source fields associated with particular map area.

To set up tooltips in a SVG map, click on the  Tooltip Options icon on the main toolbar. The following dialog
will appear:
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Tooltip options dialog

On this dialog, you can choose which data source fields will be displayed in tooltips, which will pop up in yellow
background when you move your mouse cursor over a map area.

Note
If you deselect all options on the Tooltip options dialog, default browser tooltips will be displayed (in
grey background), showing SVG area IDs.

SVG Map with a Tooltip

5.3.4.8. Map Title

To insert a map title, click the  Map Title icon on the toolbar. Check the Enable Map Title checkbox. Then
you can insert the map title text and select various options - font, font style, font size (positive integers only), text
alignment, title position, and text color. The color can be either choosed from swatches or inserted manually by
entering red, green and blue components (all values has to be integers from 0 to 255). To apply your settings, click
the OK button.
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Map Title

5.3.4.9. Map Size

To set a map size, click the  Set Map Size icon on the toolbar. Enter dimensions and then click the OK button
to apply your setting.

Map Size Setting

5.3.4.10. Change Parameter Values

To change parameter values (for maps with parameterized data source) or refresh the map, click the  Refresh
icon on the toolbar and the Parameter setting dialog will appear. Select a parameter value(s) and then click the
Submit button to apply parameter values on the map (You can reset your selection by clicking the Reset button).

Parametr Setting Dialog for Single-value Parameters

Parameter Setting Dialog for Multi-value Parameters
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5.3.4.11. Change Area ID Mapping

To change area ID mapping, click the  Change Area ID Mapping icon on the toolbar. Select a column from the
drop down menu and then click the OK button to apply your setting (For more information about area ID mapping,
please see Section 5.3.3 - Area ID Mapping).

Changing Area ID Mapping

5.3.5. Dynamic SVG Maps
EDAB Dynamic SVG Maps allow changing SVG image according to a parameter, i.e. you can use several SVG
images in a single SVG map. Dynamic SVG map can be used also as a drilldown, so you can create useful SVG
map with drilldown - for example continent to country, country to state, state to county, etc.

There are some rules and recommendations for Dynamic SVG Maps:

• SVG images have to be in format: imageName_PARAMETER.svg, where imageName is the same for all
SVG images and PARAMETER is used as the parameter.(e.g. worldmap_political, worldmap_phys-
ical, worldmap_topographic,... )

• Data source has to be parameterized where one of parameters takes the same values at the end of the SVG images
file names (after the underscore character).

• SVG images have to be saved inside a single folder.

• One of the SVG images has to be in Organizer. This image is used as default for creating a map and it is also
used in case the SVG image is not available due to a wrong parameter, missing file, etc.

• It is recommended to have all SVG images in the same size.

It is possible to change SVG Images by clicking the  Refresh/Set Parameters icon on the toolbar. You will see
a drop down menu for selecting a parameter. Select a parameter and click the Submit button. The corresponding
image will be used for the map. All settings of the map (thresholds, legend, title, tooltips, drilldowns) will be applied
to each SVG image.

Parameter Selection

Let's take a look at the following example of a shopping center with three floors. We want to display the status
of annual sales per square foot of stores. Open SVG Maps designer (from the EDAB main page) and click the

 Create New Map icon on the toolbar. Data Source Dialog will appear. Select Sample data registry and then
select Databases/GoldCenter/Query/Stores query as a data source. Click the OK button to close the
Data Source Dialog.
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Select Data Source

Now you are prompted to select an SVG image. Select Examples/Maps Examples/MapFiles/Gold-
Center_1 SVG image. We have three SVG images for this example (GoldCenter_1.svg, GoldCen-
ter_2.svg, and GoldCenter_3.svg in the EDAB/help/examples/Maps/MapExample4 folder), but you can
see only one of them in the Select SVG Image dialog because only one was inserted into Organizer (it is not neces-
sary to insert all SVG images to Organizer). Next select a parameter for changing SVG images in the Change Map
Image by Parameter dropdown menu. Select the parameter floor and click the OK button.

Select SVG Image

Next step is to map IDs to the data source column. Select UNIT and click the OK button. You can also select a
parameter, a number of floor in our case, in this step. Leave the first floor selected and click the Submit button
to open a map.
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Set Mapping and Parameter

You can now see a map of the first floor (Left pane is collapsed in the next image).

Set Mapping and Parameter

To change the SVG image (the other floor of the shopping centre in our case), you only need to change the parameter

value by clicking the  Refresh/Set Parameters icon and selecting parameter value from the dropdown menu.

The next image shows the finished SVG map (you can find this SVG map in Examples/Maps Exam-
ples/MapFiles/AnnualSales). There are set thresholds (for more information, see Section 5.3.4.5 - Thresh-
olds), a legend (for more information, see Section 5.3.4.5.1 - Legend, a title (for more information, see Sec-
tion 5.3.4.8 - Map Title), and a tooltip (for more information, see Section 5.3.4.7 - Tooltips).
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Finished Map

The next image shows the SVG map for the parameter value 2, which is the second floor of the shopping center.
All adjustments are also valid for the SVG image of the second floor.

Changed SVG Image

Dynamic SVG map can also be used as a drilldown. For example, open GoldCenter SVG map from Exam-
ples/Maps Examples/MapFiles directory. You should see this map:
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Basal SVG Map

Add a drilldown by clicking the  Drilldown Options button, select Examples/Maps Examples/Map-
Files/AnnualSales file in the Drilldown Options dialog and click the OK button. Then you can click on the
area of some floor to open the drilldown.

You can also open the finished SVG map with drilldown GoldCenterWithDrilldown under Exam-
ples/Maps Examples/MapFiles node.

5.3.6. Save Map

You can save the SVG map by clicking the  Save button on the toolbar. This will open a dialog allowing you
to specify a name for the map. Enter a name for the map, select the project where you want to save it and click
the OK button.

Save Dialog
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After saving or opening an existing SVG map, the  Save As button allows you to save the existing or modified
map into a different name or location.

5.3.7. Open Saved Map

You can open a saved map by clicking the  Open icon on the main toolbar. The Open Map dialog will appear.

Open the SVG Map

All SVG maps created in SVG Maps designer are visible in Organizer. Select a map and click the OK button to
open it.

5.3.8. Exit

You can exit SVG Maps designer either by clicking the  Home icon in the upper right corner, clicking the SVG

Maps title, or clicking the  Logo icon in the upper left corner. Before closing, you will be asked if you want
to save an unsaved map.

5.4. Map Viewer
Map Viewer is a JSP page used for viewing maps. It is located in http://machine:port/
<EDAB_CONTEXT>/MapBuilder/MapViewer.jsp and it can be used for both Online Maps and SVG Map-
s. If you open a map from Menu Page, it is automatically opened in the Map Viewer (If you open a map from
Organizer, it is opened in corresponding map designer). Another way to use the Map Viewer is to write your own
map URL. This is described in the next chapter.
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EDAB Maps Viewer (showing SVG Maps with threshold)

5.4.1. Writing Map Viewer URL
You can write your own Map Viewer URL. The URL always begins with the location of the Map View-
er JSP: http://<machine>:<port>/<EDAB_CONTEXT>/MapBuilder/MapViewer.jsp?. Follow-
ing the question mark you need to specify Map Viewer parameters. Parameters are separated by the “&” character.

The most important Map Viewer parameter is filePath. It specifies the path to the map you want to display. The
value can be either URL or file path on the server. The file path can be absolute or relative to the EDAB installation
directory. This parameter is mandatory and must always be specified.

The remaining Map Viewer parameters are used for setting map parameters. These parameters have no function in
non-parameterized maps, so they are ignored if the map is not parameterized. The parameters are:

ForHTMLParamPage: This is a Boolean flag that indicates whether or not to display parameter page before
displaying the map. If this argument is set to true then the URL will return the parameter
page and ignore any parameter values passed into the URL. This argument is set to
false by default.

QueryParamName: This parameter is used to specify parameter for parameterized map. QueryParamName
specifies the name of the parameter you will be supplying a value for (Parameter names
are specified when you create the query. For more information about this, see Sec-
tion 3.1.3.2.2 - Parameterized Queries). It is always followed by QueryParamSize and
QueryParamValue parameters.

QueryParamSize: This parameter is used to specify the number of values that will be passed into a particu-
lar map parameter. As described in Section 3.1.3.2.2.1 - Multi-Value Parameters, some
queries can have multi-value parameters. This URL parameter allows you to specify
if the parameter (indicated by the previous QueryParamName parameter) takes multi-
ple values. This parameter is always followed by one or more QueryParamValue argu-
ments for each of the parameter values for a particular parameter. If you do not specify
this parameter, it will assume that the number of the values to be passed in is one.

QueryParamValue: This parameter is used to specify a parameter value you want to pass to the query pa-
rameter specified by the QueryParamName argument. For multi-value parameters, a
separate QueryParamValue argument must be supplied for each distinct parameter val-
ue that you are passing in. For more information about creating parameterized queries,
please see Section 3.1.3.2.2 - Parameterized Queries.

Example:
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To open GoogleMapParam (one of the map examples - parameterized Online Map) with parameter State set to
CA, use this URL:

http://machine:port/<EDAB_CONTEXT>/MapBuilder/MapViewer.jsp?filePath=help/
examples/Maps/MapExam-
ple1/GoogleMapParam.gxml&QueryParamName=State&QueryParamSize=1&QueryParamValue=CA

Please replace machine with your machine name or IP, port with the port Tomcat is running on (8080 by default)
and <EDAB_CONTEXT> with your EDAB context (EDAB by default).

5.5. Migrating Maps
Often you may need to move maps from one location to another. For example, maps have to be moved between the
server and the develop machine. On the develop machine the tooltips/drill-downs/svg images locations can change
and may not be located from the data stored in the map .gxml or .sxml file. Therefore, EDAB uses SPAK (for
SVG Maps) and GPAK (for Online Maps) files to move or archive maps along with its components. To learn how
to create a SPAK or a GPAK file, see Section 2.1.4.4 - Dashboard and Map Packages.

Note
The SPAK and GPAK files can be viewed in the MenuPage, but they cannot be opened in the SVG
or Online map designers. To edit a map from a SPAK or a GPAK file, you have to unpack it first (to
learn how to unpack DPAK or SPAK files, see Section 2.1.4.4 - Dashboard and Map Packages).

5.A. List of SVG Map Images
The following SVG map images are distributed with EDAB. They are prepared to be used for creating SVG Maps.
They all have uniform look - the land is gray and borders and oceans are white. You can change the colors in any
SVG editor (e.g. Inkscape) or you can edit them directly in the SVG files (this requires at least basic knowledge
of the SVG format).

The maps are split in two directories according to the Area IDs naming convention. The maps in the
<EDAB_Installation_directory>/MapFiles/SVG/English directory use English country (conti-
nent) names, while the maps in the <EDAB_Installation_directory>/MapFiles/SVG/ISO directory
use ISO 3166-1-alpha-2 [ https://www.iso.org/iso-3166-country-codes.html ] code. All Area IDs in these maps are
in UPPER CASE. The English names are exactly the names from this table [ https://www.iso.org/obp/ui/ ], only
the spaces are replaced with underscores (_), because spaces are not supported in the SVG objects IDs. However,
underscores are automatically converted to spaces before comparing them to the data source columns, so you should
still use spaces in your data source.

These SVG map images are already inserted in the Organizer in the SVGMap project. Please note that this project
is hidden in the Menu Page, but it can still be displayed and modified in Organizer and the files from this project
can be used for creating maps.

This is the list of all SVG map images distributed with EDAB with short description. The <NAMING> placeholder
can be one of “English” or “ISO”, depending on the naming convention used.

Africa-<NAMING>.svg Map of all countries in Africa

Americas-<NAMING>.svg Map of all countries in
North and South America

Asia-<NAMING>.svg Map of all countries in Asia

Australia-<NAMING>.svg Map of all countries in
Australia and Oceania

Continents-English.svg Map of the whole world divided
by continents. The Area IDs are
English names of the continents.

This map is not available with ISO
naming convention because there
are no codes for the continents.

https://www.iso.org/iso-3166-country-codes.html
https://www.iso.org/iso-3166-country-codes.html
https://www.iso.org/obp/ui/
https://www.iso.org/obp/ui/
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Eurasia-<NAMING>.svg Map of all countries
in Europe and Asia

Europe-<NAMING>.svg Map of all countries in Europe

NorthAmerica-<NAMING>.svg Map of all countries
in North America

SouthAmerica-<NAMING>.svg Map of all countries
in South America

WorldCompact-<NAMING>.svg Map of all countries in the
world except Antarctica.

WorldCompact-Small-
Countries-<NAMING>.svg

Same as WorldCom-
pact-<NAMING>.svg, but very

small countries are represented by
circles, so they are more visible.

World-<NAMING>.svg Map of all countries in the
world including Antarctica.

World-SmallCoun-
tries-<NAMING>.svg

Same as World-<NAMING>.svg,
but very small countries

are represented by circles,
so they are more visible.
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Chapter 6. Designing Dashboards
6.1. Introduction to Dashboards

Dashboards allow users to easily consolidate summarized information in a single page or briefing. EspressDash-
board requires no special skill or administrative support. Simple thin-client interfaces allow all users to easily create
customized information presentations.

Here are some sample dashboard presentations.

Sales Dashboard

Summary Dashboard
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Population Dashboard

The top-level or main presentation consists of a set of charts, reports or maps arranged on the page. You can add
shared parameters in a panel, or list the values of parameters so that the dashboard users can apply filters to refresh
the applicable charts/reports/maps.

Individual options for each chart or report allow users to apply additional filters as well as export the charts, reports
and maps to various formats.

Users can also add layers of drilldown to each chart/report/map in the main presentation. The drilldown can point
to a report, chart or map. This allows each piece of summarized information in the presentation to be immediately
actionable.

6.2. Create Dashboard
Dashboards in EDAB can be created using the Dashboard Builder interface. This easy-to-use thin-client interface
allows you to easily create dashboard presentations using charts, reports and maps. You can simply insert dashboard
components (charts, reports and maps) that are already deployed in the Organizer to the dashboard. Alternatively,
you can create them from scratch directly in the Dashboard Builder. The newly created item will be automatically
inserted in the dashboard. One convenient feature is that you can edit a chart, report or map in the Dashboard Builder
interface without leaving it.

The dashboard layout can be either static or responsive. As you may know, responsive layout is great for displaying
content on small devices such as mobile phones. In a static dashboard, the width is dependent on the size and layout
of its components. If the dashboard is wider than the screen, all the components stay in place and a horizontal scroll-
bar appears. Unlike the static dashboard, the responsive layout, using Responsive Dashboard feature, optimizes
utilization of the display without exceeding the display width. Therefore the layout is automatically rearranged.
The width of the responsive dashboard can also be set manually by dragging a limiter, a vertical line on the right
side of the Dashboard Builder working space (in case you want the dashboard to be narrower than the screen).

Note
It is not possible to display static dashboards as responsive and it is not possible to change them to
responsive and vice versa.

The Dashboard Builder can be launched from the EDAB Start page. If you've logged in as a user with design
privileges, you can follow the Dashboard Builder link to open the interface.
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Dashboard Builder Interface

6.2.1. Toolbar
The top part of the Dashboard Builder interface contains a small toolbar that allows you to initiate the following
actions:

 Start a new static dashboard

 Start a new responsive dashboard

 Open an existing dashboard

 Save the current dashboard

 Add report/chart/map to the current dashboard

 Add share parameter(s)

 Insert a label into the current dashboard

 Insert Folder

 Hide/Show Grid

 Add dashboard background

 Migration

 Dashboard additional options

 Preview the current dashboard
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6.2.2. Responsive Dashboard

To create a new responsive dashboard, click the  New Responsive Dashboard icon on the toolbar.

New Responsive Dashboard

You can click and drag the limiter to set a dashboard width.

Dashboard Limiter Setting

Now you can add reports/charts/maps and resize them. The limiter (or the screen width) keeps the width of the
dashboard. The layout of reports/charts/maps is arranged automatically.

Dashboard With Limiter
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To change the layout manually, click on the header of the report/chart/map, hold the mouse button and move it.
If there is enough space for the component, a blue rectangle will appear. Release the mouse button. The moved
component is placed instead of the blue rectangle and the other components are arranged as best as possible.

Dashboard Layout Changing

Note
It is not possible to insert labels and folders (see Section 6.2.9 - Folders) into responsive dashboards.
Also, you cannot show component header bar (see Section 6.2.7 - Additional Options). Hence dynamic
charts are not supported in preview and published dashboards.

6.2.3. Add Charts, Reports and Maps

To add a chart, report or map to the dashboard, click the  Add Report/Chart/Map button on the toolbar. After
you do so, the Insert Reports/Charts/Maps dialog will appear in the left pane. The dialog contains a tree that mirrors
the folder structure in the Organizer. All charts, reports and maps to which you have access to are listed here. In
order to insert a chart, report or map into the dashboard, simply click on the chart or report entry in the tree. The
chart, report or map will then be added to the dashboard.
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Insert Report/Chart/Map Dialog

You can also create a new report/chart/map directly from the Dashboard Builder. To do this, click the relevant
link in the lower pane of the Insert Reports/Charts/Maps dialog (titled create new Report/Chart/Map) and you
will be taken to the corresponding designer. Create a new report/chart/map in the designer and save it. Then close

the designer or click the exit icon  to return to the Dashboard Builder. Your new component is added to the
dashboard. For more information about working in designers, please see Section 4.1 - Chart Designer, Section 4.2 -
QuickDesigner Reports, Section 4.3 - QuickDesigner Charts, Section 5.2 - Online Maps, Section 5.3 - SVG Maps.

QuickDesigner Reports Opened from Dashboard Builder

6.2.3.1. Move and Resize Charts, Reports and Maps
Charts, reports and maps in the dashboard can be moved or resized in free-form. You can resize and move charts,
reports and maps using the mouse. To move a chart/report/map, simply click on the header bar of the chart/re-
port/map window and drag it. To resize a chart/report/map, click on the lower right corner of the chart/report/map
window and drag on the sizing handle that appears in the lower right corner of the window.
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You can see a gray stripe under the Dashboard Builder toolbar. This stripe allows you to place a report/chart/map
so that its header bar isn't visible in the preview window. You can see the difference in two images below.

Report/Chart/Map Placement

Report/Chart/Map in Preview

If a report, chart or map contains alerts, Watch alerts icon  appears in the header bar. To learn more about
alerts in dashboards, please visit Section 11.3 - Alert types.

6.2.3.2. Snap to Grid
You can see a grid of dots in Dashboard Builder that helps you to align charts, reports and maps in the dashboard.
The grid is visible by default and it snaps all dashboard elements (reports, charts, maps).

Dashboard Grid
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You can hide/show the grid by clicking the  Hide/Show icon on the toolbar. To position charts/reports/maps

completely free, open the Dashboard Options dialog by clicking the  Options icon and disable the option Snap
to Grid under Other section.

6.2.3.3. Chart/Report/Map Toolbar
Each chart/report/map in the dashboard has its own toolbar that allows you to initiate the following actions:

 Edit Template - This button opens appropriate designer that allows you to edit a template.

 Refresh Template - This button refreshes a template.

 Add/Modify Link - This button allows you to use data from one chart/report/map as a parameter in another.
(see Section 6.2.10 - Template Linkage)

 Add/Modify Drilldown - This button allows you to add/modify drilldowns. (see Section 6.2.8 - Drilldown)

 Filter Data - This button allows you to specify filters/parameters for a template. (see Section 7.4.2 -
Preview Options)

 Export - This button allows you to export chart/report/map. (see Section 7.4.2 - Preview Options)

6.2.4. Shared Parameters
Shared parameters allows you to group common parameters from all charts/reports/maps into a single parameter.
You can apply a common filter to some or all of the dashboard items at the same time. All of the dashboard's shared
parameters are listed in the Shared Parameter list in the Share Parameters dialog that can be opened by clicking

the  Share Parameters icon on the Dashboard Builder toolbar.

For example, create a dashboard by adding all files from the Examples/Dashboards/CategorySales-
Dashboard node (OrdersCatRegion, ProductSales, SalesRegionalSuccess, TimeSales). Then click the Share Pa-
rameters icon. You will now see Share Parameters dialog in the left pane.

Share Parameters Dialog
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To create a shared parameter, click the Add Share button in the Share Parameters dialog. This will open a dialog
that allows you to set options for the share.

Shared Parameter Dialog

The left side of the dialog shows all parameters for all the selected charts/reports/maps in the dashboard. You can
select which parameters you want to add to the share by selecting them in the left side window and clicking the Add
button. Note that all parameters in the share must have the same data type.

The parameter mapping options (whether the parameter is mapped to a database column) is based on the first
parameter selected for a share. For more information about parameter mapping, see Section 3.1.3.2.2.2 - Initializing
Query Parameters.

You can enter a prompt name for each shared parameter. Once you finish entering all informations for the shared
parameter, be sure to specify a name for it in the field at the top and then click the Ok button to save the changes.
The parameter will then be added to the Shared Parameters list in the share parameters dialog.

You can edit or remove a shared parameter by selecting it in the list and clicking the Edit Share or Remove Share
buttons.

For our example, write Category as the Shared Parameter Name and the Prompt Name and select all available
parameters Category. Click the Ok button to create a shared parameter.
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Shared Parameter Dialog

6.2.4.1. Arrange Shared Parameters
In addition to adding/editing/removing shared parameters, you can also list values of a shared parameter into a set of
buttons in the dashboard or arrange a shared parameter to be displayed in the panel that allows you to enter parameter
value right from the dashboard. Please note that in order to list the values of a parameter, the shared parameter can
be either single or multi-valued and must have predefined selectable values. To add the shared parameters to the
dashboard, simply click the List Values or Add to Panel button in the Share Parameters dialog.

Share Parameters Dialog

Edit Share Allows you to edit a shared parameter. To do this, select a shared parameter and click the Edit
Share button. This will open Edit parameter dialog.
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Edit Shared Parameter

List Values If the parameter has a small number of values, you can choose to list the values as buttons or
images. For example, let's say your dashboard shows sales data for your products and you have
a relatively small number of products. You can select this option to make a list which makes
it easier for the users to pick a value for the filter. To list the values for a shared parameter,
first select it from the shared parameters list and click the List Values button. This will open
the parameter value-list panel that contains the parameter values in buttons.

Parameter Value-list Panel

There are four buttons available in the panel header bar.

Modify Panel Attributes: This button will open a new dialog that allows you to modify
panel attributes such as background color and panel border. For more information about
the dialog, please see Section 6.2.5 - Insert Labels.

Modify Button Attributes: This button will open the following dialog that allows you
to modify button attributes.
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Set Button Properties Dialog

The first option in this tab allows you to map shared parameter value to an image. To
map a shared parameter value, first select it either from the left panel, specify the image
URL or browse for it using the Browse button and click the Set button. In order to remove
image URL mapping, select appropriate parameter value, clear the image URL text box
and press the Set button or use the Remove All button to remove all mapping. The other
options in the dialog allows you to specify button width, height and padding. You can
also choose whether to show the buttons border or whether the buttons should be shaded
or not. Another option allows you to display the boxes with a radio button. This option
is not available for multi-valued parameters, which are automatically given checkboxes.

The other tabs of the Set Button Properties dialog allows you to set the button text and
background. The tabs are basically the same as for labels and they are described in the
following Section 6.2.5 - Insert Labels.

The next screenshot shows our example with a modified view of buttons.

Modified Buttons

Delete: This button will delete the parameter value-list panel.

Set Buttons Alignment: These buttons allows you to set vertical or horizontal align-
ment of buttons. By default, buttons are aligned horizontally and you will only see

the  Vertical Align button. When you click on it, the alignment will be changed

to vertical and the  Horizontal Align button will appear.
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Vertical Buttons Alignment

Add To Panel To arrange the layout of shared parameters by adding them to a panel, first select it from the
shared parameters list and click the Add to Panel button. This will open a parameter panel with
the parameter's list box added to the panel.

Parameter Panel

In the Dashboard Builder, you can move/resize the panel or move the small parameter box
inside the panel. If you close the panel, you can still use the shared parameter with the preview
toolbar (see Section 7.4.1 - Preview Toolbar). If you change the parameter value, the dashboard
will be automatically refreshed.

There are three buttons available in the panel header bar:

Disable Auto Rearrangement: This button will disable/enable auto rearrangement.

Modify Detach Panel Attributes: This button will open a new dialog that allows you
to modify the parameter panel attributes such as adding an OK button, changing panel
layout, text label properties, background color and border for the panel. For more infor-
mation about the dialog, please see Section 6.2.5 - Insert Labels.

Delete: This button will delete the parameter panel.

Set Range This option allows you to define a range across two shared parameters. For more information,
please see Section 6.2.4.2 - Parameter Range.

Remove Share This option allows you to remove shared parameter. To do this, select the shared parameter
and click the Remove Share button.

Sequence This option allows you to set an order of shared parameters. For more information, please see
Section 6.2.4.3 - Cascading Parameters.

6.2.4.2. Parameter Range
This function allows you to define a range across two shared parameters. To use this function, select two related
shared parameters (such as start and end date, or integer objects representing a range) and then click the Set Range
button. This will bring you to the Range Param Attributes dialog. To create a user defined range variable, simply
fill out the Range Variables Detail dialog box. To see an example, please see the QuickStart Guide (Section Q.9.1.1
- Create a Dashboard). The next screenshot shows other setting of parameter range for the example created in
QuickStart Guide.
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In addition to creating your own range variables, you can also create range variables using Predefined Range Vari-
ables as described below.

Parameter Range Dialog

The dialog has these following options:

Range Name: This field allows you to enter a title for the parameter range window.

Prompt Text: This text is displayed next to the selected combo parameter dropdown menu.

Range Variable Detail: This window has several sub-fields:

Option Name: This is the display name in the Selected Range Vari-
ables list.

First Param: This is the first parameter in the combined parameter,
usually the starting value.

Second Param: This is the last parameter in the combined parameter,
usually the ending value.

Expression: There are two expression fields, one for each parame-
ter.

For date parameters, you can click on the Date calcu-

lator button  next to the expression field.

In this screen, you can enter one of the three keywords:
CurrentDate, CurrentTime, and Current-
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DateTime, or one of the function names, such as
FIRSTOFTHISYEAR. Details about functions are
listed in the list of functions.

You can add or subtract time units from the current
date/time, allowing you to have a dynamic date range.
For example, a report may have the following default
values:

StartDate: CurrentDate - 1 WEEK

EndDate: CurrentDate

This would indicate that every time the report is
run, the default prompt should be one week ago of
the current date. Other supported options are YEAR,
MONTH, DAY, HOUR, MINUTE, and SECOND.
This feature only supports single addition or subtrac-
tion and it does not support multi-value parameters.

Selected Range Variables: This window displays all range variables that have been defined. Clicking
on any range variable in this list allows you to modify it, delete it or copy
it. Once the variable is selected, you can see its detail in the Range Variable
Detail window where you can modify it. You can move the selected range

variable up or down in the list by clicking the   arrows right next to
the window.

The next screenshot shows a dropdown menu in the dashboard that contains
defined range variables (range variables from the Selected Range Variables
window).

Range Variables in Dashboard

Add: This button has two modes: Change or Add. When the text of the button
reads Add, the parameter information in the Range Variable Detail window
will be added into the Selected Range Variables list.
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Range Variable Adding

Change: This button has two modes: Change or Add. Clicking on an item in the Se-
lected Range Variables list will change the text to Change. When in this
mode, clicking the button will save any changes made in the Range Variable
Detail window to the currently selected range variable.

Range Variable Change

Copy: This button will copy the selected item and add it to the Selected Range
Variables list under a new name. The new name is created automatically
by adding _0,_1,_2,etc. or you can change it in the Range Variable Detail
window. To copy a variable under your name, select it, change a name in the
Range Variable Detail window and then click the Copy button.
Copy can help you to create range variables more quickly. For example, you
can select a range variable, change only the year and then click the Copy
button.
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Range Variable before Copy

Range Variable Copied

Remove: This button will remove the selected item from the Selected Range Variables
list.

Predefined Range Variables: This window contains predefined date range variables for your convenience.
It contains commonly used date range expressions such as This Year,
This Month, This Week, This Quarter, and many more. To
use a predefined variable, simply select the needed predefined range variable
and click the Add button. You can add more than one expression and all of
them will be listed under the Selected Range Variables window.

Allow Custom Range Settings: This option allows you to specify a parameter range by using calendar and
parameter input boxes in the parameter range panel. The following screen-
shots show the difference between with and without custom range.
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Enabled Custom Range Settings

Disabled Custom Range Settings

Enable Submit Button If you allow Custom Range Settings, you can add Submit Button. This button
allows you to apply custom range when both parameters are set. Without this
button, each parameter is applied immediately when it is set. You can also
determine a text of this button.

Once you finish setting up the parameter range in the Range Param Attributes dialog, click the Ok button to close
the dialog. A rectangle will follow your mouse pointer around the dashboard design window. Position the rectangle
and click. A parameter range panel will appear.

Parameter Range Panel with Submit Button

You can select range variables from the dropdown menu where are all variables from the Selected Range Variables
window, or use customer text boxes (text boxes are available only when Allow Custom Range Settings option was
checked). The text boxes represent the first and second parameters in the combined parameter. To use customer
text boxes, check the radio button next to them and insert parameter values. Note that you can use the calendar to

specify the date parameters. To open the calendar, simply click the Calendar button  next to the textbox.

There are three buttons available in the panel header bar:

Modify Panel Attributes: This button will open a new dialog that allows you to modify panel attributes such
as text label properties, background color and border for the panel. For more information about the dialog,
please see Section 6.2.5 - Insert Labels.

Modify Range Param Attributes: This button will open the Range Param Attributes dialog that allows you
to edit range variables.

Delete: This button will delete the range parameter panel.

Note
If you delete this panel, all range variables that were defined in the Range Param Attributes
dialog will be lost.

6.2.4.3. Cascading Parameters
By default, you are prompted to enter all report parameters at once in the prompt dialog. However, this configuration
may not be the best solution in case some parameters are mapped to database columns with a significant number
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of distinct values. It can be difficult to go through a very large list and you may select values that don't return any
data, depending on the parameter combination.

To assist with these problems, EDAB provides a feature that allows you to configure the order in which the para-
meters should be entered. With this feature enabled, you can enter parameters in the dialog in a pre-defined order.
As such each selection will be applied as a filter to the next parameter prompt(s). Using cascading parameters can
limit the number of distinct values presented and can prevent selecting invalid parameter combinations.

First, create a query named e.g. Cascade with parameter sequence in Woodview HSQL database that is in EDAB.

To do this, open Organizer, click the  Manage Data Sources icon to open the Data Registry Manager dialog,
select a data registry and click the Edit button. Select Queries under Databases/Woodview (HSQL) node
and click the ADD button to create a new query. Type Cascade as a name and for example, use the following query:

SELECT ORDERS.QUARTER, YEAR(ORDERS.SHIPDATE) as "year",
 CATEGORIES.CATEGORYNAME, PRODUCTS.PRODUCTNAME                
FROM ORDERS, CATEGORIES, PRODUCTS, ORDER_DETAILS
WHERE (ORDERS.ORDERID = ORDER_DETAILS.ORDERID)
AND (PRODUCTS.PRODUCTID = ORDER_DETAILS.PRODUCTID)
AND (CATEGORIES.CATEGORYID = PRODUCTS.CATEGORYID)
AND QUARTER = :quarter AND YEAR(ORDERS.SHIPDATE) =:year
                

Cascading Parameters Query

Now initialize query parameters. Check Prompt parameter in sequence and click the Config button. Set the para-
meter sequence according to the image below, i.e. the quarter parameter will be in the first level and year in the
second level. Then map the first parameter quarter to database column ORDERS.QUARTER.
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Initialize First Parameter

Map the second parameter year to database function YEAR and Set Parameter Values to ORDERS.SHIPDATE.
Then click OK to save the query.

Initialize Second Parameter

Go to Dashboard Builder and open the Alerts dashboard (Published Files/Examples/Dashboard-
s/Alerts Dashboard).
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Alerts Dashboard

Then click the  Share Parameters icon on the Dashboard Builder toolbar to show the list of shared parameters
in the dashboard (Notice that there are two shared parameters quarter and year already added in a dashboard. You
can remove them to make room for the cascading parameters). From the dialog, select one of parameters to activate
options and click the Sequence button at the bottom.

Shared Parameters Setting

The Parameter Sequence dialog will then appear. From the query tree on the left, select Cascade query you have
created in previous steps. It should automatically map query parameters to shared parameters in the dashboard.
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Parameter Sequence Dialog

Click the OK button and place the parameter panel into a dashboard.

Parameters Panel

The image below shows inserted cascade parameters panel in the dashboard. Now you can specify a parameter
value for the first and second level. Once you specify the last parameter in the sequence, the dashboard templates
should refresh according to the selected values.
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Dashboard with Cascade Parameters Panel

6.2.5. Insert Labels

You can insert a label into a dashboard by clicking the Insert Label button  on the dashboard builder toolbar
(Please note that labels are not available for responsive dashboards). After you click the button, a small rectangle
will follow your mouse pointer around the builder interface. Position the rectangle where you want to insert the
label and click. The label will be inserted into the dashboard. You can edit the label text by double-clicking on
the label body.

Inserting a Label

Editing a Label

Labels can be moved or resized in the same way as charts, reports and maps. To move a label, simply click on the
header bar of the label window and drag it. To resize a label, click on the lower right corner of the label window
and drag on the sizing handle that appears around the lower right edge of the window.

There are three additional buttons available for a label in the label header bar.

Move to Back: This button will move the label to back.

Edit: This button will open a new dialog that allows you to specify text label properties, background color
and border for the label.

Text Label Properties: The first tab of the edit window allows you to adjust text label proper-
ties. You can adjust the font type, font style, font size and alignment of
the label as well as changing font color using swatches or RGB values.
In the preview section you can still see the original and new text.
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Label Text Properties

Label Background Color: The second tab of the edit window allows you to set label background
color or to use background image. The background color can be ad-
justed using swatches or RGB values. You can also specify the label
opacity or choose whether or not to set the label background transpar-
ent. If you want to use a label background image, simply check the
Use Background Image checkbox and enter the image URL or use the
Browse button to browse to the appropriate background image. Please
note that the URL must be absolute Web URL. In addition to adding
background images, you can also specify the background image posi-
tion (available positions are: center, left, right, top, bottom and fixed) or
choose whether to set the dashboard background image to be repeated
(available options are: both, horizontal, vertical and none).

Label Background Color
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Border Properties: The third tab of the edit window allows you to set label border style and
border color. The label border can be adjusted using swatches or RGB
values. If you want to use border style, specify the border thickness
and select appropriate border style (available options are: solid, dotted,
dashed, double and groove). In the preview section you can still see the
original and new text and border.

Label Border Properties

Delete: This button will delete the label.

Please note that the labels can also contain any HTML tags, which may override external settings from the dialog.

For example, let's say you have a label with the font type set to Arial. However, once you enter HTML tag
<font face="Garamond">Label content</font> into the label, Arial font will be overriden with
Garamond font for the Label content text.

6.2.6. Add Background

You can also add dashboard background by clicking the Add Dashboard Background button  on the dashboard
builder toolbar. This will open a dialog that allows you to set the dashboard background.
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Dashboard Background Dialog

The first option in the dialog allows you to use a background image for a dashboard. If you want to use a background
image for the dashboard, simply check the Use Background Image checkbox and enter the image URL or use the
Browse button to browse to the appropriate background image. Please note the URL must be the absolute Web
URL. In addition to adding background images, you can also specify the background image position (available
positions are: center, left, right, top and bottom) or choose whether to set the dashboard background image to
be repeated (available options are: both, horizontal, vertical and none). In the preview you can still see updated
dashboard background.

The second option in the dialog allows you to set dashboard background color. The background color can be adjusted
using swatches or RGB values.

Once you finish setting up the dashboard background options, click the Apply button to apply the changes. You can
close this dialog by clicking the Close button or by clicking the X sign in the upper right corner.

6.2.7. Additional Options

You can also specify additional dashboard options by clicking the Options button  on the dashboard builder
toolbar. This will open a dialog that allows you to set the dashboard components resizable/movable and other
options.
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Dashboard Options Dialog

Dashboard components resiz-
able:

This option allows you to resize the dashboard components. It doesn't affect
the Dashboard Builder as it works in dashboard viewer (i.e. when you open
a dashboard from MenuPage etc.) and dashboard preview only.

Dashboard components movable: This option allows you to move the dashboard components. Like the previous
option, this one also affects deployed dashboards only.

Show header bar: Shows/hides header bars for templates in the dashboard. Affects deployed
dashboards only. In Dashboard Builder, headers are always visible.

Show border for dashboard com-
ponents:

Shows/hides borders for templates in the dashboard. Affects deployed dash-
boards only. In Dashboard Builder, borders are always visible.

Transparent dashboard compo-
nents:

Enable transparent background of dashboard components (e.g. transparent
background of chart/report/map title, legend).

Use report/chart's original size: This option only affects charts/reports at the moment you add them to the
dashboard. If this option is enabled, charts/reports will be added to the dash-
board using their original size settings (i.e. canvas size for charts and page
size for reports). If this option is disabled, all reports/charts will be resized
to standard size and their original size settings will be ignored. This option
doesn't affect charts/reports after they have been added to the dashboard so
you can resize them as you like.

Maximize on double tap on mo-
bile devices:

Enable this option to maximize a dashboard template by double tapping on
mobile devices.

Single page for report: This option allows you to set whether reports will be displayed in single page
or multi-page format

Enable Expand/Collapse for re-
port?

Enables Expand and Collapse function for reports.

Enable Expand/Collapse anima-
tion:

Enable animation for Expand and Collapse function.

Use original margin for report: This option will set reports to be displayed with their original margins as
defined in the Page Setup in the Report Designer. If this option is disabled,
report margins are set to 0.2 inches.
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Use Flash for Charts: Use Flash for charts instead of the default PNG format.

Enable Flash Charts Animation: Enable/disable animation for Flash charts.

Show toolbar in preview: Hides/displays toolbar in deployed dashboards. For more information about
the preview toolbar, please see Section 7.4.1 - Preview Toolbar.

Snap to Grid: Snaps components to grid when resizing/moving.

Auto Refresh: Enables auto refresh for deployed dashboards (this option doesn't affect
the Dashboard Builder - it affects dashboard viewer and dashboard pre-
view only). In already deployed dashboards, auto-refresh can be also en-
abled/modified from the preview toolbar.

Once you finish setting up the dashboard options, click the Apply button to apply the settings. You can close this
dialog by clicking the Close button or by clicking the X sign in the upper right corner.

6.2.8. Drilldown
You can add a drilldown to any chart/report/map in the dashboard. The drilldown feature allows you to map the chart
data points, report columns, and/or shared parameters to the lower-level chart or report parameters. This creates a
relationship where an end-user can either click on a data point in a dashboard chart, or row in a table and be taken
to a lower-level report or chart that shows detailed information for the selected point.

To add a layer of drilldown, click the  Add/Modify Drilldown button in the chart/report/map header bar. A dialog
will open that allows you to configure drilldown options for the chart, report or map.

Drilldown Options Dialog

The first option in the dialog, Existing drilldown destinations, is a dropdown selection box that will contain a list of
the drilldowns that have been set in the template. The first element is always --New--. You can select a drilldown
from the list and the component information will be filled automatically. If you choose --New--, all dialogs will be
cleared and new entries into the dialogs can be entered. The items in the list are names of the drilldown targets with
an icon that can help you to identify the type of the file (see Section 2.1.4.3 - File Identification Icons). The Delete
button will only be enabled when you select an existing drilldown from the Existing drilldown destinations. When
you hit this button, the current selected drilldown will be removed from the list and the whole dialog will be reset.

The field on the left side of the dialog contains a tree that mirrors the Organizer folder structure. All of the report-
s/charts/maps and dashboards to which you have access to will be listed. Please note that drilldowns to dashboards
will be discussed in the next section.
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To select a chart, report or map as the drilldown destination (lower-level), click on it in the list. The dialog will
update to show the name of the currently selected drilldown report/chart/map. The first drop-down list below the
name will be populated with all of the parameters in the selected report/chart/map.

Each parameter in the destination report/chart/map can be unmapped (i.e. it does not pass the parameter value and
shows the drillable link no matter where you click on the report/chart) or mapped to either a column (data element)
in the top-level chart/report/map, or one of the shared parameters defined in the dashboard. To set an unmapped
link, simply select the Do not Map To Column. Note that this option is only available if the next drillable link is a
dashboard. To set the parameter, first select the destination parameter in the drop-down list. Then select the radio
button to indicate whether it should be mapped to the top-level chart/report/map or a shared parameter. Then select
the element/field or shared parameter from the appropriate drop-down list.

Note that a column selected for the drilldown in the Map to Template Data Column can only be used once, i.e. you
can have only one drilldown per column. A shared parameter in the Map to Shared Parameter can be used multiple
times in the dashboard. This is because a shared parameter isn't tied to a specific template in the dashboard and it
behaves like a parameter value provider for the drilldown destination template.

If all destination template parameters are mapped to shared parameters and if the parent template is a report, the
first column of the report is used as the anchor for the drilldown link, although it won't pass the element value to
the destination template. If the parent template is a chart or a SVG map, the data points become the anchor for
the drilldown links.

You can click the Set button to save the drilldown settings that is currently being worked on. If the drilldown is
new, a new entry in the Existing Drilldown destinations will be added, else the drilldown settings are updated in
the browser memory. To make the saved settings permanent, click the OK button.

The Refresh button reloads the folder tree with latest organizer folder list. Note that all folders will be shown in
a collapsed view.

Once you finish selecting the options, click the Ok button to save the changes. You will be returned back to the
Dashboard Builder interface.

6.2.8.1. Drilldown to Dashboard
In addition to drilldown to any chart/report/map in the dashboard, you can also map the chart data points, report
columns, and/or shared parameters to another dashboard. The dashboard builder supports both parameterized and
non-parameterized dashboard as the destination of the drilldown. If the target dashboard has no parameter or you
don't setup any parameter mapping, the template from which the drilldown link starts will become clickable and
the result of the click will popup the target dashboard in a new window without any default parameter setup.

In case you want to set a parameterized dashboard to be a drilldown destination, you will need to map shared
parameter(s) from the target (child) dashboard to chart data points/report columns or shared parameters in the
mother dashboard. It will behave like setting up a drilldown link for a report, chart or map, as mentioned before.
The corresponding field(s) will then be changed to a hyperlink and when you click the link, the target dashboard
will pop up and the shared parameter of the target dashboard will be updated.

You can set up a drilldown link without any parameter mapping to another dashboard. If the template has both
unmapped and mapped drilldowns and is a report or chart, the drilldown that appears depends on which point on
the report/chart was clicked. If it is a datapoint that is used as a drilldown link for a mapped drill-down, a mapped
drillable link will appear. If not, an unmapped drillable link will appear.

The other drilldown functionalities are basically the same as mentioned in the previous section. For more details
about setting drilldowns and the drilldown options dialog, please navigate to the previous Section 6.2.8 - Drilldown.

6.2.9. Folders
Folders allow you to place tabbed objects into your dashboard. Folders can contain charts, reports or maps, and
use a tabbed interface that allows you to switch between current objects to display. You can insert a folder into

a dashboard by clicking the Insert Folder button  on the dashboard builder toolbar. After you do so, a small
rectangle will follow your mouse pointer around the builder interface. Position the rectangle where you want to
insert the folder and click. The folder will be inserted into the dashboard. To move a folder, click and drag your
mouse over the right side of the folder's header bar.
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New Folder

After adding a folder to the dashboard, you can drag and drop reports, charts and maps into it. After you add an
object to a folder, a new tab will be visible inside the folder, showing the names of the objects within it. To switch
between objects, simply click on the tab of the object you wish to view. Objects can be removed from the folder
by clicking and dragging on the object's title bar.

Folder with objects and style formatting

There are two additional buttons available for a folder in the folder header bar:

Edit: This button will open a new dialog that allows you to specify text label properties, style, background
color and border for the folder tabs.

Text Properties: The first tab of the edit window allows you to adjust text label properties.
You can adjust the font type, font style, font size and alignment of the
label as well as changing font color using swatches or RGB values.



Designing Dashboards

481

Style Properties: The second tab of the edit window allows you to set style properties. You
can adjust tab shape and position.

Width: This option allows you to set a width
of tabs in pixels.

Char Length: This option allows you to set charac-
ter length. Shortened file names will
end with three dots (included in the
length).

Spacing: This option allows you to set a space
between tabs in pixels.

Out of Bound Handling: Tile - The width of the tabs
will be kept even if the
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whole tabs are not vis-
ible.

Shrink - The width of the tabs
will adjust to make the
whole tabs visible.

Background Properties: The third tab of the edit window allows you to set the background color
for either active or inactive tabs. The background color can be adjusted
using swatches or RGB values.

Border Properties: The fourth tab of the edit window allows you to set the tab border color.
The tab border can be adjusted using swatches or RGB values.
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Delete: This button will delete the folder.

6.2.10. Template Linkage
Template Linkage allows you to use data from one chart, report or map as a parameter in another. To use this

feature, click the Add/Modify link button  on the source chart, report or map to bring up the Set up Links in
Dashboard screen.

On this screen, there are three columns:

Column Name List - This is a list of available columns and their data type in the source template.
Click on a value from this column to use it as a parameter in another template.
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Available Template(s) - This lists the other templates that are open in the current dashboard. Click on a
template name to select it. While a template is selected, it will be highlighted
in the dashboard.

Available Parameter - After selecting a column name and template, this list of available parameters
will appear. Select a parameter you want to map to the selected column name
in the first column.

When you are done selecting values in each column, click the Set button. You can then select new fields if you
wish to add additional links. Once a link has been established, clicking on a value in the specified source column
(or chart object) will cause the target templates to be refreshed using data from that column.

To remove a link, select it and then click the Remove button.

6.2.11. Dashboard Preview

At any point in the design process, the dashboard can be previewed by clicking the Preview button  on the
dashboard builder toolbar. This will open a new window showing the dashboard. Dashboards that have been de-
ployed to the Organizer can also be viewed in the Menu Page.

For more information about dashboard preview options, please see Section 7.4 - Dashboard Viewer.

6.3. Dashboard Migration
Often you may need to move dashboards from one location to another. For example dashboards may move between
the server and the develop machine. On the develop machine the reports/charts/maps locations can change and may
not be located from the data stored in the dashboard .dsb file. Therefore, EDAB uses the DPAK files to move
or archive dashboards along with it's components. To learn how to create a DPAK file, see the Section 2.1.4.4 -
Dashboard and Map Packages.

Note
The DPAK files can be viewed in Published Files, but they can't be open in the Dashboard Builder.
To edit a dashboard from a DPAK file, you have to unpack it first (to learn how to unpack a DPAK
file, see the Section 2.1.4.4 - Dashboard and Map Packages).

6.3.1. Migrating from previous EDAB versions
DPAK files can't be created in EDAB version 6.3 and older. If you want to move a dashboard from an old EDAB
version (6.3 or older) to a new EDAB version (6.6 or newer), you will have to use the “Dasboard Migration” feature.

To use this feature, you will need to copy the following files from source EDAB server to the corresponding files
on the destined EDAB server :

• dashboard file from <InstallDirectory>/DashboardFiles

• report files from <InstallDirectory>/ReportFiles (can be a stand-alone report or behave as a drilldown target)

• chart files from <InstallDirectory>/ChartFiles (can be a stand-alone chart or behave as a drilldown target)

• drilldown reports/charts from <InstallDirectory>/DrillDown (for drilldown templates that were created in the
drilldown wizard)

• charts embedded in reports from <InstallDirectory>/chart

• map files from <InstallDirectory>/MapFiles with all the files used by this map (i.e. Coordinates file, Tooltip
template and DrillDown template for Google Maps or SVG Image and DrillDown template for SVG Maps). If
you are not sure about what files are used by your map, you can view the map file and search for filenames. Map
files are XML files, so they are human-readable. Please note that all the files used by your map should be copied
in the same subdirectories of the EDAB installation directory on the destinated EDAB server. Otherwise, you
will have change the file links in the map file manually.

• necessary images which are used in dashboard, but not available from the destined machine
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Note
The directories that are mentioned in the above list are the default directories that are used for saving
certain file types. If you saved a template to a different directory or if you inserted some files into
Organizer from a custom directory, you will have to search for the files in their original locations.

Next, you will need to add previously mentioned files to the destined Organizer and then launch the dashboard
builder.

To migrate a dashboard from the Dashboard Builder, click the Migration button  on the Dashboard Builder
toolbar. After you have clicked the button, the following dialog will then appear.

Dashboard migration dialog

The dialog contains a tree that mirrors the folder structure in the Organizer. All of the dashboards to which you have
access are listed. In order to select a dashboard to migrate, simply select it in the tree and click Ok. The migration
mapping dialog will then appear.

Dashboard migration dialog
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From this dialog you can map the original reports/charts/maps to the reports/charts/maps in the destined Organizer.
Please note when your dashboard uses images (dashboard background, shared param panels background, shared
param value list button icons, etc.), which are not available from the destined machine, you need to set image
mapping as well. To set the image mapping click Set Image Mapping link at bottom of the dialog. The dialog will
then extend to allow you specifying/changing the image mapping.

Dashboard migration dialog

All the images that were used in the original dashboard will be listed with their URLs. You can see the preview of
the original (the first image) and current mapped image (the second image). If an image is not correctly mapped,
the second preview image will be blank. Once you have finished specifying the mapping for the dashboard files/
images click Save. It will open the following dialog prompting you to enter the name for the migrated dashboard.

Dashboard migration dialog

Once you have finished specifying the options click Ok and the dashboard will then be saved.

6.4. Save Dashboard
Once you have finished setting up all the dashboard definitions, you can save the dashboard by clicking the Save

button  on the toolbar. A new dialog will open prompting you to specify the name for the dashboard.
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Save Dashboard Dialog

The first option allows you to specify a name for the dashboard. The dashboard will be saved with a .dsb extension
in the /DashboardFiles/ directory of your EDAB installation.

The second option allows you to insert the dashboard into the Organizer. The drop-down list contains all of the
projects and folders in Organizer to which you have access. Select the project or folder in Organizer where you'd
like to place the dashboard.

Once you have finished specifying options, click the Ok button to save the file.

6.5. Open Saved Dashboard
You can open the saved dashboard by clicking the  Open icon on the main toolbar. Open Dashboard dialog
will appear in the left pane.

Open the Dashboard

You can see all dashboards from Organizer created in Dashboard Builder. Select a dashboard and click Ok to open it.
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6.6. Exit
You can exit Dashboard Builder by clicking the  Home icon in the upper right corner, by clicking the Dashboard

Builder title, or by clicking the  Logo icon in the upper left corner. Before closing, you will be asked if you
want to save an unsaved dashboard.
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Chapter 7. Publishing (Menu & URLs)
7.1. The Menu Page

In EDAB, all reports, charts, maps and dashboards created or added to the Organizer are automatically published.
By logging into the menu page, users can access and run any files to which they have privileges in the Organizer.
The menu page is included with EDAB and deploys without any code.

7.1.1. Launching the Menu Page
The menu page can be launched from the EDAB start page. Once you've successfully logged in, click the Published
Files link.

The menu page can be also accessed directly by going to the menu page login: Menu_Login.jsp. If you installed
EDAB with Tomcat, the URL to the login is http://machinename:port/EDAB/Menu_Login.jsp. This
will bring up a page allowing you to login to the menu page directly.

Direct Access to Menu Page

7.1.2. Using the Menu Page
When the menu page first loads, it will show a collapsed tree-list of all the reports, charts, maps, dashboards, and
other files in the Organizer which you have privileges to see in a tabular format.

Menu Page

7.1.2.1. Viewing Reports and Charts
To open a file, expand respective project/folder nodes (in the tree-list on left side) to locate the file and click on the
filename. The file will load in the right DHTML Viewer panel.

You can also search for specific files. To do so, enter search terms in the upper left dialog and click the Search

button. The tree-list will reload, showing only relevant files. To cancel the search filter, click the  Close Search
icon next to the search field. Note that the Close Search icon will not be visible if there is no filter applied to the
list at the moment.

You can hide the left panel by clicking on the  Collapse icon located in the top-right corner of the navigation panel.
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To close the MenuPage and to return to the EDAB start page, click the  button in the top-right corner of the
MenuPage.

7.1.2.1.1. Viewing Reports with Encrypted Data
If your report contains encrypted data, you need to do two things in order to view the data.

1. You need to create an XML file that gives the database URL, database driver, name of column to be decrypted,
and the function to be applied when the data is being retrieved.

2. You need to include the ReplaceColumnInfoList option in the command line, i.e. servercommand.txt be-
fore you start EDAB server.

For more details and an example for viewing encrypted data, please see Section 3.2.2.1.2 - Querying Encrypted
Data.

7.1.2.2. Using the DHTML Report Viewer
If you click on a report in the menu page tree-list, the report will open in the DHTML report viewer. This interface
is a thin-client component that allows you to view and interact with the report. In the DHTML report viewer, the
first page will show as soon as it is ready, while the rest of the report continues to be processed on the server side.
This means that for larger reports, navigating to a page that is not yet exported will result in delay. Before a report
is finished processing, the toolbar options will not be available and clicking on any of them will result in a warning
message. The main window of the interface provides HTML view of the report with a small toolbar in the top-left
corner of the page. Each option on the toolbar will bring up a dialog allowing you to make changes to the report.

The main window also contains a page navigator that contains first page, previous page, next page, last page buttons
and a textbox that allows you to jump to any specific page number. The textbox displays the current page number
in the form <Current Page Number> / <Total Page Number>. To jump to a specific page, simply type the page
number into the textbox and press Enter. You can also enter the value in the same fractional format that is used in
the display. For example, to jump to page 7 of a 22 page report, you can enter 7 or 7 / 22.

DHTML Viewer Interface

7.1.2.2.1. The DHTML Report Viewer Toolbar
The options in the DHTML report viewer toolbar are as follows:

Filter Report:  This option is only available if the report is parameterized. It will bring up a dialog containing
all parameters defined in the report.
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Filter Dialog

Select new values and click the Ok button to update the report. There is a validation system for unmapped
parameters that will check entered values against expected datatype and alert you if it does not match.

Export Report:  This option allow you to export the report in a variety of file formats. It will bring up a
dialog prompting you to select export options.

Export Dialog

The first option in the dialog allows you to specify in which format you want to export the report. Available
options are HTML, PDF, CSV, Excel (XLS), Excel 2007 (XLSX), DHTML, text, XML and rich text.

Other options allow you to set single or multi-page export for HTML, DHTML, and XML exports. PDF
format allows you to enable encryption. For text export, you can select delimiter to be used, and for XML
export, you can select whether to export only report data or XML description of the report and data.

Once you finish specifying options for the exported report, click the Ok button. A new window will open
containing the exported report. The toolbar will be active on this window, allowing you to save the generated
file to your local system or print the report locally.

Print Current Report:  This option allows you to print current page of the report on user's local printer,
as displayed inside the right-side panel.
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1. By default, all browsers don't print background colors and images to save ink. You have to change print
settings to allow that.

How to set it in different browsers:

Chrome: Check the Background colors and images option. It is in the Print dialog that opens automati-
cally.

IE 11: Click the gear icon in the upper right corner → Print → Page Setup → check Print Background
Colors and Images

Firefox: Print → Page Setup → check Print Background (colors & images)

2. Reports wider than page might be cut off. If you need to print wider reports, please export them to PDF
and print the PDF.

Expand and Collapse View:  This option allows you to add expand and collapse controls to any grouped
report.

Expand and Collapse Dialog

The first option in the dialog allows you to turn the control for expanding and collapsing on. Enable Anima-
tion allows the grouping to fade in and out as it is expanded and collapsed. Expand To specifies the initial
presentation of the report, i.e. collapsed completely, expanded completely or expanded to a specific group
level.

Once you finish specifying the options, click the Ok button. The controls will now be added to the report.

Change Grouping/Summaries:  This option is only available if the report was created using QuickDesigner.
It opens a dialog that allows you to edit the report grouping and aggregation.

Grouping Dialog

To add or remove grouping, select a column and click the Add or Remove button. If you select more than one
level of grouping, you can change the nesting order using the arrow buttons on the right side of the dialog.

To set column aggregation, click the Select Aggregation button below the column list on the left side. This
will open a new dialog allowing you to change the aggregation for the columns in the report.
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Aggregation Dialog

The top drop-down list contains all selected columns for the report and the lower list contains all available
aggregation options. To set aggregation for a column, select it in upper list and set the desired aggregation
in lower list. Once you finish setting up the aggregation, click the Ok button and the dialog will close. The
new aggregations will be reflected in the column list.

Change Column Order/Visibility:  This option is only available if the report was created using Quick-
Designer. It opens a dialog that allows you to change the column order in the report as well as show/hide
columns.

Column Order Dialog

The dialog contains a list of all columns in the report. To change the column order, select a column in the list
and click on the up or down arrow buttons to change the order. The order from top to bottom in the dialog
represents the column order from left to right in the report. To show or hide a report column, check or un-
check Visible option in the bottom of the dialog.

Change Sorting Options:  This option allows you to change the sorting in the report. It will bring up a
dialog prompting you to set sorting options.
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Sorting Dialog

The left side of the dialog contains all columns in the report. To sort it by a column, select it in the left side
and click the Add button. You can control the sort priority by selecting a sort-by column on the right side and
clicking on the up or down arrow buttons to change its position. You can control the sort direction by selecting
a sort-by column on the right side and clicking on the Asc or Desc radio buttons to indicate the direction.

Refresh Data:  The DHTML Viewer caches the report and therefore when you close and reopen the same
report, the data is not updated. This option will refresh the data in the report.

Reload Report:  When you run a report in the DHTML Viewer, make some changes to this report and then
try to open this report again in DHTML Viewer, you'll notice that the report does not reflect the new changes.
This is because the DHTML Viewer caches the report to improve performance. To see the changes, use the
Reload Report button to have the DHTML Viewer read the report structure again and also refresh the data.

7.1.2.2.2. Parameterized Reports and Reports with Unmapped Drilldown Parame-
ters

When viewing a parameterized report in the DHTML Viewer, the parameters are initially set to their default values.
You can then change the parameter value using the Filter icon described above. The DHTML Viewer can also be
used to view drill-down reports with unmapped parameters. Similar to a regular parameterized report, the drilldown
report will display using default values, but you can adjust them by using the Filter icon.

Drilldown with Unmapped Parameter
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7.1.2.3. Using the DHTML Chart Viewer
If you click on a chart in the menu page tree-list, the chart will open in the DHTML chart viewer. This interface
is a thin-client component that allows you to view and interact with the chart. The DHTML chart viewer displays
the chart using default parameter value (if the chart is parameterized). The parameter value can be changed using
the toolbar options. The main window of the interface provides you with HTML view of the chart with a small
toolbar in the top-left corner of the page. Each option on the toolbar will bring up a dialog allowing you to modify
the chart's look and feel, and navigate through the chart.

7.1.2.3.1. The DHTML Chart Viewer Toolbar
The options in the DHTML chart viewer toolbar are as follows:

Filter Parameter :  This option is only available when the chart is parameterized. Clicking on the icon will
bring up a dialog that allows you to specify parameter values for the chart. You can choose/select the values
and then click the OK button to update the chart. For unmapped parameter, the value is validated against the
expected data type and alerts you in case of a mismatch.

Export Chart :  This option allows you to export the chart to a variety of formats such as PDF, PNG, GIF,
JPEG and SVG. The exported chart is then displayed in a new window from where it can be saved to your
local system or printed.

3D Display Option :  This option is only available when the chart is hree dimensional. Three-dimensional
charts have several additional options. These options can be accessed by clicking the 3D Display Options
button on the toolbar. This will open a dialog in a new window. Available options include:

• Arrow buttons at the top of the dialog allows you to adjust the viewing angle of the chart. The 3D chart
can be rotated horizontally and vertically.

• The first three sliders allows you to control the chart scaling of the chart in the X, Y, and Z directions. The
scaling features control the proportion of the chart in each direction. The final slider controls the thickness
of the data points.

• The remaining options allow you to toggle wire frame mode for the chart, show/hide the border around
the chart, and draw the series inline (instead of on the Z axis) for charts with data series. The last option
also enables 3D approximation for the chart. 3D approximation is useful when dealing with charts with
a large number of data points. The approximation can improve 3D rendering performance when a large
amount of data points exists on the chart. This feature is automatically enabled when the chart contains
more than 100 data points.

Once you finish setting the options, click the Ok button to save the changes.

Zoom Option :  The Zoom option dialog is only available for a chart with zoom feature enabled. You can
modify the zoom properties such as lower bound, upper bound and zoom scale, as well as change the period
layout to linear. Then click the Ok button to apply the new zoom changes.

Refresh Data :  You can use the refresh data option to fetch the latest data for the chart.

Reload Chart :  Changes in the chart are not always reflected in the DHTML chart viewer. This is because
the DHTML chart viewer caches the chart to improve performance. You can click on the Reload icon to
display the changes and refresh the data.

Back Button :  The Back button appears if you are in a sub-level chart. Clicking the Back button will take
you back to the previous level.

The DHTML chart viewer also supports drill-down. You can drill-down to the next level chart (if the chart is a
drill-down chart) by clicking on the desired data point.

The DHTML chart viewer also pops up a hintbox that displays the data information/hyperlink information for the
specific data point. If a hyperlink is embedded, clicking on the data point will direct the user to the linked page.

7.1.3. Mobile MenuPage
If you access EDAB main page from a mobile device, a special simplified EDAB start page will be displayed.
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EDAB mobile start page

Note
The mobile features don't work in so-called PC view, which can be enabled in some mobile web
browsers. In PC view, the standard EDAB start page and MenuPage will be displayed.

Enter your user name and password and tap on the Login button. You will be redirected directly to a special mobile
MenuPage which allows you to view reports, charts, maps and dashboards.

Mobile MenuPage

The mobile MenuPage is easy to use - scroll/swipe up or down to locate a template or a dashboard and tap on its
name to open it.

Mobile Report Viewer If you open a report from the mobile MenuPage, standard DHTML Viewer
will open. To learn more about the DHTML Viewer, see Section 7.1.2.2 -
Using the DHTML Report Viewer.
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DHTML Viewer

Mobile Chart and Map Viewer Chart/map viewer has no control elements.

If the chart/map has any parameters, a parameter prompt will be displayed
first. Enter any parameter values and tap on the Submit button to display the
chart/map.

Parameter prompt

Dashboards If you open a dashboard on a mobile device, you can swipe the dashboard
to navigate in it.
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However, on smaller devices, navigating through large dashboards may re-
quire extensive zooming and scrolling. In such cases, you can maximize a
dashboard template to display the dashboard in a more mobile-friendly way.

To maximize a template, click on its  maximize icon, or double-tap/pinch
on the template.

When navigating in maximized-mode, all dashboard templates will be
arranged in a single loop, so you don't have to remember the dashboard lay-
out at all. If you swipe on a maximized template to the left, the next template
will be displayed.

For example: Templates from the following dashboard:
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Would be displayed in the following order:

7.2. Dashboard URLs
In addition to the menu and the API, EDAB also allows you to deploy dashboards using URLs. Dashboard URLs
allow dashboards to be called via http call to the server. Dashboard URLs are whole URLs that are run by pointing
the web browser to the URL address, or by specifying a hyperlink to the dashboard URL in another Web page.

7.2.1. Generating URLs in Organizer
The easiest way to generate dashboard URLs is to have the Organizer do it for you. To generate a dashboard URL in
the Organizer, first select the dashboard file (.dsb) that you want to use. Then you can select Generate Dashboard
URL from the Publish menu, click the Generate Dashboard URL button on the toolbar, or right-click and select
Generate Dashboard URL from the pop-up menu. A new dialog will appear allowing you to specify user option
for the generated dashboard URL.
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Generate Dashboard URL Dialog

Dashboard URLs can have username and password passed in as arguments in the URL. If the For Current User
option is checked, the current user will be embedded in the URL. If no username or password is supplied in the
URL (For Current User option is unchecked) when it is run, the user will be re-directed to a login page before
viewing the dashboard.

User Login Page

7.2.1.1. Running Dashboard URLs
Once you specify the For Current User option and click the OK button, a new window will open containing the
generated URL string. From this window, you can copy the dashboard URL.

Generated Dashboard URL

In order to view a dashboard, just copy and paste the URL into the browser window.
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View Dashboard URL

7.2.2. Writing Dashboard URLs
Rather than having the Organizer generate the dashboard URL, you can write your own by using the URL syntax
below.

7.2.2.1. URL Syntax
The syntax for dashboard URLs is fairly simple. Every URL begins with a call to the Server:
http://<MACHINE_NAME>:<PORT>/<CONTEXT_ROOT>/Dashboard/Dashboard.jsp?. The MA-
CHINE_NAME is either the URL, machine name, or ip address of the server machine. The PORT is the port number
for the application server, the default for Tomcat is 8080. The CONTEXT_ROOT is the context root for the EDAB.
By default, the context root is EDAB, but this can be changed by administrator. Following the question mark, users
need to specify either the USERNAME and PASS parameters, or the USESESSION parameter instead, as well as
the dashboard file location.

The following URL will open the Population.dsb dashboard file for the specified user.

http://<MACHINE_NAME>:<port>/<CONTEXT_ROOT>//Dashboard/Dashboard.jsp?
USERNAME=qMFq-5dab27h&PASS=qMFq-5dab27h&OpenFile=http://
<MACHINE_NAME>:<port>/<CONTEXT_ROOT>/help/examples/Dashboard/Population.dsb
            

For example, if the server was set up on www.quadbase.com with port 8080 and the context root is EDAB, then
the dashboard URL will look like this.

http://www.quadbase.com:8080/EDAB/Dashboard/Dashboard.jsp?
USERNAME=qMFq-5dab27h&PASS=qMFq-5dab27h&OpenFile=http://
www.quadbase.com:8080/EDAB/help/examples/Dashboard/Population.dsb
            

7.2.2.2. URL Parameters
URL parameters allows you to specify the dashboard file you want to run as well as specify whether to use username
and password that are stored in the browser session or not.

OpenFile: This allows you to specify the dashboard file that you want to run.
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&OpenFile=http://machinename:port/EDAB/DashboardFiles/
TestDashboard.dsb
                    

Note
You can use both absolute and relative paths for the dashboard file location.

USERNAME: This option allows you to specify a username. If you generate an URL in Organizer and select
to use an user, the username will be encoded in the generated URL. You can also specify the
username as plain text.

&USERNAME=user
                    

PASS: This option allows you to specify a user password. If you generate an URL in Organizer and
select to use an user, the password will be encoded in the generated URL. The password can
also be specified using plain text.

&PASS=password
                    

USESESSION: This allows you to have the server read the username and password from the session. If this
option is enabled, the information will be retrieved from session parameters USERNAME and
PASS. This option is only available if you will be deploying the URL within a servlet or JSP
application.

&USESESSION=true
                    

7.3. Menu Page Listener
The menu page and URL publishing options provide a convenient deployment vehicle for reports and charts. Using
these interfaces, users can easily deploy charts and reports to the Web without any coding. However, the interfaces
themselves do not provide any significant run-time customization capability. Report and chart templates are run
in a pretty much “as is” format.

For users that would like to provide some additional logic, or run-time customization to reports and charts, EDAB
provides the Menu Page Listener interface which is part of the EDAB extension package. Using this method, users
can implement listeners that will intercept the report or chart prior to export, and use the APIs to modify it.

7.3.1. EDAB Listener Manager
The EDAB Listener Manager is a user-implemented class that is used to manage several listeners that monitor
events on the server, including the Menu Page Listener. In order to implement the Menu Page Listener, users must
implement the Listener Manager. Below is a sample Listener Manager class:

package extensionClasses;

import quadbase.reportorganizer.ext.*;

public class MyEdabListenerManager extends DefaultListenerManager {

      public MyEdabListenerManager() {}

      public EdabSchedulerListener getSchedulerListener() {
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            return new MyEdabSchedulerListener(); 

      }

      public MenuPageListener getMenuPageListener() {

            return new MyMenuPageListener(); 

      } 

}
      

Users can impelement the EDABListenerManager interface or extend DefaultListenerManager. The
above code implements two listeners, the Scheduler Listener and the Menu Page Listener. The Scheduler Listener
takes effect when a schedule job executes.

7.3.1.1. Deploying the Listener Manager
You can specify the Listener Manager class as a server option for EDAB. You can set this in one of two places.
The first option is the Admin Console. You can specify the class in the Server Options tab. For more information
about server configuration options, see Section 1.4.1.3 - Server Options. You can also specify the class by modi-
fying the QB.properties under <EDABInstallDir>/WEB-INF/classes. However, editing configura-
tion files directly is not recommended and should be done only in case when the EDAB server cannot be started
because incorrect values have been provided through the Admin Console.

7.3.2. Using the Menu Page Listener
The following code shows a sample implementation of the Menu Page Listener:

package extensionClasses;

import java.lang.*;
import java.awt.*;
import quadbase.reportorganizer.ext.*;
import quadbase.reportdesigner.ReportAPI.*;
import quadbase.reportdesigner.ReportElements.*;
import quadbase.reportdesigner.util.*;
import quadbase.ChartAPI.*;
import quadbase.reportdesigner.report.Formula;

public class MyMenuPageListener implements MenuPageListener {

      public QbReport modifyBeforeRun(QbReport report, String username) {

            System.out.println("Calling Menu Page Listener...");

            try {

                  // Create a new label to show user that is running the
 report
                  ReportCell userLabel = new ReportCell();
                  userLabel.setText("Report Run By: " + username);
                  userLabel.setFont(new Font("Arial", Font.PLAIN, 8));
                  userLabel.setAlign(IAlignConstants.ALIGN_RIGHT);
                  userLabel.setHeight(0.2);
                  userLabel.setWidth(1.6);
                  userLabel.setY(0);
                  userLabel.setX(5.90);
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                  // Create a new formula to show the report run date/time
                  ReportCell runDate = new ReportCell();
                  Formula runDateFormula = new
 Formula("ReportRunDate", "\"Report Run Date: \" +
 printDateTime(getCurrentDateTime(), \"MMM dd, yyyy h:mm a\")");
                  report.addFormula(runDateFormula);
                  runDate.setFormulaObj(runDateFormula);
                  runDate.setFont(new Font("Arial", Font.PLAIN, 8));
                  runDate.setAlign(IAlignConstants.ALIGN_RIGHT);
                  runDate.setHeight(0.2);
                  runDate.setWidth(2.5);
                  runDate.setY(0.2);
                  runDate.setX(5.0);

                  // Add new cells to page header section
                  report.getPageHeader().addData(userLabel);
                  report.getPageHeader().addData(runDate);

                  // Adjust section height if necessary
                  if (report.getPageHeader().getHeight() < 0.4)
                        report.getPageHeader().setHeight(0.4); 

            } catch (Exception ex) {

                  ex.printStackTrace(); 

            }

            return report; 

      }

      public QbChart modifyBeforeRun(QbChart chart, String username) {

            System.out.println("Calling Menu Page Listener");

            try {

                  // Define an array of chart colors
                  Color gold = new Color(227,215,130);
                  Color salmon = new Color(199,85,90);
                  Color burgandy = new Color(125,18,66);
                  Color slate = new Color(81,119,156);
                  Color teal = new Color(130,203,217);
                  Color blue = new Color(26,42,103);
                  Color beige = new Color(188,204,177);
                  Color[] chartColors = {gold, salmon, burgandy, slate,
 teal, blue, beige};

                  // Apply new colors to the chart
                  chart.gethDataPoints().setColors(chartColors); 

            } catch (Exception ex) {

                  ex.printStackTrace(); 

            }
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            return chart; 

      } 

}
      

This example implements to modifyBeforeRun methods, one for charts and one for reports. With this code
deployed, everytime a report is run, the username and the run time is added to the report header. Everytime a chart
is run, the chart colors are modified to use the palette defined in the method. Note that this is only one example.
Any report/chart API code can be used in these interfaces to modify the reports and charts prior to export.

7.4. Dashboard Viewer
Dashboard Viewer is an applet that enables you to view and manipulate a dashboard dynamically through a web
browser. Viewer reads the file (in .dsb format) as outputted by Dashboard Builder and then displays the dashboard.

The dashboard can be previewed by clicking the Preview button  on the Dashboard Builder toolbar. This will
open a new window showing the dashboard.

Dashboard

7.4.1. Preview Toolbar
The top part of the Preview interface contains a small toolbar that allows you to initiate the following actions:

 Set shared parameter(s)

 Refresh a dashboard

 Set auto refresh

 Export Dashboard to PDF (Note: All objects in dashboard including Online maps are exported, however, if
map type is set to Google street map or Google satellite, map imagery will be missing in the exported file due
to its license restrictions.)
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 Pack/Unpack the preview toolbar

7.4.2. Preview Options
This section gives you description of options available from the preview toolbar and additional options available

from the chart/report/map header bar. You can hide/show the toolbar by clicking the  /  Pack/Unpack
icons.

Set Shared Parameters:
To set shared parameters, click the Set Shared Parameters button  on the
preview toolbar. After you click the button, the shared parameters dialog will
then appear. The dialog allows you to specify values for shared parameters.

Set Shared Parameters Dialog

Note that you can use calendar for specifying date parameters. To open the

calendar, simply click the Calendar button  in the shared parameters dialog.

Calendar

Once you finish specifying the shared parameters, click the Ok button to save
the changes. You will be taken back to the Preview.

Auto Refresh: If you want your dashboard to be refreshed periodically, click the Auto Refresh

button  on the preview toolbar. After you do so, the Auto Refresh dialog
will then appear. You have to check off the AutoRefresh checkbox to enable the
auto refresh feature. The dialog allows you to set the refresh interval in seconds.
For example, if you specify the refresh interval for 10 seconds, the dashboard
will refresh every 10 seconds.

Auto Refresh Dialog
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Once you finish setting up the auto refresh options, click the Ok button to save
the changes. You will be taken back to the Preview.

In addition to the options on the preview toolbar, there are additional options available for a chart/report/map that
can be triggered by clicking the small buttons in the chart/report/map header bars.

Filter:  This option will open a new dialog that allows you to specify additional filters/parameters for the
chart/report/map, if it has parameters that aren't associated with one of the dashboard's shared parameters.

Dashboard Filter Chart/Report/Map Dialog

You can select parameter values in this dialog. Once you complete your selection, click the Ok button. The
dashboard will refresh and the chart/report/map will reflect the new parameter values.

Change Chart Type:  This option will open a new dialog that allows you to change a chart type. The chart
type is changed only in the Preview. It is not possible to save the changed view of the chart, but you can
export it.

Select Chart Type Dialog

Export:  This option will open a new dialog that allows you to export the chart/report/map in a variety of
formats. For charts the following dialog is displayed:
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Dashboard Export Chart Dialog

The first option allows you to specify the format in which to export the chart. The available formats are GIF,
JPEG, PNG, PDF, SVG, Excel Image (XLS), Flash, Text Data File, XML Data File and MAP Data File
(HTML Image Map).

The second option allows you to set dimensions of the exported image. By default, these will match the
canvas dimensions of your chart.

The last set of options allows you to set some image type-specific options. You can set the background
transparent for GIF files, quality for JPEG files, and specify encoding for PNG files.

For more information about chart export options, please see Section 4.1.6.2 - Exporting Charts.

Once you finish specifying the options for exporting the chart, click the Ok button. A new window will open
containing the exported chart.

For reports the following dialog is displayed:

Dashboard Export Report Dialog

The first option in the dialog allows you to specify in which format you want to export the report. Available
options are PDF, CSV, Excel (XLS), Excel 2007 (XLSX), DHTML, text, XML and rich text.
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Other options allows you to set single or multi-page export for DHTML and XML exports. You can enable
encryption for PDF format. For text export you can select to use the delimiter and for XML export you can
select whether to export only report data, or XML description of the report and data.

Once you finish specifying the options for exporting the report, click theOk button. A new window will open
containing the exported report.

Online Maps and SVG Maps support only one export format, PDF, so no export format settings dialog is
displayed for maps. Please note that Online Maps cannot be exported if Google street map/Google satellite
is used as map type, due to license restrictions. In this case, map imagery will be missing in the exported file.

Maximize:  This option maximizes the report/chart/map.

Minimize:  This option minimizes the report/chart/map (only template header bar is visible).

Restore:  This option resizes the report/chart/map to its original size.
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Chapter 8. Programming
8.1. Managing Users and Groups
8.1.1. Introduction

User and group administrator can be done programmatically via the API instead of always going to the EDAB home
page. API calls are available to create, edit, and delete users and groups.

Both EDABOrganizer.jar and EDABServer.jar (in the <EDAB-installation-directory>/lib
directory) needs to be added to the CLASSPATH for any code using EDAB Organizer. The following snippet shows
how to connect to EDAB Organizer:

QbOrganizer.setServletRunner("http://localhost:8080");
QbOrganizer.setServletContext("EDAB/servlet");
QbOrganizer organizer = new QbOrganizer(null, "admin", "admin");
        

The above code sets the connection information to connect to EDAB Server and provides the username and pass-
word (in the above example, admin and admin) for EDAB Organizer.

All examples and code given in the manual assume that EDAB server is running locally (i.e. on your local machine)
and on port 8080. You can change this by going to the source code (you can download the source code by clicking
on the Full Source Code link in the corresponding chapter), editing the code to enter the new connection information
and recompiling it.

Also, note that if you have applets that use EDAB Report API, the browser must have JVM plugin at least version
1.5 or higher.

8.1.2. Users and Groups
You do not have to use the EDAB Admin console to create, edit, and/or delete user and group information. You
can modify any user and/or group information via the API. Note that only admin user can call the API methods.

To modify the user and group information, you must get a handle to UserGroupProperties using the following
call:

UserGroupProperties userGroupProperties = new
 UserGroupProperties(organizer);
        

Please note that the code must log to EDAB as the admin user, otherwise the user/group information will remain
unchanged. Any username and/or group name must be in lowercase. Uppercase and mixed case names are converted
to lower case automatically.

8.1.2.1. Creating Users and Groups
Use this following method to create a new user:

public void createUser(String userName, String fullName, String email,
 String password, String role, String securityLevel)
            

For example:

userGroupProperties.createUser("jdoe", "John Doe", "jDoe@somedomain.com",
 "123", IUser.ROLE_DESIGNER, "manager");
            



Programming

511

Use this following method to create a new group:

public void createGroup(String newGroup, String description, String[] users)
            

For example:

userGroupProperties.createGroup("testinggroup", "For testing purpose only",
 new String[]{"admin", "jDoe"});
            

Full Source Code [ https://data.quadbase.com/Docs71/help/manual/code/src/CreatingUserGroup.zip ]

Result Screenshot [ https://data.quadbase.com/Docs71/help/manual/images/CreatingUserGroup.gif ]

The above code creates a new user jdoe along with a new group testinggroup. The user profile information
as well as group information is also passed via the code.

8.1.2.2. Deleting Users and Groups
You can also delete any users/groups through the code in the same manner.

Use this following method to delete a user:

public void deleteUser(String[] users)
            

For example:

userGroupProperties.deleteUser(new String[] {"jdoe"});
            

Use this following method to delete a group:

public void deleteGroup(String[] groups)
            

For example:

userGroupProperties.deleteGroup(new String[] {"testinggroup"});
            

Full Source Code [ https://data.quadbase.com/Docs71/help/manual/code/src/DeletingUserGroup.zip ]

Result Screenshot [ https://data.quadbase.com/Docs71/help/manual/images/AdminConsole.gif ]

The above code deletes jdoe user and testinggroup group. Note that the user and group have to exist before
they can be deleted.

8.1.3. Single Sign-On
You can also have your own custom login page (for example, login to your portal) and then pass the required
information to EDAB (rather than having to login twice, once for your application and the other for EDAB).

To pass in the login information, you would need to pass the following parameters to authenticate.jsp
(located in the root EDAB install directory):

origPage : Page to be redirected to if login is successful.

loginPage : Page to be redirected to if login is not successful.

https://data.quadbase.com/Docs71/help/manual/code/src/CreatingUserGroup.zip
https://data.quadbase.com/Docs71/help/manual/code/src/CreatingUserGroup.zip
https://data.quadbase.com/Docs71/help/manual/images/CreatingUserGroup.gif
https://data.quadbase.com/Docs71/help/manual/images/CreatingUserGroup.gif
https://data.quadbase.com/Docs71/help/manual/code/src/DeletingUserGroup.zip
https://data.quadbase.com/Docs71/help/manual/code/src/DeletingUserGroup.zip
https://data.quadbase.com/Docs71/help/manual/images/AdminConsole.gif
https://data.quadbase.com/Docs71/help/manual/images/AdminConsole.gif
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username : username to be passed.

password : password to be passed.

The following example shows the possible contents of a jsp page that is passing the information to authenti-
cate.jsp. Note that in the example, username and password is inputted, although you can specify them before
calling authenticate.jsp :

<html>

      <head>
      </head>
      <body>

            <form name="Login" action="authenticate.jsp" method="POST">

                  <input type="hidden" name="origPage" value="MenuPage.jsp">
                  <input type="hidden" name="loginPage"
 value="myLogin.html">

                  <table width=100% cellpadding=2 cellspacing=0>

                        <tr>
                        <td width=80 valign="center" align="right">User
 Name: </td>
                        <td align="left"><input type="text"
 name="username"></td>
                        </tr>

                        <tr>
                        <td width=80 valign="center" align="right">Password:
 </td>
                        <td align="left"><input type="password"
 name="password"></td>
                        </tr>

                  </table>

                  <input type="image" src="Web_Component/STARTUP/Login.gif"
 border=0></td>

            </form>

      </body>

</html>
        

The recommended way to run the above code is to go to the root EDAB directory and copy the contents to an empty
.jsp page. Note that myLogin.html has to be created as well.

8.1.4. Login Listener
You can also create additional code that changes the datasource (only if the datasource is a database) of the re-
port/chart based on the user logged into EDAB at the time. This code extends the LoginListener class and
specifies the database connection information based on the user.

Please note that after creating the code, you need to change QB.properties (in the <EDAB-installa-
tion-directory>/WEB-INF/classes directory) and add the following argument to the ServerCom-
mands= line:
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-LoginListenerClass:<name of class file extending LoginListener>
        

The following code shows how to use the LoginListener class:

      import javax.servlet.http.HttpServletRequest;
      import javax.servlet.http.HttpSession;

      import quadbase.auth.WebLogin;
      import quadbase.auth.bean.Login;
      import quadbase.reportorganizer.ext.LoginListener;

      public class ExampleLoginListener extends LoginListener {

            public void setUserDatabaseConnection(HttpServletRequest req,
 String userName) throws Exception {

                  HttpSession session = req.getSession();
                  WebLogin wl =
 (WebLogin)session.getAttribute(Login.WEB_LOGIN);
                  if (wl == null || wl.getUser() == null) {

                        return;

                  }

                  String user = wl.getUser();
                  if (user.equalsIgnoreCase("user1"))
                  {

                       
 session.setAttribute(USER_DBURL, "someDatabaseURL1");
                       
 session.setAttribute(USER_DBDRIVER, "someDatabaseDriver1");
                       
 session.setAttribute(USER_DBUSERNAME, "someDatabaseUsername1");
                       
 session.setAttribute(USER_DBPASSWORD, "someDatabasePassword1");

                  } else if (user.equalsIgnoreCase("user2"))
                  {

                       
 session.setAttribute(USER_DBURL, "someDatabaseURL2");
                       
 session.setAttribute(USER_DBDRIVER, "someDatabaseDriver2");
                       
 session.setAttribute(USER_DBUSERNAME, "someDatabaseUsername2");
                       
 session.setAttribute(USER_DBPASSWORD, "someDatabasePassword2");

                  }

            }

      }
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To use the above code, add the following to QB.properties (located in the /WEB-INF/classes directory)
to the ServerCommands= line:

-LoginListenerClass:ExampleLoginScheduler
        

Make sure that ExampleLoginScheduler is in the CLASSPATH. The code will switch the datasource infor-
mation to a different database, depending on whether user1 or user2 has logged in. If it is a different user, the
original datasource will be used.

8.1.5. Javadoc
Javadoc for the entire API is provided along with EDAB. It is located  here (server functions) [ https://data.quad-
base.com/Docs71/edab/help/EDABapidocs/index.html ].

8.1.6. Summary
EDAB API provides an easy-to-use and powerful API that can be used in your custom code to administer and
manage users and groups in EDAB.

Please note that the API requires JDK 1.8 or higher. The EDAB API has been tested on Windows, Solaris, Linux,
AIX, HP, and Mac platforms.

8.2. EDAB Menu API Overview
8.2.1. Introduction and Setup

A Menu is typically a jsp page that shows all published reports and charts. Depending on the options available, a
Menu may allow the user to choose the format in which the report and/or chart are to be presented. The Menus
discussed here are analogous to those described in the Menu chapter.

EDAB provides an easy-to-use application programming interface (API) that allows users to create and customize
Menus to show in their servlet/jsp applications. This API is written in 100% Pure Java and can be run on any
platform with no or few minimal changes. Any and every part of the Menu is customizable using the API.

The main package for EDAB Menu API is the quadbase.reportorganizer.MenuAPI. Five main classes
are associated with this package: MenuNode, MenuTableRow, QbMenu, ScheduleJob and Util. The
remainder of this chapter will give you an overview of these various classes and their usage. Please note that the
complete documentation is located at help/EDABapidocs/index.html.

The jar files for using EDAB Menu API are located in the EDAB/lib directory. These jar files should already be
present in your application's CLASSPATH when you set up EDAB.

Currently, you can only use EDAB Menu API in a servlet/jsp environment. The servlets/jsps must also run in the
same servlet context as EDAB server.

8.2.2. Using the API
This section discusses the usage of EDAB Menu API with code examples and contains descriptions of the main
API classes.

8.2.2.1. Creating and Customizing an EDAB Menu
The sections below describe various steps involved in creating and customizing an EDAB Menu:

8.2.2.1.1. Connecting to EDAB Server
The first step is to connect to EDAB server. After successfully connected to the server, a QbMenu object can be
allocated. QbMenu is the main class containing contents for a Menu page.

The EDAB server is simply an object that resides in the ServletContext of the web application. Since you will
want to put most Java code in your Java bean, you will need to pass the HttpServletRequest and Servlet-
Context objects from jsp to bean. The following jsp and bean code illustrates this:

https://data.quadbase.com/Docs71/edab/help/EDABapidocs/index.html
https://data.quadbase.com/Docs71/edab/help/EDABapidocs/index.html
https://data.quadbase.com/Docs71/edab/help/EDABapidocs/index.html
https://data.quadbase.com/Docs71/edab/help/EDABapidocs/index.html
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Example jsp (Menu_login.jsp):

<!-- import the bean class -->
<%@page language="java" import="help.examples.Menu.exampleMenuLogin"%>

<!-- include/instantiate the bean -->
<jsp:useBean id="exampleMenuLogin" scope="session"
 class="help.examples.Menu.exampleMenuLogin" />

<!-- pass the HttpServletRequest and ServletContext objects to the bean -->
<% exampleMenuLogin.processRequest(request, application); %>
                

where the jsp passes the request (HttpServletRequest) and application (ServletContext) to the Java
bean MenuLogin's processRequest method. Next, you will need to implement code in the bean that allocates
the QbMenu object from the ServletContext:

Example bean (MenuLogin.java):

public void processRequest(HttpServletRequest request, ServletContext
 context) throws IOException {

      QbMenu qbMenu = new QbMenu(context.getAttribute(QbMenu.QBMENUDATA));

}
                

where context.getAttribute(QbMenu.QBMENUDATA) is set when EDAB server started.

8.2.2.1.2. Getting User Menu Page
The second step uses the QbMenu object to authenticate the user. This is easy since all security and permission
checks are performed by EDAB server. If login is successful, you can store the QbMenu object for the session so
that for the duration of the session, the user will not have to login again. The following code illustrates this:

boolean loginSuccess = qbMenu.login(userName, password);
if (loginSuccess) {

      //store the QbMenu object in session

      session.setAttribute("QBMENUOBJ", qbMenu);

}
                

where “QBMENUOBJ” is the name that you can use later for retrieving the stored QbMenu. This
means that after storing the QbMenu in the session, you can retrieve it in other jsp pages by doing
session.getAttribute("QBMENUOBJ"). The QbMenu.login method returns true if and only if the user
name and password match. If login failed, the user can be prompted again. Please note that login MUST succeed
for the QbMenu object to return a valid Menu.

8.2.2.1.3. Getting all Visible Nodes
After authenticating the user, you can get a list of authorized Menu nodes, which contain reports or charts from the
QbMenu. A node is either a project or a folder in EDAB Organizer.

MenuNode[] MenuNode = qbMenu.getMenuNodeList(null);
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Passing in null to the getMenuNodeList method results in getting all the available Menu nodes. If you pass in
a string, the method will return only those nodes items that contain the string.

Please note that the path for the Menu node will be a complete one i.e., Project1/Folder1/SubFolder2 .

8.2.2.1.4. Getting the Node Details
Once you have retrieved the Menu nodes, the next step is to get the node details, namely, the files contained in
the node. Conceptually, each item in the node is a row and is represented by the MenuTableRow object. The
following code iterates through each file in all nodes:

for (int i = 0; i < MenuNode.length; i++) {

      for (int j = 0; j < MenuNode[i].getRowItemCount(); j++) {
            MenuTableRow MenuTableRow = MenuNode[i].getMenuTableRowAt(j);

      }

}
                

8.2.2.1.5. Getting the File Details
You can obtain all the information of the file (such as file name, description, whether it is a chart or report, etc.)
using the MenuTableRow class.

The following methods are used to obtain the file details:

String getDescription()
Returns the description for the row item

String getName()
Returns the name for the row item

String getPath()
Returns the path for the row item

String getSecurityLevel()
Returns the security level for the row item

String getURL()
Returns the URL for the row item

boolean isChart()
Returns whether the row item is a chart

boolean isReport()
Returns whether the row item is a report

boolean isDashboard()
Returns whether the row item is a dashboard
                

Using the above methods, you can get the various file details.

8.2.2.2. Exporting Reports/Charts using the LookupServlet Servlet
Depending on your needs and architecture, you can setup the Menu to show reports and charts in various static
formats (such as DHTML, PDF, JPEG, GIF, PNG, etc.) or in an interactive applet. You can code your own servlet
using the API's provided in the EDAB Reporting API Overview and EDAB Charting API Overview chapters to
get the templates and export them to the format desired.
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EDAB also comes with a ready-made servlet that can take different parameters to produce the report and/or chart in
the format desired without you having to write any additional servlet code. This servlet is the LookupServlet
servlet and is generally in the EDAB/servlet context (For example, http://192.168.0.1:8080/EDAB/
servlet/LookupServlet). For more details on this servlet and the various parameters it requires, please refer
to the Designer guide.

8.2.3. Javadoc
Javadoc for the entire API is provided along with EDAB. It is located  here (server functions) [ https://data.quad-
base.com/Docs71/edab/help/EDABapidocs/index.html ].

8.2.4. Summary
EDAB already provides a Menu for any user-created reports and/or charts. This Menu can be reached by logging
into the Organizer and choosing View Published Dashboards. In addition to this, EDAB also provides an easy-to-
use, yet powerful library to create your own Menu in your own styles to display any reports and/or charts.

The jsp code discussed in this chapter is also available in the EDAB/help/examples/Menu directory (this direc-
tory contains both the jsp pages and the css styles). The EDAB/WEB-INF/classes/help/examples/Menu
directory contains the source and class files for the beans. This example demonstrates the steps given above.

Please note that the Menu API requires JDK 1.8 or higher. The EDAB Menu API and jsp pages have been tested with
Mozilla (1.3 and above), Firefox (0.91 and above) and Microsoft Internet Explorer (5.x and above) on Windows
NT/2000, Solaris, Linux, AIX, and HP platforms.

8.3. Organizer
8.3.1. Introduction

Using the API, the EDAB Organizer can also be called with custom choices instead of the default options provided.
It can be customized in terms of look, feel, and function. Report and Chart Designer, called from the Organizer,
can also be customized via the API.

Both EDABOrganizer.jar and EDABServer.jar (in the <EDAB-installation-directory>/lib
directory) needs to be added to the CLASSPATH for any code using EDAB Organizer. The following snippet shows
how to connect to EDAB Organizer:

QbOrganizer.setServletRunner("http://localhost:8080");
QbOrganizer.setServletContext("EDAB/servlet");
QbOrganizer organizer = new QbOrganizer(null, "admin", "admin");
        

The above code sets the connection information to connect to EDAB Server and provides the username and pass-
word (in the above example, admin and admin) for EDAB Organizer.

EDAB Organizer can then be shown by getting a handle to the Organizer user interface and setting it visible.

JFrame frame = organizer.getOrganizerUI();
frame.setVisible(true);
        

Please note that you need to copy the contents of the images, orgimages, reportimages, and backgroundImages
directories to the working directory of the .class file.

All examples and code given in the manual assume that EDAB server is running locally (i.e. on your local machine)
and on port 8080. You can change this by going to the source code (you can download the source code by clicking
on the Full Source Code link in the corresponding chapter), editing the code to enter the new connection information
and recompiling it.

Also note that if you have applets that use EDAB Report API, the browser must have at least 1.5 JVM plugin.

https://data.quadbase.com/Docs71/edab/help/EDABapidocs/index.html
https://data.quadbase.com/Docs71/edab/help/EDABapidocs/index.html
https://data.quadbase.com/Docs71/edab/help/EDABapidocs/index.html
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8.3.2. Look and Feel
You can specify a look and feel to EDAB Organizer before getting a handle to the user interface. By default, the
EDAB Organizer uses the system's look and feel. The look and feel can be set using the following method in
QbOrganizer:

public static void setLookAndFeel(javax.swing.LookAndFeel newLookAndFeel);
        

8.3.3. Inserting and Removing Items
You do not have to show EDAB Organizer in order to insert and remove items. You can add and delete items from
Organizer via the API.

The following method shows how to add an item to the Organizer:

public void insertNewItem(String name, String description, String location,
 String url, String folderName);
        

For example:

organizer.insertNewItem("Orders_Breakdown", "This is an example report
 added to Organizer", "OrdersBreakdown.qrp", "http://localhost:8080/EDAB/
OrdersBreakdown.qrp", "/New Project");
        

Full Source Code [ https://data.quadbase.com/Docs71/help/manual/code/src/InsertingItemEDAB.zip ]

Result Screenshot [ https://data.quadbase.com/Docs71/help/manual/images/InsertingItem.gif ]

The above code inserts a new item called Account_Report in the Organizer under the /ReportFiles project
folder. The URL and physical location of the file is also passed along with a short description. Please note that
to run the above code successfully, you will need to create a project called ReportFiles in Organizer. The
recommended way to run the above code is to compile the source code, then go to the root EDAB directory and
enter the following command:

java -classpath "../../src/er/bin;./lib/EDABOrganizer.jar;./
lib/EDABServer.jar;./lib/qblicense.jar;./lib/
hsqldb.jar;.&gt;PATH_TO_COMPILED_CLASS_FILE&lt;" InsertingItem
        

You can also remove items from the Organizer using the following method:

public void removeItem(String name, String folderName);
        

For example:

organizer.removeItem("Orders_Breakdown", "/New Project");
        

Full Source Code [ https://data.quadbase.com/Docs71/help/manual/code/src/RemovingItem.zip ]

Result Screenshot [ https://data.quadbase.com/Docs71/help/manual/images/RemovingItem.gif ]

The above code deletes Account_Report from the /ReportFiles project folder in EDAB Organizer. The
recommended way to run the above code is to compile the source code, then go to the root EDAB directory and
enter the following command:

https://data.quadbase.com/Docs71/help/manual/code/src/InsertingItemEDAB.zip
https://data.quadbase.com/Docs71/help/manual/code/src/InsertingItemEDAB.zip
https://data.quadbase.com/Docs71/help/manual/images/InsertingItem.gif
https://data.quadbase.com/Docs71/help/manual/images/InsertingItem.gif
https://data.quadbase.com/Docs71/help/manual/code/src/RemovingItem.zip
https://data.quadbase.com/Docs71/help/manual/code/src/RemovingItem.zip
https://data.quadbase.com/Docs71/help/manual/images/RemovingItem.gif
https://data.quadbase.com/Docs71/help/manual/images/RemovingItem.gif


Programming

519

java -classpath "../../src/er/bin;./lib/EDABOrganizer.jar;./
lib/EDABServer.jar;./lib/qblicense.jar;./lib/
hsqldb.jar;&gt;PATH_TO_COMPILED_CLASS_FILE&lt;" RemovingItem
        

8.3.4. Javadoc
Javadoc for the entire API is provided along with EDAB. It is located  here (server functions) [ https://data.quad-
base.com/Docs71/edab/help/EDABapidocs/index.html ].

8.3.5. Summary
EDAB API provides an easy-to-use and powerful API to customize and show Organizer interface as well as cus-
tomize Report Designer and Chart Designer interfaces. You can also write code to insert and delete items in Or-
ganizer.

Please note that the API requires JDK 1.8 or higher. The EDAB API has been tested on Windows, Solaris, Linux,
AIX, HP, and Mac platforms.

8.4. Menu Page Listener
The menu page and URL publishing options provide a convenient deployment vehicle for reports and charts. Using
these interfaces, users can easily deploy charts and reports to the Web without any coding. However, by themselves
these interfaces do not provide any significant run-time customization capability. Report and chart templates are
run in a pretty much “as is” format.

For users that would like to provide some additional logic or run-time customization to reports and charts, EDAB
provides the Menu Page Listener interface, which is part of the EDAB extension package. Using this method, users
can implement listeners that will intercept the report or chart prior to export and use the APIs to modify it.

8.4.1. EDAB Listener Manager
The EDAB Listener Manager is a user-implemented class that is used to manage several listeners that monitor
events on the server, including the Menu Page Listener. In order to implement the Menu Page Listener,
users must implement the Listener Manager. Below is a sample Listener Manager class:

package extensionClasses;

import quadbase.reportorganizer.ext.*;

public class MyEdabListenerManager extends DefaultListenerManager {

      public MyEdabListenerManager() {}

      // not used. Always returns null
      public EdabSchedulerListener getSchedulerListener() {

            return null(); 

      }

      public MenuPageListener getMenuPageListener() {

            return new MyMenuPageListener(); 

      } 

}
        

https://data.quadbase.com/Docs71/edab/help/EDABapidocs/index.html
https://data.quadbase.com/Docs71/edab/help/EDABapidocs/index.html
https://data.quadbase.com/Docs71/edab/help/EDABapidocs/index.html
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Users can impelement the EDABListenerManager interface or extend DefaultListenerManager. The
above code implements the Menu Page Listener (note that the Scheduler Listener always returns null).

8.4.1.1. Deploying the Listener Manager
You can specify the Listener Manager class as a server option for EDAB. You can set this in one of two
places. The first option is the Admin Console. You can specify the class in the Server Options tab. You can also
specify the class by modifying the QB.properties under <EDABInstallDir>/WEB-INF/classes. For
more information about server configuration options, see Section 1.4.1.3 - Server Options.

8.4.2. Using the Menu Page Listener
The following code shows a sample implementation of the Menu Page Listener:

package extensionClasses;

import java.lang.*;
import java.awt.*;
import quadbase.reportorganizer.ext.*;
import quadbase.reportdesigner.ReportAPI.*;
import quadbase.reportdesigner.ReportElements.*;
import quadbase.reportdesigner.util.*;
import quadbase.ChartAPI.*;
import quadbase.reportdesigner.report.Formula; 

public class MyMenuPageListener implements MenuPageListener {

      // Note that ... is not valid and is just an example
      String databaseURL = "...";
      String databaseDriver = "...";
      String databaseUID = "...";
      String databasePwd = "...";

      public QbReport modifyBeforeRun(QbReport report, String username) {

            System.out.println("Calling Menu Page Listener...");

            try {

                  // Change the datasource of the report
                  report.getInputData().setAllDatabaseInfo(databaseURL,
 databaseDriver, databaseUID, databasePwd); 

            } catch (Exception ex) {

                  ex.printStackTrace(); 

            }

            return report; 

      }

      public QbChart modifyBeforeRun(QbChart chart, String username) {

            System.out.println("Calling Menu Page Listener");

            try {
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                  // Change the datasource of the chart
                  quadbase.ChartAPI.DBInfo newChartDataSource = new
 quadbase.ChartAPI.DBInfo(databaseURL, databaseDriver, databaseUID,
 databasePwd, chart.gethInputData().getDatabaseInfo().getQuery());

                 
 chart.gethInputData().setDatabaseInfo(newChartDataSource); 

            } catch (Exception ex) {

                  ex.printStackTrace(); 

            }

            return chart; 

      } 

}
        

This example implements two “modifyBeforeRun” methods, one for charts and one for reports. With this code
deployed, everytime a report or chart is run, the datasource is changed to the one specified in the code. Note that
for best results, the report and/or chart should be using a database datasource originally and the new datasource
must return a result set for the original queries.

This example shows the most common scenario where the Listeners are used. Note that any report/chart API code
can be used in these interfaces to modify the reports and charts prior to export. You can refer to the java documen-
tation [ https://data.quadbase.com/Docs71/edab/help/apidocs/index.html ] to learn more about the API available.

8.5. Class File Data Source
For maximum flexibility, you can retrieve and prepare the dataset in any way you want and pass it to the report
engine. To pass in your class file as the data source, your class file must implement the IDataSource [ https://
data.quadbase.com/Docs71/edab/help/apidocs/quadbase/reportdesigner/util/IDataSource.html ] interface.

8.5.1. Non Parameterized
Below is a simple example that implements IDataSource and contains no parameters:

public class CustomClassData implements IDataSource {

      // Setting DbData for passing data as arguments
      String dataType[] = {"string", "String", "double"};
      String fieldName[] = {"Destination", "Time", "Price"};
      String records[][] = {{"Mayfair", "13:43", "3.50"},
            {"Bond Street", "13:37", "3.75"},
            {"RickmansWorth", "13:12", "5.25"},
            {"Picadilly", "13:24", "3.00"}};
      DbData data = new DbData(dataType, fieldName, records);

      public IResultSet getResultSet()
      {
            return data; } 

}
        

Full Source Code [ https://data.quadbase.com/Docs71/help/manual/code/src/CustomClassDataEDAB.zip ]

https://data.quadbase.com/Docs71/edab/help/apidocs/index.html
https://data.quadbase.com/Docs71/edab/help/apidocs/index.html
https://data.quadbase.com/Docs71/edab/help/apidocs/index.html
https://data.quadbase.com/Docs71/edab/help/apidocs/quadbase/reportdesigner/util/IDataSource.html
https://data.quadbase.com/Docs71/edab/help/apidocs/quadbase/reportdesigner/util/IDataSource.html
https://data.quadbase.com/Docs71/edab/help/apidocs/quadbase/reportdesigner/util/IDataSource.html
https://data.quadbase.com/Docs71/help/manual/code/src/CustomClassDataEDAB.zip
https://data.quadbase.com/Docs71/help/manual/code/src/CustomClassDataEDAB.zip
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The example above creates data (DbData instance) and stores it in memory. When getResultSet() method is
called, it returns DbData object which implements IResultSet. Keep in mind that it is not necessary to create
your data in this manner. As long as you are able to return an object that implements IResultSet, you can obtain
the data from any data source.

Please note that if you are passing in your own class file as the data source, the class file must be accessible from
the CLASSPATH of the EDAB Server.

8.5.2. Parameterized
You can also pass in a parameterized class file as the data source for the report. The parameter is obtained at run-
time from the user and the data is then fetched and used to generate the report. Here is an example of a parameterized
class file.

public class ParamClassFile implements IParameterizedDataSource
{
 String url = "jdbc:hsqldb:help/examples/DataSources/database/woodview";
 String driver = "org.hsqldb.jdbcDriver";
 String username = "sa";
 String password = "";

// Specify what the parameter properties are.
 public IQueryInParam[] getParameters()
 {
  SimpleQueryInParam[] params = new SimpleQueryInParam[2];
//  SimpleQueryInParam(name, promptString, mapToColumn, TableName,
 ColumnName, dataType, defaultValue, actualValue)
  params[0] = new SimpleQueryInParam("price", "Max price:", false, null,
 null, Types.DOUBLE, new Double(500.00), null);
  params[1] = new MySimpleQueryInParam("popular", "Popular Items Only:",
 false, null, null, Types.VARCHAR, new String("NO"), null);
  return params;
 }

 private class MySimpleQueryInParam extends SimpleQueryInParam implements
 IQueryParamValuesProvider
 {
  public MySimpleQueryInParam(String paramName, String promptName, boolean
 mapToColumn, 
    String tableName, String columnName, int sqlType, Object defaultValue,
 Object value)  {
   super(paramName, promptName, mapToColumn, tableName, columnName, sqlType,
 defaultValue, value);
  }
  public Vector getSelectionChoices() {
   Vector choices = new Vector();
   choices.add(new String("Yes"));
   choices.add(new String("No"));
   return choices;
  }
 }

// Specify what data is to be returned
 public IResultSet getResultSet(IQueryInParam[] params)
 {
  double price = 500.00;
  int units = 999;

  if ((params != null) && (params.length >= 1))
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  {
   Object obj = params[0].getValue();
   if ((obj != null) && (obj instanceof Double)) price =
 ((Double)obj).doubleValue();
   obj = params[1].getValue();
   if((obj != null) && (obj instanceof String) &&
 ((String)obj).equalsIgnoreCase("yes")) units = 15; 
  }

  try{
   Class.forName(driver);
   Connection conn = DriverManager.getConnection(url, username, password);
   String query = "SELECT ProductName, Description, UnitPrice, UnitsInStock
 FROM Products WHERE UnitPrice < " 
    + price + " AND UnitsInStock < " + units;
   Statement stmt = conn.createStatement();

   ResultSet rs = stmt.executeQuery(query);
   QueryResultSet qry = new QueryResultSet(rs);

   return qry;

  } catch(Exception e) {
   e.printStackTrace();
  }

  return null; 
 }

}
        

Full Source Code [ https://data.quadbase.com/Docs71/help/manual/code/src/ParamClassFile.zip ]

The parameterized class file must implement IParameterizedDataSource [ https://data.quadbase.com/Docs71/edab/
help/apidocs/quadbase/reportdesigner/util/IParameterizedDataSource.html ]. The above example obtains data from
woodview (HSQLDB) database and the query contains two parameters. The first parameter allows the user to
set the maximum price for the query results. The parameter is of type double and the default is set to 500.00.
The second parameter is a custom parameter and its purpose is to give the user a yes or no option to determine
whether or not to show popular items only. To construct a custom parameter, create a class that extends the Simple-
QueryInParam [ https://data.quadbase.com/Docs71/edab/help/apidocs/quadbase/reportdesigner/util/SimpleQuery-
InParam.html ] class, implements the IQueryParamValuesProvider [ https://data.quadbase.com/Docs71/edab/help/
apidocs/quadbase/reportdesigner/util/IQueryParamValuesProvider.html ] interface and overwrites the getSe-
lectionChoices() method. If the user selects yes, only items with less than 15 UnitsInStock will be returned
in getResultSet().

8.5.3. Custom Selection Choices
When using parameterized class file as the data source, keep in mind that you can not map it to a column directly
(i.e. set the table name and column name in the SimpleQueryInParam constructor). In order to map a parameter
to a column, you will have to use a custom parameter similar to the one shown above. However, the getSelection-
Choices() method will look as follows:

public Vector getSelectionChoices() {

      System.out.println("getSelectionChoices called");
      try {
            Class.forName("jdbc:hsqldb:help/examples/DataSources/database/
woodview");

https://data.quadbase.com/Docs71/help/manual/code/src/ParamClassFile.zip
https://data.quadbase.com/Docs71/help/manual/code/src/ParamClassFile.zip
https://data.quadbase.com/Docs71/edab/help/apidocs/quadbase/reportdesigner/util/IParameterizedDataSource.html
https://data.quadbase.com/Docs71/edab/help/apidocs/quadbase/reportdesigner/util/IParameterizedDataSource.html
https://data.quadbase.com/Docs71/edab/help/apidocs/quadbase/reportdesigner/util/IParameterizedDataSource.html
https://data.quadbase.com/Docs71/edab/help/apidocs/quadbase/reportdesigner/util/SimpleQueryInParam.html
https://data.quadbase.com/Docs71/edab/help/apidocs/quadbase/reportdesigner/util/SimpleQueryInParam.html
https://data.quadbase.com/Docs71/edab/help/apidocs/quadbase/reportdesigner/util/SimpleQueryInParam.html
https://data.quadbase.com/Docs71/edab/help/apidocs/quadbase/reportdesigner/util/SimpleQueryInParam.html
https://data.quadbase.com/Docs71/edab/help/apidocs/quadbase/reportdesigner/util/IQueryParamValuesProvider.html
https://data.quadbase.com/Docs71/edab/help/apidocs/quadbase/reportdesigner/util/IQueryParamValuesProvider.html
https://data.quadbase.com/Docs71/edab/help/apidocs/quadbase/reportdesigner/util/IQueryParamValuesProvider.html
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            String url = "org.hsqldb.jdbcDriver";
            Connection conn = DriverManager.getConnection(url, "sa", "");
            Statement stmt = conn.createStatement();
            String query = "SELECT DISTINCT " + getColumnName() + " FROM " +
 getTableName();
            ResultSet rs = stmt.executeQuery(query);
            Vector v = new Vector();

            while (rs.next()) {
                  switch (getSqlType()) {
                        case Types.INTEGER:
                              v.add(new Integer(rs.getInt(1)));
                              break;
                                case Types.VARCHAR:
                              v.add(rs.getString(1));
                              break; } }
            stmt.close();
            conn.close();

            return v;

            } catch (Exception ex) {
                  ex.printStackTrace(); } return null; 

}
        

Full Source Code [ https://data.quadbase.com/Docs71/help/manual/code/src/ClassDataMapToColumn.zip ]

In addition to mapping the parameter to a column, this example also uses a multi-value parameter. Although the
process is similar to using a single value parameter, there are some places where the code deviates from the norm.
Please see the comments in the above source code for details.

https://data.quadbase.com/Docs71/help/manual/code/src/ClassDataMapToColumn.zip
https://data.quadbase.com/Docs71/help/manual/code/src/ClassDataMapToColumn.zip
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Chapter 9. Configuration
9.1. Using Other Databases

As discussed in Section 1.3.2.1 - The EDAB Database, EDAB uses a database as a persistent storage mechanism for
users, groups, permissions, data sources, and published dashboards. By default, EDAB uses an HSQL database that
comes with the installation. However, since this database is generally inappropriate for production environments,
users can easily configure EDAB to use a different one.

9.1.1. Create Table Scripts
The first step in configuring EDAB to run with another database is to setup the tables and fields that are used to
store application information. Several scripts for different databases are available in the <EDABInstallDir>/
data directory. The scripts contain the create table statements for the database.

In addition to database specific scripts, a generic script is also provided that can be modified to run with other
databases. The quadbasedb_jdbc.sql file contains default scripts that are used to create the HSQL database.

9.1.1.1. Database Specific Notes
For each of the supported databases, there can be a couple additional configuration steps that needs to be taken to
correctly setup the tables.

9.1.1.1.1. DB2
The script to create the tables for DB2 is named quadbasedb_db2.sql. For DB2, you will need to first create
a TABLESPACE for the new tables. To do so, use the following steps from the command line:

1. connect to your database using db2admin using this command:

db2 connect to <DBNAME> user <DB2USER> using <Password>    
                    

Be sure to substitute your database username and password when making the connection.

2. Create buffer pool with the command below:

db2 CREATE BUFFERPOOL BP32k SIZE 100 PAGESIZE 32k
                    

3. Create tablespace with the command below:

db2 "CREATE REGULAR TABLESPACE DATASPACE1 PAGESIZE 32 K MANAGED BY
 DATABASE USING ( FILE 'c:\db2\db2data\dataspace1_01.dbf' 1000 )
 EXTENTSIZE 4 OVERHEAD 10.5 PREFETCHSIZE 4 TRANSFERRATE 0.33 BUFFERPOOL
 BP32k"
                    

9.1.1.1.2. MS SQL Server
The script to create the tables for Microsoft SQL Server is named quadbasedb_sqlserver.sql. There is no
additional setup needed to run the script for this database. However, the database connection cannot be established
to SQL Server with the default settings. The requirements may vary with different SQL Server versions.

MS SQL Server 2005

Download the latest MS SQL Server 2005 JDBC Driver from: msdn.microsoft.com [ https://learn.microsoft.-
com/en-us/sql/connect/jdbc/download-microsoft-jdbc-driver-for-sql-server?view=sql-server-ver16 ]

Unpack the driver and copy the sqljdbc.jar file into the <EDAB>/WEB-INF/lib directory.

Recommended Admin Console entries (see Section 9.1.2 - Specifying the Database Connection):

Database URL: jdbc:sqlserver://hostname:port;databaseName=<databaseName>;

https://learn.microsoft.com/en-us/sql/connect/jdbc/download-microsoft-jdbc-driver-for-sql-server?view=sql-server-ver16
https://learn.microsoft.com/en-us/sql/connect/jdbc/download-microsoft-jdbc-driver-for-sql-server?view=sql-server-ver16
https://learn.microsoft.com/en-us/sql/connect/jdbc/download-microsoft-jdbc-driver-for-sql-server?view=sql-server-ver16
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Database Driver: com.microsoft.sqlserver.jdbc.SQLServerDriver
                

EDAB will connect to the SQL server instance using TCP/IP protocol, so you will have to determine the TCP port
number of your SQL Server instance. To do that, launch SQL Server Configuration Manager, expand the SQL Server
2005 Network Configuration node and click Protocols for <YourSQLServerInstanceName> (for example Protocols
for MSSQLSERVER). Double click on the TCP/IP protocol. First of all, make sure that the TCP/IP protocol is
enabled. Look at the Enabled option in the Protocol tab, it should be set to Yes, if it is not, please do so. Then look
at the Listen All option, there are two possibilities:

1. Listen All is set to Yes (default) : Go to IP Addresses tab and scroll down to the IP All section. The port number
you are looking for is below the IP All section in the TCP Dynamic Port option.

2. Listen All is set to No : Go to IP Addresses tab and find the section that has the IP Address option set to the
IP address you will be connecting to. The port number can be found one row below the particular IP address
option (TCP Dynamic Ports option).

EDAB connects to the SQL database using SQL Server Authentification mode, so you have to have this function
enabled in your MS SQL Server. You can do that in MS SQL Server Management Studio. Right click on the server
name in Object Explorer and click Properties. Go to the Security page and select the SQL Server and Windows
Authentification mode option. Also the user that you will use to connect to the SQL Server has to have the SQL
Server authentification mode set. Be sure that the user has sufficient right to use the database.

MS SQL Server 2000

Download the latest tar version of MS SQL Server 2000 JDBC Driver from: download.mi-
crosoft.com [ https://learn.microsoft.com/en-us/sql/connect/jdbc/download-microsoft-jdbc-driver-for-sql-serv-
er?view=sql-server-ver16 ]

Unpack the mssqlserver.tar file. Go to the unpacked directory and unpack the msjdbc.tar file. Go to
the msjdbcd/lib directory. You should see three jar files in the lib folder. Copy them into the <EDAB>/WEB-
INF/lib directory.

Recommended Admin Console entries (see Section 9.1.2 - Specifying the Database Connection):

Database URL: jdbc:microsoft:sqlserver://
hostname:port;databaseName=<databaseName>;
                

Database Driver: com.microsoft.jdbc.sqlserver.SQLServerDriver
                

9.1.1.1.3. MySQL
The script to create the tables for MySQL is named quadbasedb_mysql.sql. There is no additional setup
needed to run the script for this database.

Please make sure that your MySQL database uses case-insensitive identifiers (see MySQL Identifier Case Sensi-
tivity [ https://dev.mysql.com/doc/refman/8.0/en/identifier-case-sensitivity.html ]).

9.1.1.1.4. Oracle
The script to create the tables for Oracle is named quadbasedb_oracle.sql. There is no additional setup
needed to run the script for this database.

9.1.2. Specifying the Database Connection
Once you have successfully created the tables in your database, you can configure EDAB to use that database for
storage. To setup the database connection, log in as Admin and enter the Admin Console. The database information

can be entered under Setting Info → EDAB Repository.

Replace the URL, driver, username, and password with values of your database. EDAB uses JDBC to connect to
the database, so you will need to make sure to enter the correct URL and JDBC driver class for the connection.

https://learn.microsoft.com/en-us/sql/connect/jdbc/download-microsoft-jdbc-driver-for-sql-server?view=sql-server-ver16
https://learn.microsoft.com/en-us/sql/connect/jdbc/download-microsoft-jdbc-driver-for-sql-server?view=sql-server-ver16
https://learn.microsoft.com/en-us/sql/connect/jdbc/download-microsoft-jdbc-driver-for-sql-server?view=sql-server-ver16
https://learn.microsoft.com/en-us/sql/connect/jdbc/download-microsoft-jdbc-driver-for-sql-server?view=sql-server-ver16
https://dev.mysql.com/doc/refman/8.0/en/identifier-case-sensitivity.html
https://dev.mysql.com/doc/refman/8.0/en/identifier-case-sensitivity.html
https://dev.mysql.com/doc/refman/8.0/en/identifier-case-sensitivity.html
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Once you finish making the changes, save the file. Next you will need to copy the JDBC driver for your database
(typically one or several Jar files) to the <EDABInstallDir>/WEB-INF/lib directory. For application servers
other than Tomcat, please refer to the instructions in Section 9.3 - Using Other Application Servers.

You can also specify a connection to the EDAB database using JNDI. To do so, you must first edit
<EDABInstallDir>/WEB-INF/web.xml and uncomment the JNDI tag (remove the <!-- and --> tags).
You can also change the JNDI reference name (in the <res-ref-name> tag) from jdbc/EDABdb to another
name. Then login as Admin, enter Admin Console and pass in the JNDI details (such as JNDI context factory,

JNDI provider URL and JNDI name) under Setting Info → EDAB Repository. The values can be entered after
the JNDI radio button is selected. Note that depending on the application server and the mapping used, the JNDI
context factory and JNDI provider URL may not be necessary. For example, if EDAB is installed on a Tomcat
or WebSphere Application Server, connecting to the JNDI server only requires supplying the JNDI name. For
Oracle 10g, you have the choice of either omitting the context factory and provider URL to use the default en-
vironment, or you can specify one of context factories they provide: oracle.j2ee.rmi.RMIInitialCon-
textFactory, oracle.j2ee.naming.ApplicationClientInitialContextFactory, or or-
acle.j2ee.iiop.IIOPInitialContextFactory. Due to the wide range of application servers and JNDI
implementations, please see the documentation for your JNDI server for configuration options and details. When
the JNDI name is specified, the database information (URL, driver, username, password) is ignored.

With the connection information set, restart the server. The EDAB server should start connected to the new database.
Note that this new database will be blank, so any information about old users, privileges, or reports and charts
will not be available. In addition, several key pieces of information will need to be manually setup in order to
successfully deploy and run reports in EDAB with the new database.

Web Root: You will need to enter the correct Web Root for your application server/servlet contain-
er. This information is supplied in the Admin Console. For more information, see Sec-
tion 1.4.1.2 - Setting Info.

Servlet Context: You may need to re-set the servlet context information. For more on this, please see
Section 1.4.1.2 - Setting Info.

URL Mapping: You will need to add a virtual directory in Organizer that maps the Web path to your
EDAB installation. For more information, see Section 2.1.5 - URL Mapping.

9.1.3. Migrating the EDAB Database
Sometimes it may be necessary to migrate the EDAB database from one platform to another. For example, initial
development on an implementation may be done using EDAB in default configuration with the HSQL database.
However, since HSQL is not recommended for production environments, users may need to migrate data to another
database. To accomodate this, EDAB provides a database migration utility for all supported databases.

Warning
Since version 6.3, this tool can be used for database migration only. Database upgrade using this tool
is no longer supported. Please use dbupgrade (DBUpgradeGUI or UpgradeAppl) application instead
(Section 1.3.2.1.3 - Upgrading EDAB Database from previous version of EDAB).

Before starting the database migration process, you will have to prepare the destination database, which must contain
empty EDAB 6.6 tables. To create the tables, run the appropriate SQL script from the <EDABInstallDir>/
data directory. To learn more about the scripts, see the Section 9.1 - Using Other Databases chapter.

Please make sure that both the source and the destination databases belong to EDAB version 6.6. If not, use the
dbupgrade application to fix this problem.

The program for the utility is in <EDABInstallDir>/data/converter directory. It is a Java application
that is run from the command line (the souce code is also provided). To run the converter, modify FromDB.prop-
erties file to use the JDBC connection information for your source database. Then modify ToDB.properties file
to use the JDBC connection information for your destination database (sample connection files are provided for
different databases in the directories under <EDABInstallDir>/data/converter).

At the command line, navigate to <EDABInstallDir>/data/converter directory and execute the follow-
ing command:



Configuration

528

java -classpath ".;driver1;driver2" CopyEDABDB
        

For example:

java -classpath ".;hsqldb.jar;jdbc_mysql.jar" CopyEDABDB
        

Within the -classpath argument, you will need to specify the archives/classes that contain the JDBC drivers
for the source and destination databases.

Running this program will copy all data from the source (FROM) EDAB database tables to the destination (TO)
EDAB database tables.

Once the conversion is complete, you need to modify the database connection information in the Admin Console
as described in Section 9.1.2 - Specifying the Database Connection, before restarting the server.

Please note that EDAB log records can not be transferred during the database migration.

9.2. Integrating Existing Users/Groups
By default, the EDAB database provides persistent storage for users, groups, and their relationships. However,
many users already have a set of users and groups, as well as persistent storage mechanism in place. In these cases,
duplicating users and groups in the new reporting environment is inefficient, time-consuming, and requires extra
administration overhead.

To prevent these issues, EDAB provides three different ways on how users can integrate their existing user/group
framework into the reporting system. The first option is to retrieve users and groups from an LDAP server. This
connection and setup is detailed in Section 1.4.1.4 - LDAP Settings. The second option is to retrieve users and
groups from an existing database and the third option is to use the UserSecurityProvider interface which provides
an open API allowing users to retrieve/implement users and groups from any source.

9.2.1. Using a Database
If your existing users are in a database, EDAB provides a simple implementation of the UserSecurityProvider that
can be configured using a properties file. This implementation allows you to supply the connection information for
the database as well as SQL statements for all the user/group related actions. Note that this implementation will not
work in all circumstances. If your schema cannot retrieve/set the proper information with a single SQL statement,
you may need to provide your own implementation of UserSecurityProvider.

The properties file is named user-database.properties, and should be placed in the
<EDABInstallDir>/WEB-INF/orguserdb directory. A sample properties file is shown below:

#############################################################
#Whether to use custom database for user/group
custom.user.database=true
#############################################################

#############################################################
#If custom.user.database=true, then use these information to
#connect to the database.
custom.user.database.url=jdbc:hsqldb:C:/EDAB/data/quadbasedb
custom.user.database.jdbcDriver=org.hsqldb.jdbcDriver
custom.user.database.login=sa
custom.user.database.password=
#############################################################

#############################################################
#Whether each of the methods in UserSecurityProvider
#is enabled.
#-----------------------------------------------------------
getUsers.enable=true
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getUsers.sql=Select username, fullname, email, password, user_role, id,
 securitylevel From users Order
By username
#-----------------------------------------------------------
getGroups.enable=true
getGroups.sql=Select name, description, id, securitylevel From groups Order
 By name
#-----------------------------------------------------------
getGroupRelations.enable=true
getGroupRelations.sql=SELECT parent_g.name, child_g.name FROM
 group_relations r, groups parent_g, groups
child_g WHERE r.parent_id = parent_g.id AND r.child_id = child_g.id
#-----------------------------------------------------------
getGroupUserRelations.enable=true
getGroupUserRelations.sql=Select g.name, u.username From
 group_user_relations gr, groups g, users u
Where gr.group_id=g.id And gr.user_id=u.id Order By g.name
#-----------------------------------------------------------
getUserParents.enable=true
getUserParents.sql=SELECT r.group_id, g.name FROM group_user_relations r,
 groups g WHERE r.group_id =
g.id AND r.user_id=?
#-----------------------------------------------------------
getGroupParents.enable=true
getGroupParents.sql=Select parent_id From group_relations Where child_id=?
#-----------------------------------------------------------
deleteUser.enable=true
deleteUser.sql=Delete From users Where username=?
#-----------------------------------------------------------
deleteGroup.enable=true
deleteGroup.sql=Delete From groups Where name=?
#-----------------------------------------------------------
createUser.enable=true
createUser.sql=Insert Into users (id, username, fullname, email, password,
 user_role, securitylevel)
Values (?, ?, ?, ?, ?, ?, ?)
#-----------------------------------------------------------
createGroup.enable=true
createGroup.sql1=Insert Into groups (id, name, description, securitylevel)
 Values (?, ?, ?, ?)
createGroup.sql2=Delete From group_relations Where parent_id=?
createGroup.sql3=Delete From group_user_relations Where group_id=?
createGroup.sql4=Insert Into group_relations (parent_id, child_id) Values
 (?, ?)
#-----------------------------------------------------------
updateUser.enable=true
updateUser.sql=Update users Set username=?, fullname=?, email=?, password=?,
 user_role=?,
securitylevel=? Where username=?
#-----------------------------------------------------------
updateGroup.enable=true
updateGroup.sql1=Update groups Set name=?, description=?, securitylevel=?
 Where name=?
updateGroup.sql2=Delete From group_relations Where parent_id=?
updateGroup.sql3=Delete From group_user_relations Where group_id=?
updateGroup.sql4=Insert Into group_relations (parent_id, child_id) Values
 (?, ?)
#-----------------------------------------------------------
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addGroupUserRelation.enable=true
addGroupUserRelation.sql=Insert Into group_user_relations (group_id,
 user_id) Values (?, ?)
#-----------------------------------------------------------
setSecurityLevels.enable=true
setSecurityLevels.sql1=Update users Set securitylevel=? Where username=?
setSecurityLevels.sql2=Update groups Set securitylevel=? Where name=?
#-----------------------------------------------------------
resetSecurityLevel.enable=true
#-----------------------------------------------------------
getGroupsBySecurityLevel.enable=true
getGroupsBySecurityLevel.sql=Select name From Groups Where securitylevel=?
#-----------------------------------------------------------
getUsersBySecurityLevel.enable=true
getUsersBySecurityLevel.sql=Select username From users Where securitylevel=?
#-----------------------------------------------------------
#############################################################
        

The question marks in the SQL statements will be supplied by the EDAB engine when it runs queries. For any
method that isn't enabled, EDAB will save that information in the EDAB database. Depending on your configura-
tion, saving some information in the EDAB database and some in your own may not be able to work correctly.

9.2.2. Implementing UserSecurityProvider
For maximum flexibility, EDAB allows users to provide their own implementation of users and groups. The User-
SecurityProvider interface provides open APIs into all the methods that set/retrieve user and group information.
Implementing UserSecurityProvider allows you to retrieve user/group information from any source, and allows you
to integrate your user database if the schema prevents you from retrieving the correct information with a single
query. Below is a sample UserSecurityProvider implementation:

import java.util.*;

import quadbase.reportorganizer.data.*;
import quadbase.reportorganizer.ext.*;

/**
* A sample implementation of UserSecurityProvider that provides hard-coded
* initialized users/groups/security that does not have any data persistent
* mechanism.
*/
public class MyUserSecurityProvider implements UserSecurityProvider {

      User[] users;
      Group[] groups;
      GroupRelation[] gr;
      GroupUserRelation[] gur;

      /**
      * Initializes the provider with dummy users/groups/security
      */
      public MyUserSecurityProvider() {
            users = new User[6];
            users[0] = createUser("admin");
            users[1] = createUser("jason");
            users[2] = createUser("ricky");
            users[3] = createUser("jordan");
            users[4] = createUser("oneal");
            users[5] = createUser("jerry");
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            groups = new Group[6];
            groups[0] = createGroup("nba");
            groups[1] = createGroup("sports");
            groups[2] = createGroup("testers");
            groups[3] = createGroup("managers");
            groups[4] = createGroup("marketing");
            groups[5] = createGroup("engineers");

            gr = new GroupRelation[3];
            gr[0] = new GroupRelation("sports","nba");
            gr[1] = new GroupRelation("managers","marketing");
            gr[2] = new GroupRelation("engineers","testers");

            gur = new GroupUserRelation[6];
            gur[0] = new GroupUserRelation("managers", "jason");
            gur[1] = new GroupUserRelation("nba", "jordan");
            gur[2] = new GroupUserRelation("marketing", "ricky");
            gur[3] = new GroupUserRelation("nba", "oneal");
            gur[4] = new GroupUserRelation("testers", "jerry");
            gur[5] = new GroupUserRelation("testers", "jason"); 

      }

      public User[] getUsers() throws Exception {
            return users; }

      public Group[] getGroups() throws Exception {
            return groups; }

      public GroupRelation[] getGroupRelations() throws Exception {
            return gr; }

      public GroupUserRelation[] getGroupUserRelations() throws Exception {
            return gur; }

      public String[] getUserParents(String username) throws Exception {
            Vector v = new Vector();
            for (int i = 0; i < gur.length; i++)
                  if (gur[i].getUserName().equals(username))
                        v.add(gur[i].getGroupName()); return
 toStringArr(v); }

      public String[] getGroupParents(String groupname) throws Exception {
            Vector v = new Vector();
            for (int i = 0; i < gr.length; i++)
                  if (gr[i].getChildName().equals(groupname))
                        v.add(gr[i].getParentName()); return
 toStringArr(v); }

      public void deleteUser(String username) throws Exception {
            if (users.length == 0) return;
            User[] users2 = new User[users.length-1];
            int j = 0;
            for (int i = 0; i < users.length; i++) {
                  if (j == users.length-1 && !
users[i].getName().equals(username))
                        return; if (!users[i].getName().equals(username)) {
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                        users2[j] = users[i];
                        j += 1; } }
            users = users2; }

      /**
      * Delete a Group. Also deletes the group relationships and
      * group-user relationships
      * that references this GROUPNAME.
      * @param groupname the group name
      */
      public void deleteGroup(String groupname) throws Exception {
            if (groups.length == 0) return;
            Group[] groups2 = new Group[groups.length-1];
            int j = 0;
            for (int i = 0; i < groups.length; i++) {
                  if (j == groups.length-1 && !
groups[i].getName().equals(groupname))
                        return; if (!groups[i].getName().equals(groupname))
 {
                        groups2[j] = groups[i];
                        j += 1; } }
            groups = groups2;

            Vector v = new Vector();
            for (int i = 0; i < gr.length; i++) {
                  if (gr[i].getParentName().equals(groupname) ||
                        gr[i].getChildName().equals(groupname)) continue;
 v.add(gr[i]); }
            GroupRelation[] gr2 = new GroupRelation[v.size()];
            for (int i = 0; i < gr2.length; i++)
                  gr2[i] = (GroupRelation) v.get(i); gr = gr2;

            v = new Vector();
            for (int i = 0; i < gur.length; i++) {
                  if (gur[i].getGroupName().equals(groupname)) continue;
                  v.add(gur[i]); }
            GroupUserRelation[] gur2 = new GroupUserRelation[v.size()];
            for (int i = 0; i < gur2.length; i++)
                  gur2[i] = (GroupUserRelation) v.get(i); gur = gur2; }

      public void createUser(User user) throws Exception {
            User[] users2 = new User[users.length+1];
            System.arraycopy(users, 0, users2, 0, users.length);
            users2[users2.length-1] = user;
            users = users2; }

      public void updateUser(User user) throws Exception {
            for (int i = 0; i < users.length; i++) {
                  if (users[i].getName().equals(user.getName())) {
                        users[i] = user;
                        return; } } }

      /**
      * Create a new Group.
      * @param parentGroup create this group
      * @param childUsers set the group to have these child users
      * @param childGroups set the group to have these child groups
      */
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      public void createGroup(Group parentGroup, User[] childUsers, Group[]
 childGroups) throws Exception {
            addGroup(parentGroup);

            if (childUsers != null && childUsers.length > 0) {
                  for (int i = 0; i < childUsers.length; i++) {
                        addGroupUserRelation (parentGroup.getName(),
 childUsers[i].getName()); } }

            if (childGroups != null && childGroups.length > 0) {
                  GroupRelation[] gr2 = new GroupRelation[gr.length
+childGroups.length];
                  System.arraycopy(gr, 0, gr2, 0, gr.length);
                  int j = 0;
                  for (int i = gr.length; i < gr2.length; i++) {
                        gr2[i] = new GroupRelation(parentGroup.getName(),
 childGroups[j].getName());
                        j++; }
                  gr = gr2; } }

      /**
      * Update a Group. This simple implementation simply calls
      * deleteGroup(parentGroup.getName()) and calls
      * createGroup(parentGroup, childUsers, childGroups);
      *
      * @param parentGroup update this group
      * @param childUsers set the group to have these child users
      * @param childGroups set the group to have these child groups
      */
      public void updateGroup(Group parentGroup, User[] childUsers, Group[]
 childGroups) throws Exception {
            deleteGroup(parentGroup.getName());
            createGroup(parentGroup, childUsers, childGroups); }

      public void addGroupUserRelation(String groupname, String
 username) throws Exception {
            GroupUserRelation[] gur2 = new GroupUserRelation[gur.length+1];
            System.arraycopy(gur, 0, gur2, 0, gur.length);
            gur2[gur2.length-1] = new GroupUserRelation(groupname,
 username);
            gur = gur2; }

      // SECURITY
 LEVEL ///////////////////////////////////////////////////////

      /**
      * Sets the security level(s) for a group or user of the specified
 name(s)
      * Also sets the security level(s) for group or user that is not in
 NAME
      * but with the same SECLEVEL to -1 (Can simply call
      * resetSecurityLevel(secLevel) in the first line of this method
      * to achieve this).
      * @param secLevel the result security level number
      * @param name an array of name(s) to change
      * @param isGroup whether the name[i] is a group (isGroup[i]==true)
      * or a user (isGroup[i]==false).
      */
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      public void setSecurityLevels(int secLevel, String[] name, boolean[]
 isGroup) throws Exception {
            resetSecurityLevel(secLevel);
            for (int i = 0; i < name.length; i++) {
                  if (isGroup[i]) {
                        for (int j = 0; j < groups.length; j++)
                              if (groups[j].getName().equals(name[i])) {
                                    groups[j].setSecurityLevel(secLevel);
                                    break; } } else {
                        for (int j = 0; j < users.length; j++)
                              if (users[j].getName().equals(name[i])) {
                                    users[j].setSecurityLevel(secLevel);
                                    break; } } } }

      /**
      * Resets (set to -1) the security level number of all groups
      * and users whose security level number is SECLEVEL.
      * @param secLevel the security level number of the group/user
      */
      public void resetSecurityLevel(int secLevel) throws Exception {
            for (int i = 0; i < users.length; i++)
                  if (users[i].getSecurityLevel() == secLevel)
                        users[i].setSecurityLevel(-1); for (int i = 0; i <
 groups.length; i++)
                  if (groups[i].getSecurityLevel() == secLevel)
                        groups[i].setSecurityLevel(-1); }

      /**
      * @param secLevel the security level number of the group
      * @return the Group names of all groups with SECLEVEL
      */
      public String[] getGroupsBySecurityLevel(int secLevel) throws
 Exception {
            Vector v = new Vector();
            for (int i = 0; i < groups.length; i++)
                  if (secLevel == groups[i].getSecurityLevel())
                        v.add(groups[i].getName()); String[] result = new
 String[v.size()];
            for (int i = 0; i < result.length; i++)
                  result[i] = (String) v.get(i); return result; }

      /**
      * @param secLevel the security level number of the user
      * @return the User names of all users with SECLEVEL
      */
      public String[] getUsersBySecurityLevel(int secLevel) throws Exception
 {
            Vector v = new Vector();
            for (int i = 0; i < users.length; i++)
                  if (secLevel == users[i].getSecurityLevel())
                        v.add(users[i].getName()); String[] result = new
 String[v.size()];
            for (int i = 0; i < result.length; i++)
                  result[i] = (String) v.get(i); return result; }

User createUser(String name) {
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if(name.equalsIgnoreCase("admin")){
return new User(name, //name
name + " full name", //full name
name, //password
name + "@example.com", //email
User.ADMIN, //role
-1); //security level
}else{
return new User(name, //name
name + " full name", //full name
name, //password
name + "@example.com", //email
User.DESIGNER, //role
-1); //security level
}
}

      Group createGroup(String name) {
            return new Group(name, //name
                              name + " desc", //description
                              -1); //security level 
            }

      void addGroup(Group g) {
            Group[] g2 = new Group[groups.length+1];
            System.arraycopy(groups, 0, g2, 0, groups.length);
            g2[g2.length-1] = g;
            groups = g2; }

      static String[] toStringArr(Vector v) {
            String[] p = new String[v.size()];
            for (int i = 0; i < p.length; i++)
                  p[i] = (String) v.get(i); return p; } 

}
        

In the previous sample, the users and groups are defined as simple arrays in the code. As with the database proper-
ties file, any method that you do not implement in the UserSecurityProvider interface will use the default EDAB
database as the storage mechanism.

9.2.2.1. Deploying UserSecurityProvider
The UserSecurityProvider class can be set as a server option in EDAB. You can set this in one of two places.
The first option is the Admin Console. You can specify the class in the Server Options tab. For more information
about server configuration options, see Section 1.4.1.3 - Server Options. You can also specify the class by modi-
fying the QB.properties under <EDABInstallDir>/WEB-INF/classes. However, editing configura-
tion files directly is not recommended and should be done only in case when the EDAB server cannot be started
because incorrect values have been provided through the Admin Console. If you still want to edit the files manually:
edit user-database.properties to use the "users/groups" other than ERES database, QB.properties
to set ERES database not only "users/groups", but also ERES setting, report/chart/etc/file paths, schedules, email
settings, extension classes. It has higher priority than the database defined by user-database.properties.
Compiled, MyUserSecurityProvider.class, if used, should be located in <EDABInstallDir>/WEB-
INF/classes directory.

9.3. Using Other Application Servers
EspressDashboard deploys as servlet and JSP collection in an application server. As detailed in Section 1.3.1 -
Installing EDAB, EDAB comes bundled with the Tomcat servlet container. Users have an option to install Tomcat
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(with EDAB automatically deployed) when running the installer. This option is recommended for new users and
evaluators because EDAB will work “out-of-the-box” in this configuration.

However, EDAB can also be deployed on most popular application servers. This chapter provides step-by-step
setup instructions for Tomcat, Resin, WebLogic, WebSphere, JBoss, Oracle, and Sun servers.

Throughout this chapter, the following naming conventions will be used.

<EDAB_INSTALL_DIR> : This is the location where EDAB is installed.

<EDAB_DEPLOY_DIR> : This is the final deployment directory of EDAB. It might not be same as your
installation directory (<EDAB_INSTALL_DIR>).

<EDAB_CONTEXT> : This is the context path used to access EDAB web application components.

<EDAB_SERVLET_CONTEXT> : This is the servlet context of EDAB. EDAB uses servlets for many
of the back-end functions. There is a web.xml file under the
<EDAB_INSTALL_DIR>/WEB-INF directory that maps all servlet class-
es packaged with EDAB. By default, every servlet is mapped to /
servlet/<servlet name>. After deploying EDAB, you may need to
change the servlet context.

<server> : This is your application/web server name. It can be the name of the server
machine or IP address.

<port> : The port number on which your application/web server is listening.

EDAB Start Page : This is the main/home page for EDAB. It should be accessed by the fol-
lowing URL: http://<server>:<port>/<EDAB_CONTEXT>/in-
dex.jsp.

In addition, instructions in this chapter refer to starting and stopping the EDAB server, as well as features/options
in the Admin console. If you are using AUTOSTART feature, you need to set correct port in Server Options -
Auto-Start in Admin Console page. For details about these actions, please see Section 1.3.2.2 - Starting the Server
and Section 1.4 - Administration.

As the result of moving to a different application server, the <EDAB_INSTALL_DIR> location may move or the
name of the EDAB context may be changed. When this happens, you will need to modify the URL mapping in
Organizer in order to create/modify/run reports and charts. For more information about setting URL mapping, see
Section 2.1.5 - URL Mapping.

Note
These instructions assume you are running EDAB with the default (HSQL) database. If you are us-
ing a different database, you need to add the JDBC driver classes for your database to your servlet
container's classpath. All JAR files are under <EDAB_INSTALL_DIR>/WEB-INF/lib, which is
used by the servlet container to load classes required by the EDAB web application. Therefore, if you
are adding JDBC driver that is needed by the EDAB web application, you can simply copy the JAR
file to <EDAB_INSTALL_DIR>/WEB-INF/lib.

You can also deploy EDAB as a war file. To make an EDAB war file, you must:

• Go to <EDAB_INSTALL_DIR>/WEB-INF directory and edit web.xml. Remove the two instances of the
<!-- WAR Deployment and WAR Deployment --> references and then save the file.

• Open command prompt and cd to <EDAB_INSTALL_DIR> directory. Then run following command (make
sure jdk/bin is in your PATH):

jar -cvf0 EDAB.war *
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• The EDAB.war file is now available under the <EDAB_INSTALL_DIR> and can be deployed to an application
server.

Please note that when deploying the war file, the <EDAB_INSTALL_DIR> is still being used to store all templates
and user files, so it must be valid and accessible. Also, the instructions, given above, must be carried out again
when an update is performed on the <EDAB_INSTALL_DIR> directory and the newly created war file should be
deployed again. Note that certain application servers requires additional files (such as JBoss needing a jboss-
web.xml file) before the war file can be successfully deployed.

9.3.1. Tomcat 4.1/5.x/6.0.x/7.0.x
The following instructions show how to deploy EspressDashboard under Tomcat 4.1/5.x/6.0.x/7.0.x. The instruc-
tions assume that Tomcat has been installed on the system. The location of the Tomcat installation is referenced
as <TOMCAT_INSTALL_DIR>.

For reference, please note that Tomcat's default port is 8080, the default working directory is
<TOMCAT_INSTALL_DIR>/bin and the default Web root is <TOMCAT_INSTALL_DIR>/webapps/ROOT.

1. Modify the <TOMCAT_INSTALL_DIR>/config/server.xml file and add the following entry: <Con-
text path="/EDAB" docBase="<EDAB_INSTALL_DIR>" debug="0"/>. Path is the context path
of EDAB web application and docBase is the absolute path or relative path of the EDAB installation. Please
substitute <EDAB_INSTALL_DIR> with your actual path.

Note
Please use double quotes.

2. Now start Tomcat from <TOMCAT_INSTALL_DIR>/bin/startup.bat/.sh.

3. With Tomcat running, go to EDAB Start page http://<server>:<port>/<EDAB_CONTEXT>/in-
dex.jsp With the above configuration, EDAB_CONTEXT is EDAB. Start the EDAB Server.

4. From the EDAB Start page, login as administrator and launch the Admin Console.

5. From Admin Console page, go to Setting Info tab and change the EDAB Servlet Context entry to /EDAB/
servlet. This change requires you to restart the EDAB Server. You can also change the webroot entry to
<TOMCAT_INSTALL_DIR>/webapps/ROOT, but it is not necessary.

6. Stop and restart the EDAB Server.

9.3.2. Resin

9.3.2.1. Resin 3.x/4.x
Deploying EspressDashboard to Resin 3.x/4.x can be accomplished using the instructions provided below. The
location of the Resin installation is referenced as <RESIN_INSTALL_DIR>.

For reference, please note that Resin's default port is 8080, the default working directory is <RESIN_INSTAL-
L_DIR> and the default Web root is <RESIN_INSTALL_DIR>/docs.

1. You may need to move tools.jar file from your Java development kit to the <RESIN_INSTALL_DIR>/lib
directory (for JSP compilation) or add a library path entry for the file.

2. Modify <RESIN_INSTALL_DIR>/conf/resin.conf. Add the following entry for context path /EDAB
<web-app id="/EDAB" document-directory="<EDAB_INSTALL_DIR>"/> between <host-
default> and </host-default> tags. The id in the entry is the context path of EDAB, and docu-
ment-directory is the absolute path of the EDAB installation. Please substitute <EDAB_INSTALL_DIR>
with your actual EDAB installation directory.



Configuration

538

3. In Resin 3.X, start your Resin server by running <resin-installation-dir>/bin/httpd. In Resin
4.X, first navigate to the <RESIN_INSTALL_DIR> directory and then start the server by running the following
command: java -jar lib/resin.jar start.

4. Now from your web browser, browse to the EDAB Start page to start the server (http://
<server>:<port>/<EDAB_CONTEXT>/index.jsp). For the above configuration, the context path is
EDAB.

5. From the EDAB Start page, login as the administrator and launch the Admin Console.

6. From Admin Console page, go to the Setting Info tab. Change the EDAB Servlet Context entry to /EDAB/
servlet. You can also change the webroot to <RESIN_INSTALL_DIR>/doc, but it is not necessary.

7. Stop the EDAB Server.

8. Stop and re-start Resin if necessary.

9. Go to the EDAB Start page and start the EDAB server.

9.3.2.2. Resin 2.1.12
The following instructions show how to deploy EspressDashboard under Resin 2.1.12. The instructions as-
sume that Resin has been installed on the system. The location of the Resin installation is referenced as
<RESIN_INSTALL_DIR>.

For reference, please note that Resin's default port is 8080, the default working directory is <RESIN_INSTAL-
L_DIR> and the default Web root is <RESIN_INSTALL_DIR>/docs.

1. You may need to move tools.jar file from your Java development kit to the <RESIN_INSTALL_DIR>/
lib directory (for JSP compilation), or add a library path entry for the file.

2. Modify <RESIN_INSTALL_DIR>/conf/resin.conf. Add the following entry for context path /EDAB
<web-app id="/EDAB" app-dir="<EDAB_INSTALL_DIR>"/> Where id is the context path of
EDAB, and app-dir is the absolute path of the EDAB installation. Please substitute <EDAB_INSTALL_DIR>
with your actual EDAB installation directory.

3. Start your Resin server by running <resin-installation-dir>/bin/httpd.

4. Now from your web browser, browse to the EDAB Start page to start the server (http://
<server>:<port>/<EDAB_CONTEXT>/index.jsp). For the above configuration, the context path is
EDAB.

5. From the EDAB Start page, login as administrator and launch the Admin Console.

6. From Admin Console page, go to Setting Info tab and change the EDAB Servlet Context entry to /EDAB/
servlet. You can also change the webroot to <RESIN_INSTALL_DIR>/doc, but it is not necessary.

7. Stop the EDAB Server.

8. Stop and restart Resin if necessary.

9. Go to the EDAB Start page and start the EDAB server.

9.3.3. WebLogic Server

9.3.3.1. WebLogic Server 9.2/10.3
The following instructions show how to deploy EspressDashboard under WebLogic Server 9.2/10.3. The instruc-
tions assume that you have WebLogic 9.2/10.3 Server installed on the system and will be deploying EDAB un-
der the wl_server that comes with WebLogic. The location of the WebLogic installation will be referenced as
<WL_INSTALL_DIR>.
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For reference, the wl_server port number is 7001 and the working directory is <WL_INSTALL_DIR>/sam-
ples/domains/wl_server/bin.

1. Start WebLogic 9.2/10.0 example server by executing <WL_INSTALL_DIR>/samples/domain-
s/wl_server/bin/startWebLogic.cmd (Windows) or startWeblogic.sh (Unix).

2. When Weblogic Server web is loaded, press the Start the Administration console button on the home page.

3. Login to the administration console page and select Deployments node from the Domain Structure panel on the
left side. This will bring up the Deployments panel on the right.

4. To install a new application, press the Install button from the Deployments panel. This will direct you to the
Install Application Assistant.

5. From the Application Assistant, browse to the expanded application directory of EDAB, which in this case will
be the installation directory of EDAB <EDAB_INSTALL_DIR>, and then select the radio button to the left of
the EDAB directory and press the Next button. This will show up the following panel. From this panel, select
the Install this deployment as an application radio button and press the Next button.
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6. This will show up the following panel that will allow you to specify optional settings of the configuration pro-
cedure. From this panel, enter the information for EDAB and then press the Finish button.

7. If the deployment has been installed and added to the list of pending changes successfully, press the Activate
Changes button from the Change Center dialog to activate the pending changes.

8. Activate the EDAB application by checking the checkbox to the left of the EDAB link and press the "Start"
button.
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9. Now go to the EDAB Start page http://<server>:<port>/<EDAB_CONTEXT>/index.jsp. From
the start page, start the EDAB server.

10.From the EDAB Start page, login as administrator and launch the Admin Console.

11.From Admin Console page, go to Setting Info tab and change EDAB Servlet Context entry to /
<EDAB_CONTEXT>/servlet. Please substitute <EDAB_CONTEXT> with your actual context for EDAB.

12.Stop and restart the EDAB Server.

9.3.3.1.1. WebLogic Server 8.1
Deploying EspressDashboard to WebLogic Server 8.1 can be accomplished using the same steps as listed in the
next two sections for WebLogic Server 7.0. Note that there are a few small file structure and user interface differ-
ences between WebLogic Server 7.0 and 8.1. First, the exampleServer for WebLogic Server 8.1 is under the path
<WL_INSTALL_DIR>/samples/domains/examples. Also, the sequence of links in step 3 is changed to

examples → Deployment → Web Application Modules instead of examples → Deployment → Web Applications,
and the link in step 4 is called Deploy a new Web Application Module for WebLogic Server 8.1 instead of Configure
a new web application.

Use the following instructions in place of steps 5 and 6:

5. From the right panel, browse to the expanded application directory of EDAB, which in this case will be the
installation directory of EDAB <EDAB_INSTALL_DIR>, and then click the radio button to the left of the EDAB
directory and press the Target Module button. This will show up the Review your choices and deploy panel. From
this panel, enter the information for EDAB.

6. Then press the Deploy button to deploy EDAB.

9.3.3.1.2. WebLogic Server 7.0
The following instructions show how to deploy EspressDashboard under WebLogic Server 7.0. The instructions
assume that you have WebLogic Server 7.0 installed on the system and will be deploying EDAB under the ex-
ampleServer that comes with WebLogic. The location of the WebLogic Server installation will be referenced as
<WL_INSTALL_DIR>

This section uses administration console to deploy EDAB. For quick deployment without using the administration
console, please refer to Section 9.3.3.1.3 - WebLogic Server 7.0 - Quick Deployment.

For reference, the Example Server port number is 7001 and the working directory is <WL_INSTALL_DIR>/
samples/server/config/examples
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1. Start WebLogic example server by executing <WL_INSTALL_DIR>/samples/server/config/exam-
ples/startExamplesServer.cmd

2. When Example Server web page is loaded, click the Administration console link in the home page.

3. Login to the administration console page and click examples → Deployment → Web Applications from the left
panel. This will bring up the Web Applications panel on the right.

4. Click the Configure a new web application link from the above page. This will direct you to install and configure
the EDAB web application.

5. From the right panel, browse to the expanded application directory of EDAB, which in this case will be the
installation directory of EDAB <EDAB_INSTALL_DIR>, and then click the Select link to the left of the EDAB
directory. This will bring you to the following panel to continue with Steps 3, 4 and 5 of the configuration
procedure. From this panel, enter the information for EDAB and choose the targeted server which in this case
will be the exampleServer.
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6. Then press the Configure and Deploy button to deploy EDAB.

7. If hot deployment is not enabled in your WebLogic application server, stop and restart the exampleServer.

8. Now go to the EDAB Start page http://<server>:<port>/<EDAB_CONTEXT>/index.jsp. From
the start page, start the EDAB server.

9. From the EDAB Start page, login as administrator and launch the Admin Console.

10.From Admin Console page, go to Setting Info tab and change EDAB Servlet Context entry to /
<EDAB_CONTEXT>/servlet. Please substitute <EDAB_CONTEXT> with your actual context for EDAB.

11.Stop and restart the EDAB Server.

9.3.3.1.3. WebLogic Server 7.0 - Quick Deployment
These instructions will accomplish the same effect - deploying EspressDashboard under the WebLogic example-
Server - as the previous section. This section explains how to deploy EDAB without using the WebLogic adminis-
tration console. Users who are not very familiar with WebLogic should use the instructions in the previous section.
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1. Modify the <WL_INSTALL_DIR>/samples/domains/examples/config.xml file to add the follow-
ing entry:

<Application Deployed="true" Name="EDAB" Path="<PARENT of
 EDAB_INSTALL_DIR>" TwoPhase="true">

      <WebAppComponent Name="EDAB" Targets="examplesServer" URI="EDAB"/> 

</Application>
                        

Path is the parent directory of <EDAB_INSTALL_DIR>. Application name is the EDAB installation directory
name. For example, if you install EDAB under C:/EDAB, this should be “EDAB”. WebAppComponent Name
is the name of this component. These instructions show how to deploy EDAB with exampleServer. This is
declared by the Target attribute in the config.xml file. URI is how to access this web component. This is
the context path that will be used to access this web application. “EDAB” is used as the default context path.

2. Start the WebLogic 7.0 exampleServer by executing the following command: <WL_INSTALL_DIR>/sam-
ples/server/config/examples/startExamplesServer.cmd

3. Now go to the EDAB Start page http://<server>:<port>/<EDAB_CONTEXT>/index.jsp. From
the start page, start the EDAB server.

4. From the EDAB Start page, login as administrator and launch the Admin Console.

5. From Admin Console page, go to Setting Info tab and change the EDAB Servlet Context entry to /
<EDAB_CONTEXT>/servlet. Please substitute <EDAB_CONTEXT> with your actual context for EDAB.

6. Stop the EDAB Server.

7. Stop and restart Weblogic if necessary.

8. Restart the EDAB Server.

9.3.4. WebSphere

9.3.4.1. WebSphere 7.1
While EspressDashboard can be deployed in WebSphere 7.1 using several ways, the following instructions show
how to do so with minimal changes to WebSphere and EDAB. The instructions assume WebSphere has been
installed, started, and running on the same machine as EDAB.

1. Reinstall EDAB under the following directory EDAB/EDABApp_war.ear/EDABApp.war (for example, C:
\EDAB\EDABApp_war.ear\EDABApp.war), then enter the host name/IP of the WebSphere machine and
the port it is running on when prompted in the EDAB installer. Leave the default EDAB as the servlet context.

2. In order to deploy EDAB under WebSphere, you will need to convert the EDAB web application into a WAR
file, called EDABApp.war, using the Java's JAR tool. To do this, make sure that the java/bin directory is in your
path and navigate to <EDAB_INSTALL_DIR> in a command window. Then execute the following command:
jar -cvf EDABApp.war *

3. Start the administration console for WebSphere. From the left panel of the administration console, select the
Applications node and then click the Install New Applications link.

4. Select New Enterprise Application and then browse to the created war file (which should be EDAB/EDABAp-
p_war.ear/EDABApp.war/EDABApp.war). After selecting EDABApp.war, click on Next.
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5. When you get asked about how to install the application, select Fast Path and click the Next button.

6. Under Directory to install application, enter the path to /EDAB. For example, if you installed EDAB under c:
\EDAB\EDABApp_war.ear\EDABApp.war, enter c:\EDAB. Click Next.

7. Under Map modules to application servers, select Module and click on Next.
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8. Under Map virtual hosts for Web modules, select Web module and click on Next.

9. For Map context root for Web modules, enter /EDAB under Context Root and click on Next.

10.A summary of the installation options is then shown. Click on Finish and the WebSphere will now deploy the
EDAB web application.

11.If the deployment was successful, finish it by clicking the save link on this page.

12.Expand Applications on the right side and select WebSphere enterprise applications. Then select EDABAp-
p_war and click on Start.

13.Now go to the EDAB Start page http://<server>:<port>/EDAB/index.jsp. Note that port is 9080
by default. From the start page, start the EDAB server.
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9.3.4.2. WebSphere 5.0/6.1
EspressDashboard can be deployed in WebSphere in a number of ways. The following instructions show how to
deploy EDAB under WebSphere Application Server 5.0 or 6.0/6.1 with minimal configuration changes. The in-
structions assume that WebSphere Application Server has been installed on the system. The location of the Web-
Sphere installation is referenced as <WS_INSTALL_DIR>. WebSphere is also assumed to be started and running.

1. Reinstall EDAB under the following directory EDAB/EDABApp_war.ear/EDABApp.war (for example, c:
\EDAB\EDABApp_war.ear\EDABApp.war), then enter the host name/IP of the WebSphere machine and
the port it is running on when prompted in the EDAB installer. Leave the default EDAB as the servlet context.

2. In order to deploy EDAB under WebSphere, you will need to convert the EDAB web application into a WAR
file, called EDABApp.war, using the Java's JAR tool. To do this, make sure that the java/bin directory is
in your path and navigate to <EDAB_INSTALL_DIR> in a command window. Next, execute the following
command: jar -cvf EDABApp.war *

3. Start the administration console for WebSphere. From the left panel of the administration console, select the
Applications node and then click the Install New Applications link.

4. You will be redirected to the following window for preparing the application installation. From the right panel,
provide the war file path (which should be EDAB/EDABApp_war.ear/EDABApp.war/EDABApp.war),
enter EDAB for the context path and then click the Next button. Please note that if you are deploying EDAB
under WebSphere 6.1, you can skip steps 5 and 6 and continue with step 7.

5. In case you do not have any binding specified, select Generate Default Bindings in the next page.
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6. Click the Next button.

7. Click the Continue button. Now you are redirected to the step 1 of the installation: Provide options to perform
the installation. Under Directory to install application, enter the path to /EDAB. For example, if you installed
EDAB under c:\EDAB\EDABApp_war.ear\EDABApp.war, enter c:\EDAB.
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8. Click the Next button to go to step 2: Map virtual hosts for web modules. Select Web Modules.

9. Click the Next button to go to step 3: Map modules to application servers. Select Module.
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10.Click the Next button to go to step 4: Summary of this web application. Please make sure that all information is
correct. If it's not, go back to the previous pages to edit the information.

11.After verifying all informations, click the Finish button. WebSphere will now try to deploy the EDAB Web
application.

12.If the deployment was successful as shown above, save the changes either by clicking the save link in this page,
or clicking on the save link on top of the administration console. Note that you may have to go under Applications
in the right frame, expand Enterprise Applications and start EDABApp_war.

13.Now go to the EDAB Start page http://<server>:<port>/EDAB/index.jsp. Note that port is 9080
by default. From the start page, start the EDAB server.

9.3.4.3. WebSphere on z/OS
Deploying EspressDashboard to WebSphere for z/OS has a few additional steps:

1. Download EDAB.war and deploy it on WebSphere (see above section for general WebSphere deployment).
You will need to use viascii to configure text files that are mentioned in the instructions. Also, since the required
jar files are in the WEB-INF/lib directory inside the war file, you can skip the steps for adding them
as classpath to your servlet container.
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2. EDAB requires Java graphics support to run. If you are using JDK 1.5 or higher, the solution is to set it to run in
headless mode by specifying the -Djava.awt.headless=true flag for the java command that starts your
WebSphere. For JDK 1.3 or lower, you can use PJA graphics emulation.

3. Stop and restart WebSphere if necessary. EDAB is now set up and accessible using URL: http://
host:port/EDAB/index.jsp.

9.3.5. JBoss 3.2.3 (with Tomcat 5.0) / JBoss 4.0.5/6.0.0
The following instructions show how to deploy EspressDashboard under JBoss 3.2.3 with Tomcat 5.0 / JBoss
4.0.5 /6.0.0. The instructions assume you have JBoss installed on the system. The location of the JBoss installation
is referenced as <JBOSS_INSTALL_DIR>.

For reference, the default port is 8080 and the default working directory is <JBOSS_INSTALL_DIR>/bin.

1. You need a jboss-web.xml deployment descriptor to deploy EDAB. This file should be added to the
<EDAB_INSTALL_DIR>/WEB-INF directory. This is the same location as web.xml file. This deployment
descriptor is to specify the EDAB context. The content should look like this:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE jboss-web PUBLIC "-//JBoss//DTD Web Application 2.3//EN"
 "http://www.jboss.org/j2ee/dtds/jboss-web_3_0.dtd">

<jboss-web>

      <context-root>/EDAB</context-root> 

</jboss-web>
                

2. Rename the EDAB installation directory <EDAB_INSTALL_DIR> to EDAB.war, then move the entire
EDAB.war directory to <JBOSS_INSTALL_DIR>/server/default/deploy. This new directory is
referenced as <EDAB_DEPLOY_DIR>. Next time when JBoss starts, server will automatically deploy the EDAB
web application.

3. Open <EDAB_DEPLOY_DIR>/WEB-INF/classes/QB.properties file and change the AutoStart-
ServerInstallDir entry to point to <EDAB_DEPLOY_DIR>. Example:
Original entry

AutoStartServerInstallDir=<EDAB_INSTALL_DIR>
                

New entry

AutoStartServerInstallDir=<EDAB_DEPLOY_DIR>
                

Now you have to change Database URL. If the DatabaseUrl entry already exists in your QB.properties
file, just change it to point to the hsql database under <EDAB_DEPLOY_DIR>. Example:

Original entry

DatabaseUrl=jdbc\:hsqldb\:<EDAB_INSTALL_DIR>/data/quadbasedb
                

New entry
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DatabaseUrl=jdbc\:hsqldb\:<EDAB_DEPLOY_DIR>/data/quadbasedb
                

If the entry does not exist in your file, save the changes and open <EDAB_DEPLOY_DIR>/WEB-IN-
F/orguserdb/config.txt file. In the file, modify [database url] entry to point to the hsql database
under <EDAB_DEPLOY_DIR>. Example:

Original entry

[database url] jdbc:hsqldb:<EDAB_INSTALL_DIR>/data/quadbasedb
                

New entry

[database url] jdbc:hsqldb:<EDAB_DEPLOY_DIR>/data/quadbasedb
                

4. Execute run.bat/.sh in the <JBOSS_INSTALL_DIR>/bin directory to start the JBoss Server. The
EDAB application will be automatically deployed. The deployment information should be printed out on the
JBoss console.

5. Go to the EDAB Start page http://<server>:<port>/<EDAB_CONTEXT>/index.jsp to start the
EDAB server. EDAB_CONTEXT is defined in your jboss-web.xml file. In this case. it will be EDAB.

6. From the EDAB Start page, login as administrator and launch the Admin Console.

7. From Admin Console page, go to Setting Info tab and change EDAB Servlet Context entry to /
<EDAB_CONTEXT>/servlet . Please substitute <EDAB_CONTEXT> with your actual context for EDAB.

8. Stop and restart the EDAB server.

9.3.6. Oracle Containers for J2EE (OC4J) 10g
(9.0.4.0/10.1.3.5)

The following instructions show how to deploy EspressDashboard under OC4J 10g (9.0.4.0/10.1.3.5). The instruc-
tions assume that you have OC4J installed on the system. The location of the OC4J installation is referenced as
<OC4J_INSTALL_DIR>

For reference, the default port is 8888 and the default working directory is <OC4J_INSTALL_DIR>/j2ee/
home.

1. The easiest way to deploy EDAB is to put EDAB under default-web-app. Copy the entire EDAB directory
<EDAB_INSTALL_DIR> to <OC4J_INSTALL_DIR>/j2ee/home/default-web-app. This new di-
rectory is referenced as <EDAB_DEPLOY_DIR>.

2. You will need to copy the tools.jar file from your Java development kit to the <OC4J_INSTALL_DIR>/
j2ee/home/applib directory (for JSP compilation), or add a library path entry for the file. Check your
<OC4J_INSTALL_DIR>/j2ee/home/config/application.xml file. The following entry should
exist in the file: <library path="../applib"/>

3. Open <EDAB_DEPLOY_DIR>/WEB-INF/classes/QB.properties file and change the AutoStart-
ServerInstallDir entry to point to <EDAB_DEPLOY_DIR>. Example:

Original entry

AutoStartServerInstallDir=<EDAB_INSTALL_DIR>
                

New entry
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AutoStartServerInstallDir=<EDAB_DEPLOY_DIR>
                

Now you have to change Database URL. If the DatabaseUrl entry already exists in your QB.properties
file, just change it to point to the hsql database under <EDAB_DEPLOY_DIR>. Example:

Original entry

DatabaseUrl=jdbc\:hsqldb\:<EDAB_INSTALL_DIR>/data/quadbasedb
                

New entry

DatabaseUrl=jdbc\:hsqldb\:<EDAB_DEPLOY_DIR>/data/quadbasedb
                

If the entry does not exist in your file, save the changes and open <EDAB_DEPLOY_DIR>/WEB-IN-
F/orguserdb/config.txt file. In the file, modify [database url] entry to point to the hsql database
under <EDAB_DEPLOY_DIR>. Example:

Original entry

[database url] jdbc:hsqldb:<EDAB_INSTALL_DIR>/data/quadbasedb
                

New entry

[database url] jdbc:hsqldb:<EDAB_DEPLOY_DIR>/data/quadbasedb
                

4. Backup the web.xml file under <OC4J_INSTALL_DIR>/j2ee/home/default-web-app/WEB-
INF, then move all directories and files (except for the /orguserdb/ directory) under the
<EDAB_DEPLOY_DIR>/WEB-INF to the <OC4J_INSTALL_DIR>/j2ee/home/default-web-ap-
p/WEB-INF directory. This will make all the class files and servlets accessible from OC4J. If necessary, merge
the old web.xml file with the web.xml file for EDAB to create a new web.xml file.

5. Start the Oracle server by executing the command java -jar oc4j.jar in the <OC4J_INSTALL_DIR>/
j2ee/home directory.

6. Go to the EDAB Start page http://<server>:<port>/<EDAB_CONTEXT>/index.jsp to start the
EDAB server. The EDAB_CONTEXT will be the directory name of <EDAB_DEPLOY_DIR>.

7. From the EDAB Start page, login as administrator and launch the Admin Console.

8. From Admin Console page, go to Setting Info tab and change the EDAB Servlet Context entry to /servlet/.

9. Stop and restart the EDAB server.

9.3.7. Oracle Application Server 10g R3 (10.1.3)
The following instructions show how to deploy EspressDashboard under Oracle Application Server 10g R3. The
instructions assume that you have Oracle AS installed on the system with standard installation. The location of the
Oracle AS installation is referenced as <O10g_INSTALL_DIR>

1. Install EDAB to the <O10g_INSTALL_DIR>/j2ee/home/default-web-app/ or

2. Copy the EDAB directory to <O10g_INSTALL_DIR>/j2ee/home/default-web-app/.
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3. The new location for the EDAB directory is referenced as <EDAB_HOME>.

4. If the database is set up with direct path, open <EDAB_HOME>/WEB-INF/classes/QB.properties and
modify the database info as shown below.

DatabaseUrl=jdbc:hsqldb:<EDAB_HOME>/data/quadbasedb
                

5. Move all directories and files (except for the /orguserdb/ directory) from <EDAB_HOME>/WEB-INF to
<O10g_INSTALL_DIR>/j2ee/home/default-web-app/WEB-INF/ directory.

6. Add <EDAB_HOME>/lib/EDABServer.jar to the CLASSPATH user variable.

7. Go to http://<machine>:80/j2ee/EDAB and start EDAB server.

8. In the admin console, change the servlet context to /j2ee/servlet.

9. Restart EDAB Server

9.3.8. GlassFish Server 3.0.1
The following instructions show how to deploy EspressDashboard under GlassFish Server 3.0.1. The instructions
assume that the application server and EDAB are installed on the same machine and that GlassFish is up and running.

1. Log in to the GlassFish Admin Console. Click on Aplications or (in Glasfish v2) expand Applications on the
left and then click on Enterprise Applications.

2. Click on Deploy to deploy a new enterprise application.

3. Select Browse Folders and select <EDAB_INSTALL_DIR>.

4. Enter EDAB under Application Name and select the server under Virtual Server.
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5. Click on the OK button to finish deployment.

6. In the Enterprise Application window, select the EDAB application you have created and then select Launch.
This will enable the enterprise application (i.e. start it) and launch it in a separate browser window. You can
now start using EDAB.

9.4. Clustering/Load Balancing
Scalability is an important concern for enterprise reporting. One of the best ways to easily scale an application while
eliminating server down-time is to deploy the application in a clustered environment. To provide for maximum
scalability, EDAB can be deployed in a clustered environment.

When running EDAB in a cluster, one server acts as the load balancing machine, receiving incoming requests and
routing them to other servers in the cluster where they are processed. This following diagram illustrates EDAB
running in a clustered environment.

EDAB Clustering Diagram
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All incoming requests are handled by the load balancing server, which will redirect the requests to one of the cluster
members. The client's entire session will then take place on the cluster member. Users have an option to either
make the load balancer one of the cluster members, or use it solely as the balancer. Each of the cluster members
will directly access data sources and read/write information from the EDAB Server, but only the load balancer
will access the file system. All i/o requests from the cluster members are routed through the load balancer. This
ensures that users are working with the same set of deployed dashboards, regardless of which cluster member they
are currently using.

The following chapter details how to deploy EDAB cluster in different application server environments.

9.4.1. Tomcat 5.0
In this section, you will be modifying the following:

• <TomcatInstallDir>/conf/server.xml

• Admin Console

• <TomatInstallDir>/webapps/balancer/WEB-INF/web.xml

• <TomcatInstallDir>/webapps/balancer/WEB-INF/config/rules.xml

• <EDABInstallDir>/index.html

• <EDABInstallDir>/WEB-INF/web.xml

The first step in setting up EDAB cluster is to deploy EDAB to all the servers in the cluster. You will need to install
EDAB on all the machines and deploy it in the Tomcat instance. You can follow the instructions in Section 9.3.1
- Tomcat 4.1/5.x/6.0.x/7.0.x.

Next, modify the server.xml under <TomcatInstallDir>/conf on the load balancing machine. Add the
following configuration to this file to enable clustering.

<Cluster className="org.apache.catalina.cluster.tcp.SimpleTcpCluster"

     
 managerClassName="org.apache.catalina.cluster.session.SimpleTcpReplicationManager"
      expireSessionsOnShutdown="false"
      useDirtyFlag="true">

      <Membership
            className="org.apache.catalina.cluster.mcast.McastService"
            mcastAddr="228.0.0.4"
            mcastPort="45564"
            mcastFrequency="500"
            mcastDropTime="3000"/> 

      <Receiver
            className="org.apache.catalina.cluster.tcp.ReplicationListener"
            tcpListenAddress="auto"
            tcpListenPort="4000"
            tcpSelectorTimeout="100"
            tcpThreadCount="6"/> 

      <Sender
           
 className="org.apache.catalina.cluster.tcp.ReplicationTransmitter"
            replicationMode="pooled"/> 
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      <Valve className="org.apache.catalina.cluster.tcp.ReplicationValve"
            filter=".*\.gif;.*\.js;.*\.jpg;.*\.htm;.*\.html;.*\.txt;"/> 

</Cluster> 
        

There is a default clustering implementation in the server.xml file, but it is commented out. For the load balancer
server, you will need to use this slightly different implementation instead.

For all the other servers in the cluster, you can use the default cluster configuration in the server.xml file You
just need to uncomment the default configuration. In the default configuration, the default tcpListenPort is
4001.

If any of the cluster members have more than one IP address, it may be necessary to add mcastBindAddress
parameter to the <Membership> tag. This argument allows you to specifically set an IP for the cluster service.

If you are using HSQL as the EDAB database, you will need to change the configuration of this database on the
load balancer machine. HSQL usually runs as application process and cannot be accessed from other machines. In
order to make it available to other servers in the cluster, it needs to be configured to run in client-server mode. For
setup instructions, please see Section 1.3.2.1.2 - Running HSQL in Client-Server Mode.

Next, you will need to log in as Admin and enter the Admin Console . Go to Setting Info → Clustering & Load
Balancer Settings and add the entries for Server Host, Server Port Number and Cluster Member
List.

Server Host: 192.168.0.8

Server Port Number: 8080

Cluster Member List: 192.168.0.8:8080
                     192.168.0.10:8080
                     192.168.0.16:8080
        

The Server Host and Server Port Number entries should be the address and port number for the load
balancing server. The first entry under the Cluster Member List heading should also be the load balancer
server. It needs to be listed under this argument even if the load balancer is not acting as a cluster member. The
order of other servers should be same in the Admin Console for each EDAB instance.

Next, you will need to deploy the balancer web application to the load balancer server. This is a standalone
Web application for Tomcat that is included in the EDAB installation under <EDABInstallDir>/Cluster-
ing/Tomcat/balancer. To deploy the Web application, copy the contents of the /balancer/ directory
to the load balancer server and place it under <TomcatInstallDir>/webapps/. The web.xml file for the
balancer application, now under <TomcatInstallDir>/webapps/balancer/WEB-INF, maps Load-
Balancer to a BalancerFilter and gives the definition of the BalancerFilter with its class file and
rules.xml file.

<web-app>

      <!-- BalancerFilter definition --> 

<filter>

      <filter-name>BalancerFilter</filter-name>
      <filter-class>org.apache.webapp.balancer.BalancerFilter</filter-class>
      <init-param>
            <param-name>configUrl</param-name>
            <param-value>/WEB-INF/config/rules.xml</param-value> </init-
param> 
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</filter>

<!-- BalancerFilter mapping -->

<filter-mapping>

      <filter-name>BalancerFilter</filter-name>
            <url-pattern>/LoadBalancer</url-pattern> </filter-mapping> 

</web-app>
        

Rules.xml defines how the BalancerFilter should redirect requests to server instance. The following is an
example of ruler.xml file and it is based on RoundRobinRule. RoundRobinRule.class and several
other rule classes are included in the balancer package.

<rules>

      <!-- Redirect to server instance based on RoundRobinRule -->
      <rule className="org.apache.webapp.balancer.rules.RoundRobinRule"
            serverInstance="1"
            maxServerInstances="3"
            tcpListenAddress="127.0.0.1"
            tcpListenPort="4000"
            redirectUrl="http://192.168.0.8:8080/EDAB/index.jsp" /> 

      <rule className="org.apache.webapp.balancer.rules.RoundRobinRule"
            serverInstance="2"
            maxServerInstances="3"
            tcpListenAddress="127.0.0.1"
            tcpListenPort="4001"
            redirectUrl="http://192.168.0.10:8080/EDAB/index.jsp" /> 

      <rule className="org.apache.webapp.balancer.rules.RoundRobinRule"
            serverInstance="3"
            maxServerInstances="3"
            tcpListenAddress="127.0.0.1"
            tcpListenPort="4001"
            redirectUrl="http://192.168.0.16:8080/EDAB/index.jsp" /> 

</rules>
        

Each defined server instance in the rules.xml file should point to one of the EDAB cluster members. If you want
the load balancer server to also function as a cluster member, include it as a server instance here. You need to make
sure that the tcpListenPort in the rules.xml file matches the port specified in the server.xml file for
that server. The RoundRobinRule, as depicted above, routes each incoming request to the next cluster member in
sequence using the default tcpListenPort. The balancer application also includes RandomRedirectRule
option. This will randomly choose a cluster member for each incoming request.

Finally, you need to create a new index.html (instead of the current index.jsp) page in the <EDABIn-
stallDir> directory on the load balancer server. The page can be blank, however, it needs to have the following
meta tag at the top of the page:

<meta http-equiv="refresh" content="0; URL=http://servername:8080/balancer/
LoadBalancer" />
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This will redirect all incoming requests to the balancer application, where it will be routed to one of the cluster
members following the logic defined in the rules.xml file. Replace servername with the domain or IP address
of your load balancer server in the URL. In order to make the new index.html page the default start page for the
load balancer machine, you have to edit the web.xml file under <EDABInstallDir>/WEB-INF and change
the following entry:

<welcome-file-list>

      <welcome-file>index.jsp</welcome-file> 

</welcome-file-list>
        

to

<welcome-file-list>

      <welcome-file>index.html</welcome-file> 

</welcome-file-list>
        

9.4.1.1. Running EDAB in a Tomcat Cluster
Once you complete the deployment, start Tomcat on your load balancing server and then do the same on all other
servers in the cluster. To get to the EDAB home page, call the index.html file that you created on the load
balancer server. You will then be redirected to the Start page on one of the cluster machines. When you start the
EDAB server on this cluster machine, it will automatically start the EDAB server on all other machines in the cluster.

Once you have been redirected to a particular server through the load balancer, your entire session will take place
on that machine. However, all file I/O will take place on the load balancing machine. This ensures that all users will
interact with the same set of reports, charts and dashboards which are stored in the file system. All other system
information is stored in the EDAB database, which can be accessed by any server in the cluster.

9.4.1.2. Set up EDAB clustering using Apache Web Server and Tom-
cat

The following instructions will help you setup EDAB using Apache Web Server as the load balancer and Tomcat
Clusters. In this section, you will be modifying the following files:

• <ApacheInstallDir>/conf/httpd.conf

• <ApacheInstallDir>/conf/workers.properties

• <TomcatInstallDir>/conf/server.xml

1. Setup EDAB cluster with Tomcat using the instructions in Section 9.4.1 - Tomcat 5.0.

2. Apache HTTP server:

a. Download Apache HTTP server 2.2.4 from The Apache HTTP Server Project (https://httpd.apache.org/" [
https://httpd.apache.org/ ])

b. Run the installer and select standard installation.

Note
Do not install to the default Program Files directory as space in directory name could cause
problems later. Install directory name must not have space in it, for example "Apache2.2" is fine.

https://httpd.apache.org/
https://httpd.apache.org/


Configuration

560

c. Open the Apache Server Monitor and start the web server if it's not already running.

d. Point your browser to http://localhost/ to verify that Apache is running on port 80.

e. Stop Apache.

3. Apache-Tomcat connector

a. Download Mod JK Tomcat connector from https://tomcat.apache.org/download-connectors.cgi.

Note

You want to download the binary - click on JK 1.2 Binary Releases → win32 → jk-1.2.21 →
mod_jk-apache-2.2.4.so

b. Copy the mod_jk-apache-2.2.4.so to the modules directory in your Apache installation.

c. Rename it to mod_jk.so

d. Open httpd.conf in the conf directory of your Apache installation in a text edit and add the following
line at the end of the LoadModule statements: LoadModule jk_module modules/mod_jk.so

e. Create a file called workers.properties in the conf directory. Add these lines to it:

workers.tomcat_home=<tomcat_install_directory>
workers.java_home=<jdk_install_directory>
worker.list=balancer

worker.worker0.port=8009
worker.worker0.host=192.168.0.8
worker.worker0.type=ajp13
worker.worker0.lbfactor=1

worker.worker1.port=9009
worker.worker1.host=192.168.0.8
worker.worker1.type=ajp13
worker.worker1.lbfactor=1

worker.worker2.port=8009
worker.worker2.host=192.168.0.10
worker.worker2.type=ajp13
worker.worker2.lbfactor=1

worker.worker3.port=9009
worker.worker3.host=192.168.0.10
worker.worker3.type=ajp13
worker.worker3.lbfactor=1

worker.balancer.type=lb
worker.balancer.balance_workers=worker0,worker1,worker2,worker3
worker.balancer.method=B
worker.balancer.sticky_session=True
                        

We have specified the worker list to a single worker called balancer and specified that the worker type of
balancer is 'lb' or load balancer. The workers it manages are worker0, worker1, worker2 and
worker3. And we set the balance method to 'B' or balance by busy factor. Apache will delegate the next

https://tomcat.apache.org/download-connectors.cgi
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request to the Tomcat instance which is the least busy. Please note that there are several options for the balance
method - consult the Apache/Tomcat documentation, which lists the options for workers properties, to help
you decide the best method for your type of application.

Note
Port numbers must match the Connector port (with protocol=“AJP/1.3”) defined in Tomcat's
server.xml. 8009 is the original port and 9009 for the second instance of Tomcat on the
same machine.

f. Edit the server.xml for each instance of Tomcat and add a jvmRoute attribute to the Engine element:

<Engine name="Catalina" defaultHost="localhost" jvmRoute="worker0">
                        

for the first instance and

<Engine name="Catalina" defaultHost="localhost" jvmRoute="worker1">
                        

for the second.

<Engine name="Catalina" defaultHost="localhost" jvmRoute="worker2">
                        

for the third.

<Engine name="Catalina" defaultHost="localhost" jvmRoute="worker3">
                        

for the last.

g. Specify the worker properties in httpd.conf:

Add these lines just after the LoadModule definitions:

JkWorkersFile c:/apache2.2/conf/workers.properties
JkLogFile c:/apache2.2/mod_jk.log
JkLogLevel info
JkLogStampFormat "[%a %b %d %H:%M:%S %Y] "
JkOptions +ForwardKeySize +ForwardURICompat -ForwardDirectories
JkRequestLogFormat "%w %V %T"
#use apache balancer
JkMount /EDAB balancer
JkMount /EDAB/* balancer
                        

4. Start up

a. Startup Tomcat50, Tomcat51, Tomcat52 and Tomcat53

b. Start Apache Server

c. Go to http://192.168.0.8:8080/EDAB/index.html and start the EDAB server

d. Go to http://192.168.0.8/EDAB/index.jsp
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Note
The internal Tomcat server (http://192.168.0.8:8080/EDAB) is for Administrator to
start and stop EDAB server and should not be available to other users. Other users must go through
Apache web server (http://192.168.0.8/EDAB/) and their requests will be forwarded to
Tomcat cluster which is invisible to them. Apache HTTP server will serve loadbalancer.

The above example creates four instances of EDAB on two separate machines (192.168.0.8 and 192.168.0.10). To
change the number of clusters and machines, modify the worker configuration in step 3.

9.4.2. JBoss 3.2.5 (with Tomcat 5.0)
In this section, you will be modifying the following files:

• Admin Console

• <JBossInstallDir>/server/default/deploy/loadbalancer.sar/META-INF/jboss-
service.xml

• <EDABInstallDir>/index.html

The first step in setting up an EDAB cluster is to deploy EDAB to all servers in the cluster. You will need to install
EDAB on all machines and deploy it in the JBoss instance. You can follow the instructions in Section 9.3.7 - Oracle
Application Server 10g R3 (10.1.3).

If you are using HSQL as the EDAB database, you will need to change the configuration of this database on the
load balancer machine. HSQL usually runs as an application process and cannot be accessed from other machines.
In order to make it available to other servers in the cluster, it needs to be configured to run in client-server mode.
For setup instructions, please see Section 1.3.2.1.2 - Running HSQL in Client-Server Mode.

Next, you will need to log in as Admin and enter the Admin Console. Go to Setting Info → Clustering & Load
Balancer Settings and add the entries for Server Host, Server Port Number and Cluster Member
List.

Server Host: 192.168.0.8

Server Port Number: 8080

Cluster Member List: 192.168.0.8:8080
                     192.168.0.10:8080
        

The Server Host and Server Port Number entries should be the address and port number for the load
balancing server. The first entry under the Cluster Member List heading should also be the load balancer
server. It needs to be listed under this argument even if the load balancer is not acting as a cluster member. The
order of other servers should be same in the Admin Console for each EDAB instance.

Next, you will need to deploy the balancer web application to the load balancer server. This is a standalone
web application for JBoss that is included in the JBoss installation under <JBOSS_INSTALL_DIR>\docs
\examples\varia\loadbalancer. To deploy the web application, copy the contents of /loadbal-
ancer.sar/ directory to the load balancer server and place it under JBoss deploy directory (<JBOSS_INSTAL-
L_DIR>\server\default\deploy if you follow the instructions from this manual).

Edit loadbalancer.sar/META-INF/jboss-service.xml to match your configuration. Modify
<host-url> and add new <host> so the configuration file contains all cluster members. The example below
shows the configuration for two clusters. Value of <lb-factor> isn't important because it is not used in this
JBoss version.
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<hosts>

      <host>
            <host-url>http://192.168.0.8:8080/EDAB</host-url>
            <lb-factor>1</lb-factor> </host>
      <host>
            <host-url>http://192.168.0.10:8080/EDAB</host-url>
            <lb-factor>2</lb-factor> </host> 

</hosts>
        

Uncomment the first Monitor service in the jboss-service.xml.

<!-- Monitor Services -->
<!-- A monitor that only checks that a given path is reachable -->
<mbean code="org.jboss.web.loadbalancer.monitor.SimpleMonitorService"
 name="jboss.web.loadbalancer:service=Monitor">

      <depends optional-attribute-
name="Scheduler">jboss.web.loadbalancer:service=Scheduler</depends>
      <attribute name="Interval">15000</attribute>
      <attribute name="Timeout">20000</attribute>
      <attribute name="Path">/</attribute> 

</mbean>
        

You can find a sample jboss-service.xml in <EDAB_DEPLOY_DIR>/Clustering/JBoss. Or you can
take a look at <JBOSS_INSTALL_DIR>\docs\examples\varia\loadbalancer\loadbalancer.-
doc for more detailed description of the load balancer application and its configuration files.

If you use Tomcat 5.0 plugin, you must remove the <JBOSS_DEPLOY_DIR>/jbossweb-tom-
cat50.sar/ROOT.war directory because the load balancer also wants to be root.

Finally, you need to modify index.html page in <EDAB_DEPLOY_DIR> directory on all cluster members. The
page can be blank, but it needs to have the following meta tag at the top:

<meta http-equiv="Refresh" content="0; url=http://machine:port/EDAB/
index.jsp">
        

Replace machine/port with IP address/port of the machine the cluster member is running on. EDAB is EDAB
context on the cluster member. Make the index.html page the default start page for all cluster members. You can
do this by editing the web.xml file under <EDAB_DEPLOY_DIR>/WEB-INF on all cluster members. Change
the following entry:

<welcome-file-list>

      <welcome-file>index.jsp</welcome-file> 

</welcome-file-list>
        

to

<welcome-file-list>
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      <welcome-file>index.html</welcome-file> 

</welcome-file-list>
        

9.4.2.1. Running EDAB in JBoss Cluster
Once you complete the deployment, start JBoss on all servers in the cluster and then start JBoss on your load
balancing server. Do not forget to start the HSQL database server first (if you are using it). To get to the EDAB
home page, open http://machine:port, where machine is your load balancing server and port is the port
JBoss is running on (8080 by default). You will then be redirected to the Start page on one of the cluster machines.
When you start the EDAB server on this cluster machine, it will automatically start the EDAB server on all other
machines in the cluster.

Once you have been redirected to a particular server through the load balancer, your entire session will take place
on that machine. However, all file I/O will take place on the load balancing machine. This ensures that all users will
interact with the same set of reports, charts and dashboards which are stored in the file system. All other system
information is stored in the EDAB database, which can be accessed by any server in the cluster.

9.4.3. JRun 4 (with Apache Web server)
In this section, you will be modifying the following files:

• Admin Console

• <JRUNInstallDir>\lib\wsconfig\1\jrunserver.store

• <EDABInstallDir>/index.html

• <EDABInstallDir>/WEB-INF/web.xml

The first step in setting up an EDAB cluster is to deploy EDAB to all servers in the cluster. You will need to
install EDAB on all machines and deploy it in the JRun instance. You can follow the instructions in Section 9.3.4
- WebSphere. EDAB needs to be installed in the same context on all cluster members.

If you're using HSQL as the EDAB database, you will need to change the configuration of this database on the
load balancing machine. HSQL usually runs as application process and cannot be accessed from other machines. In
order to make it available to the other servers in the cluster, it needs to be configured to run in client-server mode.
For setup instructions, please see Section 1.3.2.1.2 - Running HSQL in Client-Server Mode.

Next, you will need to log in as Admin and enter the Admin Console. Then go to Setting Info → Clustering & Load
Balancer Settings and add the entries for Server Host, Server Port Number, and Cluster Member
List.

Server Host: 192.168.0.8

Server Port Number: 8080

Cluster Member List: 192.168.0.8:8080
                     192.168.0.10:8080
                     192.168.0.16:8080
        

The Server Host and Server Port Number entries should be the address and port number for the load
balancing server. The first entry under the Cluster Member List heading should also be the load balancing
server. It needs to be listed under this argument even if the load balancer is not acting as a cluster member. The
order of other servers should be same in the Admin Console for each EDAB instance.

Use the following steps to complete the JRun deployment:
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1. This configuration uses Apache web server as a load balancing server. You will need to install it on the load
balancing machine.

2. Next, go to the JRun admin console on the load balancing server and log in. The default port of admin console
is 8000.

3. Click Register Remote Server at the top of the page. Enter the IP address, server, and JNDI port of the cluster
member which is hosted on a machine other than the load balancer. Repeat this step for all cluster members
which are hosted on other machines.

4. Then click Create New Cluster at the top of the page. Enter the name of the cluster and click next. Select all
cluster members on the next page. Then click next and done.

5. Now run all cluster members and run the JRun Web Server Configuration Tool. Here click Add. In the following
dialog, select the previously created cluster in the JRun server field. Select Apache web server and insert Apache
configuration directory (<APACHE_INSTALL_DIR>\conf). Then click OK and close the Web Server Con-
figuration.

6. Open the <JRUN_INSTALL_DIR>\lib\wsconfig\1\jrunserver.store file. There will be a similar
entry to the one below:

proxyservers=192.168.0.8:51000
                

Add all cluster members to this file (separate them with semicolon “;”). The port is the cluster member proxy
port (51000 by default). You can find this port in the admin console.

proxyservers=192.168.0.8:51000;192.168.0.10:51000
                

Finally, you need to modify index.html page in <EDAB_INSTALL_DIR> directory on all cluster members.
The page can be blank, but it needs to have the following meta tag at the top of the page:

<meta http-equiv="Refresh" content="0; url=http://machine:port/EDAB/
index.jsp">
        

Replace machine/port with IP address/port of the machine the cluster member is running on (port is 8100 by default).
EDAB is the EDAB context on the cluster member. Make the index.html page the default start page for all
cluster members. You can do this by editing the web.xml file under <EDAB_INSTALL_DIR>/WEB-INF on all
cluster members. Change the following entry:

<welcome-file-list>

      <welcome-file>index.jsp</welcome-file> 

</welcome-file-list>
        

to

<welcome-file-list>

      <welcome-file>index.html</welcome-file> 

</welcome-file-list>
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9.4.3.1. Running EDAB in a JRun Cluster
Once you complete the deployment, start JRun on all servers in the cluster and then start Apache on your load
balancing server. Do not forget to start the HSQL database server first (if you are using it). To get to the EDAB
home page, open http://machine:port, where machine is your load balancing server and port is the port
Apache is running on (80 by default). You will then be redirected to the Start page on one of the cluster machines.
When you start the EDAB server on this cluster machine, it will automatically start the EDAB server on all other
machines in the cluster.

Once you have been redirected to a particular server through the load balancer, your entire session will take place
on that machine. However, all file I/O will take place on the load balancing machine. This ensures that all users will
interact with the same set of reports, charts and dashboards which are stored in the file system. All other system
information is stored in the EDAB database, which can be accessed by any server in the cluster.

9.4.4. WebSphere 6.0
In this section, you will be modifying the following files:

• Admin Console

To deploy EDAB in a WebSphere cluster, you will first need to have a WebSphere cluster setup (using HTTP
Server). We will call your deployed WebSphere cluster <Cluster_Name>

Next, you will need to deploy EDAB to each of the WebSphere cluster members. To do this, you will need to
WAR the /EDAB/ directory and deploy it using the WebSphere administration console. or more information about
deploying EDAB in WebSphere, see Section 9.3.6 - Oracle Containers for J2EE (OC4J) 10g (9.0.4.0/10.1.3.5).
Follow the steps in this section until you get to Map modules to servers step. In this step, map the EDAB Web
application to the <Cluster_Name> and your HTTP server.

Make sure that you deploy EDAB on all cluster members using the same context.

Next, you will need to log in as Admin and enter the Admin Console. Go to Setting Info → Clustering & Load
Balancer Settings and add the entries for Server Host, Server Port Number, Cluster Member
List, Member Host and Member Port Number.

Server Host: 172.26.35.12

Server Port Number: 9080

Cluster Member List: 172.26.35.12:9080
                     172.26.35.13:9080
                     172.26.35.14:9080
                     172.26.35.15:9080

Member Host: 172.26.35.15

Member Port Number: 9080
        

The Server Host and Server Port Number entries should be the address and port number for the load
balancing server. The first entry under the Cluster Member List should also be the load balancer server. It needs
to be listed under this argument even if the load balancer is not acting as a cluster member. The order of the other
servers should be the same in the Admin Console for each EDAB instance. The Member Host entry should be
the IP address of the current machine, and the Member Port Number entry should be the server port number
for the current machine. These entries will change for each cluster member.

In the WebSphere administration console, click on Servers → WebServers → Generate Plug-in and Propagate Plug-
in. The re-start the HTTP Server.

Next, start the WebSphere cluster. Navigate to the index.jsp page on the load balancer machine, and start the
EDAB Server. Note that because the IBM HTTP server does the balancing, you do not need to change the start page
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for EDAB. Users can simply start their session by pointing to the index.jsp page on the load balancer machine.
The HTTP server on that machine will re-direct their requests to the cluster members.
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Chapter 10. Internationalization
10.1. Internationalizing EDAB

EDAB provides many different features that allows you to generate reports for just about any locale and language.
Different internationalization features can require different system or setting configurations depending on your
specific requirements.

10.1.1. Specifying Locales
EDAB allows different time zones and locales reports and charts. They are not limited to the locale on the machine
where they are created. The locale can be set through API right before the report or chart is run.

10.1.1.1. Locale-Specific Formatting
For data formatting (date and numeric), EDAB allows you to set locale-specific formatting for report elements.
Locale-specific formatting allows data elements to be displayed in the correct format for the particular locale that
is being used for the report. Locale-specific options are available in the data formatting dialog.

The locale for report and charts, as well as the time zone, can be set at run-time through the API. Note that this
only effects the date, the time, and the data formatting.

10.1.1.2. Setting Time Zones and Locales Using the API
To set the time zone or locale, you can use the methods in QbReport/QbChart (applies to the entire report/chart)
or use LocaleDateTimeFormat and LocaleNumericFormat objects (applies to a specific object in the
report/chart). The following code fragments shows how to do this with two different approaches.

report.setLocale(Locale.UK);
report.settime zone(time zone.gettime zone("GMT"));
        

Here, the formats are applied to the entire report. Alternatively, you can apply the format to specific data columns
as follows:

LocaleNumericFormat currencyFormat =
 LocaleNumericFormat.getCurrencyInstance();
currencyFormat.setLocale(Locale.UK);
int columnIndex = 2; //column 2 is the "Unit Price" column
report.getTable().getColumn(columnIndex).setDataFormat(currencyFormat);

LocaleDateTimeFormat dateFormat = LocaleDateTimeFormat.getDateInstance();
dateFormat.settime zone(time zone.gettime zone("GMT"));
report.getPageFooter().getData(1).setDataFormat(dateFormat);
        

10.1.2. Language and Encoding
EDAB includes a set of features that removes limitations caused by language differences. By utilizing a simple to
use interface, it is possible to translate all text, buttons, and menus within EDAB to a different language. Through
some basic configuration, you will be able to import, view, and type characters in a foreign language, as well as
save and export reports in that language.

10.1.2.1. EDAB Language Translation
Internationalization is supported through the use of an .xml file, EDAB_Language.xml (located in the <EDAB
installation directory>). A GUI is provided to work with the EDAB_Language.xml file and replace the lines of
English with those of another language.
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The EDAB_Language.xml file has the following structure:

<Product name="REPORTDESIGNER" dir="quadbase/reportdesigner/designer">

      <File name="ReportMenubar.java">
            <CODE>File</CODE>
            <TEXT>File</TEXT>
            <CODE>New</CODE>
            <TEXT>New</TEXT>
            ... </File> 

</Product>
        

The file has the following tree structure: Product (Directory) → File → text. You can easily search the product,
file, or text you want to translate and simply replace the Text between <Text> and </Text> with the transla-
tion. EDAB will replace <Code> with <Text> in the Java Swing UI and/or in the EDAB web application. The
translation GUI will list all products and each product will list codes that need translation. A same code (for ex-
ample, File) may be listed under several products to maintain the completeness of each product. However, the
translation for a code is duplicated across all products. The same code cannot have two different translations for
different products.

The EDAB_Language.xml file is located in the install directory. It is recommended that you make a copy (of
EDAB_Language.xml) and then use the GUI provided (on the copy) to put in the translation without touching
the xml file directly. To utilize the user interface, navigate to the EDAB root directory and enter the following
command:

java -classpath "./lib/EDABOrganizer.jar;.;"
 quadbase.internationalization.TranslateWizard -file:<fileName> -
enc:<encoding>
        

where <fileName> represents the xml file that will store the translation and <encoding> represents the en-
coding for the translation. For correct results, the proper encoding must be specified. If the file name and encoding
are not provided, the default file name (EDAB_Language.xml) and default encoding (Cp1252) will be used.

An example of the above command is given below:

java -classpath "./lib/EDABOrganizer.jar;.;"
 quadbase.internationalization.TranslateWizard -file:Chinese.xml -enc:gbk
        

Where gbk is the encoding used to save Chinese.xml file.

When the Translate wizard is started, it appears as below:
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Translate Wizard

You can see the various codes (available for translation) by selecting appropriate Product. Products are shown in
a tree on the left that contains all the files available for translation. For example, on the image below you can see
expanded QUERYBUILDER product. You can either translate entire product by selecting the product node or just
select a file that you want to translate.

Insert Translation

The English texts are listed on the left and you can enter the translation on the right. The translation can be entered
by clicking on the cell and typing in the text. The translation can be saved (to the file specified by the command
that started the wizard) by clicking on the SAVE button. You can navigate to the previous screen by clicking on
the PREVIOUS button. Note that if a translation for a code has already been set, it will appear for every instance
of the code.

You can use EDAB_Language.xml (or the copy you modified) in EDAB Organizer by adding the -file and
-enc arguments (e.g. -file:ERES_Language.xml and -enc:UTF-8) to the java web start (jnlp) file that
starts Organizer (in ERESOrganizer.jnlp).

For the web application, edit index.jsp page as follows:
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• Add an import for the LanguageEncoder class:

<%@page
 language="java" import="quadbase.common.util.internal.LanguageEncoder"
 errorPage = "MenuError.jsp" contentType="text/html; charset=UTF-8" %>
<jsp:useBean id="index" scope="session" class="quadbase.auth.bean.Index" /
>
<jsp:setProperty name="index" property="*"/>
                

• Add a few lines near the beginning of the jsp to load the language file.

<%
     quadbase.common.util.internal.LanguageEncoder.load("<language
 file>", "<encoding>");
     index.setRequest(request, application);
%>
                

where <language file> is the language file (for example, Chinese.xml) and <encoding> is the en-
coding (for example, gbk).

10.1.2.1.1. Upgrading Language File
When the user upgrades to a newer version, the EDAB_Language.xml file needs to be upgraded as well. The
language upgrade program will copy over the translations from the previously customized EDAB_Language.xml
file and append the additional entries in the new version. To use the language upgrade program, navigate to the
EDAB directory from a console window and use the following command:

java -classpath ".;.\lib\EDABOrganizer.jar"
 quadbase.internationalization.UpgradeLanguageXMLFile -from:oldfile -
to:newfile -enc:encoding
          

It may be necessary to replace the semicolon with colon and backslash with slash on non-Window environments.

Oldfile refers to the customized EDAB_Language.xml from a previous version of EDAB, newfile refers to the
EDAB_Language.xml included in the upgraded EDAB installation, and the enc is the language encoding used
in the translation. After running the program, the resulting file will be named EDAB_Language.xml and you
can open it with Translate Wizard to further translate any new entries.

10.1.2.2. Displaying Foreign Characters
Foreign characters can be easily displayed in Designer and various Viewers. To display foreign characters in a
report/chart, you will need to have fonts for that language installed in your system. Then, in the report/chart, you
can set the font for the object that contains foreign characters to the appropriate system font.

Another option is to modify the font.properties file in the JVM so that foreign characters are supported in the
default JVM fonts. For Sun JVMs, the font.properties file is located under the jre/lib directory. The different
language files have names like font.properties.ru for Russian, font.properties.zh for Chinese,
etc. To change the language settings for the JVM, rename the current font.properties file to back it up and
change the name of the desired language file to font.properties. With the language settings changed in the
JVM, the default fonts in EDAB (Dialog, Serif, Monospaced, etc.) will display with foreign characters.

10.1.2.3. Entering Foreign Characters
In order to enter foreign characters into any EDAB interface (for example, Organizer and Designer), the following
changes to the system settings are required:

• The default locale of your system must be set to the region for the language you want to use.
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• The input locale for the system must also be set to the region for the language you want to use

Note that for Windows the settings can be accessed through Regional Options in the Control Panel.

In addition, the font settings in the JVM must be adjusted to the desired language following the instructions discussed
in Section 10.1.2.2 - Displaying Foreign Characters.

Once these settings have been applied, foreign characters can be entered in labels, queries, formulas, and parameters
in reports/charts.

10.1.2.4. XML Encoding
By default, EDAB use UTF-8 character set for encoding when writing to XML. This includes data registry files,
XML report templates, XML exports, and XML representations of global format information and font mapping.
Please note that for most of users it is not necessary to change character set encoding, because UTF-8 fully supports
all languages.

This encoding can be changed for other languages by adding a run-time parameter to Organizer and EDAB Server.
For Organizer, you can do this by modifying the JSP source of the applet page used to launch the Organizer.

To change the XML encoding, you will need to add the following parameter to the Organizer.jsp page:
<PARAM NAME="xml_encoding" VALUE="ISO-2022-JP">.

This parameter also needs to be set for the server. For more information about server settings, please see Sec-
tion 1.4.1.3.1 - Secured Parameter.

10.1.2.5. Exporting With Foreign Characters
Most of the EDAB export formats will be automatically generated with the UTF-8 character encoding. In order
to view the exported reports/charts, the client will need to have the appropriate system fonts installed. The only
exception to this is the PDF export. PDF format does not depend on client fonts for viewing. Therefore, foreign
language fonts will need to be embedded into the PDF document in order for characters to display properly. To do
this, you will need to use the PDF Font Mapping feature. The Font Mapping can be set in Designer and in API.

If you wish to export the report/chart to a locale different from the one that is set on the machine, you can specify
a different encoding before doing the export. This is done using the following method in QbReport:

public void setExportEncoding(String encoding);
        

where encoding is a character encoding supported by the Java 2 platform. For example, the character encoding for
English (Windows Latin-1) is Cp1252. Please note that you have to use the canonical name used by the java.io
and java.lang APIs.

You can also specify the character set used in the DHTML exports using the following method in QbReport:

public void setHTMLCharSet(String charset);
        

where charset is a valid character set. For example, a character set for English used in DHTML documents is
UTF-8.

10.1.2.6. Specifying Encoding for Text Data Files
By default, EDAB use system encoding for any text data files. The encoding for input text data files can be set via
API using the following block of code:

report.getInputData().setDataFile("sample.dat", false, "ASCII");
        

The above block use the following method found in quadbase.reportdesigner.util.IInputData:
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public void setDataFile(String fileName, boolean isDataSorted, String
 encoding);
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Chapter 11. Alerts
11.1. What is an Alert

An alert is basically an exception handling mechanism that notifies user when certain data is out of a pre-defined
range. Typically, the user is looking at some KPIs (key performance indicators) that are important to his/her or-
ganization. Some example KPIs on which a user may want to set alerts are inventory level, profit margin, sales
growth rate, percentage of dropped calls in a mobile network, number of intrusion attempts on a company network,
response time on customer support/service center etc..

11.2. Specifying alerts
Alerts are specified in a displayable object, namely maps, charts and reports.

11.2.1. Online Maps
There is currently no support for alerts in Online Maps.

11.2.2. SVG Maps
For SVG Maps, alerts can be specified on all thresholds in the map. You can select ranges that are critical for you.
If any of the areas on the map would be in that range, alert will trigger.

If the map doesn't have any thresholds, alerts will not be available for the map.

Example:

SVG map with thresholds

You can for example say that ranges <= $90000 and $90000 - $330000 are critical and you will get alert if there
are any yellow or light green areas in the map.

11.2.3. Charts
For Charts, you can specify alerts on control areas. Similarly to SVG maps, you can choose the ranges that are
critical for you. If there are no control ranges, alerts will not be available for the chart.

Example:
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Chart with control areas

You can say that the Reject control area is critical and you will get alert whenever there is at least one data point
in this (blue) control area.

Control area ranges are evaluated as left-closed, right-open intervals [start, end). In other words, the alert will trigger
if the following condition is true: start <= ActualValue < end.

11.3. Alert types
EspressDashboard supports two types of alerts, dashboard alerts and monitoring alerts. Dashboard alerts are eval-
uated only on currently opened dashboards. They are not triggered when the dashboard is not open. Monitoring
alerts are alerts in scheduled objects (reports, charts, maps, dashboards). Monitored alert tasks are run at certain
times. You can set a time pattern or specify custom times (timing possibilities will be described later). At the time
when alert monitoring task is run, alert conditions are evaluated and the monitoring task actions (i.e. Send email,
upload to FTP) are run only if an alert was triggered. If no alerts in the alert monitoring task are triggered, no action
is performed.

11.3.1. Dashboard alerts
Dashboard alerts are set up for individual templates (reports, charts, maps) in the dashboard using the user interface
in the dashboard builder. Alert (exception) conditions are evaluated when the templates are exported, i.e. during
initial loading, auto refresh, manual refresh of the dashboard, changing parameters and resizing the template. Auto
refresh is enabled every time you preview or view a dashboard. Default auto refresh interval is 60 seconds.

11.3.2. Visual alert display
If an alert was triggered, color of template border will change and the border will start blinking. For templates in
folders, tab header color will change and blink.

In addition, the template will have its own “native” highlighting of the values:

• coloring of areas in the SVG maps

• control ranges in charts

Please note that alert highlighting, blinking and alert messages are visible only in Preview of the Dashboard Builder.

11.3.3. Alert messages
If you also set up an alert message, a message with your text will pop-up.
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Triggered alert message

11.3.4. Sound alert
In some cases, sound alerts may be preferred over the visual alerts. When an alert is triggered, the template will
continuously make beeping sound. If the alert is muted and you change a parameter in the template and the watched
alert is triggered again, the alert sound will be active again. However, if the same watched alert is triggered after
auto refresh, the alert sound will not reset, but if another watched alert is triggered, the alert sound will be active
again. If the alert is disabled during auto refresh, it will reset back to active state.

11.3.5. User interface

Alerts dialog can be accessed using this button  in the header of every template in the dashboard. This button
is only visible for templates that can have some alerts. It will not be displayed for templates that cannot have alerts
(i.e. all Google maps, SVG maps without thresholds, charts without control ranges and reports without scripts with
ALERT variable).

After clicking the button, you will get a dialog with all possible alerts that can be watched (i.e. names of all control
ranges for charts or all ranges for SVG maps).

Watch alerts dialog

All the watched checkboxes will be unchecked by default, which means that no alert is watched. After checking
a watched checkbox, you enable Sound checkbox and Alert message textbox, which will allow you to use sound
alerts and alert messages. The text you fill in alert message textbox will then display as a pop-up message when the
watched alert is triggered. If you leave it empty, no message will appear. You can then check the checkboxes and
start watching the alerts. The alert name cannot be changed. It will always be read from the template.

All alerts will be joined using logical OR. If any of these alerts trigger, the dashboard alert will trigger.

11.4. Monitoring
Monitoring is supported for dashboards and also for individual reports, charts and maps (let’s call them monitored
objects). The monitored objects are checked in given time intervals and notifications are sent if alert occurs in some
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of the monitored objects. This is done in background, so the notifications are sent even if the monitored object is
not viewed.

The user interface to set up monitoring is a simple wizard dialog. If the monitored object has parameters, user can
set up several parameter sets. Monitoring has many options for testing intervals (e.g. one time, time interval, fixed
days, etc.). Monitoring is not supported for drilldowns.

Administrators and designers are the only users who can set up monitoring (only for objects they have read access
to). They can also select recipients of notification emails. Viewers are not allowed to set up monitoring.

11.4.1. Alert notifications
Alert notifications are sent via emails. Exported templates can also be uploaded to FTP. Alert notification can be
sent every time an alert occurs or it can be send only when an alert starts (i.e. if alert wasn’t triggered during last
check, but it is triggered during current test).

You can set email subject and body. They have to be the same for the entire monitoring (for all templates, alerts and
parameter sets). Body of the notification email can contain some variables that will be substituted during runtime.
List of these variables will be detailed later (Section 11.4.3.1.1 - Email Delivery Options).

You can set different recipients for different templates and different parameter sets. It is not possible to set different
recipients for different alerts in one template. If you want that, you have to create another alert monitoring task
(you can add as many tasks as you want).

11.4.2. Failed emails
If some of the monitored objects are not available, or their data sources are not available, or if there are any other
problems with exporting the monitored objects or alert evaluation (e.g. watched control area was removed), the
user can be notified with failed emails.

You can set failed email subject and body. Recipients are the same as for the notifications. Error log (with
stack traces) can be sent to a selected user (typically admin). Failed emails dialog will be described later (Sec-
tion 11.4.3.1.1 - Email Delivery Options).

11.4.3. User interface

11.4.3.1. Create/Edit monitoring dialog
To set up new alert monitoring task, please use the following steps:

Launch the Create alert monitor-
ing wizard -

first of all, launch Organizer and select at least one file you want to monitor.
You can also select multiple files from single directory, but you don't have
to select all files you want to monitor at once because you will be able to
modify the file list later (and maybe add more files from different organizer
folders if needed). Then you have two options: either right-click on one of
the selected files and then choose the Set alert monitoring option from the
pop-up menu, or you can click Monitoring (in the main menu) and then select
Set Alert Monitoring. Both methods will open the first step of the Setup alert
monitoring wizard.

Select alerts - Select templates you want to monitor in the task. You can select any dash-
board, stand-alone report, chart or map.
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Create monitoring task dialog

The monitored template list is a tree.

The first level of the tree is the selected templates (before the dialog was
opened) or templates added using the Add button. The leaf nodes are avail-
able alerts (for their parent node). You can check alerts that should be mon-
itored. You have to select at least one alert for each template. If you don't
want to monitor any alert of a monitored object, remove the object by select-
ing it and clicking the Remove button.

If the selected template is dashboard that already have some dashboard alerts
defined, the checkboxes are initialized according to the dashboard alerts (the
alerts that are watched in the dashboard are checked). If the selected template
is not dashboard, all the checkboxes are unchecked by default.

Following two buttons allow you to set export format. Monitored templates
will be exported to this format in case an alert was triggered. Also, if you se-
lect additional delivery options like email or FTP delivery (will be described
later), templates will be delivered in this format.

Report options - shows dialog allowing you to set report export
format. For reports, you can select DHTML,
PDF, CSV, Excel (XLS), Excel 2007 (XLSX),
text, rich text, or XML. Additional options al-
lows you to select single page or multi-page ex-
porting for DHTML and XML. The Options...
button allows you to set format-specific options
for the exported file. For DHTML, you can set
single or multi-page exporting and you can also
specify which CSS options to use. For PDF, you
can set encryption, and for text you can specify
the delimiter.
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Report Options Dialog

Chart options - shows dialog allowing you to set chart export
format. For charts, you can select JPG, GIF,
PNG, PDF, SVG, or FLASH. Other options al-
lows you to specify PNG compression, set JPEG
quality, and specify background transparency
for GIFs. You can also enable and configure
Flash animation if the image depiction should be
animated. You can also specify the size of the
exported image.

Chart Options Dialog

Set timing – allows you to set a time pattern of the alert monitoring task.
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Set timing dialog

You have following timing options:

One time only - task is run one time only at pre-de-
fined time. You can choose when the
task will run using the Begin on op-
tion (will be described later).

At regular time interval - alert monitoring task will run at fixed
intervals for a pre-defined period of
time. For example, you can set the
task to run every X hours (or min-
utes, days, months...) from Begin on
to End on time and date. When you
select this option, the Set time inter-
val dialog pops up. This dialog will
be described later.

On fixed days/dates every week/
month -

If you need to run your task ir-
regularly, this option should do the
trick. It allows you to run the task
on certain week day(s) (for example:
every Monday and Friday), or cer-
tain days of the month (for example:
first day of a month). This is set in
the Set fixed days/dates Interval dia-
log which pops up when you select
the option. Also, when you select this
option, the Daily frequency section is
enabled. These two dialogs will be
described later.

You also need to set when the task should start running and when it should
stop. You can do that using the following options:

Begin on - allows you to set when the task will start running. By de-
fault, the Start now option is enabled. It means that the
task start time and date will be set few minutes in the
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future, thus the task will start running immediately after
you're done configuring it. If you don't want the task to
start immediately, uncheck this option to pick the start
time and date from a calendar. You can access the cal-
endar by clicking the Change button (which is available
only when the Start now option is disabled).

End on - controls when the task will end. This option is very sim-
ilar to the Begin on option. The only difference is that the
Start now option is replaced by Run indefinitely option.
If you choose this option, the task will never stop unless
you stop it manually. Or you can unselect this option and
pick the End on time and date manually from a calendar.

Set Time Interval Dialog

This dialog is enabled only if the At regular time interval option is selected.
First of all, choose a time unit (namely: hours and minutes, days or months)
that suits your needs. Then enter a number of the time units that should be
waited for between each task runs.

Set Fixed Days/Dates Dialog

This dialog is enabled only if the On fixed days/dates every week/month op-
tion is selected. First choose whether you want to run the task on a weekly
basis or monthly basis. Then select days of the week or month the task should
run on. After you're done setting this dialog, click the OK button and proceed
to the Daily frequency settings.
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Daily frequency settings

After you have set the days of the month/week you want the task to run on,
you have to set when exactly it should run during those days. That can be
done in the Daily frequency section. You have two basic options:

Set run times - allows you to manually enter the run
times. You can add as many values as you
want. You can use 12-hour or 24-hour for-
mat. Individual values must be separat-
ed by comma. For example: 08:05AM,
11:15PM, 22:35

Set fixed interval - use this option to run the task periodically
from the From: time to the To: time every
X hours/minutes. To set the times, you can
use up and down arrows or you can enter
the value manually (click in the field and
enter a number). If you enter an incorrect
time (for example: 11:65), the value will
be marked with red color. Correct values
are marked with green color.

Once you finish specifying the periodicity, click the Next button to continue
with the schedule wizard.

Set parameters – this step is skipped if there are no parameters in the selected templates. If
you have selected to monitor a report, chart, map or dashboard that contains
parameters, the next tab will appear allowing you to set the parameter values
you want to use.
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Set parameters dialog

To add a set of parameters, select the Add button. This will bring up the pa-
rameter prompt dialog allowing you to select the set of parameter values you
want to use. Once you have selected a parameter set, your choices will appear
in the dialog. You can add as many different combinations of parameter sets
as you like. A separate file will be generated for each set of parameters you
specify. Alerts will be evaluated separately for each parameter sets. Only the
templates that triggered some alerts will be sent in the notification email or
uploaded to FTP.

You can also specify a name for each parameter set by double clicking on
the first column. The name specified here will be used in later dialogs to help
you organize your recipients.

Once you specify all parameters, click the Next button to continue.

Set delivery options - This dialog allows you to configure the delivery options for the alert notifi-
cations.
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Delivery options dialog

You have two delivery options:

Email Delivery - allows you to send an email when some alert was
triggered during task runtime. How to config-
ure email settings will be described later (Sec-
tion 11.4.3.1.1 - Email Delivery Options).

FTP Delivery - uploads exported report(s) to a FTP server if a
monitored alert was triggered. FTP delivery set-
tings will be described later (Section 11.4.3.1.2
- FTP Delivery Settings).

You can select if you want to perform the delivery (send emails or upload
files to FTP) every time an alert occurs or if you only want to perform it when
alert starts (i.e. if alert wasn’t triggered during last check, but it is triggered
during current test).

Email Recipients - If you selected email delivery, the next tab allows you to specify the recipient
list. The recipient list is set up differently depending on the type of monitored
object you are monitoring. If the monitored object contains parameters, you
will see the following dialog. This allows you to send different parameter
sets to different users or groups.
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Set recipients dialog for parameterized reports

Entering recipients into the list is simple, click on the Add User/Group icon
to select users and groups from the EDAB database. You can also add regular
email addresses by double clicking any row in the recipients list and typing
it in manually. You can also click on Add User/Group and view the Prev.
List tab for previously listed recipients.

If you want to send all parameter sets or all templates to the same recipients,
you don't have to add the recipients manually into all parameter sets and
templates. Just add the recipients into one recipients list and then use one of
the following buttons:

Copy to all templates - click this button to copy current re-
cipient list into all scheduled tem-
plates recipient lists.

Copy to other parameter sets - allows you to copy current recipient
list to the rest of the parameter sets.

For all other cases, you will see the following dialog containing only one
recipients list.
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Set recipients dialog

11.4.3.1.1. Email Delivery Options
When you click the Config button for email delivery, the following dialog will open allowing you to set an email
message.

Email settings dialog

The first tab contains information for the email sent when the report or chart has successfully exported. The General
Email Information portion of this tab allows you to specify the from addresses for the email as well as the subject.

The first tab is called Successful email and it allows you to set an email message which will be sent in case the
scheduled task finished with no problems.

There are following elements:

From: - enter an email address into this field. This address will be used as an email
sender's address. Please make sure that your SMTP server won't reject the
address (depends on your SMTP server security settings).
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Subject: - email subject. Enter any convenient text in here.

Email body text - enter a message that will be sent on every task run. You can enter any text
and you can also use Runtime variables (will be described later).

Attach exported files - allows you to attach all exported reports and charts to the email.

as HTML - if this option is enabled, email body text will be replaced by the scheduled
report or chart in HTML format. This option is available only if the Attach
exported files is enabled and there is only one scheduled report/chart in the
scheduled task. Also, PDF, SVG and Flash charts can't be added into HTML
emails and only HTML and DHTML reports can be added into HTML email-
s. You can set the export format on the Create task tab - described in Sec-
tion 11.4.3.1 - Create/Edit monitoring dialog.

Insert runtime variables - allows you to insert certain variables into the email body text. Variables are
replaced by real values at the task run time. All variables also have a “default
value”. If no convenient data can be inserted into the variable, the default
value is used (for example: when user hasn't provided his name). You can
choose among following variables:

<USERNAME> - recipient's user name. For example: you can
use this variable in a salutation like Hello
<USERNAME>. This variable works only for
email recipients that were chosen from the
EDAB database (adding email recipients was
described in previous chapter). If you add an
email address to recipients list manually, no
username is displayed because no username
was provided.

<FULLNAME> - recipient's full name. Just like the USERNAME
variable, this variable also doesn't work for
manually entered recipients email addresses.

<EMAIL> - recipient's email address.

<TIMESTAMP> - current time and date. Shows when the email
was sent.

<PARAMETERS> - list of all parameter sets and parameter values.

<SAVED_LINKS> - links of all files in which at least one alert was
triggered. Users can access the exported files
through these links.

<LIVE_LINKS> - links of all files in which an alert was triggered.
Unlike the SAVED LINKS, these links lead to
DHTML Viewer which allows users to access
current version of the triggered files.

<ALERTS> - names of all alerts that were triggered during
the export.

<ALERT_DETAILS> - For reports, alert details are replaced by
whole row of data in a format like (COLUM-
N1_NAME) VALUE1 (COLUMN2_NAME)
VALUE2... For charts, it shows values of the
tooltips that would be displayed on the data
points that triggered alerts. For maps, it shows
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all values from the data source rows associated
to the areas that triggered alert.

Note
In order to send email correctly, the SMTP host needs to be set up. How to configure a SMTP server
is described in Section 1.4.1.2 - Setting Info.

The Failed Email tab allows you to send a different email (subject and body) to your recipients if an error has
occurred during the task running (for example: one of the scheduled reports has been removed).

Failed email settings dialog

This tab also allows you to send error logs to a specific user. Typically, this would be the admin or technical user
who is able to diagnose and troubleshoot the problem.

11.4.3.1.2. FTP Delivery Settings
When you click the Config button for FTP delivery, the following dialog will open allowing you to set options for
FTP schedule delivery.

FTP Delivery Options Dialog

The following information is required for FTP schedule delivery:

FTP Host Name: This is the hostname of the FTP server you want to use to upload the reports. If you have
a Secure FTP Server (SSH FTP), enter sftp:// in front of the hostname.
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FTP Upload Path: This is the path or directory (relative to the FTP root) where you would like to write the
exported report files.

FTP User Name: This is the username for the FTP server.

FTP Password: This is the password for the FTP server.

11.4.3.2. Monitoring list
You can view monitoring list from pull-down menu Schedule/Archive → View Alert Monitoring Tasks. The dialog
allows users to view, edit and remove current monitoring tasks.

View alert monitoring tasks dialog

It also displays the following info about each monitoring task.

• name

• next check time

• last check time

• last check result (alert was triggered or not) – red light means that an alert was triggered, green light means no
alerts

• last triggered time

The Check Now button is similar to the Run Now button in the Schedule list dialog. It checks selected alerts imme-
diately (and sends notifications if necessary).

You can use the Details button to view more details about selected monitoring.
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Alert monitoring details dialog

The Monitored files list contains list of all monitored files with all monitored alerts (in the square brackets). It also
contains all parameter sets if the template is parameterized. If you hold cursor over a template or parameter set in
the Monitored files list, you will get a tooltip with more details.

11.4.4. Monitoring log
To open the monitoring log, log in as admin and click Admin Console. Then go to the Server option tab, select
EDAB logs category and click the View Alert Monitoring Log button.

View alert monitoring log button

The monitoring log will pop up in a new window. The log contains monitoring tasks that have been checked at
least once in the past.
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Alert monitoring log

The most important indicator is whether an alert was triggered at the last check. Basically, triggered alerts are
highlighted by red color.

There are several possibilities:

Task that doesn't contain any triggered alerts looks like this:

Task with no triggered alerts

Task that contains at least one triggered alert looks like this:

Task with one triggered alert

Alert that wasn't triggered at the last check:

Untriggered alert

Alert that was triggered at the last check:
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Triggered alert

Each task has a Success indicator which is not to be confused with triggered/not triggered alerts. The indicator
tells whether the last check was performed successfully. There are a few things that can go wrong during checks
- monitored templates or alerts could have been renamed or removed, one of the delivery options (FTP or Email
delivery) may have failed because of network problem... If a check has failed, the Success indicator will look like

this: . You can get more details about failed checks in a drilldown, which will be described later.

A template can have multiple parameter sets and/or multiple monitored alerts. In such situations, the template will
take several rows in the template list, but its name will be displayed only once (see the following picture).

Parameterized chart with two monitored alerts

It is possible to exclude tasks without any triggered alerts from the log. To do that, click on the  Filter icon
and set the Show only tasks with triggered alerts? parameter to true.

Log filter

To display detailed report about a task, click on its name. A second level of the monitoring log will open.
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Task details

The second level log contains results of all alert checks (unlike the root level log which only contains result of the
last check). Triggered alerts are also highlighted by red color. The Success indicator is displayed for all templates.

If you are wondering why notifications were not sent, always check the Send notifications indicator. The indicator
has two possible states:

Always - notifications will be sent every time an alert occurs

First alert occurrence - notifications will be sent only when an alert wasn't triggered during the pre-
vious check, but was triggered at the current check. So if an alert was trig-
gered in two consecutive checks, notifications would be sent only once. If
notifications were not sent because of this feature, the task's Success indica-

tor will look like this .

To go back to the root level log, click on the  back icon.

If the task uses some additional delivery method(s) (FTP or Email), you can click on the Success indicator. A third
level of the monitoring log will open showing the delivery method's settings and results. If there is no additional
delivery method, the Success field will not be clickable.

The third log level's appearance may vary. If a notification was performed, its detailed log will open. If a notification
wasn't performed (for example: the alert wasn't triggered), only delivery settings will be shown.

Note
There is a difference between not performed delivery and failed delivery. A delivery isn't performed
when the alert wasn't triggered or, in some cases, when the Send notifications on first alert occurrence
only feature is enabled (as described above). In that case, the EDAB server doesn't even try to perform
the delivery. If a delivery failed, it means that the EDAB server tried to perform the delivery (because
the alert was triggered), but it wasn't able to finish (for example: because of a network problem, a
human error...).

Delivery settings
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FTP delivery settings

Email delivery settings

Delivery logs

FTP delivery log shows FTP delivery settings + results. If the delivery has failed, an error message is also displayed.
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FTP delivery log

Email delivery log shows basic email settings and results for all recipients. In the following picture, you can see
that emails from clint@quadbase.com to john@quadbase.com and peter@quadbase.com (not ac-
tual email addresses) couldn't be sent because the EDAB server wasn't able to connect to the SMTP server at
localhost:25. It could be caused by a network problem or by incorrect SMTP settings (as described in Sec-
tion 1.4.1.2 - Setting Info). This is probably the most common problem with email delivery.

Email delivery log

11.5. Handling special situations

11.5.1. Change in script/control area/range
If for some reason an alert is removed or renamed, the monitoring job or dashboard alert cannot find the missing
alert. The following approaches will be taken to resolve the situation.
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• For monitoring – An error email is sent. An explanation is included, e.g. alert <ALERT_NAME> not found in
the template <TEMPLATE_NAME>.

• For dashboard alert – An error icon is displayed in the template header. If you mouse over the error icon, you
will see error message explaining the problem. If you are using the Dashboard Builder at that time, you can fix
the problem immediately.

11.5.2. Missed monitoring jobs
If a monitor check is missed,because server was not running, it will run immediately after the server is started. Each
missed task will only run once, even when more checks were missed. After the missed monitoring jobs were run,
checks will be performed as before according to their schedule.
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